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*OVERVIEW OF MIXW
_________________________________________________________

1. Welcome to MixW   -- Information about the Program

2. Quick Start   -- For experienced digital mode users

3. Registration   -- How to become a registered user

4. Using the MixWHelp System   -- Finding Information! 

Welcome
_________________________________________________________ 

The Demo version of the MixW program is good for 15 days. For registration information please 
see Registration 

There are 5 sections in MixWHelp:
This overview is Section 1. To download sections 2 - 5 please see: Using MixWHelp

From version MixW3.2.102 an up to date Help file is included in the release. 
_________________________________________________________ 

MixW stands for a Mixture of different modes. MixW now fully supports CW, BPSK31, QPSK31, 
BPSK63 & 125, MFSK, RTTY, FSK31, Packet (HF and VHF including TCP/IP over AX25), Pactor 
RX/TX (TX requires TNC), Amtor (Sitor) TX/RX (No TNC needed), Hellschreiber, FAX (RX only), 
SSTV, THROB, and MT63. In addition to these built-in modes, new modes can be added to MixW using 
a facility called "External mode plugin support". The first example of a plugin mode was Olivia, which 
was included in the 2.16 release package. Additional plugin modes now available are Contestia and 
RTTYM.

MixW supports WinKeyer and a number of different manufacturers Rotors.

MixW also includes support for multimode TNCs for those preferring a hardware-based approach to the 
digital modes. Even more modes can be accessed by configuring MixW to call other software packages 
from within MixW.

Other MixW features include a voice keyer for SSB, FM, and AM phone modes. Excellent logging, QSO 
scheduling and reminding, and even auto CQing of scheduled events through the fully configurable 
MACROS. There is also a sophisticated contest mode facilitating competitive digital mode contest 
operation, and an export of the contest log to the newly required Cabrillo format. The log will import and 
export CSV and ADIF files. MixW has support for printing custom QSL cards or labels and automatic 
sending of QSO data to eQSL. There is built in DX Cluster support either via Packet Radio or the 
internet. 

MixW does not require a TNC to operate. The requirement to run MixW2.19 and earlier is you have a 
computer running Windows 9x, ME, NT, 2000, XP, Vista, Windows 7, Windows 8 or Windows 10 
operating system, either 32 or 64 bit can be used and a compatible soundcard. MixW2.2 or MixW3 



requires an operating system of Windows2000 or later.

If you are experienced with the sound card modes you can just go straight to the Quick Start.

If you are new to SoundCard digital mode operation, you will need to connect your radio's transmit and 
receive audio to your computer soundcard via the mic or line input, and the headphone or line output. 
You will also need to provide for transmit keying by PTT or some other method.

The following site is recommended for additional information about interfacing your radio with the 
computer. First go to:

Understanding Soundcard Interfacing, by Ernie Mills, WM2U:
http://www.qsl.net/wm2u/interface.html 

to get an overview of the subject. Then if you are a home brew ham, just get to work and build an 
interface. If you are an appliance type there are plenty of plug-and-play interfaces. Follow any of the links 
on Ernie Mills' site above, use your favorite search engine, or check amateur radio magazines for the 
latest information. 

_________________________________________________________ 

AND NOW A WORD FROM OUR SPONSORS

For the latest MixW software and related information, visit the MixW website at:
http://www.mixw.net

From MixW3.2.1 up to date Help files are included in the release. 

To keep up to date on the status of MixW and the latest Help files join the MixW reflector at:
http://groups.yahoo.com/group/MixW/

_________________________________________________________ 
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To learn more about using MixWHelp, see Using MixWHelp.

If you have any concerns or comments about the contents of MixWHelp contact:
Colin Bell, 2E0BPP 
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Quick Start
________________________________________________________

A brief outline for configuring and operating MixW for experienced sound card digital mode users. 
For the full MixWHelp suite see: Using MixWHelp 

If your station is already interfaced and configured for SoundCard digital software, and you're an 
experienced operator with the SoundCard digital modes, then all you need to do to get on the air with 
MixW is: 

• Install the software 
• Configure your Personal Data 
• Configure your Transceiver PTT settings 
• Review the commands for basic operation 
• GOTA! (Get on the Air)! 

_________________________________________________________

Install the software: 

The program download is a self extracting installation file.

From Windows XP onwards the operating system is built in either 32 or 64 bit format. MixW, which is 
only released in 32 bit format, will run on either formats the only difference is during the install if a 
default installation is being performed. The program files are installed in C:\Program Files\MixW\ on 32 
bit systems but in C:\Program Files (X86)\MixW\ on 64 bit systems. 

Up to Mixw V2.19 you can choose any directory you would like, or use the default directory of 
C:\Program Files\MixW\ for 32 bit systems or C:\Program Files (X86)\MixW\ for 64 bit systems

For Mixw2.2 and Mixw3 the installation has two parts, the program files which will be installed into the 
default 

For 32 bit Windows installation C:\Program Files\MixW\
For 64 bit Windows installation C:\Program Files (X86)\MixW\

program files directory unless the selection is changed on the installation screen and the data files which 
can be installed into any directory of your choice or by default:
for windows XP:
  C:\documents and settings\{your_username}\Application Data\Mixw\
for windows Vista, Windows 7, Windows 8 or Windows 10:
  c:\users\{your_username}\Appdata\Roaming\Mixw\

Make sure you remember the directories you installed the program and data files in. Windows does 
not always display full pathnames which can lead to 'lost' files or using the 'wrong' file. 

The extraction procedure will automatically install all the files MixW needs to run on your system. The 
most important files for you to know about are:

MixW2.exe (the main program file for V2)
MixW3.exe (the main program file for V3.0 and V3.1)
MixW3_2.exe (the main program file for V3.2) 
CmnData.dll (program information)
bands.ini (default band frequency information)



contest.mc (contest macros)
cty.dat (antenna heading system)
pfx.dat (prefix id file)

Other files are automatically created by MixW which are:

MixW2.log (default log file - be sure to back up often!)
MixW2.ini (default initialisation file - saves your configuration - back up often)
MixMacros.ini (default macro file created when you first modify a macro)

As you learn to use new features of MixW you will create new files, particularly for your mode specific 
macros. These files will have a .mc or .ini extension.
Be sure to back up all of your *.mc and *.ini files, as well as your .log files.

Up to Mixw2.19 if you have registered MixW, make a copy of your MixWReg1.dll file and paste it into 
your MixW folder. 
Mixw2.2 and Mixw3 do not use a registration file. Registration is achieved by connecting to the internet 
and then selecting the Menu Help->Apply registration. 
_________________________________________________________ 
In early versions of MixW Help from the menu bar was not always visible.

Mixw uses two different menu layouts. If Help is not available change your menus to look like this:

If the Help menu is not visible in the main Mixw menu bar, select:

View | Menu and choose Layout 1.

_________________________________________________________

Configure your Personal Data: Select Configure | Personal Data. This will display the following dialog 
box:



Enter your Station information and select your CW ID options, then click OK. (Your callsign should be in 
ALL CAPS).

Configure your Transceiver PTT settings:

If you are using VOX to trigger TX/RX function, and you are not using CAT features you can ignore this 
section entirely and go directly to the Commands for basic operation.

If you are triggering TX/RX with a PTT circuit, or CAT control, you will need to configure MixW to key 
your transceiver. To do so Select: Configure | TRCVR CAT/PTT. This will display the following dialog 
box:



This dialog box is for the PTT and/or CAT features. If you will not be using the CAT function, set 
TRCVR to "None", ignore the rest of this dialog, and click on "Details" to configure your PTT COM port 
options. 

If you will be using CAT for PTT, first select your transceiver make and model from the drop down 
menus. (Note: if your model is not listed, try a similar model of the same make. For instance, almost all 
CAT capable Kenwoods work with the TS-850 setting). Next, check PTT via CAT command box, then 
click on "Details" to configure your CAT COM port options.

Select the COM port you will be using. If you are using this port for PTT only, then only the COM port 
number and the RTS/DTR settings apply. If you are using this port for CAT PTT then set the port to 
match the requirements of your transceiver for CAT.

If you want to use one COM port for CAT and another for PTT, first configure the CAT/PTT port for 
CAT, then choose: Configure | Secondary PTT port | Port Settings to set the secondary COM port for 
PTT.



 
_________________________________________________________

Commands for basic operation:

Mode selection
Select the mode you wish to operate by clicking Mode | your choice of mode:



 

You can also switch modes by clicking on the mode box in the status bar and selecting the mode you wish 
to operate from the pop up menu:



Switching between TX and RX: There are several ways to switch MixW between TX and RX. The 
Pause/Break key (on the computer keyboard) will toggle TX/RX. You can also toggle TX/RX by clicking 
on the TX/RX box in the Status Bar, or by using the TX and RX buttons on the Macro Bar (depending on 
your Macro Setting). 

Panic Button: Pressing the "Esc" key twice will immediately stop Transmission. Text remaining in the 
TX window will NOT be sent.

Positioning and Sizing Windows
Pointing to a vacant space on the Control Bar, Log Bar, Tuning Indicator, or any of the other "Dockable" 
windows and holding the left mouse button down while moving the mouse makes it possible to reposition 
and dock any of these features. An outline of the feature will appear when the mouse is first moved, and 
when that outline shrinks, it indicates a position where the feature may be placed by releasing the mouse 
button. The docked position of the feature will be remembered from session to session in the initialisation 
file.

Pointing to a window separator will cause the mouse cursor to change to a small pair of parallel lines, and 
pressing the left mouse button and keeping it pressed will make it possible to resize the Spectrum, TX or 
RX windows. Releasing the mouse button will leave the window in the resized position.

The following screen indicates one approach to screen layout using the various MixW displays:

Notice that the status bar will change according to the options and features specific to the mode you have 
selected, and the mode will be indicated in the mode box. For instance, IMD is only relevant in the PSK 
modes, while Connected or Disconnected is only relevant for the connected modes:



Opening Multiple RX Windows
To open additional RX windows, right click on a signal in the waterfall and select: New RX window. To 
TX on the frequency of a secondary RX window, right click on the secondary window and select: Swap. 
The primary RX window will be swapped with the selected secondary window and then RX can be 
initiated on that frequency.

_________________________________________________________ 

These basic commands will suffice to get you on the air with MixW's default settings in most of the 
modes, however, there are many user configurable settings to refine and improve your operation. To learn 
more about general operating settings, as well as settings for the specific modes offered in MixW, see the 
Welcome and Using MixWHelp topics for information on other MixWHelp modules.

The Demo version of MixW is good for 15 days. For registration information click Registration. 

Registration
______________________________________________________ 

The Demo version of MixW is good for 15 days. There are no other restrictions on the demo.

The Registration Fee for MixW2x is $50 USD.

To register and pay online, up to MixW2.19 please visit: http://www.mixw.net 

When your registration is received you will be sent a special registration file via EMAIL, MixWReg1.dll, 
which will stop the timer in the downloaded program.

A dual registration can be issued provided that the second call is either the user's own MARS call, another 
personal call issued by a different country, or another member of the Immediate household living at the 
same address (confirmed by a callbook).

_________________________________________________________

For MixW2.2 the cost is the same as for MixW2.19 but for MixW3 an upgrade from MixW2.x is an 
additional $20 US Dollars or an outright purchase it is $70 US Dollars (or equivalent in other currencies).
To download MixW go to http://www.mixw.net. There are two download sections:

A centre column with New Updates. Scroll down to find the latest available version of MixW.

On the left a Menu heading below which is a Download entry. Double click this entry and any version of 
MixW from V2.21 for MS Dos and later can be downloaded.

To check if you are registered click on the Check Registration green tick in the New updates latest 
version entry. If you choose to purchase by this method you will be taken through an online purchase 
procedure with Digital River GmbH (Share-it).

Once you have purchased MixW2.2 or MixW3, by whatever means, to register MixW ensure you have an 
internet connection, start MixW, fill in your callsign detail and save it. MixW may be automatically 
registered but to make certain select Help menu.

http://www.mixw.net/
http://www.mixw.net/


If the Apply registration is greyed out MixW is registered. If not click on Apply registration...
If after 24 hours registration has not been achieved contact MixW in Ukraine, using the contact address 
on the mixw.net web site.

_________________________________________________________

Once registration has been achieved MixW can then be used with or without immediate internet access. 
The registration information is copied to the Windows registry.

For additional registration information visit:
http://www.mixw.net,

Using MixW Help
_________________________________________________________ 

In early versions of MixW Help from the menu bar was not always visible.

Mixw uses two different menu layouts. If Help is not available change your menus to look like this:

If the Help menu is not visible in the main Mixw menu bar, select: 

View | Menu and choose Layout 1.

_________________________________________________________

MixWHelp can provide you with very powerful methods to help you find the information you are looking 
for, if you take just a moment to learn to use the tools available.

FIRST: Notice that the Table of Contents stays visible under the Contents tab in the left panel while you 
are viewing the contents of the topic in the right panel. The name of the topic you are viewing is 
highlighted so you can keep track of where you are in the file.

http://www.mixw.net/


Note: A red star on the topic symbol  in the Contents indicates a new topic, or a topic with major 
modifications.

SECOND: The Search tab provides a full text search which will find, and highlight, every occurrence of 
a word. This not only helps you find the topics where a subject is discussed, but makes it easy to locate 
the word within the topic by looking for the highlight.

THIRD: Use the Back and Forward buttons at the top of the Help window when you return to topics you 
have been reading. The Back and Forward buttons will take you to the position in the topic from which 
you left, rather than back to the top of the topic.

FOURTH: MixWHelp has 5 modules, each of which can be downloaded individually, so that you only 
need to download the modules you want, or the modules which have been updated. After downloading 
unzip and place the modules you want to use, up to MixW2.19 in the MixW folder, for MixW2.20 and 
later in the data folder. All modules are optional except the Overview of MixW module (which is 
included in the program release package).

Blocked Files. 

Windows XP and later Windows versions may mark the imported files as a security risk. If you are not 
able to access a downloaded and unzipped file, start Windows Explorer and navigate to the inaccessible 
file and right click on the file. Then left click on Properties at the bottom of the menu. In the Properties 
dialog box look at the bottom for a statement like: "Security: This file came from another computer and 
might be blocked to help protect this computer". Click the Unblock button beside that statement, and then 
click the Apply and OK buttons. Repeat for each file that will not open.

Module Name File Name Comments

Overview of MixW MixWMain.chm Required Module
Must be in MixW Data Folder

Configuration and Set Up MixWConfig.chm Covers the most important
MixW features

Operation MixWOps.chm Menu descriptions and operations
that are common to all modes

Digital Modes MixWModes.chm Basic theory and operating specifics
for each of MixW's modes

Appendices MixWApndx.chm More detailed and less frequently used 
information

To use MixWHelp standalone, such as on a different computer, copy the modules you want onto the 
computer and create a shortcut, on the desktop, pointing to MixWMain.chm.

_________________________________________________________

To download the MixWHelp modules see the Files section on the MixW reflector (see below)

or

the MixW web site http://www.mixw.net

MixW help is available as a .pdf file from the reflector.

http://www.mixw.net/


To keep up to date on the status of MixW join the MixW reflector at:
http://groups.yahoo.com/group/MixW/

_________________________________________________________

http://groups.yahoo.com/group/MixW/


*CONFIGURATION & SET UP
_________________________________________________________

1. Configuration   -- Software Settings

2. Basic Set Up   -- PC/Tcvr Interface

3. PTT Circuit   -- Hardware Connection

4. Configuring Macros   -- Operating Efficiently

Configuration
_________________________________________________________ 

In early versions of MixW Help from the menu bar was not always visible.

Mixw uses two different menu layouts. If Help is not available change your menus to look like this:

If the Help menu is not visible in the main Mixw menu bar, select:

View | Menu and choose Layout 1.

_________________________________________________________

Personal Data
Your first task is to tell MixW who you are, and where your QTH is. Click on Configure | Personal Data. 
This brings up the following dialogue box:



Fill in your station information, as indicated. (Use ALL CAPS for your callsign).

Note: If your location is South of the Equator your Lat(itude) value will be negative.
If your location is West of the Greenwich Meridian the Long(itude) value will be negative.

MixW will set a default log file name of MixW2.log . This log will be a semi-colon separated text data 
file located in the MixW data directory. From Version 2.2 onwards MixW now offers 4 different format 
options: 

CSV - the default Semi-colon separated fields)
MDB - Microsoft Access file format.
MySQL - SQL database. Requires MySQL to be downloaded.
Web - External Web format. Requires suitable software to be installed.

If you want to be able to send a CW ID at the end of your transmissions, click the checkbox, choose the 
speed, and enter the text to send. The <CWID> command, inserted in your sign-off Macro, sends your 
CW ID string.

When finished configuring here click the OK button.

Note: You must at least enter your station call sign in order to transmit with MixW.

MACRO Configuration
MixW has extensive Macro features for contesting as well as rag chewing. See Configuring Macros for 
instruction on configuring and operating with Macros.

Fonts
Select Configure | Fonts >Font for TX/RX windows, Font for macro buttons, Font for the Log Bar or Font 
for Telnet Windows. This will bring up the font selection dialog box. Here you can select the font that 
will be used in your receive and transmit windows, for the macro buttons, the Log Bar or the Telnet 
windows.

There are separate Font selections available in the DX Cluster settings and Additional Rx window 
configuration.

Text Colors
Select Configure | Text Colors. This will bring up the following dialog box:



Here you can select the text colors for the various text types. This is a handy way to customize your text 
to easily recognize call signs, new call signs, new DX, customize contest mode colors such as new 
multiplier or QSO before, receive and transmit window background colors etc... The ability to customize 
your applications and operating preferences is an important feature of MixW.

A separate Color selection is available in the Additional Rx window configuration.

Configure your Transceiver CAT and PTT settings:

If you are using an external interface check the installation instructions in case there are differences from 
the following CAT/PTT set up instructions.

If you are triggering TX/RX with a PTT circuit, and/or using CAT control, you will need to configure 
MixW to communicate with your transceiver. To do so Select: Configure | TRCVR CAT/PTT. This will 
display the following dialog box:



This box is for the PTT and/or CAT features. If you will not be using the CAT function, set TRCVR to 
"None" and click on "Details" to configure your PTT COM port options. 

If you will be using CAT, select your transceiver make and model from the drop down menus. 
Note: If you do not find your model continue to look carefully all the way through both lists. The lists are 
not in order. If your model is not listed, try a similar model of the same make.

Display zero beat frequency: If checked the CAT Bar will display the frequency of the transceiver. If 
not checked the CAT Bar will display the frequency of the current QSO (ie. Zero Beat Frequency + 
Audio Frequency).

If you are using a Yaesu transceiver and have elected to use a USB digital mode setting in the transceiver 
menu set DIG (Yaesu) is USB.

Default digi mode: This drop down box contains 5 selections. If you cannot find a selection that 
corresponds to your transceiver operational digital mode select none or either USB or LSB.

Default digi mode is the mode selected if you enter a mode that is defined as Default in the bands.ini file.

See Cat Bar/Cat config and Bands.ini to set the bands.ini and CAT configuration for best operation of 
your MixW/Transceiver combination. 

Check the PTT via CAT command box, if applicable, and then click on "Details" to configure your CAT 
COM port options. 



Select the COM port you will be using. If you are using this port for PTT only, then only the COM port 
number and the RTS/DTR settings apply. If you are using this port for CAT then set the port to match the 
requirements of your transceiver for CAT.

If you want to use one COM port for CAT and another for PTT, first configure the CAT/PTT port for 
CAT, then choose: Configure | Secondary PTT port | Port Settings to set the secondary COM port for 
PTT.



If you are triggering PTT by radio command (CAT) and do not need to key a separate PTT or CW circuit 
then you can click the Hardware flow control box in the CAT/PTT Serial Port dialog, and make sure your 
COM Port, Baud Rate, Data Bits, Parity, and Stop Bits match your transceiver's settings. RTS and DTR 
are not used. 
Note: The transceiver must support "hardware flow control" if this box is checked. If it does not support 
it, you will encounter several problems. If this is the case, uncheck the "hardware flow control" box, and 
instead set the DTR and RTS to "always on". Make sure you have enabled the PTT via CAT in the 
previous dialog box. 

The RTS and DTR pins of the selected COM port are where High/Low signals are delivered to key your 
PTT circuit, your CW circuit, or both. They can also be set to "always on" or "always off" to facilitate a 
combination of PTT keying via a PTT circuit in conjunction with using CAT for automatic rig QSY, 
frequency reporting, and other features. 

RTS uses pin 4 of the DB-25 connectors, or pin 7 of the DB-9 connectors.
DTR uses pin 20 of the DB-25, or pin 4 of the DB-9. 

Configuring for LSB or USB operations: The MixW options for RF, USB/LSB should be configured to 
reflect your mode of operation by selecting View | Spectrum | "Sound". "RF, USB", "RF, LSB" or 
"Auto". These must be set correctly in order for the frequencies in the log and spectrum/waterfall displays 
to represent your actual operating frequencies, and for MixW to automatically adjust the inversion 
settings based on your RF mode. 

Inversion:

Note: This feature works differently in MixW than most other SoundCard digital programs, so please 
read and understand the following information to avoid confusion while operating.

Modes that utilize the inversion feature are QPSK31, MFSK16, RTTY, AMTOR, Hellschreiber, THROB, 
SSTV, Olivia, Contestia, RTTYM and FAX. In MixW, "Inverted" means to invert the Mark and Space 
tones from the normal operating standards of the active mode. This feature can be used in cases where the 
station you are attempting to work is inverted. 

To illustrate: When using a traditional hardware TNC, RTTY is almost always operated in the LSB mode, 
utilizing a 170 Hz shift between the MARK and SPACE tones, with the MARK tone being the higher in 
frequency. If MixW is set on "RF, LSB" it will set the Mark tone as the higher tone. However, if MixW is 
set on "RF, USB" then the Mark tone will be set to the lower tone. (You can think of this as an 
automatic inversion if you like). In other words, if MixW is configured correctly (it needs to know if 
you are using LSB or USB) then it will automatically adjust your Mark and Space tones for you. You 
would only use the "Inverted" feature to operate inverted from the standard practice of that mode 
of operation, regardless of whether you're using USB or LSB.



If you are configured to use the CAT features of MixW, the USB/LSB and frequency changes will all be 
done automatically for you by selecting View | Spectrum | Auto:

Now, MixW will automatically know if you are using USB or LSB, as well as your operating frequency 
by polling your transceiver via the CAT feature. Your MixW operating frequencies (in the spectrum 
display as well as the log and CAT bars) will also automatically represent the audio offset, which will be 
either plus or minus your transceiver's frequency, depending on whether you are operating LSB or USB.

If you are not using CAT to determine your mode and frequency, you can still set your "RF, USB" or 
"RF, LSB parameters manually from this menu. Your frequency will be accurately displayed as long as 
you manually set your frequency in MixW to match your transceiver's frequency and sideband. This can 
be done using Alt-F to bring up the CAT bar and entering the settings manually.

Selecting View | Spectrum | Sound will show the audio offset alone, without regard to the RF operating 
frequency. 
Note: The audio frequency can also be displayed by placing the cursor above the spectrum display until 
you see the cursor turn into a hand and pressing the left mouse button.

Rotor Selection and Control
This section pertains to PC controllable Rotors. Select Configure | Rotor | and then click on your Rotor 
brand.



Next select Configure | Rotor | Settings. This brings up the following Port dialog:

While this looks the same as the Port dialog for your CAT/PTT information it is for selecting your Rotor 
control information. Set these parameters by consulting the manual for your rotor. 

When you click OK to close this dialog a box will pop up to allow you to input an Azimuth setting. Type 
it in and click OK. This can be changed later by selecting Configure | Rotor | Turn to... Your other options 
are Turn! (Turns the rotor toward the station in Call), and TurnLP (Turns the rotor torward the long path 



direction of the station in call).

Note:

There are 5 Macros associated with Rotor Control. See the Macros section in the Appendix.

To use Rotor control successfully both the cty.dat and pfx.dat files are required. MixW will start 
without having these files present, although a warning is given.

The cty.dat file is regularly updated. See using cty.dat and pfx.dat in the Appendix section.

Configure the WinKey Port

If you are going to make use of a WinKeyer device select Configure|WinKey port. The following 
dialogue box is displayed. 

The only value that can be changed is the Port number. Click OK when you have selected your Port 
number.

A file Winkey.ini is installed with the other data items. This file can be modified to your personal needs. 
See WinKeyer site for further information on modifying this file.

To use the WinKeyer there must be no ticks in any of the CAT CW configuration boxes

and neither the CAT nor any of the Com Port configuration settings should have CW via DTR or CW via 
RTS selected.

Configuring the Sound Device
Open the sound device settings dialog by selecting Configure | Sound device settings... If you have 
multiple sound devices in your system, you select which one you want MixW to use for TX and RX 
functions. You can also set the sample rate, sound history, spectrum speed, as well as select a DSP filter, 
which can help your copy in certain conditions.

MixW3.1.1h and earlier

http://www.k1el.com/


MixW3.2

Sample rate: A value between 7000 Hz and 12000 Hz for a soundcard sample rate is displayed. MixW is 
delivered with a default setting of 11025 Hz. It has been recommended the setting should be increased to 
12000 Hz for the latest soundcards.

Calibrate: The correct operation of many MixW modes depends on a properly calibrated soundcard.

Clock adjustment, ppm: These values are obtained from the action of calibrating the sound card.

Sound history:

For MixW3.1.1h and earlier Sound history presents an input box for entering the number of seconds of 



previous reception to be stored in MixW to be played back by holding down the Shift key while clicking 
on a signal. The signal will be played back at an accelerated rate.

For MixW3.2 History time is same as previous versions Sound history with a maximum of 60 seconds. 
If check box Always replay history on waterfall pressing is set clicking on a signal on the waterfall will 
now replay the last saved sound for that frequency. If the shift key is held down the last saved sound is 
not replayed. This is the reverse of the MixW3.1.1h and earlier action.
If Always replay history on waterfall pressing is not set the action is the same as for earlier versions of 
MixW.

Spectrum Speed: This setting alters the speed of your waterfall or spectrum display. A faster display will 
make tuning in signals easier and faster, but it also requires a faster computer and soundcard.

DSP filter: For digital mode use any selection, other than None, will result in the loss of decoding of 
signals from the waterfall. These filters are not intended for digital modes use. If a filter is selected and 
MixW is put into transmit mode the filter will be reset to None.

FFT window: Square has best frequency resolution, Nuttall has the best sidelobe suppression and is the 
best for IMD measurements, and Cosine (default) is a reasonable compromise for usual daily operations.

Full duplex: Setting this will cause the transmitted data to be displayed on the waterfall/spectrum 
display.

Waterfall Audio Frequency Markers
By selecting Configure | Markers... markers can be set in up to 5 audio frequency locations. This will 
place a thin red line running down the waterfall display at the desired location as follows:

Waterfall Known Frequency Markers
By placing known frequencies in the "KnownFqs.dat" file a grey marker can be placed on the waterfall at 
that frequency. In the example below a NCDXF/B marker at 14.100 mhz is shown. Open the file with a 
text processor to add your own frequencies. View | Spectrum | Bookmarks must be checked to make the 
markers visible. A temporary known frequency can be set at the current RX position by right clicking on 
the waterfall and selecting Mark Known Fq.



Band Edge Markers
A small red circle with a white line throught it (international "Do Not Enter" traffic sign ? ) is placed just 
below the lowest frequency for the band and just above the highest frequency for the band. The lowest 
and highest frequencies are taken from the Bands.ini file which you can modify using a text editor such as 
Notepad.

Callbook...

MixW will automatically look up log entries in a callbook. Select Configure | Callbook...

MixW3.1 and earlier Callbook selection

MixW3.2 Callbook selection.

In the Callbook settings dialog select your Callbook type and provide the path to the callbook database.

For example, if you have copied the QRZ database to your C: drive, you would enter "C:\callbk\". If you 
are using the QRZ directly from the CD you would enter "D:\callbk\" if your CD was in drive D.

MixW offers the facility to install a third party dll enabling the user to access call data from a remote web 
site. One dll available permits call lookup from QRZ.COM. You must have a valid username/password to 
use this DLL and to get detailed information an annual subscription is required for QRZ.COM. 



 

Select MixW custom DLL for the callbook type and enter QRZ:"username/password" in the Database 
path text box. The double quotes(") must be included in the input.

MixW3.2 addition
A further Callbook type selection Site www.qrz.com is now available.

 
As with the comment above you must have a valid QRZ.COM username/password and to obtain full 
details a XML Data subscription is required.

Just enter your callsign and QRZ.COM password in the relevent boxes.

When the callbook set up has been entered select Options | Auto search in callbook. Now when you enter 
a call in the current QSO line of the log MixW will look up the call and display it as shown here.

NOTE: The data shown when the mouse pointer is hovered over the call does NOT come from the 
callbook.

Callbook dialogue
An option available from the view menu allows independent display of a call to a separate window.

Basic Set Up
_________________________________________________________



Interfacing your Transceiver to your PC:

Interfacing your transceiver and PC to work with MixW can be handled many ways. A two-way audio 
path must be provided between the transceiver and the computer soundcard, and the transceiver needs to 
be switched between TX and RX. You can configure MixW to switch between TX and RX in four ways.

1. Operate a push-to-talk (PTT) switch via a voltage to the DTR or RTS pins of a com port, the same port 
can also be used for serial communication with the radio (CAT operation) if desired.
2. Use transmit and receive commands to the radio via the serial port through CAT, without using the 
PTT circuit (your radio must support PTT by CAT).
3. Use the VOX circuit in your radio to switch it into transmit when it hears the audio sent by the 
computer, and back to receive when the audio stops.
4. Operate the radio transmit/receive manually

Note: There are a number of commercially constructed interfaces available to enable CAT control and 
PTT operation of most modern transceivers. A number of these interfaces also contain separate built in 
sound cards. Also available are units that allow COM ports to be derived from PC USB ports.

A number of circuit diagrams are available on the internet to allow personal construction of an interface.

Important Note: Your microphone must be disconnected from the radio (or otherwise switched out of 
the circuit) to avoid inadvertently transmitting voice signals in the digital bands. When using VOX, Non-
MixW computer sounds (such as the Windows start up chime) can also trigger the VOX circuit and key 
the transceiver.

It is extremely important to match your sound input and output levels. This is done with either the 
Windows Volume and Recording controls or if you have a sound device with physically accessible level 
controls, these controls. The windows Volume and Recording controls can be launched from within 
MixW by selecting Configure | Input volume, or Configue | Output Volume. Be sure your MixW software 
has been configured as described in Configuration.

Setting Audio RX Levels:

Set the input volume first by selecting Configure | Input Volume, which will bring up some version of the 
audio mixer recording control.



For these adjustments it is convenient to arrange your MixW window and your audio mixer control so 
that you can easily see both windows and switch between the two. Set your transceiver's audio (listening) 
volume to a comfortable listening level.

Depending on your set up, you will be adjusting the Mic or Line-in controls. The best way to set these 
levels is to roughly tune in digital mode activity with your transceiver, and then click on the strongest 
signal in the waterfall display to direct MixW to that QSO. If MixW does not lock onto the signal right 
away you can then fine-tune it with your transceiver, or by clicking on the signal in the waterfall display 
again.

Adjust the input level on the Mic or line inputs until the background noise shows a dark to light blue 
color, and the actual signals (or strong noise) are a light green color. Strong signals on the tuning display 
will be yellow or orange. It's very important not to overdrive your soundcard inputs. Overdriving these 
inputs will severely degrade your copy, and give you inaccurate IMD readings. Adjusting for the 
minimum record levels, while still providing a good display is the best starting point. It may be necessary 
to attenuate the signal between the transceiver and sound card, especially if you're using the Mic input of 
your soundcard. This can be done with a simple voltage divider circuit.

If you don't see any receive activity on MixW's displays at all, make sure that your Mic or line-in control 
is not muted ("Mute" is a check box near the slider) and/or that the input you are using is selected. (These 
options will vary depending on your soundcard drivers). Also double-check all your connections. It's also 
possible you're overdriving your soundcard and will need to attenuate the input signal.

After these receive adjutments are optimized, go ahead and try to copy some QSOs to get a feel for the 
proper levels.

Setting Audio TX Levels:

To transmit digital signals, you need to connect the sound card output often through an isolation 
transformer, or 100:1 attenuator) to the transmitter microphone, AFSK, or audio input.

With the interface connected, and your transceiver connected to a dummy load you can now set the audio 
output level of your PC soundcard to match your transceiver's input circuit.

It is extremely important to match your sound output levels. To set the output level bring up the 
Windows Volume control by selecting Configure | Output volume:

These audio output adjustments are best made with your transceiver connected to a dummy load. This 



eliminates QRM as well as wear and tear on your equipment. Set your transceiver MIC gain control (if 
you are using mike input) slightly above its minimum setting and make sure your rig's VU meter (or 
indicator) is set to monitor "ALC". Your VOX threshold setting (if you're using VOX) should be adjusted 
as you normally have it for your other modes. Set the VOX delay to LONG to prevent the possibility of 
dropouts. VOX must be on if you plan to trigger your TX/RX function with it. If you're not using VOX or 
an optional PTT circuit you can do these tests by manually engaging transmit on the rig when you tell 
MixW to transmit.

NOTE: MixW will not enter the transmit mode until you have configured your personal data information.

It is best to have MixW active in one window and the Volume Control mixer in a second window. For 
now slide the Windows Volume Control to a minimum (all the way down), and the Wave slider at just 
slightly above the minimum setting.

First select the BPSK31 mode by selecting Mode | BPSK31. Put MixW into transmit by clicking the RX 
in the status bar. The "RX" turns to "TX", and MixW will transmit a BPSK31 idle signal. To toggle back 
to the receive mode click the "TX" box in the status bar. Caution: Do not transmit for long periods 
while making these adjustments. If you find that your adjustments take a while, let your rig rest in the 
receive mode for a while in between adjustment attempts.

The adjustments. Slowly raise the Volume control fader on the mixer while watching the ALC meter. As 
soon as you see a reading on the ALC meter, back the Volume control slider off until the ALC is at (or 
slightly below) zero. It is VERY important that you have NO ALC reading. Now check the reading on 
your power meter. It will probably be about 50% of your maximum power. Remember that most of the 
digital modes run a 100% (constant) key down (duty) cycle. Many rigs cannot sustain 100% power for 
very long. Depending on the mode you are using you may want to reduce the power output of your 
transmitter even further than the zero ALC reading.

If you are using VOX transmit switching and the VOX has not engaged by the time your Volume is set at 
mid way up the slider scale, then raise your rig's Mic gain slightly and try again. If VOX does not seem to 
kick in at low enough audio level, you may want to set the levels by manually setting the rig into transmit, 
then adjusting the sliders to optimize your audio signal (again you should just see your ALC indicator 
moving, and then back it off to zero), then reset your VOX circuit to trip at that level of input.

The optimal setting when using an interface which has no attenuation, will usually have your soundcard 
output (Volume and Wave Control settings) very low, and your Mic gain at a little lower than your norm 
for SSB operations. If you find that you are unable to control the audio using these controls in reasonable 
ranges, you very likely need to add attenuation between the soundcard output and the rig's Mic input. You 
can also try using the audio input of your accessory jack (if you're rig is so equipped). This may avoid 
your Mic pre-amp circuit and be a better choice for signal matching.

Once you've optimized these settings make a note of the positions of your rig controls as well as the 
Windows Volume and Recording mixer positions.

A number of additional soundcards are available that can be added to the control PC internal sockets or 
connected via USB or FireWire ports. Using an additional card for digital operation means the PC internal 
soundcard does not need to be adjusted and a number of external soundcards have level controls available 
for ease of adjustment. 

Note: The ALC reading may vary between different bands. If the ALC value changes (in particular if the 
ALC level has increased) as a new band is selected the soundcard output level must be adjusted to reduce 
the ALC reading to zero or below.

Sound Card Calibration 

Sound card calibration is essential for good operating practices and techniques in digital modes. In SSTV 



mode pictures may not be square and working in keyboard modes the QSO may wander up or down the 
band with an uncalibrated sound card. This of course will happen if the station being worked has an 
incorrectly calibrated sound card anyway. 

It is recommended with later soundcards to set the sample rate to 12000 (see Sound Card Configuration) 

To calibrate the sound card: 

locate the program CheckSR.exe in the MixW program folder
Double click on the CheckSR program to start it 

 

Select the correct sound card for both input and output
Change the sample rate to the value you have selected in the soundcard configuration
Click Start.
Let the program run until there is hardly any movement on the Difference PPM. This will take 30 
minutes or more.
If you have the time leave it to run for an hour+ to get the most accurate readings.
Click on Stop and copy down the Difference PPM for the Input and Output.
Click on Close.
In MixW under Configure click on Sound Device Settings.
Copy the results from CheckSR into Clock adjustment ppm.
The Input reading goes into RX and Output to TX.
Click OK

Calibration is now complete.

It is advisable to check the sound card settings every 6 months.

PTT Circuit
_________________________________________________________

You have three basic options for PTT transmitter keying:

• Keying of the radio PTT line from a dedicated serial port, 



• Direct command to PTT on/off Via the PC - Radio command interface (Certain radios only). 
• Sharing the PC-Radio command serial port with the PTT circuit. 

See Configuration to configure the MixW software for the PTT option you will be using. 

Keying of the radio PTT line: For serial port keying, the PTT signal is accomplished by high/low 
voltages on pin 20 or 4 of a DB25 connector or pins 7 or 4 of a DB9 connector. (These are the DTR and 
RTS lines). To key the radio PTT line from DTR or RTS a transistor interface circuit is required. This 
simple circuit will do the trick:

Direct command to PTT on/off Via the PC - Radio command (CAT) interface:
On some models of Kenwood. Yaesu, Icom, and TenTec radios, the built in capabilities of the radio serial 
interface can be used for PTT keying. If your radio supports PTT using the CAT interface no additional 
hardware connections are required.

Sharing the PC-Radio command (CAT) serial port with the PTT circuit:
Many transceivers do not use the RTS and/or the DTR lines for CAT. In this case you can use the same 
serial port for both CAT and a PTT circuit. This will require wiring a DB9 or DB25 connector such that 
the required pins are wired to each of the two (CAT and PTT) interfaces (normally a level converter for 
CAT and an electronic switching circuit for the PTT). Then in the PTT & CAT dialog you will 
UNCHECK "PTT via CAT command" and in the Serial Port dialog you will select either RTS or DTR for 
PTT and set the other parameters as needed for the CAT interface.

Configuring Macros
_________________________________________________________

For a complete list of Macro Commands see the Appendices Section of the MixW Help file.

A WARNING

If an attempt is made to use a text editor to edit the raw macro files it is possible Windows will 
'corrupt' the file when it is written back. This will occur if a 'special' character (eg the temperature 
degree symbol) is included in a macro text. Some text editors write the data back with a sequence of 
characters identifying there are special characters in the file. This sequence of characters is 
invisible to a text editor but confusing to MixW and the macro set is now 'lost' to MixW although it 
is visible to File Explorer and can be edited by text editors.

Macro commands can be combined with each other, or combined with text, to control many functions of 
MixW, your CAT equipped transceiver, or your TNC. They can be used to reduce the need for repetitive 



typing.

MixW supports different Macro groups for each mode of operation, which can be automatically loaded 
when you switch modes (called "local" macros). You can also have different sets of Macros in files, 
which can be configured for specific types of operation. For instance, you can configure one set for 
contesting, and another for rag chewing. These can be custom configured, saved, and then reloaded from 
the Macro Configuration Window. To optimize Macros for contest operation see the Contest Operation 
topic in the Appendices Section of MixWHelp.

MixW's Macro system is extremely flexible and powerful, however it will take a little time to understand 
how to configure macros to best match your operating styles. Macros can be added or edited six different 
ways:

• By right clicking on the Macro button 
• By selecting Configure | Default Macros 
• By Selecting Configure | Macros for this mode... 
• By Selecting Configure | Macros for this contest... 
• By using the <EDITMACRO:macroname> macro 
• By using the <macroname?> macro 

Note: Macro commands must be typed in all capital letters. Text can be typed as upper or lower case. 
Lower case characters will automatically be converted to uppercase when transmitted for modes like 
RTTY and AMTOR, which only support upper case.

Simplified Macro editing instructions:

When you first start MixW you will see the following set of buttons across the top of the screen: 

For MixW3.1 and earlier

For MixW3.2

This is the Control Bar and can be switched on or off by the menu View|Control Bar.

These buttons, which correspond to the F1 through F12 keys on the keyboard, are called Macros in 
MixW. If you click one of these buttons with the mouse or press the corresponding F key, it will cause a 
script of Macro Commands to be run. If you hold down the Ctrl key on the keyboard you will see a 
different set of macros which can be called with Ctrl-F1 through Ctrl-F12. Notice that some of the keys 
are blank, indicating that there is no script of Macro Commands assigned to that key. Twelve more 
macros can be created for Shift-F1 through Shift-F12, and twelve more for Shift-Ctrl-F1 through Shift-
Ctrl-F12 providing a total of 48 macros for the F keys. 

For MixW3.1 and earlier releases the four different rows of Macro buttons can also be accessed by 
"rolling" the mouse wheel while the mouse is over the Macro buttons.

MixW3.2 introduces a small gear wheel icon  in the macro display bar. Left clicking on this icon 
brings up this menu:



Selecting Extended Bar will display all 4 rows of macros 

To view and/or change the F1 through F12 Macros, right (mouse) click the Macro (button). Right clicking 
the fourth macro, for example, will bring up the following dialog:

You can now edit this Macro's Label, as well as its text (script). You can also change the color of the 
button by selecting the small rectangle containing the "A" to the right of the Label box. All edit functions 
are available from this edit window with the exception of the Macro Key assignment (It is assumed you 
want this to be the key you right clicked on to bring up the window). There is a convenient list of Macro 
functions and short explanations in the box on the right. Highlight the desired function and click the 
double arrow to move it into the desired location in the Macro text box.

This simple example in Macro location F4 is named "Call", and will return the standard 1 X 1 call 
sequence.

Macros can be modified to increase the automation of MixW. For example, the Call Macro above can 
automatically toggle MixW between transmit and receive modes by placing <TX> as the first command 
and placing <RX> as the last command, so Call would read, <TX><CALL> de <MYCALL> k<RX>. In 
this example, pressing F4 would cause MixW to go into transmit mode, send the other station's call once, 
followed by "de", send your call once, followed by "k" and then automatically return to the receive mode.

The fourth item in the Edit User Macro dialog is a pull down text box which reads "Default for all modes" 
and indicates that the label and script that you enter here will become part of your Default Macros. Later 
you will find out about other sets of macros such as contest macros and mode specific macros.

There are several other types of macros which are not called by the F1 through F12 keys, and therefore 



cannot be edited using the right click method. You can call up a different Edit Window by clicking on 
Configure | Default macros, which will bring up the following dialog box:

Click Edit to see the entire set of Default Macros. You should get the following screen.

Double Clicking any of the Macro lines in this Window will bring up the Macro edit window. Notice that 
this edit window allows you to change the macro to a different F key or even to events such as On Start, 
On End, etc.

You can also add or delete macros from your Default Macro list as well as Load and Save this list to a file 
for later recall. This gives you unlimited use of Macros for every type of operation. Each group has a 
potential for 48 separate Macros assigned to specific F-keys and buttons, and there are several event 
macros available under "other Macros" as well. To see the "grey key" and event macro's look at the very 



bottom of the pull down Macro list box. 

The Grey Key and Event macros will appear in the edit window as shown here:

An individual macro can be edited by using either the macro:

<EDITMACRO:macroname>
This will bring up the Edit user macro window.

or

<macroname?>

This will bring up a small text input box.

eg <OnEndMixW?>

Input or change the text as required.
Using this method of creating or changing a macro has limitations. It is not possible to create extra lines 
using the Enter key for the macro being changed and if it is being created only one typed line is possible. 
However by use of <CRLF> multiple transmitted lines can be created.

When the edit text box is exited the macro will be executed.

Use <macroname> to execute the macro if it is being created/changed as an event macro
An example in the macro list is <WX?> 



All of the things that we have talked about here which can be done with your MixW Default Macros can 
also be done with separate Macros for the different digital modes. This makes the use of application 
specific Macros almost limitless. The section below is written by one of the programmers of MixW to 
explain some of the more complex uses of macros.

MixW 2 Macros explained by Denis Nechitailov, UR8US (ex UU9JDR) (with minor editing by 
K4SET)
MixW 2 is supplied with a default set of macros. These macros are loaded from the "MixMacros.ini" file, 
which is located in your MixW directory, when MixW 2 is launched. This is the Default set of Macros 
used for all modes, meaning they are used regardless of which mode you are operating, unless you have 
configured specific mode macros that replace them.

You can choose another file to be your default macro file by selecting Configure | Default macros, which 
will bring up the complete list of default macros. Here you can add, delete, or edit each macro. You can 
also save this macro list to another file, or you can load a different list from a different file, which will 
then become your default macros. If you right-click on a macro in the control bar you can easily edit just 
the single corresponding macro, without having a big full list. Each macro has a label which appears on 
the corresponding button in the Control Bar, and a text which is placed in the TX window when you 
select that macro.

There are two general ways to use macros. The simple way uses a single set of macros at any given time. 
This set (or file) can be changed as outlined above, or it can also be changed on-the-fly using a macro. 
This is done by using the <MACRO:filename> macro. For example, you might like to configure another 
set of macros for a different language. For instance, your F5 key macro (using the default MixMacros.ini 
for the English language), might be the following:
Macro: F5 
Label: Name 
Text: My name is Eugene.
While in the Spanish version (MixMacrosSpanish.mc), your F5 key may look like this:
Macro: F5 
Label: Nombre 
Text: Mi nombre es Eugenio.
And so on.

We can configure MixW to quickly change between the English and Spanish macro sets by configuring a 
macro to change which macro file is active. This is achieved by doing the following: While using the 
English MixMacros.ini, at any unused key location (e.g. Ctrl-Shift-F1, for instance), place the macro:
Macro: Ctrl-Shift-F1 
Label: Spanish 
Text: <MACROS:MixMacrosSpanish.mc>
And in Spanish set (e.g. MixMacrosSpanish.mc),
Macro: Ctrl-Shift-F1 
Label: English 
Text: <MACROS:MixMacros.ini>

Now if you press Ctrl-Shift-F1 when you are using the English set, the Spanish set will be loaded (and 
vice versa).

Of course, this single default set of macros is not right for ALL the modes you operate, or for ALL 
situations. Sometimes, even switching macros by using the <MACROS:filename> macro does not solve 
the problem. So, in addition to using the simple macro mode (single set of macros) MixW 2 is capable of 
using a secondary system (called the local system), which can integrate mode or contest specific macros 
into your default macros. This can also be used to integrate macros specifically configured for hardware 
TNCs.

Why does one need to use local macros? For example, you would not want to have a macro with the text 



RYRYRYRYRYRYRY on the screen in SSB mode, even though this might be very helpful in the RTTY 
mode. You would also not want to have your recorded voice calling "CQ CQ etc.." in the PSK31 mode, 
while this could be helpful in the SSB or FM modes.

Using the local macro system MixW2 can automatically switch to a set of macros that you have custom 
configured for a specific mode, or even a specific contest (using the MixW 2 Contest Mode). MixW 2 can 
also automatically load TNC command macros (for instance, to switch baudrate "on-the-fly", etc.) when 
you use hardware TNCs.

For example, you may want to use a separate set of macros for BPSK31. To do this, select the BPSK31 
mode from mode menu, then click Configure | Macros for this mode... Then, enter the name of the file 
you want to use for this mode (e.g. BPSK.mc). Now, whenever you switch to the BPSK31 mode, you will 
have these special BPSK macros on the screen. 

Note: The "Merge macros" item from the "Configure" pull-down menu tells MixW how you want the 
local and default macros to be merged. If this is left unchecked, you will see only the mode/contest/TNC 
specific macros. If you check the "Merge macros" option, you will see your local macros merged with 
your default macros. The default and local macros are merged using a simple rule: If a macro (for 
example, for the F5 key) exists in the local set (BPSK.mc in this example) it will be used. If not, the F5 
macro from the default set will be used.

Merging macros is very useful when you want to add just a few macros to the default set. For example, if 
the F2 key from the default set contains
<TX> 
CQ CQ CQ de <MYCALL> <MYCALL> <MYCALL> 

You might like to define an F2 macro for the RTTY mode like this:
<TX> 
RYRYRYRYRYRYRYRYRYRYRYRYRY 
CQ CQ CQ de <MYCALL> <MYCALL> <MYCALL> 

Most likely, the same local macro files can be used for the BPSK31, QPSK31, and the FSK31 modes. 
RTTY and AMTOR can also share the same local macro file, and the phone macros for SSB, AM and the 
FM modes can be shared as well.

You can edit these local macros through Configure | Macros for this mode (this will load the full list of 
macros). When you are using separate macros for each mode (or for a groups of modes), right-click on 
one of the keys on the Control Bar to edit this macro. This will show the same Edit user macro dialog 
box, but now you can choose if you want this macro to be used for the current mode by selecting "For this 
mode", or it can be set to use it as a default macro for all modes by selecting "Default for all modes". 

Suppose you don't have separate macros for RTTY yet, and you want to add RYRYRYRY for the RTTY 
mode only (as shown in the example above). Here is how to do that:
1. Switch to the RTTY mode (from Mode menu). 
2. Go to Configure | Macros for this mode, and then enter name for the RTTY mode macro file (e.g. 
RTTY.mc). If there is no file by that name yet, when you press the Edit button at the Filename for RTTY 
macros dialog, you will be asked if you really want to make a new file. Say yes. At the RTTY macros 
dialog, you can add the F2 macro, but close the dialog and press OK on Filename for RTTY macros 
dialog. 
3. If the "Merge macros" option from Configure menu is disabled, you will see the blank keys on the 
Control Bar (that is because you are using separate macros for RTTY, but no macros have been defined 
yet). Now, enable "Merge macros" from the Configure menu. Now the Control Bar shows the default 
macros. 
4. Right-click the F2 key and select "For this mode" in the Edit user macro dialog box. Then add the 
"RYRYRYRYRYRYRYRY" line and press OK.
You now have RYRYRYRYRYRY line on the F2 key while using the RTTY mode, but not in any of the 



other modes.

To delete a local macro; the macro we just made for the RTTY mode for instance, open the Edit User 
Macro dialog for the F2 key while in the RTTY mode (it now indicates "For this mode"), and clear the 
macro with the Clear button. Press OK and now F2 macro with RYRYRYRY is deleted from RTTY set.

<OnStartMode> & <OnEndMode>

These macros are executed when you start or end a mode. They should be included in the separate Macros 
for this mode macro files.

For example, if you have a separate set of macros for SSB, you can define OnStartMode to turn on a 
Notch filter, and OnEndMode to turn it off. Now if you switch to SSB, the filter will be automatically 
turned on.

TNC Macros: When using TNC, the TNC's own file (it's name is entered into TNC Modes dialog from 
Mode | TNC modes settings menu) is used as a local macro file. Merge Macros can also be used if you 
want to merge TNC's macros with the default macros.

Using macros with TNCs: TNC operations in MixW 2 are based on two general principles:
1. TNC works in terminal mode (not host mode).
2. TNC state (mode, baudrate, TX/RX state, etc.) is controlled by using macros.
Usually you will have different sets of macros for different modes on the same TNC, and there are several 
steps that should be done for each set. First, you must define the macros to initialize the TNC and place it 
into the mode you want to operate (and de-initialize it at the end of mode).These two macros are used for 
this purpose:

OnStartMode
OnEndMode

For example, to operate PACTOR using a KAM+ TNC, you may define them like this:
Macro: OnStartMode
Label: Start (or whatever you choose)
Text: <HIDETEXT><AUDIOFQ:2200>
<SHIFT:200> <CTRL-C>X
PACTOR
<SHOWTEXT>

Macro: OnEndMode
Label: End (label does not matter)
Text:
<HIDETEXT><CTRL-C>X
<SHOWTEXT>

The first macro sets the center audio frequency and shift to draw the cursor at Waterfall/Spectrum 
window, then it sends "Ctrl-C" and "X" characters to TNC (to make sure it's placed into command mode), 
and then sends "PACTOR" command to place TNC into PACTOR mode. The second macro just places 
TNC into command mode. After defining OnStartMode and OnEndMode macros, re-define the TX and 
RX macros that are used to make the TNC transmit or receive. For PACTOR using the KAM+, they may 
look like this:
Macro: TX
Label: tx (label does not matter)
Text: <HIDETEXT><CTRL-C>T<SHOWTEXT>

Macro: RX
Label: rx (label does not matter)



Text: <HIDETEXT><CTRL-C>E<SHOWTEXT>

The first macro sends "Ctrl-C" and "T" characters (to transmit), and the second one sends "Ctrl-C" and 
"R" to receive. And now if the <TX> or <RX> macros are used in any other macro, like F2 with 
"<TX>CQ CQ CQ...<RX>" text, then by pressing F2, the TNC will transmit "CQ CQ CQ..." and then go 
back to receive.

Other macros to connect, disconnect, etc. can also be defined using these methods.

Contest macros: You might like to have another set of macros (with short "CQ CQ TEST" serial 
numbers etc..) for contests. At the Contest Settings dialog (choose a contest from View | Contest mode | 
then highlight the contest and select the Edit button) then enter a name of the Macro file you want to use 
for this contest (and also check the Merge macros check-box).

Now, a combination of 3 sets of macros is used: macros for the specific mode, macros for the specific 
contest, and your default macros. Contest macros are only active when View - Contest mode - On menu is 
checked.

Configuring Additional Macro Keys: There are several keys which can be used for containing macros 
as well as the function keys, but they are not shown on the control bar, so these keys can only be edited 
through the full list (either the default list, the macros for this mode list, the TNC macros list, or the 
contest macros list).

At the Edit User Macro dialog, select (or enter) the hot key name in the Macro field. The additional keys 
supported now:
Ins
Gray+
Gray-
Gray*
Gray/
OnAppCommandxx (MultiMedia Keys)
Please note that these names are case-sensitive.

To identify which multimedia key has been pressed to link to the appropriate OnAppCommand macro 
definition carry out the following steps:

With MixW loaded press the multimedia key.
The following message is displayed in the left side of the Status Bar

where the one or 2 digit number is used to identify the key. The numbers do not necessarily 
logically relate to the physical position of the keys on the keyboard.
Use the macro editing facilities to create the appropriate macro. 

Calling a macro from a macro: It's also possible to call a macro from another macro. For example, if 
you have the following configured in the F2 key macro:
<TX>
CQ CQ CQ de <MYCALL> <MYCALL> <MYCALL>

You might like to use this same text for your Auto CQ. To do this, just place <F2> in the Auto CQ, 
instead of the Auto CQ text. Now AutoCQ will play the F2 text. You cannot call a macro from itself, 
however, if you try you will be warned about this when you try to run it. Moreover, you may call a 
macro anything you want.
For example, you can define a macro like this:
Macro: POWER



Label: (Anything you choose, it will not appear anywhere).
Text: 40
(This will not be shown on the Control Bar because it is not assigned to a specific key)
Now, this is used with the other macro as follows:
Macro: F6
Label: Brag
Text: <CR>The power is <POWER> <POWER> watts.<CR>
This uses the value that is entered into the POWER macro, and inserts it into the text for the brag macro. 
To change the power macro on-the-fly, choose an unused key (e.g.Ctrl-Shift-F2) and fill it with 
<EDITMACRO:name> like this:
Macro: Ctrl-Shift-F2
Label: myPWR
Text: <EDITMACRO:POWER>
Then if you press Ctrl-Shift-F2, it will bring a dialog box with the value 40 in it. Replace the 40 with 20 
(for instance) and press OK. Now your F6 key will yield the following:
 
power is 20 watts

Favorite Macros from the MixW beta test team, and others who have written in:

From Richard "Griff" Griffin, NB6Z
"SK"
<CALL> de <MYCALL> SK at <TIME><CWID><SAVEQSO><RXANDCLEAR>

"BTU"
BTU <NAME>... <CALL> DE <MYCALL> K <RXANDCLEAR>

"CALL"
<TX><CALL> <CALL> <CALL> de <MYCALL> <MYCALL> <MYCALL> K
<RXANDCLEAR>

"RST"
Thanks for report from <QTH>; you are <RSTS> <RSTS> here in
<MYQTH>.

From Nick Fedoseev, UT2UZ
Use <LOCKTX> in CQ macros:
<LOCKTX><TX>CQ CQ CQ de <MYCALL> <MYCALL>
<RX>
Use <UNLOCKTX> in Search/Pounce macros:
<UNLOCKTX><TX><CALL> <CALL> de <MYCALL> <MYCALL> <MYCALL> pse k <RX>

While calling DX in pileups I need to send my call several times (from
one to five times. I use following macro:
<MYCALL> <TX><RXE>
If I press according button four times, MixW transmits
"UT2UZ UT2UZ UT2UZ UT2UZ " and switches to RX.

From Dick Thompson, WB0DUL
Many times, we all type something like "Well Scott, the temp here is 60 degrees F and is supposed to stay 
that way for..." and so on.

I programmed my F12 key to display ºF when I hit it. So When I type in the number 60 (or whatever it 
may be, it looks like this:
Well, Scott, the temp here today is 60ºF and....
 



To create the "º" character, choose an empty macro. Put the cursor in the text box. Then, while holding 
down the Alt key, hit 0186 on the "keypad". The º will appear. Just type the F (or C for centigrade) after 
it, name the Macro Temp and save it. Just hit that key (in my case the F-12 key) when you want to insert 
ºF or ºC after a temperature.

Use of <LANG_> 

This macro modifier makes it possible to change the contents of an associated macro to the language of 
the current QSO callsign.

It makes use of the lang.ini file delivered as part of the Mixw installation.

The content of lang.ini after installation is:

[MASK]
U*=RUS
R*=RUS
F*=FRA
I*=ITA

[DXCC]
DL=GER
EA=SPA
F=FRA
JA=JAP

As it stands this lang.ini file is assumed to be for an English speaking installation.

The MASK section defines calls where a complete initial prefix letter assigns the whole of that prefix 
group a language key. In the settings any call that starts with U or R is assumed to be Russian Language, 
F is French and I Italian. The DXCC section defines individual countries to a language key. France is 
included in both sections because as well as F prefix France can also have other letters as the first letter of 
a prefix (eg TM).

An example of the use of <LANG_>:

The end of a QSO is:

73 <CALL> de <MYCALL> bye SK<SENDEQSLNP><SAVEQSO><RXANDCLEAR>

This could be changed to:

73 <CALL> de <MYCALL> <LANG_BYE> SK<SENDEQSLNP><SAVEQSO><RXANDCLEAR>

A number of macros are created using edit macros menu:

Name:BYE
Label: doesn't matter
Text:bye

Name:FRA_BYE
Label: doesn't matter
Text:Au Revoir

Name:RUS_BYE
Label: doesn't matter



Text:Doswidania

Name:GER_BYE
Label: doesn't matter
Text:Auf Wiedersehen

Name:ITA_BYE
Label: doesn't matter
Text:Ciao

When the <LANG_BYE> macro is actioned it will substitute the LANG with the prefix language key and 
then insert the text in the transmit window. If there is no prefix language entry in lang.ini the default 
macro BYE is used instead.

It is possible to associate multiple countries to one language. An entry in the DXCC section OE=GER 
would associate Austria with the German language and a Spanish entry could be used to link a number of 
countries.

Waiting or slowing macro execution

There are a number of ways of slowing down execution, to overcome timing problems.

Executing the sequence <FQ:29600><MODE:FM> does not reliably execute on some transceivers but 
<FQ:29600><CATWAIT:300><MODE:FM> overcomes the problem.

To completely halt a macro sequence for an indeterminate period:

......<ALERT:Macro pauses>Text <macro> will halt the sequence at the <ALERT> macro until the OK 
button in the message box is actioned.

CATWAIT only delays CAT command activity and the ALERT macro needs attention. To delay a macro 
sequence for a fixed period the Mixw Script command sleep must be used.

To delay a sequence for 5 seconds to allow an asynchronous action to take place like switching off the log 
display at Mixw start up, to overcome a problem of window sizes being incorrect:

<ASSCRIPT>sleep 5
runmacro “HIDE:LOGBAR”
close

This sequence is inserted as the last 3 lines of the <OnStartMixw> macro.

The <ASSCRIPT> macro tells Mixw to action all the following data using the Script interpreter not the 
Macro interpreter so after the <ASSCRIPT> is actioned no further Mixw macro format commands can be 
included. However Mixw Script language allows individual macros to be executed by runmacro 
“MACRONAME”. The Script commands are case sensitive, as are the Macro commands.

When the ASSCRIPT macro is executed a small window pops up. The close command clears it.

If a sequence of macro commands is to be part delayed then the following is the way to do it:

<TX>73 <CALL> de <MYCALL>sk <RX>
<ASSCRIPT>sleep 7
runmacro “Ctrl-F5”
close



Macro Ctrl-F5 contains:

<TX>qrz qrz de <MYCALL> <MYCALL> pse k<RXANDCLEAR>

If the <RX> is left out the transmitter will be left on and idling for 7 seconds.

The parameter to sleep is in seconds.

One Macro key to switch BPSK/QPSK modes

Note This only works on the latest MixW releases.

To use a single macro key to switch between B/QPSK31,63 and 125 carry out the following steps:

1) Identify the macro key to be used.
2) Select BPSK31 mode
3) Right click the macro key you have identified in step 1
4) Select a suitable Label (To PSK63?)
5) Set Macro for this mode
6) Put <MODE:BPSK63> in the text box and save the macro.
7) Click the macro button you have just changed.
8) Repeat steps 3-7 for Mode BPSK63 then Mode 125, to bring back to BPSK31 mode.
9) Selecting the macro button you have identified should cycle between the 3 modes.

Select Mode QPSK31 and repeat steps 3 to 9 for the three QPSK modes.

These actions will set up 6 mode specific macro files. One for each of the modes. If you have other mode 
specific macros for these modes they need to be included for each of the modes.

REMEMBER BACK UP ALL YOUR MACRO FILES.



*OPERATION
_________________________________________________________

1. Starting Mixw   - how to start Mixw
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9. Saving and Archiving   - files changed for Mixw running 

Starting MixW
_________________________________________________________ 

This section covers the initial start of a Mixw session in windows and what command line parameters are 
available. The history of some parameters is unknown but when a version number is known that 
introduces a specific parameter this has been recorded. 

Starting Mixw

There are a number of ways to start Mixw:

Clicking on a Mixw Icon on the desktop (this is likely to be the most popular method)
Starting Mixw via a batch file
Using the Start Menu Run facility
Typing a Mixw command line in an MSDos window
Using Windows/File Explorer to select the executable and click on it.

If you use the Windows/File Explorer method command line parameters are not available. Mixw will start 
using the settings in Mixw2.ini.
For the other methods a command line is used to start Mixw. It has the form:

{Path to Mixw executable}\mixw2.exe for V2
{Path to Mixw executable}\mixw3.exe for V3.0 & V3.1
{Path to Mixw executable}\mixw3_2.exe for V3.2



If you use the Start Menu Run facility or start Mixw using an MSDos window the command line has to be 
entered each time.
For a batch file, an edit of the file is needed to find the Mixw start line.
To find the command line in a desktop icon right click on the icon and select properties. In the Properties 
window select the Shortcut tab and on the line Target: is a text line with the mixw startup command line.

If no parameters are specified on the command line Mixw will start using the configuration in the 
Mixw2.ini file.

Parameters Available

Parameter Description

/1 Starts Mixw with 1 Spectrum/Waterfall display.
This parameter results in a change in the Mixw2.ini file.
Possibly introduced in V2.16 but certainly works in V2.18 and later.

/2 Starts Mixw with 2 Spectrum/Waterfall displays.
This parameter results in a change in the Mixw2.ini file.
Possibly introduced in V2.16 but certainly works in V2.18 and later.

/setup Mixw starts and displays the Soundcard configuration box.
This parameter must be specified each time.
Works in V2.18 and later.

NODDE Disable DDE function.

NOOLE Disable OLE function.

NONIC Disable TCP/IP over AX.25

NOREP Disable RigExpert Plus automatic detection.

MENU1 Start Mixw with the alternate menu layout (layout 2).
This parameter results in a change to the mixw2.ini file. 
This parameter works in V2.19 and later.
To revert to menu layout 1 use the View->Menu and tick Layout1.

NOAUTOREG Disable automatic registration of Mixw at start up. Available in V3

DDE:xxx Set DDE server name to "xxx".

INI:ffff Set .ini file to "ffff".Only available in V3.

See below.



/gblpath:yyy Set Mixw data directory path to “yyy”. Available in V2.2 and later.

See below.

Note:

In the following section the term mixwexe refers to MixW3.exe for V3.1 or MixW3_2.exe 

Multiple parameters maybe specified:

"C:\Program Files\Mixw\mixwexe" /2 MENU1 /setup

will start Mixw and initially display the Configure Soundcard box. When that is exited Mixw will then 
show two Spectrum/Waterfalls and use menu layout 2.

If Mixw is restarted with no parameters it will still have two Spectrum/Waterfall displays and use menu 
layout 2. 

Use of INI: and /gblpath: parameters

The INI: parameter is used to specify an alternate .ini file. This .ini file can be located anywhere 
addressable by the file system. It is read at Mixw load time and rewritten at Mixw close time. The other 
data used by Mixw will be in the installed data directory or referenced by full pathname from the contents 
of the alternate .ini file.

The /gblpath: parameter specifies an alternate Mixw data directory. However the .ini file used will be the 
one Mixw would use if no parameters were specified at load time. Any files modified (Macro files, 
Contest files etc.) will be written with updated contents to the directory specified by the /gblpath 
parameter. The .ini file will be written to its original source directory.

To use a completely different data directory both parameters must be specified:

{mixwexecpath}\mixwexe INI:{inifile pathname}\fff.ini /gblpath:{data pathname}\

The backslash (\) after the data pathname must be present.

Limitation:

The inifile pathname and data pathname cannot have spaces in them. This is a limitation within the 
MixW3 code. It will likely mainly affect default MixW installations on Windows XP systems where the 
default folder is C:\Documents and Settings\username\Application Data\Mixw.

To overcome this limitation:

First method.

When the alternate MixW data folder is created make it in a path name that has no spaces. The data folder 
does not have to be installed in the default folder.

e.g. For a requirement for 3 different MixW installations.

Create a folder:
c:\radio\mixw_data



Now copy the original MixW data folder contents into this folder so the full path is
c:\radio\mixw_data\mixw

Rename the folder mixw to mixwa (Use Windows/File Explorer to do this)
Repeat the action again and copy the original MixW data folder contents into this folder. 
Rename the folder mixw to mixwb.
The MixW installation on XP, assuming a default installation, will consist of the following 
folders:

C:\Program Files\mixw
c:\Documents and Settings\username\Application Data\mixw
c:\radio\mixw_data\mixwa
c:\radio\mixw_data\mixwb

The command lines for the 3 different requirements will be:
"C:Program Files\mixwexe" (uses the default setup)
"C:Program Files\mixwexe" INI:c:\radio\mixw_data\mixwa\mixw2.ini 
/gblpath:c:\radio\mixw_data\mixwa\
"C:Program Files\mixwexe" INI:c:\radio\mixw_data\mixwb\mixw2.ini 
/gblpath:c:\radio\mixw_data\mixwb\

Second method.

This utilises the default installation and a facility within the Windows system to relatively address files.

e.g. Same requirement as for the first method.

Assuming a default XP installation with the data in:
c:\Documents and Settings\username\Application Data\mixw (default_data)

Create two folders:
c:\Documents and Settings\username\Application Data\mixwa
c:\Documents and Settings\username\Application Data\mixwb

Copy the default_data into the newly created folders (don't forget the subdirectories)

The command line for the 3 different requirements will be:
"C:Program Files\mixwexe" (uses the default setup)
"C:Program Files\mixwexe" INI:..\mixwa\mixw2.ini /gblpath:..\mixwa\
"C:Program Files\mixwexe" INI:..\mixwb\mixw2.ini /gblpath:..\mixwb\

General Operation
_________________________________________________________ 

In early versions of MixW Help from the menu bar was not always visible.

Mixw uses two different menu layouts. If Help is not available change your menus to look like this:

If the Help menu is not visible in the main Mixw menu bar, select:



View | Menu and choose Layout 1.

_________________________________________________________

Read these general instructions first to get familiar with MixW operations , then look in the Digital 
Modes section of this help file for the specific mode you want to operate.

Mode selection
Select the mode you wish to operate by clicking Mode | <your choice of mode>:

Notice that the status bar, which if displayed (see View Menu) can be found underneath the 
Waterfall/Spectrum window, will change according to the options and features specific to the mode you 
have selected, and the mode will be indicated in the mode box. For instance, IMD is only relevant in the 
PSK31 modes, while Connected or Disconnected is only relevant for Packet:



You can also switch modes by clicking on the mode box in the status bar and selecting the mode you wish 
to operate from the pop up menu:

Mode Settings
Each mode in MixW has an individual Mode Settings dialog box which can be seen by first selecting the 
mode, and then selecting Mode | Mode settings...



Clicking on the mode box in the status bar, and then selecting Mode settings... is another way to access 
the mode settings dialog.

The mode settings dialog can be accessed with the MACRO <MODESETTINGS> from one of the F-key 



Macros. Many of the settings in each dialog can also be set from Macros as well.

The mode settings available will vary depending on the mode of operation. For instance in RTTY, you 
can set the shift and inversion, which are not relevant options to the BPSK31 mode.

Note: The TX frequency and RX frequency are interpreted in different ways dependent on the mode. For 
MT63, Contestia, Olivia, RTTYM and SSTV the value shown is the lowest frequency of the signal. For 
all other digital modes the frequency shown is the centre of the signal.

If the TX or RX frequencies are referenced at all during mode switching operations care must be taken to 
ensure the correct frequency position is used. 

However use of the audio frequency macros will always align the centre of the signal to the value in the 
macro. 

Inverted:
Note: This feature works differently in MixW than most other SoundCard digital programs, so please 
read and understand the information about inversion in the Configuration Section.

Receiving
While tuning instructions are somewhat mode specific and therefore covered in the individual mode 
operation topics, there are several procedures and techniques relevant in all modes.

To tune a signal left click the mouse pointer on the signal in the waterfall or spectrum display. You 
should start seeing text in your receive window. You can fine-tune the cursor location by holding down 
the control key and using the right and left arrows keys.

Note: The RX cursor can be locked by use of the <RXLOCK> macro (see Macros section of the Help 
document). 

Seek
Stations may also be tuned in by assigning the <SEEKLEFT> and <SEEKRIGHT> macros to individual 
function keys, preferably single-finger keys. Pressing the key assigned to <SEEKRIGHT> will cause the 
cursor to jump to the next signal to the right of the current cursor position. Pressing the key assigned to 
<SEEKLEFT> will cause the cursor to jump to the next signal to the left of the current cursor position. 
Seek will send the cursor to any signal strong enough for Seek to detect,. If the cursor seems not to move, 
there may not be a detectable signal in the direction of Seek. If Seek passes the station you want to tune, 
or tunes to one side of the station and not in the middle, just press the Seek button to pass the station and 
approach it from the other side. The default keys for Seek are F11 and F12, labeled << and >>.

When Options | Arrows for Seek is checked, the left and right arrow keys can be used for the Seek 
function, releasing F11 and F12 for other one-finger macro key configurations. However, if the left and 
right arrow keys are used for Seek, they are not available for editing the TX and RX windows.

When Options | Continuous Seek is checked, Seek will search continuously for a signal and stop when it 
finds one. To manually stop Continuous Seek, just press any Seek key.

Bookmarks
A place-holder called a Bookmark is available on either the spectrum or waterfall displays. You must first 
enable bookmarks by clicking on View | Spectrum | Bookmarks. Then, to place a bookmark at the cursor 
position right click in the spectrum/waterfall window and select "Toggle Bookmark" from the pop-up 
menu. A lettered bookmark will appear at the diamond cursor position at the bottom of the Window. 
Pointing to any bookmark, clicking the right mouse button, and again clicking the "Toggle Bookmark," 
will remove a bookmark.



To return to a book-marked frequency, point to the numbered bookmark and click the left mouse button 
to position the diamond cursor there, or click the right mouse button to position the triangle cursor there 
(see Multiple RX Windows below).

You can capture the station's call sign for a bookmark by double clicking the call in the receive window 
(the call will also be captured automatically in many cases). The station's call will now appear in the 
bookmark when tuned to that frequency.

A special "permanent" bookmark can be placed at known frequencies by adding an entry to the 
KnownFqs.dat file. Known frequency bookmarks are colored grey.

When the Bookmark macro is assigned to a key, pressing that key will place a bookmark at the diamond-
shaped cursor's position.

Clear
Text in the RX window can be cleared by right clicking in the window and selecting Clear all from the 
pop-up menu, or by using the <CLEARWINDOW> macro, which is configured as one of your default 
macros (F8). Simply place the cursor in the RX window and then click on the Clear macro button (or 
press the F8 key).

Multiple RX Windows

CTRL-clicking the left mouse button in the receive window will put MixW into dual RX mode and open 
a second RX window named RX (1). If you are pointing at a signal when you CTRL-Left click, you will 
start copying that station in the RX (1) window immediately. If you already have a second RX window 
open CTRL-Left click will move the RX (1) triange cursor to the signal that you click on.

Right clicking in the spectrum window, and selecting "New Receive Window" will also launch the 
second receive window, as well as a third, fourth, fifth etc... There are unlimited RX windows available.

Note: Although more than 9 windows maybe opened the 10-19 will all be marked as 1 in the 
waterfall/spectrum display.

Here are three QSOs being copied simultaneously in the Main, RX (1), and RX (2) windows. Note the 
cursor locations of each on the waterfall display:



The spectrum window cursor for RX 1, 2, 3 etc... is a triangle (instead of a diamond) with the RX window 
number directly below the triangle.

If you wish to make contact with a station being copied in one of the RX (n) windows you can swap 
between the Main RX window and the RX (n) window by right clicking in the RX (n) window and 
selecting Swap from the pop-up menu.

You can only be transmitting to one station at a time.

When MixW is in muliple RX mode, it may be returned to single RX mode by closing the extra receive 
windows.

Positioning and Sizing Windows
NOTE: Before making changes to your MixW layout it is important to back up the MixW2.ini file so you 
can revert to your previous setting if necessary.

Pointing to a vacant space on the Control Bar, Log Bar, Tuning Indicator, or World Map and holding the 
left mouse button down while moving the mouse makes it possible to reposition and dock any of these 
features. An outline of the feature will appear when the mouse is first moved, and when that outline 
shrinks, it indicates a position where the feature may be docked by releasing the mouse button. The 
docked position of the feature will be remembered from session to session. These windows can also be 
undocked by double clicking on an empty space in the window.

The number of rows visible in the log bar can be changed. Double click in a blank area of the log bar to 
undock it. Resize the log bar for the number of rows you want. Double click the log bar again to redock it.

Reducing the font size will also enable more log entries to be visible.

Pointing to a window separator will cause the mouse cursor to change to a small pair of parallel lines, and 
pressing the left mouse button and keeping it pressed will make it possible to resize the Spectrum, TX or 



RX windows. Releasing the mouse button will leave the window in the resized position.

The following screen indicates one approach to screen layout using the various MixW displays:

Icons in the Calling Station Information window.
Small icons are shown to the left of the station information which indicate the DX status of the station. 
The status is also explained in the text. A star indicates a new DXCC entry, a star with the letter M 
indicates a new country in the current mode, and the letter B indicates a new country on the current band.

Icons in the MixW receive window.

Small icons can be shown along with the text in the MixW RX window. A default set of icons can be 
installed at MixW install time if the installer so chooses. There is an option in the Choose Components 
window to install or not. These icons are installed in the MixW Icons folder and are configured to appear 
after a text word by placing the word and the icon name in the MixW icons.cfg file.



MixW can utilise up to 4 icons configuration files, icons.cfg, icons1.cfg, icons2.cfg and icons3.cfg. Any 
combination of these files can be utilised on a MixW load. 

The format of an entry in the icons configuration file allows for any ICONS folder name to be used. You 
can add your own icons by putting your icons in the ICONS folder, and then identifying the icon in the 
icons.cfg file.

Open the icons.cfg file with Notepad (or some other text editor) and follow the format used for those 
entries already in the file. You can create your own icons by downloading one of the many Icon Editor 
programs available on the internet.

If an entry keyword is duplicated the following error popup occurs during the MixW load sequence.

Left click the OK button and MixW will load normally although the icon(s) in error may not be the 
intended ones. 

Remember that these icons are visible only in the RX window of the station where they have been 
created and stored. If you see them in your RX window it is because they are in your ICONS folder. 
The other station will see them only if they are also in his/her ICONS folder.They are not sent over the 
air. You can test your icons by running MixW without the transceiver on. Type the words for which you 
have made icons into the TX window and then switch MixW to TX. As the text is copied into the RX 
window you will see your icons. In the illustration below you see that I have added an icon which is a 
large "X", and equated it to the text prosign "sk".

Notch Filters in the Spectrum/Waterfall window.
To set an Audio Notch Filter, right click in the Spectrum or Waterfall window at the frequency to be 
notched and select Set Notch Filter from the menu. Multiple filters can be set using this method. To clear 
all the filters you have set, right click anywhere in the Spectrum/Waterfall window and select Clear Notch 
Filter. Filters can not be cleared individually.



Grid Location Distance and Azimuth.
Hovering the mouse pointer over a Grid Location in the RX window will show a tool tip with the 
Distance and Azimuth.

Transmitting
The active cursor for transmit is denoted by a green flag on the dial scale above the cursor. The transmit 
frequency may also be locked in place. When locked the flag will change to red color, warning you to 
notice the actual transmit frequency.

To transmit to a station, first tune it in, and then type outgoing text in the Transmit Window, (the smaller 
window between the Receive Window and the Spectrum Window). Press the TX/RX button on the status 
bar (or one of the other TX/RX toggles) and the text in the Transmit Window will be transmitted. You 
can continue to type, and that text will also be transmitted.

As it is being transmitted, text in the transmit Window will also appear in the Receive Window. To stop 
transmitting, click the TX/RX button again with the mouse. Pressing ESC (on the computer keyboard) 
TWICE will abort transmission and return MixW to receive mode, but the last several characters typed 
will not be transmitted. For this reason, the TX/RX button should normally be used to switch from 
transmit to receive.

When transmitting, the waterfall will freeze and remain frozen until returning to Receive.

Text in the TX window may be edited with the standard Windows editing functions while in the TX 
mode. Enabling View | Underline Sent Text will prevent you from inadvertantly trying to edit text that 
has already been sent (some users report, that on their systems, View | Underline Sent Text must be 
enabled to edit in the TX window).
NOTE: After editing in the TX window be sure to put the cursor at the end of the text you want to send. 
TX will stop if the cursor is encountered.

Text in the TX window can be deleted or Cleared by right clickling in the TX window and selecting Clear 
all, or by using the <CLEARWINDOW> macro, which is configured as one of your default macros (F8). 
Place the cursor in the TX window and then click on the Clear macro button (or press the F8 key).

TX Operation with Multiple RX Windows
To avoid the possibility of transmitting to the wrong station, MixW supports only one transmit frequency. 
You can switch TX (the diamond cursor) to any RX window by swapping the RX (n) window with the 



main window.

TX Lock
Lock can be used for what is normally referred to as "Split frequency" operation, or transmitting on one 
frequency and listening on another. In order to set the transmit frequency, position the diamond cursor to 
the frequency where you want to transmit and click Lock on the status bar. Then move to the frequency 
where you want to receive or where there is a station of interest and left click to start RX in the normal 
manner. The receive frequency will show a red triangle cursor and the transmit frequency will show an 
inverted blue triangle with a red flag.

To unlock TX, click the Lock button on the status bar again. The TX frequency will revert to your current 
RX frequency and the flag will turn green.

VFO B and Split Mode
MixW provides a number of macros to enable a transceiver with two VFOs to have the frequency for 
VFO B to be copied from VFO A or set independently. There are some limitations to the facilities within 
MixW for setting VFO B but some may be overcome by use of the <CATCMD:> or <CATCMDHEX:> 
macros.

Macro <FQB:fq in khz> will set the VFO B frequency. It does take a + or - value in the parameter but the 
frequency set will not be the current VFO B frequency +/- the parameter value in khz but the VFO A 
frequency +/- the parameter, which is the same action as <CATVFOSYNCONCE:fq in khz>.

To copy the VFO A frequency to VFO B use <CATENABLEVFOSYNC> but this will continually copy 
the frequency from VFO A to VFO B. Use <CATDISABLEVFOSYNC> to stop the copy action.
To copy the VFO A frequency to VFO B with an offset in khz, possibly to set up for a split operation, use 
<CATVFOSYNCSHIFT:+/-value in khz>. Once again though this action continues until 
<CATDISABLEVFOSYNC> is executed.
To copy the VFO A frequency to VFO B once only use <CATVFOSYNCONCE:fq in khz>. The 
frequency can be an absolute frequency or +/- for relative changes.

Limitation 1: Where there is a possible +/- frequency adjustment in the above macros a value of 0, +0 or 
-0 will not result in a straight copy of VFO A to VFO B but MixW will write the VFO A frequency to 
VFO A (a pointless action).

Limitation 2: When a relative value is specified the frequency set will also include the value of the Audio 
Frequency. 

Limitation 3: Not all transceivers will set the VFO B frequency unless VFO B has been selected in the 
transceiver prior to the VFO B frequency set command.
To overcome this it is necessary to either manually select VFO B using the transceiver front panel control 
or to use the macro <CATCMD:> or <CATCMDHEX:> to send the transceiver the command to tell it to 
select VFO B before sending the select VFO B frequency command, then send a command to select VFO 
A again.

A typical sequence could be:
<CATENABLEVFOSYNC> - Must be prior to the VFO B selection.
<CATCMD:sel VFO B>

A separate sequence is then needed to stop the action:
<CATDISABLEVFOSYNC> - Order immaterial.
<CATCMD:sel VFO A>
This second sequence must be in a separate macro button.

Limitation 4: If a series of macro commands like: <CATENABLEVFOSYNC><CATCMD:sel VFO B>
<CATDISABLEVFOSYNC><CATCMD:sel VFO A>



are created in a single macro they will not perform the required action. VFO B will be unchanged. 

Sequences that do work: The macro sequence:
<CATCMD:sel VFO B><FQB:value in khz><CATCMD:sel VFO A>
and
<CATCMD:sel VFO B><CATVFOSYNCONCE:value in khz><CATCMD:sel VFO A>

It is recommended if the activity of copying VFO frequencies between VFOs is required to use the 
facilities available within the transceiver using the <CATCMD:> or <CATCMDHEX:> macros. 

Split operation
There are a number of minor differences in the methods used to implement Split Mode working even 
within transceivers from the same manufacturer. Read the operation manual first before attempting to use 
Split Mode for the first time.

MixW supplies a number of macro commands (see above) to facilitate setting frequencies and a macro 
<SPLIT:0/1> to action the split. 

Operating With Macros
The MixW Macro Buttons in the Control Bar allow for the automation of almost all frequently used 
operating procedures. The Macros can be executed by using the keyboard F1 thru F12, Ctrl-F1 thru Ctrl-
F12, Shift-F1 thru Shift-F12, or Ctrl-Shift-F1 thru Ctrl-Shift-F12 keys. The macros can also be executed 
by (mouse) clicking on the buttons in the control bar in which case the different rows can be displayed 
before clicking by pressing the Shift, Ctrl, or Ctrl-Shift keys, or by rolling the mouse wheel while the 
pointer is hovered over the control bar.

For information on customizing Macros see the Configuring Macros topic in the Configuration and Set 
Up section.

RXLog facility
Enabling RXLog, either from the File menu or one of the <RXLOGSTART> macros causes all text that 
appears in the RX window to be saved to the named file. The file can then be opened with a text editor 
(Wordpad.exe is recommended as Notepad.exe does not correctly interpret the method MixW uses to 
write newline characters).

This is a useful facility for use in contests to enable verification of incorrectly logged exchanges and 
checking on unexpected dupes.

Note: Once started the logging will continue across MixW stops and starts and large files can be created.

File Menu
_________________________________________________________ 

A short description of some of the selections available from the file menu:

Print (CTRL-P) Prints the contents of the Receive window to the printer. Note: The cursor MUST be in 
the RX window.

Print Preview: Displays an image of the printed page.

Print Setup: Displays a dialog for setting printer parameters.

Add QSL to current print queue (Ctrl-Shift-P): Adds the selected QSO to the QSL print queue.



Extras: V2.2 and later.

Opens dialogue to download extra Mode dlls, Contest stats or languages.

Send File: Transmits the contents of a specified text file. This must be text only! Be sure to always 
"close" your file by saving it to disk.

Send Picture: Displays a dialog to send a picture in MFSK

YAPP: Send or Receive YAPP.

Run Script: Execute a script file.

Search in log file (ALT-R): Displays the "Search in Logfile" dialog allowing you to search for any string 
in the log.

QSO details (ALT-D): Displays a dialog showing all fields in the log for the selected Log bar QSO. This 
dialog also allows adding a new call area, or sending an eQSL.

Remove QSO (Alt-O): Deletes the selected QSO.

Restore removed QSO Restore the last deleted QSO.

Save QSO (Alt-S): Saves the contents of the active log entry.

Lookup call (Alt-K): Looks up the active call in the log and displays all previous contacts.

Import ADIF: Imports a log in ADIF format. The ADIF format is common to many log programs, and 
can be used to exchange logs between different programs.

Note: After an import check for a file BadAdif.txt in the MixW default data folder. A failure to import 
individual QSOs maybe logged in this file.

Export ADIF: Exports a log in ADIF format for import to another program.

Merge: Will merge two MixW2 logs together.

Backup Log: Will access the backup.pwd file for the password to use to copy the log file, in .adif file 
format, to the Mixw site.

Restore Log: Will access the backup.pwd file for the password to use to retrieve the log file, in .adif file 
format, from the Mixw site.

Save Config: Will bring up a dialogue to save the mixw configuration data to a file. The save will not 
take place until MixW exits when the current MixW configuration will be saved to the new file.
In MixW2.2 and later it will also lead to a change in the MixW2StartUp.cfg file,which contains a pointer 
to the MixW2.ini file.

Load Config: Will bring up a dialogue to load a previously saved mixw configuration file. MixW will be 
stopped and restarted with the new file data immediately.
As in the Save Config menu item (above) in MixW2.2 and later the MixWStartup.cfg file will be changed 
with the new MixW ini file replacing the existing one.

RX Log: Opens or closes a file to save the receive window text data.

Sound: You can save the last forty seconds of audio to a wave file. This is useful in cases were you want 



to demonstrate certain audio characteristics. Files can be saved, and later played back for reception and 
display.

Exit: Exits MixW

Edit Menu
_________________________________________________________ 

A short description of the selections available from the edit menu:

Undo (CTRL-Z) Standard windows action

Cut (CTRL-X) Standard windows action

Copy (CTRL-C) Standard windows action

Paste (Ctrl-V): Standard windows action

Toggle Intellegent whitespace Introduced in V3.2.105

Causes a space character to be inserted between the text of two different macros if there is no whitespace 
between text at the end of the first macro and beginning of the second macro.

A whitespace is a space character, a tab character or a linefeed character.

Insert (RX) (ALT-END Adds an <RX> to the next transmit buffer character position.

Clear window Clears the transmit window. Same as <CLEARTXWINDOW>.

Options Menu
_________________________________________________________ 

AFC 
When AFC is checked, MixW will keep a station tuned even if it drifts. It is recommended that you keep 
AFC checked unless it prevents you from tuning to a desired station. Uncheck AFC if a nearby strong 
station makes it impossible to tune to a weaker station.

Lock
Lock allows you to transmit on one frequency and receive on another. When Lock is selected, the TX 
frequency is fixed at the position of the active cursor, and the flag above the cursor changes to red. When 
LOCK is NOT selected, transmission will occur on the same frequency as receive, as indicated by the 



diamond cursor, and the flag above the cursor will be green.

Snap 
When Snap is checked, MixW will automatically find the correct tuning point for a station. Uncheck Snap 
if a nearby strong station makes it impossible to tune to a weaker station.

Squelch 
When squelch is checked, only signals above the Squelch threshold will be printed. This can be used to 
prevent random characters created by noise from being printed.

Squelch Threshold 
Displays a level control for the Squelch threshold. The threshold can be adjusted as high as possible to 
prevent noise from printing as random characters but still allow print of a desired station. Selecting Mode 
| Squelch threshold...will display a mode specific dialog in which AFC, Lock, and Snap can also be set.

When the screen-printing is "squelched", or not printing, because the signal is below the squelch 
threshold, the "Sq" shows on the status bar without the " * ". If MixW appears to stop decoding, be sure 
the squelch threshold is not set too high. For reception of weak signals, it is usually best to turn the 
squelch completely off. This will result in "garbage" print some of the time, but whenever the signal 
becomes strong enough that copy is possible, the text will appear on the screen along with the garbage 
characters.

RX Selecting RX places MixW in the receive mode.

TX Selecting TX places MixW in the transmit mode.

TX and RX can also be toggled by using the pause/break key on the computer keyboard, by clicking on 
the RX/TX box in the Status Bar, by using the TX and RX Macro buttons, or by using the <TX> or <RX> 
Macros in a Macro script.

Continuous Seek
When Continuous seek is checked, Seek will continuously look for a station until one is found and stop 
on that station. To stop Seek, just press any Seek button. If a station fades below the Seek threshold, 
Continuous Seek does not start seeking for another station. This is so you can stay on the station's 
frequency and continue to copy whatever you can, even though it is fading. To restart Continuous Seek, 
just press one of the Seek keys or buttons.

Arrows for Seek
When Arrows for Seek is checked, the left and right arrow keys can be used for Seek, but the arrow keys 
are then NOT available for editing the RX and TX window. Uncheck Arrows for Seek to make the left 
and right arrow keys available for RX and TX window editing.

Scan | Start Scan
When selected, Scan will cause MixW to Seek out a station, stop on that station, record the time and tone 
frequency of the station, and print that station on the screen for a determined amount of time (dwell). 
After printing for the selected dwell time, MixW will proceed to the next detectable signal and repeat the 
process.
Note: Snap must be on for Scan to work. 



Scan | Stop Scan
Selecting stop scan will stop the Scan process. Scan may also be stopped by selecting a station or 
frequency with the mouse. Clicking Scan | Start Scan again will start the scan from the current location.

Start Scan and Stop Scan can also be controlled by macros, so <STARTSCAN> and <STOPSCAN> may 
be assigned to function keys or put into a macro script.

Scan | Scan properties
Selecting Scan properties will bring up a dialog for setting the way Scan behaves. "Only once" will stop 
Scan after encountering the first detectable signal, Dwell sets the staying (to print) time in seconds, and 
Continue on squelch resumes scanning when the signal level falls below the squelch threshold, Checking 
Time Marks or Frequency Marks, tells MixW to display the time of the station print or the frequency of 
the station print, or both.

Scheduler
Scheduler allows the Mixw operator to specify an Event by date and time. The Event can be a reminder or 
a Macro to execute.
Selecting Scheduler brings up the Events list. 

By selecting New or selecting a previously entered outstanding Event and selecting Edit brings up the 
Event details. Click on OK to save the details.

It is possible by checking the week day boxes to execute a periodic task or reminder.

The event data is written to file events.dat.



Note: The Advanced and ShellExecute functions aren't currently available.

Memory
Mixw has the capability to store up to 20 Transceiver and Mode settings. The settings maybe saved by 
selecting the Memory option, using the macro <MEMW:> or using the short cut keys Ctrl-1 - Ctrl-Shift-
0.

The data saved can be restored by selecting the required row then Memory Read, by use of the 
<MEMR:> macro or the short cut keys Alt-1 - Alt-Shift-0. 

View Menu
_________________________________________________________ 

View is where you select which of MixW's various control windows and operating aids are displayed on 
the screen, and in several cases, how they are displayed. Simply select (check) the ones you want 
displayed.

Menu 

MixW has two different Menu Layouts. In early versions of MixW Help was not visible in Menu Layout 
2. If the Help menu is not visible in the main MixW menu bar, select View | Menu and choose Layout 1.

The Menu Layout maybe changed at MixW start. See Starting MixW.

Control Bar 
When checked, the Control Bar will be displayed. The Control Bar may be moved and repositioned 
(docked) by pointing to an empty area of the bar, holding the left mouse button down, moving the outline 
of the bar until it changes shape, and then releasing the mouse button. The usual alternate docking 
location for the Control Bar is just underneath the Spectrum Window.

Log Bar
Gives access to several settings for contest logging, and log text colors.

CAT Bar
Displays current Side Band and Frequency settings for use by the Waterfall and Logging functions. 
Enables band switching and Transceiver Mode selection. Provides variable speed Transceiver tuning.

Tuning Indicator
When checked, a phase display of the received signal will be shown. This will display as multicolored 
radial lines, like spokes of a wheel, when MixW is not tuned to any signal. When tuned to a BPSK signal, 



there will be only two vertical, or nearly vertical, spokes displayed. When tuned to a QPSK signal, there 
will be two vertical spokes and two horizontal spokes forming a cross, and when tuned to a FSK31 signal, 
two horizontal spokes will be displayed.

World Map
A World Map will be displayed showing your station as a yellow dot in the location you configured under 
Personal Data. A line will appear indicating the location of the call in the active QSO entry of the Log. If 
you have configured MixW to use Rotor control, the heading of your antenna will also be displayed, and 
it will move with your bearing when operated through MixW.

Toggle QSO meter Indicator
Displays a small window that shows in slider format and numerical count the number of QSOs made per 
hour. 

 

For MixW3.2.105 two panes are now shown. 

The upper pane shows total QSO count in the last hour.
The lower pane shows rate of QSOs per hour.

The QSO meter working parameters are set at start up using the following entries in the initialisation file. 

[QSOMeterBar]
m_iCx=1804
m_iCy=151
m_iMaxScaeHeightPx=10
m_iMaxTimeRateSecs=3600
m_iRefreshTimeSecs=1
m_iMinTimeRateSecs=300

These parameters calculate the average number of QSOs likely from a QSO save count over a 5 minute 
period (300 seconds).

The time parameter m_iMinTimeRateSecs can be changed to give other average QSO rates. If the value is 
set to 60 (one minute) the hourly average QSO rate will be calculated on the number of QSOs saved in 
the last minute.

The time parameter m_iMaxTimeRateSecs controls the total time both QSO count and QSO average rate 
are calculated over. This parameter can be changed to give other time periods.



These changes can only be made by using a text editor to change the initialisation file whilst MixW is not 
loaded.

QSO statistics
A window will be displayed. When a callsign is entered in the log line or a previous QSO is selected from 
the displayed log bar window then a pictorial representation of the QSO activity for the country and 
callsign will be displayed. 

 
In addition to the icon symbols used in the display as shown on the Legend line a  icon maybe shown 
in one of the boxes. This indicates a new mode for this country on this band. A red tick indicates previous 
QSO(s) with the selected callsign.

By left clicking on any of the boxes with a symbol in it a log activity display of the selected box will be 
displayed.

By left clicking on the Info icon on the far right of the Legend line a DXCC window will be displayed 
showing a detailed list of QSOs for the whole of the log. This display is the same as the display from the 
menu View->Statistics->Detailed by Country. 

There maybe icons of a magnifying glass and a head at the top left of the window. Left clicking on the 
magnifying glass will show a list of all QSOs with the country, left clicking on the head will show a list 
of all QSOs with the call. 

DX Cluster
The DX cluster window can be configured for packet or internet DX information.

Callbook dialog
For this option to work, a callbook must first be configured by selecting Configure->Callbook and then 
selecting your callbook type and its path settings. If there is an entry in the current QSO line in the log, 
that entry will be entered in the Call: text box when the Callbook dialog is opened. If you want a different 
call, type it into the Call: text box. Click the Search... button to look the call up in the callbook.



Note: You do not need Auto search in callbook (in the Options Menu) checked to use the Callbook 
dialogue facility.

Status Bar     
When checked, the Status Bar will be displayed. Note: Right clicking in the status bar will bring up 
additional display options.

Statistics
Give you display options for your contest statistics while in the MixW contest mode or show brief log 
statistics or detailed country by country statistics.

Quick search 
The Quick Search dialog is for searching for incomplete callsigns. Although originally intended for 
contest use the feature can be enabled at any time.

Select View->Quick search->Show dialog. Next select your preferred method of searching from the 
options by selecting View->Quick search-><preferred method>. Now with the Quick search dialog 
selected you can enter part of a call sign into the new QSO cell of the Log Bar. Wildcards ('*' and '?') are 
allowed. Red ticks will indicate if you have already had a QSO (indicating a dupe) with this station (this 
will be according to the current contest settings). 

An option is provided to enable the loading of a Master.dat database.

NCDXF/IARU Beacons
This dialog allows you to automatically QSY your rig to the various beacons. The options reflect the 
active beacons based on Zulu time. Clicking on one of the active beacons will QSY your rig to that 
beacon's frequency, and set the mode to CW for decoding it.
Note: Your computer time must be set extremely accurately to use this feature, otherwise the list will not 
be in sync with the beacon timing. You must also have the CAT feature properly configured to 
automatically QSY the rig.

Scanner
Allows you to configure frequencies or ranges of frequencies to be scanned. The scans are initiated and 
terminated with macros.

The information is written to file scanfq.dat.

Contest mode
The contest mode dialog is used for selecting, editing or adding contest settings.

Spectrum
Here you can change between the Waterfall or Spectrum displays as well as change the colors, zoom, and 
RF markers. Many of these items can also be changed by Right Clicking in the waterfall or spectrum 
display windows.



Note: you can also change the speed of this display in the sound card settings dialog box. Select 
Configure->Sound device settings...
The faster speeds require faster computers.

Displaying spectrum frequencies and Configuring for LSB or USB operations: The MixW options 
for RF, USB/LSB should be configured to reflect your mode of operation by selecting View->Spectrum-> 
RF, USB or RF, LSB or Auto, or Sound. These must be set correctly in order for the frequencies in the 
displays to represent your actual operating frequencies, and for MixW to automatically adjust the 
inversion settings based on your RF mode. See the information on inversion in Configuration.

Advanced Waterfall
When checked the entire waterfall will move as you tune the transceiver (CAT must be enabled). This 
prevents the "smearing" of the signals already in the waterfall. Requires a fast computer for smooth 
operation.

Note: From MixW V2.16 onwards two waterfall/spectrum windows can be displayed by appending the 
parameter /2 to the MixW start up command. See Starting MixW. 

Underline sent text 
When checked, the text in the TX window will be underlined as it is transmitted. Transmitted text will 
also be echoed to the RX screen in a user-assigned color as configured under Configure | TX font color. 



The Underline sent text should be enabled if you want to edit the text that still remains in the TX buffer.

Word mode
Selecting word mode prevents text from going to the transmit buffer until an entire word is typed in the 
TX window. This can be handy as it allows for editing a word in modes that do not support the backspace 
key, such as RTTY and AMTOR.

Word mode is only available when using the Underline sent text option as described above. Also, when 
using word mode, several Macros will require a space to be present after the Macro command itself in 
order for it to be sent to the TX buffer properly. 

CAPITALS ONLY
Selecting CAPITALS ONLY will automatically convert any lower case characters entered in the TX 
window to upper case when sent to the TX buffer. This is handy for the RTTY and AMTOR modes, 
which only support upper case characters.

Display Slashed Zero
Provides the user a choice of styles for the numeric zero.

UTC 
Causes the time displayed on the right end of the status bar will be in Universal Coordinated Time. When 
unchecked, will be in local time. If the clock of the host computer is set to UTC instead of local time, the 
Time Zone setting under Windows needs to be set to GMT and adjustment for "daylight savings changes" 
disabled.

Flashing 'TX' 
The 'TX' indicator for transmit on the status bar will blink on and off. When unchecked, the 'TX' indicator 
will not blink.

Use Stick Cursor
Will turn the mouse pointer to a thin stick while in the waterfall display. This can facilitate placing the 
tuning diamond in the middle of a signal.

Show hairlines
Selecting Show Hairlines causes hairline tails to extend down from the tuning indicators (from the top to 
the bottom of the waterfall display). These can be an aid to tuning certain signals.

Always show IMD 
Will display the IMD reading constantly when receiving a PSK31signal instead of just during the idle 
tones. However, the idle tones are the best time to determine the station's IMD.

Use Default RST
Will send the default RST when the RST Macro is used, instead of asking for your RST report.

2nd TNC window
Selecting this option displays a 2nd TNC window.

Telnet Window
Opens a window allowing the user to initiate a Telnet session over the internet. This could be a Telnet DX 
Cluster, or any other standard Telnet communication. An internet connection must already be open.

New RX window
Opens an additional RX window tuned to the frequency currently selected in the waterfall display and in 
the current mode. 



Status Bar Use
_________________________________________________________ 

The bottom frame line of the MixW screen displays the Status bar if selected in the View menu.

The left part of the status bar displays the call, name and qth of the current QSO (if entered), the right part 
information pertaining to the current mode, date and time. 

MixW3.2.104 enhancement

At MixW startup, if the status bar is displayed, a new display area is included to enable the download (if 
required) of updated files for Modes, Contest statistics dlls, Language files, Data files and Macros. 

These New extras are the same as can be selected from the File->Extras menu selection.

Left clicking on the New extras area will bring up a download window

that highlights all the updated files available for the main items (listed above) for your system. Further 
left clicking on this New extras area will cause other windows to be displayed.



It is necessary to left click on Close for each Download window to close them.

An improved format download window is introduced with MixW3.2.105

IT IS NOT NECESSARY TO DOWNLOAD FILES TO ENABLE THE WINDOW TO CLOSE.

Once all the New extras area has been read the Status bar will not display any New extras until a new or 
updated file is available from the mixw.net website. If you require to download a file you previously 
ignored you must select it from the File->Extras menu.

The information is held in the initialisation file. 

TX/RX or Connected/Disconnected: In all modes except Packet, the leftmost box indicates either TX or 
RX depending on the current status of MixW, and transmit and receive can be toggled by clicking on this 
indicator box. In Packet mode this box indicates Connected or Disconnected

Sq(uelch) or DCD In all modes except Packet this box displays the Squelch setting. Squelch can be 
toggled on or off by clicking on the Sq box, and the threshold can be set by right clicking on the Status 
Bar and selecting "Squelch Threshold" from the Pop Up menu:

Clicking on Squelch Threshold pops up the following box:

In addition to setting the Squelch threshold, AFC, Lock and Snap can also be set from this pop up dialog.

 If MixW appears to stop decoding, be sure the squelch threshold is not set too high. For reception of 
weak signals, it is usually best to turn the squelch completely off. This will result in "garbage" print some 
of the time, but whenever the signal becomes strong enough, the text will appear on the screen along with 
the garbage characters.



In Packet mode this box displays DCD. The DCD setting can only be adjusted by going into Mode 
settings then select the Modem tab.

AFC, Lock, and Snap are fixed for all modes. They can be toggled for the modes in which they are 
available by clicking on their boxes in the Status Bar.

Frequency: The current audio operating frequency is indicated in Hz. This represents the offset from 
your transceiver's zero beat frequency you are operating on.

Mode specific data:

A number of modes display no data in this box (FM, CW, SSB, FSK31,and MFSK) which is shrunk to a 
minimum size.

The other modes, apart from PSK modes and SSTV, show a value pertaining to the throughput of the 
mode. 

SSTV shows the current SSTV mode.

IMD:

IMD is only available in PSK modes and a value will only be displayed if menu View|Always show IMD 
is ticked. Clicking on the IMD box will freeze the IMD at the last observed value. Clicking on it again 
will activate the IMD reading again.

The macro <IMD> will insert the displayed IMD value into the transmitted text only if the IMD display is 
frozen.

IMD is a measure, in dB, of the level of the first pair of unwanted sidebands (at +/-46Hz from the center-
frequency) compared to the main pair of wanted sidebands (at +/-15Hz). The readout is accurate only 
when the signal is idling, and at that time, the emission is actually the same two-tone signal that is used 
for checking the quality of SSB transmitters, and the IMD dB figure is the same as the third-order 
intermodulation performance figure given for SSB transmitters.

IMD readings are only accurate, and only display when the station is idling, and there is not 
another station very close in frequency, and when the S/N ratio of the received station is about 20 
dB or greater. Typical IMD readings are -25 dB to -30 dB for a well-adjusted transceiver, and readings 
of -20 dB or worse indicate that the transceiver's extra sidebands can cause QRM to adjacent stations.

Left clicking on this box in CW, FSK, RTTY, Packet, Pactor, Amtor, MFSK, Throb, MT63, 
Hellschreiber, Fax, SSTV, RTTYM, OLIVIA and CONTESTIA modes will bring up the Mode settings 
dialogue box.

Mode: The current operating mode is indicated in the box to the left of the Date.

Date: The current date is displayed.

Time: The current time is displayed. By right clicking the status bar, you can select to display UTC or 
Local time. 

Logging and QSLing
_________________________________________________________ 

MixW's Logging features make it easy to keep track of all your QSOs. The contest mode will track your 



contest progress, complete with multipliers, while automatically checking for DUPs and auto-
incrementing serial numbers for exchanges. The normal mode can track your regular ragchewing and 
award hunting contacts.

The Log Bar can display up to 20 items of the log file entry and is capable of showing up to the previous 
24 QSOs. You can design 4 different log bar layouts and select the one you want for a particular purpose 
from the View menu.

The Log Button Bar which appears at the bottom of the Log Bar controls several log functions.

Search allows you to search the log for a callsign. 
Details will bring up the full log information for the selected QSO. This allows changes to the data to be 
made and saved. 
Delete will delete the selected QSO. 
Save will save the New QSO line to the Log. If the line selected in the log bar is not the current (unsaved) 
QSO a prompt will be displayed to make sure you really want to delete a saved QSO. 
Lookup call performs a log search for other QSOs with the call selected in the log bar.

Note: To scroll all the entries in your log click Search (eyeglasses) and then click the Whole Log button. 
To see all the fields in a log entry click Details ('A'). 

Up to 25 lines may be shown in the log bar. Double click in a blank area of the log bar to undock it. 
Resize the log bar for the number of rows you want. Double click the log bar again to redock it. Reducing 
the log font size will also enable further lines to be displayed.

The latest versions of MixW have an added facility to the log bar. By right clicking on an entry a pop up 
menu of four entries is displayed:



The Edit entry brings up the Details Window.

QRZ.com activates an internet connection to QRZ.com with the callsign as the database parameter.
By changing the MixW2.ini line:
QrzPage=http://qrz.com/db/
it is possible to call a different website, providing the last part is a callsign (e.g. 
QrzPage=http://www.eqsl.cc/Member.cfm will call the eQSL page). 

Google Map maps the home and distant QTHs. The way the other station is plotted is to use the 
coordinates for latitude and longitude from the cty.dat file unless the prefix of the distant station can be 
further resolved in the pfx.dat, in which case this position will be used.
Use of Google Map creates a file MixW2.kml in the default data directory and leaves a number of 
callsign-(null).html files in the appdata or application data local\temp folder.

The Search entry displays all previous QSOs with the callsign. 

MixW3.2

For MixW3.2 further enhancements have been introduced to the log display.

MixW3.2 introduces a slider bar on the right of the log. This slider will allow display of up to the last 24 
QSOs. 

Two extra icons are added to the log button bar. A small gear wheel button  and a small green button 

Left clicking on these icons causes the following action:



                      

 

This menu allows immediate        Using this icon allows for selecting
changes to the currently      contest mode (when the icon
displayed log fields.        turns red).

The fields available are
defined by the currently
selected log bar layout.
The action of removing
displayed fields shrinks
the log display and
enabling fields expands
the log display. The
fields displayed cannot
be moved positionally.
This must be done using
the configurable custom



dat files or moving the
position in the .ini file.

Since there are too many
fields in each log entry
to put in a single line across
the page you must choose
the set of fields you want
to display, and the width
you want each field.

Log Bar Layout

The Normal and Contest Layouts show a pre-chosen set of fields, while the Custom 1 and Custom 2 
Layouts have all fields available. The widths of the Log columns are configurable. Place your cursor 
between two columns in the gray (title area), then click and drag to the desired width. Up to MixW2.18 to 
see additional fields in the Custom Layouts you must either hide some of the fields on the left side of the 
layout so that fields can move in on the right side of the layout or undock the log bar and stretch the log to 
display the fields or modify the Initialisation File. To hide a field drag the right side completely over the 
left side, decreasing the size to zero.

From MixW2.19 two files Custom1.dat and Custom2.dat are installed. These files contain a list of all the 
fields that can be displayed and are of this form:

1 MODE
2 FQRX
3 FQTX
4 DATE
5 TIME
6 CALL
7 RSTSNT
;8 EXCHSNT
9 RSTRCV
;10 EXCHRCV
14 DOM
11 NAME
12 QTH
;15 COUNTY
16 IOTA
17 MGR
13 NOTES
;18 ENDDATE
;19 ENDTIME
20 LOC

Lines which begin with ";" are ignored, so fields EXCHSNT, EXCHRCV, COUNTY, ENDDATE, and 
ENDTIME are absent in this example. You may change the order of lines (and according columns) but do 
not change the numbering, i.e. CALL should always have 6 at the beginning.

Note: Before attempting to modify the Initialisation File make sure you have a working copy back up of 
the file.

Before starting to edit the Initialisation File make sure MixW is unloaded. 

If using .csv log file format it is possible to configure the two preset layouts Normal and Contest and for 
MixW2.18 and earlier the two Custom layouts. The information is held in the Initialisation File.



There are 4 headings in the initialisation file

[ContestBarLayout0] - Refers to the selection for the Normal layout
[ContestBarLayout1] - Refers to the selection for the Contest layout
[ContestBarLayout2] - Refers to the selection for the Custom 1 layout
[ContestBarLayout3] - Refers to the selection for the Custom 2 layout

For MixW2.19 and later any attempt to modify the Layout2 and Layout 3 sections will be overwritten by 
the settings in the files Custom1.dat and Custom2.dat when MixW starts.

Each section consists of 40+ lines of information, not in any particular order. There are 5 keyword line 
types:

Lines= - Only one per entry. Leave this line alone
Heightsx= - A number of entries. Leave these lines alone
FieldWidthx= - Defines how wide the field is. Leave these lines alone.
FieldAtColx= - Defines the field to be displayed at log bar column x+1
Fields= - Only one per entry. Defines the number of columns being displayed - 1

x defines the log column position + 1.

Note: x value of 0 is a special case. If you modify it MixW will most probably not start or the log bar will 
be very corrupt. The only recovery is to restore the values to their originals or restore the back up copy of 
the initialisation file. 

To modify the entries it is necessary to identify which column numbers + 1 are going to be affected. If 
insertions are being made identify the field numbers that are to be added. Use the 
Custom1.dat/Custom2.dat layout above, identify the field name(s) to be added then subtract 1 from the 
number in the left hand column (eg County is 14).

If columns are to be deleted subtract the number of columns to be deleted from the Fields= line. If the 
column(s) are the right most columns to be deleted no further action is needed. Otherwise starting at the 
FieldAtColx= where x is the column number -1 and replace the value with the FieldAtColumnx+1. This 
sequence has to be repeated until the last column value to be displayed has been updated e.g:

If displayed log column 7 is to be removed and there are currently 11 columns displayed change the line 
Fields=10 to Fields=9.
Now find the line FieldAtCol6= and replace the value after the = with the value after the = of line 
FieldAtCol7=. Now repeat for lines FieldAtCol7, FieldAtCol8, and FieldAtCol9. This has the effect of 
shifting the columns one place left.

This is repeated for each column removed.

To add columns at the right side of the log, note the value to the right of the Fields= line (value is n later 
in this sentence) and create or (if they already exist) modify the lines FieldWidthn=40 and 
FieldAtColumnn= (the value after the = is the value identified by the column name to be displayed - 1. 
Now add one to the Fields= value and repeat for any further columns to be added to the log bar.

To insert column(s) into the log bar, this is an example to insert the IOTA and Loc fields into the Normal 
log bar layout between the QTH and the RST_Sent fields:
The Fields= value is 10 (Fields=10).
The RST_Sent column is 9 (which translates to column 8).
Create, or modify (if they already exist) lines FieldWidth12=40 and FieldAtColumn12=12 (this is the 
notes field).
Create, or modify (if they already exist) lines FieldWidth11=40 and FieldAtColumn11=8 (this is the 
RST_Recv field).



Modify line FieldAtColumn10=12 to FieldAtColumn10=6 this moves RST_Sent
Modify line FieldAtColumn9=8 to FieldAtColumn9=15 this inserts the IOTA field
Modify line FieldAtColumn8=6 to FieldAtColumn8=19 this inserts the Loc field
Modify Fields=10 to Fields=12 (2 columns inserted). 

Save the modified Initialisation File and start MixW. Once you have verified the changes are correct 
adjust the log column widths as required. 

Making entries in the log. 

Entries may be typed directly into the log, by left clicking on the field, or they may be moved into the log 
from the RX window. Clicking/double clicking on data in the RX window will copy it into the Call, 
Name, LOC, RST_Recv, Notes or Exchange Received field in contest mode field in the log depending on 
the configuration of the word. 

For Roundtable operation, a second, third, etc. call may be appended to the Call window by copy and 
paste from the RX window, and separating the calls with commas. If this is done, all macros using the 
<CALL> macro will also use the additional calls.

Holding the CTRL key and clicking/double-clicking on a word will append that word to the QTH box. 
By holding down CTRL and clicking/double-clicking each word of a QTH in turn, a multi-word QTH can 
be entered into the log without typing.

Holding the ALT key and clicking/double-clicking on a word will append that word to the NOTES box. 
By holding down ALT and clicking/double clicking each required word in turn the information can be 
entered into the log without typing.

Note: The Click/Double Click option can be selected from the Options|Click menu item. I prefer double 
click since accidentally single clicking in the RX window can change the QSO data unintentionally. 

All log entries can also be filled in by highlighting the information on the screen, holding down the left 
mouse button, "dragging" the information into the desired box, and releasing the mouse button.

A log entry may also be filled in by highlighting the information, pressing the right mouse button, and 
copying and pasting the information into the desired box, or choosing a location from the displayed menu. 
This method can be used to capture a call with imbedded spaces such as "K E 6J"

This is the menu for early MixW releases.

MixW3.1 and later menu.



 
When the desired entries are filled in, clicking the Save icon button will save the information into the log, 
You can also use the <SAVEQSO> macro at the end of your sign off macro to automatically save the 
QSO to your log. By clicking the Search icon button you can search the log for any character or string of 
characters by typing a string to be found and clicking the Search button on the search dialog. You can 
also display the entire contents of the log by clicking the "Display Whole Log" button.

Note: If you select a new callsign in the RX window before you have saved your QSO information, your 
"New" QSO line will be cleared and the new call inserted. To avoid the possibility of accidentally loosing 
a QSO this way, UNcheck "Clear QSO on new call" under the Options menu, then a new call will not 
clear the unsaved QSO. You can also restore an accidentally cleared or deleted QSO by selecting File | 
Restore removed QSO.

Changing or Editing a QSO

To add data in fields not displayed by the Log Bar or to add or modify previously saved data for a QSO 
select one of the Edit methods for the QSO as detailed above.

This will bring up the Edit QSO dialogue. Make any changes you need and click OK to save the data.



There are instances where other data pertaining to the QSO may need to be changed.

In the example above the /LH suffix causes MixW to log this QSO for Norway although the /LH suffix is 
to indicate a Lighthouse. To correct this use the Change button in the Edit QSO dialogue. This will bring 
up the Change country dialogue. Either use the drop down menu to select the prefix of the country you 
wish this QSO to be associated with or just enter the prefix if you know it. By entering DL in the Country 
box the line below will change to Fed. Rep. of Germany. If this is all you need click OK. The new prefix 
will be saved in the DxPfx field of the log. If this QSO is selected again in the future the Country will 
now be shown as Fed. Rep. of Germany and not Norway. However if a new QSO with this call is made it 
will show the country as Norway unless a new rule is generated. 



To create a new rule click on Change rule in the Change country dialogue. This will now bring up the 
Add new call area dialogue. Change the Prefix to the one you are creating the new rule for (it is the same 
as for the Change country). This will now change the other data to the data for this prefix in cty.dat. If 
desired more accurate latitude and longitude can be entered and zones and timezone corrected. Click Add. 
A messagebox informing pfx.dat has been updated will appear. Click OK. Now whenever the callsign is 
entered in the log the New rule data will be displayed. 

When to use Change Country and Change Rule 

cty.dat is regulary updated. One of the items it documents are dxpeditions and temporary callsigns. This is 
OK whilst the callsign is in the cty.dat file but certain countries and political areas make changes to calls, 
reissue callsigns etc. Two examples are the USA where calls for expeditions are recycled and the UK 
where the prefix GB can be used in any of the G prefix areas and some callsigns are associated with 
exhibitions that move around the UK.

Where a callsign is likely to be reused a new rule should not be used. However where a change is 
permament (eg A prefix change that may be reflected as a new country in cty.dat) then a new rule should 
be created.

When MixW indicates it has updated pfx.dat the new data is inserted at the bottom of the file. 

Printing and Exporting your log file.
First select the QSO's you want to print by clicking on the Search button in the Log Bar, which will bring 
up the "Search in Logfile" dialog:

You can now display the whole log by clicking the Whole Log button, or search for particular groups of 
entries by selecting the fields to be searched, along with the search criteria, and clicking the Display 
button. The following window will be opened to show the records that were found:



The fields in the Search Results window can be resized in the same way as the Log Bar so that you can 
see the fields you are interested in. Select the records you want using standard Windows functions such as 
Click, Shift-Click, and CTRL-Click. To select all the records displayed in the log select a single log entry, 
right click on it select Select All from the drop down menu. All displayed records are now highlighted. 
Use the buttons at the bottom of the window to print or export the records you have selected. You can 
also Edit or Delete log entries, look up contacts in the Callbook, or display statistics from the selected 
entries.

The log for MixW V3.1 has been enhanced. 

Left clicking on the column title bars will cause MixW to sort the log entries numerically on the data in 
the selected column. Appended to the column heading is a small arrow indicating if the column is sorted 
in ascending or descending order.
Two additional buttons are now displayed. Refine does not appear to be implemented but Add allows the 
build up of multiple searches. 

Sending an eQSL card
You must be registered with eQSL (www.eqsl.cc) and have a valid password. The computer must be on-
line, but you do NOT need to be signed in to eQSL. Select the log entry you want to QSL in the Log Bar 
and click the QSO Details button, or in the Search Results window click the Edit button. This will bring 



up the Edit QSO window. Make any changes or additions you want and click the Send eQSL! button. 
You will be asked for your password, and then a window will be displayed showing the status of your 
eQSL. Click the eQSL sent box before closing the Edit QSO window.

If you want to send a batch of selected qsl-records, you just "right click" the mouse in the highlighted 
(selected) area of the MixW log file "Search results" window. A new menu now appears, where you 
choose "Send QSL(s) to eQSL.cc". The whole batch of qsl's is then transmitted to the eQSL database. 

You can also send eQSL's by exporting selected records to an ADIF file and uploading that file to eQSL.

Using the MixW program to create a QSL card to print or to email.
The MixW program provides a dynamic data exchange (DDE) link for use by other Windows programs 
such as MS Word and Excel or OpenOffice Writer. The data that is available can be used to create a QSL 
card by inserting DDE fields into a document that will be viewed as a QSL card in the final form. To 
learn more about DDE fields, go to the HELP files in your application that supports Windows DDE 
fields. The chart below shows a subset of the DDE code fields supported by MixW:

Entity Server Name Topic Item Current state     

Your call MixW Info MyCall K4SET

Your name MixW Info MyName Scott

Your QTH MixW Info MyQth Murray, KY

Program name MixW Info Program MixW

MixW version MixW Info Version 2.0 beta 21

QSO date MixW QSO Date 28-Jan-2001

QSO time MixW QSO Time 20:57

Frequency, MHz MixW QSO Mhz 14.1

Mode MixW QSO Mode BPSK31

Call MixW QSO Call W8HAT

Name MixW QSO Name RICHARD

QTH MixW QSO Qth STEVENSVILLE MI

RST sent MixW QSO RstSnt 589

RST received MixW QSO RstRcv 589

Notes MixW QSO Notes Likes to fish

QSO is unsaved MixW QSO Changed NO

QSO freq. MixW QSO Khz 14070



To use these field codes in a QSL or for making mailing labels, you enter the field code in the document 
where you want it to appear.

For MS Word you can add a DDE field by using Ctrl-F9, then fill in the field code. To view the results 
in the final form, use F9. To view the field position the cursor over the field and use Alt-F9.

From the chart above, you would create "your call" with the following string of field code:
 {DDEAuto "MixW" "Info" "MyCall" \ *MERGEFORMAT}

The following describes how to create a QSL card with MixW V2 or V3 using the MS Word form 
provided with the program:

Step 1. Open the log entry that you wish to use for the QSL card. Either select the log entry from the 
MixW log window or use the Search feature to find it and then open it in the Edit QSO window.

Step 2. Make sure all the desired log entry fields for the QSL are entered into the log. Leave the log entry 
open while completing the remaining steps.

Step 3. Find the "MixW QSL card test.doc" file in the MixW folder and open it in the MS Word program.

Step 4. Use the MS Word print function and your color printer to create a hard copy of the QSL card.

For OpenOffice Writer I would suggest updating to Open Office V3.3 or later. I have experienced 
problems trying to use DDE with Open Office V3.1

For OpenOffice 3.3 start MixW and select the QSO you want to create the QSL for. Next open MixW 
QSL card test.doc with OpenOffice.org writer.

Highlight and delete the large call field then press Ctrl-F2 or select menu item Insert|Fields|Other:



Select tab Variables, then under Type select DDE field and under Format select DDE automatic.

Fill in the Name with YourCall and the DDE Statement MixW Info MyCall. Now click on the small 
green tick to the right of the DDE Statement box, which will put the entry into Selection, then click on 
Insert. This will now insert your call in the card. Repeat this for each of the other fields in the card. You 
do not need to close the fields selection box between fields.

Save this document in .odt format. 

The following will describe how to create a graphical file of the QSL to attach to an email:

Step 1. Create the QSL card as above.

Step 2. Select (highlight) the entire QSL card by Edit | Select All, from the tool bar.

Step 3. Copy the QSL card by Edit | Copy, from the tool bar.

Step 4. Open your favorite graphics editor (like Paint Shop Pro) and then Paste the QSL card into the 
editor by Edit | Paste as New Image. (Note, Paint shop Pro is still available from the Internet.)

Step 5. Save the QSL card as a .gif file by File | Save as | CompuServe GIF file. Save it to a directory 
where you can retrieve it later as an attachment file to your out-going email.

Save Files
_________________________________________________________ 

The first time MixW is activated after installation various parameters are set up via the menu system. 
MixW saves these parameters and accesses them each time it runs. Whilst running MixW other changes 
may occur the operator is not aware of. These changes maybe saved by MixW. 

For security these files should be saved to enable an inoperable MixW setup to be restored quickly. 

Files to save

Backup.pwd - (created if the MixW log archive has been used).
Bands.ini - (helps control the Rig frequency/Mode)
Cty.dat - (Contest prefix file)
Custom1.dat - (Modified to give alternate
Custom2.dat     Log file layouts)
*eqsl.ini - (if MixW used to send qso information to eQSL.cc)
*Events.dat - (Saves schedule event settings)
Icons.cfg - (Selects icons display keywords)
Icons1.cfg - (as for icons.cfg)
Icons2.cfg - (as for icons.cfg)
Icons3.cfg - (as for icons.cfg)
Knownfqs.dat - (Marks known frequencies on the waterfall/spectrum display)
lang.ini - (used with LANG_ macros)
*Mixcontests.ini - (Contest list)
*Mixmacros.ini - (Default macros)
*MixW2.ini - (MixW initialisation parameters)
*MixW2.log - (Default file name/format that stores QSO information)
MixWReg1.dll - Registration file for MixWV2.19 and earlier
*qslprint.ini - (qslprint.exe initialisation file)
*pfx.dat - (Information about prefixes)



Winkey.ini - (WinKeyer initialisation file)

*All .mc files - (Other macro files)
.pal files - (Waterfall palette files)

Any other files changed by yourself

Note: Files marked * can be changed by MixW software.

Archiving

Archiving maybe achieved by a number of methods:

Windows archiving using the a (archiving) file flag
3rd party software package run at a preset time.
3rd party software run after MixW is terminated.
Facilities within MixW.
Under control of a Windows script. User selects runtime.
Same Windows script run at MixW exit time.

Windows archiving and use of 3rd party software is outside the scope of this file.

MixW backup options

The MixW menus and log facility only provide a back up service for the log file.

By using the eQSL.cc logging (see eQSL) eQSL can provide a back up of QSO data. eQSL provides a 
download of the outbox. How long this will take to restore data is not known and the data saved (and thus 
available for restore) is fairly limited. Callsign, date, time, band, mode and rst sent are available.

MixW has 3 save formats available from the log display:

to Text
to CSV
to ADIF

To use any of these 3 methods the log file must be displayed (see Exporting your log file) 

From MixW Version 2.2 a back up and restore log feature is provided by MixW, the users log file is 
saved in ADIF file format on a server in the Ukraine. This log file can be password protected. The user 
enters the password in the file backup.pwd.

Windows Batch File Script

Microsoft supplies a simple script language as part of the MSDos installation, present in all Windows 
installations.

Note: this is not intended as a tutorial. For more information open a CMD (MSDos) window and type 
help for a list of available commands. Type help commandname for help with that command.

Commands can be input into text files with the suffix .bat:

filename - logcopy.bat
contents - copy mixw2.log thebackuplocation

or executed in an MSDos window.



When the command copy mixw2.log thebackuplocation, or logcopy.bat is executed this command will 
attempt to copy the default MixW log file to the directory thebackuplocation. 

If the copy fails a message will be output. This message can be read if the copy command was executed 
from a CMD window or the .bat file it is in was executed from a CMD window. However if the copy 
command fails whilst it is being executed as a part of a back up macro within MixW there is every chance 
the window that displays the error will be closed before the message can be read.

A .bat file can be created that can be executed from within MixW at exit time or by double clicking on the 
.bat file name using Windows/File Explorer at any other time.

In the following script any line that starts with REM is a REMark, either an explanation or comment and 
will be ignored during execution of the working script.

This script assumes MixW has been installed using the default settings

History: this script has been modified from the original script included in the August 2013 Help Files 
following the diagnosis of two problems.

A further change has been introduced to select, via a message box, if the back up is to be taken or not. 
When MixW is being stopped and started at short intervals for an investigation, or checking changes to 
files there is no point in taking the back up every time.

Following the February 2016 release a request was made to clarify the backup directory selection 
procedure.

In March 2017 a request was made for clarification of how to specify folders in the any other files to save 
section

Script Configuration

There are 8 local selections that may be made to tailor the script to the users requirements: 

1. Introduce an execution skip option  
This option is commented out using the REM command.

2. count of saved backups  
The script count is set for 28. A value I have found suitable for me.

3. select date separator method  
The script is set to use no separator characters.

4. backup directory  
The script is set for a backup directory named backup.

5. any other files to save  
e.g. any files changed/added in the printqueue or AutoSavedPictures.
Two examples are included in the script.
They must be modified or commented out using the REM command.

6. backup script name and location  
The script is set for a backup script name of backup.bat in the MixW data directory.

7. log file name and location  
The script is set for the default log file name.



8. Select whether to pause the script at exit time or not  
This option is commented out using the REM command.

None of these changes are mandatory. 

The basic script:

@echo off

REM To introduce an option to make the back up or not remove the REM from the next three lines.
REM echo wscript.quit msgbox("Execute Back Up?",36,"BackUp") >dobackup.vbs
REM WSCRIPT //NOLOGO dobackup.vbs
REM if %ERRORLEVEL% NEQ 6 goto CJBEX

setlocal

set MSGABORT=Use Ctrl-C to abort the copy. Any other key ignores this file and continues.

REM Set up the housekeeping counters and make sure the files list file is deleted.
REM The value in RCNT is the count of the number of backup directories to keep.
REM I use 28 which, with me sometimes starting and stopping MixW more than once
REM in a day gives me 18 or 19 days backup.
set RCNT=28

set bcnt=0
set BDNM=bupdirs.txt
if exist %BDNM% del %BDNM%
REM Form date

REM I normally use a date of YYYYMMDDHHMI as Windows
REM sorts them by earliest date first

for /f "Tokens=1-3 delims=/ " %%A in ('date /t') do set SFX1=%%C%%B%%A
for /f "Tokens=1-2 delims=: " %%D in ('time /t') do set SFX=%SFX1%%%D%%E

REM If separator characters are prefered (eg YYYY-MM-DD_HH-MI) set the two lines above to be:

REM for /f "Tokens=1-3 delims=/ " %%A in ('date /t') do set SFX1=%%C-%%B-%%A
REM for /f "Tokens=1-2 delims=: " %%D in ('time /t') do set SFX=%SFX1%_%%D-%%E

REM Make the backup directory. The backup directory can be
REM a full path name to any directory name addressable by windows
REM or a directory in the current MixW data directory.

REM Change the instances of backup in the next line to your back up path\directory.

SET MYBACKUP=backup

REM The above line will make the backup into the MixW data directory.

REM To make the backup in a new path (e.g. D:\ham files\mixw\saved)
REM change the line to:

REM SET MYBACKUP=D:\ham files\mixw\saved



if not exist "%MYBACKUP%" MD "%MYBACKUP%"

REM Now count the number of backups made
for /f %%A in ('dir /b "%MYBACKUP%"') do call :XCNT %%A

REM If necessary reduce the number of backups
for /f %%B in (%BDNM%) do call :RDIR %%B

MD "%MYBACKUP%\%SFX%"

set BUPD=%MYBACKUP%\%SFX%\

REM First do the .mc files

REM -----------------------------------------------------------------------------
if exist *.mc for /f "delims=`" %%Q in ('dir /b *.mc') do CALL :FILECOPY "%%Q"

REM Now the .dat files

REM -------------------------------------------------------------------------------
if exist *.dat for /f "delims=`" %%S in ('dir /b *.dat') do CALL :FILECOPY "%%S"

REM The .pal files (palette files)

REM -------------------------------------------------------------------------------
if exist *.pal for /f "delims=`" %%W in ('dir /b *.pal') do CALL :FILECOPY "%%W"

REM The .ini files

REM -------------------------------------------------------------------------------
if exist *.ini for /f "delims=`" %%X in ('dir /b *.ini') do CALL :FILECOPY "%%X"

REM Finally any other files you think need backing up

REM Example

Set SAVELOC=autosavedpictures
SET BBUPD=%BUPD%
if not exist %BUPD%%SAVELOC% md %BUPD%%SAVELOC%
SET BUPD=%BBUPD%%SAVELOC%\
pushd %SAVELOC%
popd
SET BUPD=%BBUPD%

REM End of Example

REM You can now repeat the above example for other mixw folders.

REM To save a completely unrelated file or folder (say a copy of eqsl cards you have received and copied 
from eqsl, in a folder f:\eqsls_rxd)

Set SAVELOC=f:\eqsls_rxd
SET BBUPD=%BUPD%
if not exist %BUPD%%SAVELOC% md %BUPD%%SAVELOC%
SET BUPD=%BBUPD%%SAVELOC%\



pushd %SAVELOC%
If exist *.jpg for /f "delims=`" %%Q in ('dir /b *.jpg') do CALL :FILECOPY "%%Q"
popd
SET BUPD=%BBUPD%

REM Save the backup script in case changes have been made

REM call :FILECOPY Your script filename.bat

call :FILECOPY Backup.bat

REM Do the log file last

call :FILECOPY Mixw2.log

REM Everything completed. Exit the script

goto CJBEY

REM Part of the housekeeping.
REM This routine counts the number of back up copies made
REM and saves the back up names
:XCNT
echo %1>>%BDNM%
set /A bcnt=%bcnt%+1
goto CJBEX

REM This routine deletes the backup directories earliest first.
:RDIR
if %RCNT% LSS %bcnt% rd /s /q "%MYBACKUP%\%1"&set /A bcnt=%bcnt%-1
goto CJBEX

REM End of the housekeeping routines

REM This is the copy routine
REM FILECOPY copies a file from parameter 1 to backup
REM Any fails get reported. One retry copy of the failed file
REM maybe attempted.

:FILECOPY

REM Check file is present
REM No need to go any further if the file cannot be accessed

if exist %1 goto FILEOK
echo Unable to find file %~1
echo %MSGABORT%
PAUSE
goto CJBEX

REM Execute the copy

:FILEOK
copy %1 "%BUPD%">NUL
if %ERRORLEVEL% EQU 0 echo File %~1 copied OK&goto CJBEX
echo File copy of %~1 failed.



echo Press any key to retry the copy. Use Ctrl-c to abort the copy script.
pause
copy %1 "%BUPD%">NUL
if %ERRORLEVEL% EQU 0 echo File %~1 copied at 2nd attempt&goto CJBEX
echo 2nd attempt. File copy of %~1 failed.
echo %MSGABORT%
pause
goto CJBEX

REM Script exit point

:CJBEY

REM Delete the backup file list
if exist %BDNM% del %BDNM%

endlocal

REM If you want to see the result of the copies delete REM from the following two lines

REM echo End of Backup
REM pause

REM FILECOPY routine exit point

:CJBEX

Any copy fails will be reported to the screen and the copy paused. A retry of the copy is offered and if the 
copy fails a sceond time an abort script option is offered. If no fails are detected the window will close 
automatically.

Each backup is kept in its own directory so housekeeping will be necessary to prevent a large build up of 
backup directories.

An added bonus is all the 'tuning' files for the MixW installation are extracted so a new MixW installation 
can have as many of the last archive files as is necessary copied to it.

Assuming this script is written to a file backup.bat located in the MixW data directory to execute this 
back up at MixW exit time:

Create a macro (or add the EXEC command as the last entry) OnEndMixw <EXEC:backup.bat> 
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With thanks to Steven R. Hurst, KA7NOC

CW and Morse Code.
CW stands for "continuous wave", but when hams use the term today they are referring to the use of the 
International Morse Code to communicate with a series of on and off pulses of a single RF frequency.

Morse code is named after Samuel F.B. Morse, 1791-1872. The code consists of a series of dots and 
dashes. Each letter of the alphabet and numbers 0 through 9 have individual combinations assigned to 
them. For example, the letter "E", is a single "dit" making it the easiest letter to learn and send. Some 
people can copy code at speeds of up to 70 words per minute, but most hams copy in the 10 to 30 words 
per minute range. Once you get over the learning curve, Morse code becomes a second language, and you 
begin to hear "words", not just individual letters. You begin to recognize the rhythm of the words so you 
can easily pick them out and follow along with the conversation.

Beginning hams usually send CW with a "straight" or hand key and copy each letter and word of a QSO 
as they hear it on their receiver. If they enjoy CW they may graduate to sending with a semi-automatic 
"bug", or use paddles and an electronic keyer for fully automatic dots and dashes.



CW as a computerized digital mode.
With a program such as MixW, CW can be sent and received using the keyboard and the computer 
screen, just as is done with the more recent digital modes. MixW will copy computer-generated code 
nearly without error. It will also copy code sent well with an Iambic paddle and electronic keyer, so long 
as the timing is good. It can even accommodate small variations if the user is adept at picking out the 
good copy from the bad on the screen. Most code sent by hand, however, is simply not printable by 
computer. The timing is just not consistent enough for the computer to understand. In these situations 
being able to copy the code by ear will help supplement the code that the computer copies for you.

Sending CW from the keyboard is particually valuable for individuals who have a physical impairment 
and can no longer use a key or paddles, but still love to operate CW and can copy the code at high speeds 
in their heads.

CW Operation
_________________________________________________________

Configuration
There are six different methods for operating CW with MixW.

1. Sending and receiving with the soundcard (while the transceiver is in SSB mode) 
2. Manual sending and receiving (while the transceiver is in CW mode). 
3. Keying your transceiver with a key plugged into the computer, which is similar to the way MixW 

handles the PTT signal for the other modes (your transceiver is in CW mode) 
4. Using a CAT command to your transceiver (your transceiver is in CW mode). 
5. Using a dedicated hardware multimode TNC for both decoding and encoding of CW via the TNC 

(your transceiver is in CW mode). 
6. Using a WinKeyer (your transceiver is in CW mode . 

SoundCard approach: The soundcard approach to CW operation is the simplest to implement. In this 
approach, your transceiver is in SSB mode (either USB or LSB will work). Configuring MixW to use the 
SoundCard approach is the same as with the other digital modes. First select Configure | TRCVR 
CAT/PTT... and check "CW out via soundcard". Next, select Mode | CW, and then select Mode | Mode 
Settings... and choose an RX Algorithm. Then you can select your RX and TX frequency by clicking in 
the waterfall, and transmit by typing into the TX pane and clicking the RX button in the Status Bar. Your 
rig is switched to TX with VOX, PTT, or CAT, just as it is for any other mode.

Manual Sending and Receiving: In the manual mode you only use MixW as a tuning and logging 
program. Select Configure | TRCVR CAT/PTT... and UNCHECK "CW out via soundcard". Then choose 
Mode | Mode Settings, and select Manual from the RX Algorithm selections. Plug your key into your 
transceiver, and set the transceiver to CW mode. Now the frequency of the CW tranmission is set by the 
transceiver, so MixW will lock the TX on the waterfall and display the red flag there. You can set the RX 
frequency wherever you want since you will be decoding by ear. With the RX Algorithm set to manual 
you can type into the RX pane and use MixW's logging features. You must tune with the transceiver, but 
watching the waterfall will help you set your TX frequency right on top of the station you are answering.

Direct CW keying: In this method MixW directly keys your transceiver via a connection between your 
computer's COM port and your transceiver's key input (a PTT type circuit is used for this connection). 
This works in the same way as connecting any external keyer to your transceiver, the only difference is 
that MixW (and your computer) are acting as the external keyer. In this case your transceiver is operated 
in the CW mode, and you truly are sending CW. You then have full advantages of your transceiver's CW 
filters etc.

CAT operation: If you are already triggering PTT via the CAT control options of MixW, this may be 



your best option for keying CW as well. To implement direct CAT operation for CW select Configure | 
TRCVR CAT/PTT. Check the box to use the "CW via CAT command" option, and make sure your Com 
port and rig settings are correct. You can also adjust for correction in your frequency reading for the CW 
mode by using the "Cat correction in Hz" box for CW. For more information on these settings see 
the Configuration topic. Now when you set MixW for the CW mode, it will automatically switch your rig 
to the CW mode and trigger CW keying through CAT as well as adjust your frequency standard 
according to these settings.

CW via a Hardware TNC:
See TNC Configuration and operation topic to use MixW with a hardware TNC for CW operations.>

CW using a WinKeyer:
See Configure the WinKey Port topic to use MixW with a a WinKeyer Device.>

Operating CW (using the soundcard)

First, switch to the CW mode by selecting Mode|CW, or clicking on the mode box in the Status Bar and 
selecting CW. Next set your CW settings by selecting Mode|Mode settings. This will bring up the 
following CW settings dialog box:

Here the TX and RX frequencies are displayed and can be changed, although it is much easier to change 
them by clicking in the spectrum/waterfall window.

You can also tell MixW to convert your 0, 1, and 9s to letters as indicated by checking these boxes.

CW Speed: You can set the sending speed in the CW settings dialog box, although this is more easily 
adjusted by clicking in the speed display which automatically loads with the CW mode.

Note: The speed adjustment is for sending speed only. MixW automatically detects the RX speed and 
adjusts accordingly, but it will send at whatever speed is indicated on the CW speed box.

Speed change may also be achieved by the use of the Macro <WPM>

Temporary Sending Speed Adjustment



If using MixW to directly send data to the transceiver (i.e. not through a keyer) any of the following two 
character sequence inserted in the TX data stream will cause the sending speed to change as indicated 
until either another sequence is received or the transmit is ended. 

    ~^ - Adjust by +5wpm
    ~v - Adjust by -5wpm
    ~0 - Set speed to 16wpm
    ~1 - Set speed to 20wpm
    ~2 - Set speed to 24wpm
    ~3 - Set speed to 27wpm
    ~4 - Set speed to 30wpm
    ~5 - Set speed to 34wpm
    ~6 - Set speed to 37wpm
    ~7 - Set speed to 40wpm
    ~8 - Set speed to 50wpm
    ~9 - Set speed to 60wpm

The data to transmit is: 

<TX> <CALL> ~^~^<RSTS>~v~v <NRS> <NRS><RXC>

will send the CALL at the indicated wpm, increase speed by 10wpm, send the RST decrease the speed by 
10wpm (back to the original speed) and send a contest exchange. 

Receive: To receive CW tune to one of the CW sub-bands and listen for CW signals while watching the 
spectrum/waterfall display. Click on one of the signals as indicated here in the waterfall display, and you 
should start seeing text appear in the RX window:

You will notice in this picture that while the letters are being decoded accurately, the timing of the 
characters being sent is such there are spaces between each one. It is important to note that accurate CW 
decoding, whether by hardware or software TNCs, is difficult to achieve due to the lack of timing 
standards with CW operations. Computer generated CW is the easiest to decode accurately in software, 
but even this is a challenge (as you can see above) because timing parameters vary between the different 
software packages and user settings. You will notice quite a few missed characters while trying to decode 
some hand sent CW, especially from a straight key.

Transmit: To switch between Transmit and Receive click on the TX/RX box in the status bar. For 
additional information on general operating procedures see the General Operation topic.

As with most of the other digital modes, It is possible to open multiple RX windows and switch the active 
window (the one you will be sending to) between them. For this and other general operation techniques 
see the General Operation topic.



Other hardware options.
MixW is capable of using a Joy Stick port or a Parallel port for CW key or keyer input. The following 
diagram shows how to wire these ports:

FAX
_________________________________________________________ 

FAX Receiving

FAX Receiving
_________________________________________________________ 

For information on HF FAX stations and some theory of operation visit:

http://www.hffax.de/html/hauptteil_hffax_listings.htm

MixW supports FAX receive only. The following procedures will help you get started receiving FAXes.

http://www.hffax.de/html/hauptteil_hffax_listings.htm


Your transceiver should be set to USB and tuned to one of the frequencies of the FAX stations listed at 
the website shown above.

Calibrate your sound card.

Toggle all the toolbars off by selecting View and then uncheck the various toolbars to get a larger 
viewing window for your incoming FAXes.

Select Mode | FAX,, then select Mode | Mode settings to bring up the settings dialog box:

Most Weather fax is 120 LPM in FM mode.

To print a received FAX use a screen capture program or press the Print Screen button on the computer 
keyboard to save the screen to the Windows clipboard. Then you can paste the picture into Microsoft 
Paint or a graphics program.

The following picture shows the display of a properly tuned WX FAX station:

Notice that the picture being received is not alligned properly--it is split in the center. To correct a 
misaligned picture click on the vertical line in the picture that you want to be the new left hand edge (note 
the position of the mouse pointer in the illustration above). MixW will then realign the picture as shown 



here:

RTTY
_________________________________________________________

RTTY Introduction and Theory

RTTY Operation

RTTY Intro & Theory
_________________________________________________________

From the website of Richard B. Griffin, NB6Z

RTTY or RadioTeletype is a direct machine-to-machine communications mode using the Baudot (or 
Murray) code. This mode became popular with many amateurs when surplus TTY machines became 
available at a reasonable cost after World War II. These mechanical monsters provided a keyboard for 
Input and a paper roll for printed Output. They were also useful to help hold the house down in times of 
hurricane winds - they must weigh a ton. Video displays were still too exotic and expensive in those days. 
It was not until the mid 1970s that we began to see the Video Display come into more widespread use. 
(By the way, have you ever wondered why early Program Languages like BASIC use the command 
PRINT to display their output?)



When transmitting Morse Code, the transmitter is switched on and off to make the dits and dahs. When 
sending Teletype however the transmitter runs continuously, sending either of two frequencies 
conventionally known as Mark and Space (a reference to paper tape reception of telegraphy). The early 
pioneers found on-off keying was not all that successful for Teletype signals because of interference from 
static.
 
They experimented with FSK, or Frequency Shift Keying and found it performed much better. With FSK, 
the transmitter is shifted up in frequency every time a Mark is to be sent, reverting to the lower frequency 
for a Space. The amount of the shift is usually 170 Hz for Amateur Radio use although many commercial 
Teletype signals use other shifts, notably 425 Hz and 850 Hz. Many systems use AFSK or Audio 
Frequency Shift Keying. When this is sent, the transmitting station generates the Mark and Space audio 
tones and feeds them into the transmitter's microphone input. The result at the receiving end is that the 
same audio tones are heard and processed, whether the transmitting station used FSK or AFSK.

When listening to a teletype signal off air, you will soon get to recognize the familiar warble of Mark and 
Space tones. In the amateur shack the TTY machine is usually connected to an HF receiver or transceiver 
which the operator tunes so that the received audio is just the right pitch or audio frequency to trigger the 
demodulator's Mark and Space resonators.

If the receiver is slightly off the correct frequency the tones vary and the text becomes garbled or even 
lost altogether. To help the other station tune the receiver correctly, a RTTY operator can send a string of 
alternate R and Y characters RYRYRYRYRY. This pattern is chosen as it produces the most frequent and 
almost symmetrical alternation of Mark and Space tones, giving the receiving operator the best chance to 
tune the receiver before the "real" message starts. However, even if the signal is accurately tuned, the 
information can become garbled or completely lost due to interference, fading, or noise. Often, it is 
possible to make sense of the message even with parts missing, but RTTY is by NO means an error free 
mode!

I should point out that similar problems exist for other modes including Packet. While information can 
still fail to get through on the more sophisticated modes the Error Detecting capability of some, especially 
Packet and PACTOR, ensure that the operator will receive either accurate information or nothing at all. 
Usually, where "nothing at all" is received, the information will automatically be retransmitted when the 
radio is retuned, or the interference stops, (etc) and nothing is lost.

The Baudot code is a 5 bit code and those of you who are familiar with Binary Notation will know that 
the maximum number of values we can have with 5 bits is 32. That means that each unit of transmission, 
one keystroke if you like, can contain any one of 32 possible values. If you look up a table of Baudot 
codes you will see there are 32 values listed, one code for each letter of the alphabet plus a few other 
codes for other things such as a space and a Carriage Return. But, what if we want to send a number such 
as "9" or a question mark? These are not mentioned in that table because all 32 codes are already used.

The solution is rather similar to the Typewriter or Computer Keyboard where we have the Shift key to get 
various additional codes from the keyboard. Most keys will produce a different result if we hold down the 
Shift key as we type. Well, one of those original 32 codes is a special code known as FIGS (for Figures 
Shift). The convention is that when we want to send a number or some other special character such as a 
punctuation mark, we can do that by first transmitting a FIGS code.

Then instead of using that original table of 32 codes, we have a second table of codes to use, and that 
second table includes all ten numeric digits and various punctuation marks. Provided both sides of the 
conversation observe the convention, the sender can send a FIGS and start using the second table; the 
receiver will see the FIGS code and it too will interpret all data that follows from the second table.

With just 5 bits of data we then have almost 64 different codes we can send and receive. (I say almost 
because there is some duplication in the two tables, including a space and a Carriage Return but that is not 
important here). Even that many codes is not enough to handle all 26 letters of the alphabet in both 
UPPER and lower case, so RTTY systems always operate in upper case only.



If we wanted to type a big number (say "13579") we don't have to send FIGS before every digit. We send 
that code only once and the receiver then will take EVERYTHING we type from now as if it belongs in 
the second table. When we want to revert to the normal alphabetic table of codes we can send another 
special code, this one called LTRS (for Letters Shift). Then everything goes back to normal, using the 
original alphabetic table of codes.

Normally we don't have to concern ourselves with these FIGS and LTRS codes. Our computing 
equipment will take care of those things for us. We just type away and rely on the system to generate and 
send those codes when necessary.

As I mentioned earlier, it is quite possible to lose bits here and there when receiving a RTTY signal, 
whether it be because of fading, interference, frequency drift, or whatever. One of the big problems with 
lost data is the possible loss of a FIGS or LTRS code! Say we had sent "13579" and then typed "HAPPY 
BIRTHDAY". Our equipment would have sent a LTRS code before the first "H" but what if the receiver 
did not copy the LTRS code we sent? Can you imagine what happens? As far as the receiver is concerned 
we are still sending numbers or other codes from the numeric table! So our "HAPPY BIRTHDAY" is 
going to come out looking something like "#-006 ?845#$-6". And EVERYTHING we type from then on 
is going to look just as strange until we happen to send another LTRS code later. It is for this reason that 
many systems include an option to "Un-shift on space". If you have a multi mode TNC capable of 
handling RTTY, you will probably have this option in your TNC. If that option is ON then your receiving 
system will imply a LTRS code every time it receives a space. So if you seem to be copying lots of funny 
numbers from a strong, well tuned signal, try setting that option ON.

We can overcome some of these problems by using ASCII instead of using the Baudot code. With ASCII 
we can have 128 different codes so we do not need the FIGS/LTRS codes. All Personal Computers use 
ASCII as their native "language" so it would be a reasonable thing to use. Although not part of the 
defined ASCII standard, it has become an almost de-facto standard in the computer world that an 
additional 128 characters are available, often called Extended ASCII. But, despite these benefits, Baudot 
continues to rule the airwaves for Amateur and Commercial Teletype transmissions.

Today, RTTY is still a popular mode especially on the HF bands, and the advent of the "Glass Terminal", 
first the Dumb Terminal and now the Personal Computer, has brought this mode to even more operators 
the world over. Many specialized RTTY systems were developed for the Amateur enthusiasts but have 
been superseded now by the Personal Computer with one of the Multi Mode TNCs, which handle RTTY, 
and many other modes besides.

The latest Computerized RTTY equipment generally allows us to use the mode better, quieter, more 
efficiently, using less power and occupying less space than the old TTY machines, but the limitations of 
the mode remain.

RTTY Operation
_________________________________________________________

Transceiver Settings

Fine Tuning: If your transceiver is equipped with a "FINE" tuning feature, always use that for RTTY 
tuning once you have found RTTY activity. Most of your adjustments can be made in software, and not 
with the transceiver's VFO if you prefer. In the PSK31 modes almost all tuning is done in software. For 
RTTY, I prefer to tune with the VFO. Some older rigs are really not stable enough for PSK31 operation 
and will drift considerably off frequency, but because of the wider bandwidth, they are fine for RTTY.

USB: Historically ham radio RTTY operators use LSB transmissions and a 170Hz shift between the 
MARK and SPACE signals, with the MARK signal being the higher in frequency. With MixW the 



convention is to use USB for all modes, since the program will adjust the inversion automatically.
Note: MixW automatically adjusts the Mark and Space tones depending on which sideband you are 
operating on. If you are not using CAT, MixW needs to know which sideband your operating on to set the 
Mark and Space correctly. (See inversion in the Configuration topic).

Filtering: Optimum filtering depends on your transceiver's SSB filtering options and IF rejection 
characteristics. Wide filtering will enable you to work the largest spectrum without retuning your 
transceiver, but can also cause problems when there are strong adjacent signals. A narrow (RTTY or 
FSK) filter may help significantly with some radios and situations. Many transceivers, however, do not 
have narrow filtering options while operating in SSB modes. Consult your manual and experiment for the 
optimum configuration for your setup and conditions. The following waterfall display shows MixW's 
panoramic display when using a wide filer setting on the transceiver:

Here there are 3 different RTTY QSOs we could copy with the simple click of the mouse in roughly 3 
KHz of spectrum. The strong one in the middle is currently selected and will provide the best print. The 
others may be too weak to copy 100 percent.

Power: RTTY uses a wide bandwidth and so it will require relatively high power compared to modes 
such as CW and PSK31. Never use more power than you need for any given situation, however.

MixW Settings

Mode: Click on the mode box in the status bar and select RTTY. Next bring up the "Mode Settings" by 
clicking on the mode box in the status bar and selecting "Mode Settings". This brings up the following 
dialog box:

The TX and RX frequencies are set to the location of your cursor in the spectrum window. Keeping this 
around 1000 - 1500 Hz, will keep your transceiver operating close to the center of its pass band.

Shift is selectable (if you don't see what you want in the drop down box, any number can be typed in). 
Most RTTY uses a shift of 170 Hz, however setting this to 182 Hz often improves the copy for some 
signals.

Baud rate is also configurable. Most of the time this will be 45.45 Baud, but the other options are nice to 
have as well. You will sometimes find stations operating different shifts and baud rates.



The Character set can also be configured for the language you will be using.

The Mark and Space tones can be inverted by checking the "Inverted" box.

Up to four different sets of parameters can be configured for RTTY operation by selecting the different 
"Set" radio buttons (set 1 - 4). It is then possible to designate different operating parameters for each set, 
such as shift, baud rate, character set etc., which will then be remember for that set. These can then be 
easily recalled by selecting the different radio buttons.

AFC can be on to assist in tuning and tracking the RTTY signals. RTTY tuning is not as critical as the 
narrower modes, so AFC is more of an option than a necessity.

Lock should be off so you will be transmitting on the same frequency you're receiving. The exception 
here would be if you're working a station that is drifting and want that station to find your more stable 
frequency each time. Lock can also be used for working split.

Inverted when clicked will invert the positions of the MARK and SPACE frequencies. If you appear to 
be tuned into a strong signal and are only copying garbage, try clicking Mode | Inverted, or clicking the 
box in the RTTY settings. You will often find the station start to print 100 percent as a result.
Note: This feature works differently in MixW than most other SoundCard digital programs, so please 
read and understand the information about inversion in the Configuration Section.

Squelch and Threshold can be used and adjusted to suite your operating preferences.

Receiving RTTY
RTTY signals display as two parallel lines usually 170HZ apart. Tune in a RTTY signal by pointing right 
in the center of the two tracks with the mouse and clicking the left mouse button. The text being sent by 
the station will then appear in the Receive Window. The RTTY tuning indicator is two diamonds, linked 
together with a bar and separated by the shift width you have selected in options dialog. The diamonds 
will move together to track and tune RTTY QSOs.

When working RTTY, especially during contest operation, I prefer to leave the tuning indicators in a 
position at roughly 1500 Hz (or centered in my Spectrum window) and then use the transceiver VFO set 
on "Fine" to tune in the RTTY signals. I find that I can tune more quickly this way, and also keep the 
QSO centered more effectively in my transceiver's pass band. RTTY is much easier to tune than most of 
the other digital modes.

Transmitting RTTY
To transmit to a station, first tune it in as indicated above. Type your outgoing text in the Transmit 
Window. Press the TX/RX button and the text will be transmitted. You can continue to type, and that text 
will also be transmitted. As it is being transmitted, text in the transmit Window will also appear in the 
Receive Window. To stop transmitting, press the TX/RX button again. Pressing ESC will abort 
transmission and return MixW to receive mode, but the last several characters typed will not be 
transmitted.

Note: RTTY utilizes a limited character set, using UPPER CASE LETTERS ONLY. MixW will 
automatically convert lower case letters to upper case. You will also notice that not all punctuation marks 
are supported, although most of them are. The following characters are supported: - ( ) $ ! " / : ? .

When transmitting, the waterfall will freeze and remain frozen until returning to Receive.

Amtor
_________________________________________________________ 



Amtor Introduction and Theory

Amtor Operation 

AMTOR Theory
_________________________________________________________ 

With thanks to Tony Lonsdale, VK2DHU
and Norm Sternberg, W2JUP

AMTOR is a specialized form of RTTY. The term is an acronym for AMateur Teleprinting Over Radio 
and is derived from the commercial SITOR system (Simplex Telex Over radio) developed primarily for 
Maritime use in the 1970s.

In the late 1970's, Peter Martinez, G3PLX, made several changes to the SITOR protocol, which rendered 
it suitable for amateur radio use, and called it AMTOR.
 
AMTOR improves on RTTY by incorporating a simple Error Detection technique. The system remains 
relatively uncomplicated but AMTOR performs well even in poor HF conditions. While there can still be 
some errors in AMTOR data, the Error Detection gives excellent results for normal text mode 
conversations because of the high redundancy in plain language text.

There are two modes used in Amtor: ARQ and FEC. MixW supports the FEC mode only.

ARQ: The ARC mode is a Synchronous protocol, which means both stations are synchronized to each 
other's signals.

In ARQ mode (Automatic Repeat Query), sometimes called Mode A, data is sent in groups of 3 
characters. Although each character is only 5 bits (same as for RTTY), two additional control bits are 
added, so each character has a total of 7 bits. There are always 4 marks and three spaces in every 
transmitted character. If the receiving station gets some other combination it knows an error has occurred. 
The 40 percent overhead is considered worthwhile for error detection. This technique can identify most 
errors. The standard calls for no more than three errors in 100,000 characters.

The receiver responds to each 3-character group by sending either an ACK (ACKnowledge) code (if OK) 
or a NAK (Negative AcKnowledge). Each time the transmitting station gets a NAK, that 3-character 
group is sent again. If you listen around on the HF bands in the recognized Data Segments of the bands, 
you might hear a chirp-chirp sound that identifies an ARQ transmission. Even when there is no data 
actually being transmitted, the transmitting station continues to send idle "chirps" to maintain the link.

AMTOR supports a Listen Mode also and that allows you to monitor another ARQ session even though 
you are not participating in the session with the usual acknowledgements. Of course you are not able to 
participate in the error correction or synchronization.

One notable advantage of AMTOR is that when a link is failing AMTOR will try to reestablish 
synchronization between the sending and receiving stations rather than simply terminate the link.

FEC: In FEC mode (Forward Error Correcting), sometimes called Mode B, the sending station sends 
each character twice so this mode provides a means of transmitting to several stations at once. The 
receiving station does not acknowledge the data received. If a receiving station matches both instances of 
a character, that character will be printed, otherwise some error symbol is printed. This mode does not 
provide for the receiving station to ask for the missing data to be retransmitted. An FEC transmission 
sounds more like a Baudot RTTY signal.



 
The two stations need to keep in phase with each other so each FEC transmission is started with several 
sets of "phasing pairs" and these are sent at regular intervals even while there is no data being transmitted.

FEC Mode is still better than ordinary RTTY but its error detection is not as reliable as that in the ARQ 
Mode.

AMTOR Operation
_________________________________________________________

MixW supports FEC mode only for AMTOR, therefore AMTOR settings and operation are much like 
those for RTTY.

Transceiver Settings

Fine Tuning: If your transceiver is equipped with a "FINE" tuning feature, always use that for AMTOR 
tuning once you have found AMTOR activity. Most of your adjustments can be made in software, rather 
than the transceiver's VFO if you prefer. Some older rigs are not stable enough for the narrow modes, but 
because of the wider bandwidth, they can be used for AMTOR.

USB: In the past AMTOR operators used LSB transmissions and a 170Hz shift between the MARK and 
SPACE signals, with the MARK signal being the higher in frequency. With MixW the convention is to 
use USB for all modes, since MixW will automatically invert your signal if you have told it you are in 
USB. See inversion in the Configuration Section for more information.

Filtering: Optimum filtering depends on your transceiver's SSB filtering options and it's IF rejection 
characteristics. Wide filtering will enable you to work the largest spectrum without retuning your 
transceiver, but can also cause problems when there are strong adjacent signals. A narrow (RTTY or 
FSK) filter may help significantly with some radios and situations. Many transceivers, however, do not 
have narrow filtering options while operating in SSB modes. Consult your manual and experiment for the 
optimum configuration for your setup and conditions.

MixW Settings Mode: Click on the mode box in the status bar and select AMTOR. Then click on the 
mode box in the status bar again and select "Mode Settings". This brings up the following dialog box:

The TX and RX frequencies show the position of your cursor is in the spectrum window. Keeping this 
around 1500 Hz, will keep your transceiver operating close to the center of its pass band. Shift is 
selectable (if you don't see what you want in the drop down box, any number can be typed in). Most 
AMTOR uses a shift of 170 Hz. You can invert the Mark and Space signals by checking the "Inverted" 
box.

AFC should be on to assist in tracking the AMTOR signals but since AMTOR tuning is not as critical as 
some other modes, AFC is more an option than a necessity.



Lock should be off so you will be transmitting on the same frequency you're receiving. The exception 
here would be if you're working a station that is drifting and want that station to find your more stable 
frequency each time, or if you are working a net.

Inverted when clicked will invert the positions of the MARK and SPACE frequencies. If you appear to 
be tuned into a strong signal and are only copying garbage, try clicking Mode | Inverted, or clicking the 
box in the AMTOR settings. You will often see the station start to print 100 percent as a result.
Note: This feature works differently in MixW than most other SoundCard digital programs, so please 
read and understand the information about inversion in the Configuration Section.

Receiving AMTOR
AMTOR signals display as two parallel lines usually 170HZ apart . Tune in a AMTOR signal by pointing 
right in the center of the two tracks with the mouse and clicking the left mouse button. The text being sent 
by the station will then appear in the Receive Window. The AMTOR tuning indicator is two diamonds, 
which are linked together with a bar and separated by the shift width you have selected in options dialog. 
The diamonds will move together to track and tune AMTOR QSOs. The following screen shot shows an 
AMTOR QSO in progress:

Transmitting AMTOR
To transmit to a station, first tune it in as indicated above. Type outgoing text in the Transmit Window. 
Press the T/R button and the text in the Transmit Window will be transmitted. You can continue to type, 
and that text will also be transmitted. As it is being transmitted, text in the transmit Window will also 
appear in the Receive Window. To stop transmitting, press the T/R button (or one of the other toggles) 
again. Pressing ESC will abort transmission and return MixW to receive mode, but the last several 
characters typed will not be transmitted.

Note: AMTOR, like RTTY, utilizes a limited character set, using UPPER CASE LETTERS ONLY. 
MixW will automatically convert lower case letters to upper case. You will also notice that not all 
punctuation marks are supported, although most of them are. The following characters are supported in 
AMTOR: - ( ) $ ! " / : ? .
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Packet Intro & Theory
___________________________________

Adapted from TAPR Publication #95-1, 1995
History of VHF/UHF Packet
Packet radio has been around since the mid-1960's, but was first seen on the amateur VHF bands in 1978 
through research done in Montreal, Canada in 1978, the first transmission occurring on May 31st. This 
was followed by the Vancouver Amateur Digital Communication Group (VADCG) development of a 
Terminal Node Controller (TNC), also known as the VADCG board, in 1980. This was then followed by 
TAPR, Tucson Amateur Packet Radio, with the creation of the TNC-1 in 1982 and then the TNC-2 in 
'84-'85. The packet radio revolution ignited when TAPR sold over a thousand TNC-2 kits. The TNC-2 
was what was needed to make this mode take off. There could be another packet radio revolution fueled 
by MixW and the other new software that utilizes the soundcard based TNC approach.

What can I do?
Like any mode in the amateur service, packet provides a group of amateurs with a way of having fun and 
meeting one of our primary aims, "improving the radio art". But what can you do?

PBBS systems: Most cities have one or more packet Bulletin Board System, or PBBS for short. Many of 
these are operating on 145.01 MHz in the US. PBBSs do two main things: send and receive personal 
messages for their local users (like yourself) and send and receive messages or bulletins intended for 
people locally or around the world. Since the PBBS is part of a national system of other PBBSs, it has the 
ability to pass information or messages to any other PBBS in the US or the world. The second thing that 
BBSs do is pass local and national bulletins, which are messages intended to be read by everyone. In this 
way, amateurs can read the latest messages about the ARRL, AMSAT, TAPR, propagation, DX, and 
other bulletins on varied topics. Message passing is the primary purpose of a PBBS system, but PBBSs 
can also support callbook programs, help references, Internet access, and more. For a list of typical PBBS 
commands see the PBBS Commands topic.
 
Keyboard-to-Keyboard: Like the other amateur modes in MixW, packet radio can be used to talk to 
other amateurs directly. With the use of networks, amateurs can talk at a distance beyond the reach of 
their own stations by using the network. Keyboard-to-keyboard communication is one of the least 
frequent uses of packet communications, because amateurs are rarely on packet at the same time. Many 
packet operators send electronic mail using either personal mailboxes or a local PBBS. In this way, 
messages are read when the amateur is on the air.

DX Packet Cluster: Many cities have DX spotting nodes or networks. HF operators connect to their 
local DX Packet Cluster in order to receive reports on the latest DX. This type of packet came about from 
those interested in 'chasing' DX. Many amateurs like to frequent the HF bands looking for rare 
international operators to contact. A DX Cluster allows many HF operators to be connected over packet 
radio at the same time while operating HF and hunting for DX. When someone finds a DX station, they 
send a packet message to the DX Cluster, which then sends the information to all other packet operators 
using the DX Cluster. In this way, you have several stations monitoring the band, looking for DX. Often 
an amateur will 'spot' (hear) a DX station and then distribute the DX report almost instantly. DX Clusters 
allow everyone to operate more hard to find DX stations in one evening than was possible operating 
alone.

http://www.tapr.org/index.html
file:///C:/mixwhelp/forpdf/HF Packet Operation.htm


RACES/ARES/NTS and Emergency Communications: Packet radio is being used in many emergency 
services. Whether packet is used to pass messages accurately and in large quantities or to handle 
messages passed by the National Traffic System, it can provide an important function. A new application 
called APRS combines GPS (Global Positioning Satellites) with packet radio to allow a master station to 
plot on their computer the location of all other stations in the field. The purpose is to coordinate the exact 
position of weather spotters or searchers, without having to waste radio time informing the control station 
of their locations. It is also possible to distribute Doppler Radar images via the packet network. The small 
weather image file takes but a few minutes to retrieve and display.

Networking: The main packet networking scheme uses Digipeaters. Digipeaters work much like a voice 
repeater. Digipeaters look at the packet, and if its call is in the digipeater field, resends the packet. 
Digipeaters allow the extension of range of a transmitter by retransmitting any packets addressed to the 
digipeater.

An average packet station talks in a radius of about 10-30 miles. Packet Networks allow amateurs to 
widen the area of communications past their line of sight, by having a series of packet stations linked by 
radio, which can be used to get their packet messages to wherever the network goes. Much like the 
telephone system, networks provide long distance service outside the local area.
 
Satellite Communications: Many of the amateur radio satellites in orbit contain computer systems that 
provide packet capability. Most packet satellites provide BBS-like functions for messages to be passed to 
anywhere in the world within 24 hours. Several contain CCD cameras, which allow amateurs to download 
images of the earth and some allow users to retrieve data from the onboard experiments. Most satellites 
use AX.25 protocol with special software developed for satellite communications.

For additional information on SoundCard Packet, visit:
TAPR, Tucson Amateur Packet Radio. 

VHF Packet Operation
_________________________________________________________

MixW has many options for Packet operation including both HF and VHF configurations. For HF packet 
information see HF Packet Operation.

TCP/IP over AX.25 packet radio protocol is also supported. See TCP/IP over AX.25.

MixW offers many user settable timing parameters, as well as the ability to send beacons, and act as a 
digipeater.

Switch to the Packet mode by selecting Mode | Packet. Next, open the settings dialog box by selecting 
Mode | Mode settings. This will bring up the following dialog box:

http://www.tapr.org/index.html


 

Enter your callsign in the general tab, and select the VHF 1200 baud Standard (or the settings you wish to 
operate) in the Modem tab. If you want MixW to also act as a digipeater, enter your digipeater call sign, 
and check the box to enable digipeating. The "use PSK" and the "OEM" checkboxes should be left 
unchecked for most operations. The Parameters, Beacon/Unproto, and Monitor tabs can be ignored for the 
present. You can customize your packet timing parameters in order to facilitate connecting to certain 
BBSs or other unique situations by clicking on the Parameters Tab. The default settings here should get 
you started. The Beacon/Unproto tab can be used to set your beacon text and parameters, and the Modem 
window can be used if you have a hardware TNC and want to use it instead of your soundcard for packet 
operation.

Next you need to find a packet station or PBBS to connect too. Unlike HF packet, VHF tuning is almost 
automatic, so long as you're using a standard VHF/UHF FM radio. Simply tune your radio to the packet 
frequency you are interested in. You will notice that you cannot tune MixW by clicking in the Spectrum 
or Waterfall displays as you do for the other modes. This is because MixW assumes you are tuned right 
on frequency (due to the nature of VHF/UHF FM operations) and will be using the standard audio tones 
for the packet mode you have selected.

After first monitoring the frequency to determine that the station or PBBS you want to connect to is on 



the frequency, you then initiate the connect command. To do this, open the connect dialog box by 
selecting Mode | Connect, which will bring up the following dialog box: (You can also bring up the 
connect dialog by simultaniously depressing the Ctrl-Alt-c key combination.)

Enter your callsign in the MyCall box and the callsign of the station or PBBS you wish to connect to in 
the Remote box. If you are planning to connect through a Digipeater path, enter that in the Digis box. 
Next, click on the connect button and MixW will initiate a connection with the remote station.

As you can see in the following screenshot, I have connected directly to the K4MSU PBBS (our radio 
club operates this PBBS on 145.01MHz in Murray, KY) and I have written a message to my friend Ron, 
W4ET, who is also a user of this PBBS. What you are seeing here is the message I sent previously sent 
back to us by my use of the R <message #> command to read back the message.

When operating packet you will notice that each station must acknowledge accurately receiving the other 
station's packets (this happens automatically through the software), which results in short bursts of 
activity while each station responds. During poor band or path conditions it may take several attempts 
before each station accurately receives the other's packets.

When you are finished with the QSO, or PBBS session, you must disconnect from the remote station by 
selecting Mode | Disconnect, which will send the disconnect string to the remote station and end your 
connection and QSO. Note: If you are connected to a PBBS, you should first log off the BBS with the 
Bye command, then if you remain connected you can initiate the disconnect command, but the BBS will 
most likely initiate the disconnect process.

For a list of typical PBBS commands see PBBS Commands 



HF Packet Operation
_________________________________________________________

MixW has many options for Packet operation including both HF and VHF configurations. For VHF 
packet information see VHF Packet Operation. MixW offers many user settable timing parameters, as 
well as the ability to send beacons, and act as a digipeater.

Switch to the Packet mode by selecting Mode | Packet, or by clicking on the Mode box in the Status bar 
and selecting Packet. Next, open the settings dialog box by selecting Mode | Mode settings. This will 
bring up the following dialog box:

 

Enter your callsign, in the General tab, and select "HF", in the Modem tab, for the mode you wish to 
operate. All HF packet operations are using 300 Baud at the present time, as conditions on HF do not 
support the higher baud rates. If you wish to act as a digipeater, enter your digipeater call sign here and 
check the box to enable digipeating (this is more common for VHF packet). The Parameters, 
Beacon/Unproto, and Monitor tabs can be ignored for the present. You can customize your packet timing 



parameters in order to facilitate connecting to certain BBSs or other unique situations by clicking on the 
Parameters tab.

Next you need to find a packet station or PBBS to connect too. The following screen shot shows a packet 
QSO as tuned in and monitored in the waterfall display:

Tune a Packet signal by pointing right in the center of the signal with the mouse and clicking the left 
mouse button. You may need to fine tune by using the CTRL-arrow keys. The text being sent by the 
station will then appear in the Receive Window. The Packet tuning indicator is two diamonds which are 
linked together with a bar. The diamonds will move together to track and tune Packet connections.

Once you have tuned in and monitored packet activity you must connect to the station or PBBS you have 
received in order to have a QSO or PBBS session. To do this, open the connect dialog box by selecting 
Mode | Connect, which will bring up the following dialog box:

Enter your callsign in the MyCall box and the callsign of the station or PBBS you wish to connect to in 
the Remote box. If you are planning to connect through a Digipeater path, enter that in the Digis box. 
Note: Digis are more common on VHF packet than HF.

Next, click on the connect button and MixW will initiate a connection with the remote station.

As you can see in the following screenshot, we have now connected directly to Ron, W4ET. (Actually, in 
this case Ron imitated the connection, and my station automatically connected to him without me having 
to do anything:



We can type back in forth this way. When doing so you will notice that each station must acknowledge 
accurately receiving the other station's packets (this happens automatically through the software) so you 
will see short bursts of activity while each station responds. During poor band or path conditions it may 
take several attempts before each station accurately receives the other's packets.

When you are finished with the QSO, or PBBS session, you must disconnect from the remote station by 
selecting Mode | Disconnect, which will send the disconnect string to the remote station and end your 
connection and QSO. Note: If you are connected to a PBBS, you should first log off the BBS with the 
Bye command, then if you remain connected you can initiate the disconnect command, but the BBS will 
most likely initiate the disconnect process.

For a typical list of PBBS commands see PBBS Commands

TCP/IP over AX.25
_________________________________________________________

MixW 2 supports TCP/IP over AX.25 (datagram mode). This means that you can use standard Windows' 
software to communicate with other TCP/IP systems (UNIX/Linux, AGW Packet Engine, Flexnet, MixW 
2) over a VHF radio channel.

Download the virtual network adapter driver for Windows 98/ME/2000/XP from Nicks website by 
clicking here:
http://mixw.net/files/MixNic6.zip

http://mixw.net/files/MixNic6.zip


Or, for early Windows 98 versions:
http://mixw.net/files/MixNic6Old.zip

Unzip the files to a separate folder and see the ReadMe.txt file for installation instructions.

These drivers have been tested with Windows 98 SE 4.10.2183A, Windows 2000 5.00.2195 SP2, 
Windows XP 5.1.2600. 

PBBS Commands
_________________________________________________________ 

MSYS PACKET BBS COMMAND SUMMARY 
Version 1.18 (The first letter alone will invoke most major commands: example, B = Bye)
Note: The MSYS commands are used on many other PBBSs as well.

A Commands
Abort..................Stop current action 

B Commands
Bye.....................Disconnect

C Commands 
Conference......Multi-user/DX Node 

D Commands
Download........Download from FILES 

G Commands
Grep..................String search file 

H Commands
Help..................Help 

I Commands
Information......PBBS hardware
Info....................Basic Information 
ID.......................Port definitions 

J Commands
Just Heard......Log 
JB......................BBS Stations 
JD......................Digipeaters 
JG.....................Gateways 
JK......................K and KA nodes 
JM.....................MSYS PBBSs 
JN.....................Net/Rom 
JT.....................TCP/IP protocol 

K Commands
Kill.....................Kill a message 
KM....................Kill mine 
KT....................Kill traffic
K-Nodes........K-Node output

http://mixw.net/files/MixNic6Old.zip


                  
L Commands
List...................Message headers 
L x....................List category x 
LC....................List categories 
LM....................List mine 
LN....................List not read 
LT....................List traffic 
LL....................List last message 
LL #.................List last # 
LO #................List older #=yymmdd 
LU...................List unread to you 
LY...................List read to you
LW..................List weather 
L?....................List ? forward 
L<< x...............List fm x=callsign 
L>> x...............List to x=callsign 
L@ PBBS.....Messages to PBBS 
L #...................List since # 
LL #.................List last # 
L # #................List from # to # 
L"x".................List with x=string 
L'x'..................List with x=sTrInG 
L$....................List bulletins 

M Commands
Message......Message of the day 

N Commands
The N commands are used while to give the BBS your information, either the first time you log on, or if 
you need to edit your information:
Name............First name 
NH..................Home board 
NQ..................QTH=City, 
NZ...................Zip code 

P Commands
Path................Path to a user
PF...................Path to a PBBS
PC...................Request a callsign 

R Commands
Read.............Read a message
R x..................Read all category x
R@ xxxx.......Read all at xxxx BBS
R> xxxx..........Read all to xxxx
R< xxxx..........Read all from xxxx
RM.................Read Mine
RE..................Read for export
RH..................Read with headers
RN..................Read only text
RP..................W/O mark as read
REPly #.........Reply auto title
REP # ...........Reply to given message number. If you put a period after the number, a title will 
automatically be generated. Same as SR command.
The following variations of the R command read messages:



R # # ............. Reads the given message numbers Ex: R 12734 11521 27185
RM .................Reads your messages (Read Mine)
R ....................category Reads the messages in a given category ("TO" field). Ex: R SALE
R> ..................callsign Reads msgs with given "TO" field
R< ..................callsign Reads msgs from given callsign
R@ ................callsign Reads msgs with given @BBS Ex: R@ ARRL
RH # # ...........Like R but displays all the R: lines as well (Read Headers)
RP # # ............Like R but doesn't mark msgs as read (Read Preview)
RN # # ............Like R but gives msg text only (Read Noheaders)
RE # # ............Reads the given message numbers in export form (Read Export)
REM ...............Reads all messages to you in export form (Read Export Mine)
#RS ................Reads all messages to SYSOP (Read Sysop)
#RES..............Reads all messages to SYSOP in export form (Read Export Sysop)
#R* ..................Reads held messages showing text
#R+ .................Reads held messages showing why held verbosely
#R- ..................Like R+ but very concise
Typically, after a screefull of lines is displayed on your terminal, you will be asked: 
More? [Y]es, No or Continuous
Press just return for next screenfull, N to quit reading this message or category), or C to display all the 
rest without pausing. The number of lines per screen is set by the X command.

> REQDIR
To list files in subdirectory XXX, put /XXX in the title of a msg to REQDIR.
For information on how to request a file, send a msg to REQFIL and put
REQFIL.HLP in the title.
> REQFIL
To request a file, send a private message to REQFIL at this BBS. Put in the
title the name of the file you want. If the file is in a subdirectory,
include the name(s) of the subdirectories. Examples:
SP REQFIL @ WA8BXN
REQFIL.HLP

S Commands
The S command is used to send messages. It several formats:
SP call @ bbscall.haddr Send a private msg Ex: SP K8EIW @ WB8BII.OH.USA.NA
ST zipcode @ NTSst Send traffic msg Ex: ST 44070 @ NTSOH
SB category @ route Send a bulletin Ex: SB NEED @ ALLOH
SR msg# Send reply Ex: SR 12723 or SR 12723.
In SB if call is a user of this system you can omit the @ bbscall.haddr
In ST, NTSst means to replace st with the state its going to: OH for Ohio, etc.
In SR, if you put a period after the msg #, a title will automatically be made
by preceeding the original title with RE:
IMPORTANT: SR tries its best to determine where the reply should go, but
it is not always perfect! The same applies to the REP command.
Never uses SSID's in callsigns (ex: don't use WA8BXN-2, just use WA8BXN)
Hierarchical addresses are of the form state.country.continent. Other parts
may be used by a particular BBS, if you know them, use them.
When sending personal messages to a distant bbs, it is a good idea to put
the destination city and state in the title.
When you are done typing your message, end it with either ^Z (Control-Z) or
Putting * at the beginning of a line makes it a comment.
It also suppresses the next command prompt (but the system will
be waiting for another command). * is useful to answer the SYSOP if you
get a MESSAGE FROM SYSOP ...

Send...........Send a message



^A................Abort message
CC................Carbon copy
SP................Send personal
ST................Send traffic

T Commands
The T cmd is used to connect to the sysop's keyboard. This if the sysop is present you may enter into a 
direct conversation. If there is no response from the sysop in 60 seconds you will be returned to the BBS. 
TCP/IP Telnet users note: Server 87 connects directly to the keyboard without going through the bbs.

U commands
The U cmd lists the current users of MSYS and what they are doing. The UP command may be used to 
upload ASCII files. You must be authorized by the SYSOP to upload files. After you use the UP 
command you will be asked the file name to upload. Follow the prompts given by the command.

V Commands
The V command gives the version of this software.
Version........Version

W Commands
The What command lists the available files for downloading. The format: W - Lists all files with sizes. A 
directory name may be specified to list files names in directories that appear in the list.
What...........Download list
W x..............What in x=subdir

X Commands
The X command can be used to set a variety of options. If no argument is given, X simply toggles and 
displays the new Expert status. If a number is given after X, this is the number of lines to display for a 
command before asking More? To continue displaying the current message when More? is sent press 
return. To abort the message, type N and then return. This facility has been added to prevent a long 
message from scrolling off your screen faster than you can read it. Experiment with different values until 
you find one that pleases you. To not use this facility, set the number of lines to zero. Examples:
X.........Toggle expert
X 20 (pause after every 20 lines) X 0 (don't pause ever)
XF Set "fast" mode: BBS will put more than one line per packet
XS Set "slow" mode: BBS will put only one line per packet.
Note: If you have very good path to bbs, use XF. If you have a poor
path to bbs, use XS since short packets make it through easier.
XC............. toggles the automatic display of msg catagories when you connect to the
bbs and are using non-expert mode.
XR toggles the automatic asking if you want to reply to a msg after you read
it. Can be useful if you get a lot of personal mail.
XU toggles the automatic display of Unread mail when you connect.
X #............Lines per page

Y Commands
Yapp...........Down and uploads
YW..............YAPP Directory
YD................Download a file
YU................Upload a file
YW ..............Lists available files for YAPP Download
YD filename Downloads specified file using YAPP protocol
YU filename Uploads specified filename using YAPP protocol

*.....................Comment to sysop



^ZH..................Conference help 
^ZQ or /ex......Return to PBBS 
^ZU..................List users 
^ZA #...............Invite user on # 

^Z gets you this file, as you may already know!
SP REQFIL @ WA8BXN
XXX\EWFILE.DAT
^Z
would get you file NEWFILE.DAT from directory XXX.
SP REQFIL @ WA8BXN
STUFF.BAS @ K8EIW
^Z
would send the file STUFF.BAS back to you at BBS K8EIW, instead of the one
from which you sent the message.
NOTE: YOU CAN REQUEST ONLY ONE FILE PER MESSAGE TO THE SERVER!

NETWORK NODE COMMANDS
BBS............Connect to the PBBS
Bye............Disconnect
Connect CALL...Connect to call
C# CALL...C on port # to call
Help...........Help
Nodes..........Nodes heard
Justheard......Limited output JH
Nodes CALL..Info on node
Ports..........Port information
Routes.........Direct connect nodes
Route CALL..Other node
State Talk...........Page Sysop
Users..........Users/nodes

Pactor
_________________________________________________________

Pactor Introduction and Theory

Pactor Operation

Pactor Intro & Theory
_________________________________________________________

From the website of RICHARD B. GRIFFIN, NB6Z

I. Introduction 
PACTOR, specially designed for operation in noisy and fluctuating channels, is an improved half-duplex 
synchronous ARQ system combining the reliability of Packet with the fixed AMTOR time frame. 
Principal design considerations 
PACTOR comprises all important Packet (2-way) characteristics: 



• fixed timing structure and full synchronism to ensure maximum speed 
• fast and reliable changeover / break-in 
• required bandwidth less than 600 Hz 
• 100% ASCII compatible (true binary data transmission) 
• extremely low probability of undetected errors (16 bit CRC) 
• independent of shift polarities 
• no multi-user overhead in a narrow-band channel 
• inexpensive hardware (Z80 single-board) 
• high operational comfort (built-in message storage system, etc.) 
• listen-mode (monitor) 
• FEC-mode (CQ-transmissions etc.) 

As a novelty in Amateur RTTY, some additional powerful features have been realized: 

• optimal coherent mode, i. e. system clocks locked to frequency standards (e.g. DCF77, TV 
deflection signals and other high precision broadcasts) 

• online data compression (Huffman coding) 
• automatic speed change (100/200 baud) without loss of synchronization 
• fully acknowledged link termination (no QRT-timeout required) 
• memory ARQ (even noisy packets can be restored) 

II. System Details 
1. Timing 
The basic Pactor transmission frame is very similar to AMTOR; blocks (packets) containing data 
information are acknowledged by short control signals sent out by the receiving station.
Shift levels are toggled with every cycle in order to support memory ARQ. Since the shift polarity is 
clearly definined at synchronization time, any conventions concerning 'mark/space' become obsolete. 

• cycle duration : 1.25 sec 
• packets : 0.96 sec = 192 (96) bits at 200 (100) baud 
• control signals: 0.12 sec = 12 bits, each 10 msec long 
• Control Signal-receive gap : 0.29 sec 

Change of transmission speed only alters the internal packet structure; all other timing parameters remain 
constant. 

2. Packets
General packet structure: 
/header/..20 (8) data bytes at 200 (100) baud../status/CRC/CRC/ 
header : This byte enables fast synchronization and delivers auxiliary information (memory ARQ, listen 
mode)
data : arbitrary binary information
status : system control byte (2 bit packet number, tx-mode, break-in request, QRT)
CRC : 16 bit cyclic redundancy check based on CCITT polynomial X^16+x^12+x^5+1, calculated over 
the entire packet (except header) 

3. Control signals (CS) 
Four CS are used. As a compromise between reliability and fast detection, a CS length of 12 bit was 
chosen. 
CS1: 4D5 CS2: AB2 CS3: 34B CS4: D2C (all hex numbers, LSB right) 
The mutual Hamming distance is 8 bit, thus minimizing the chance of receiving a false CS. CS1/2 and 
CS3/4 form symmetrical pairs (bitreverse patterns). CS1..3 have the same function as their AMTOR 
counterparts; CS4 serves as the speedchange control. In contrast to AMTOR, CS3 is transmitted as head 
portion of a special changeover packet.



 
The calling station ('master') sends special synchronization packets: /head (100 bd)/..address (8 bytes, 100 
bd)../..address (8 bytes, 200 bd) Normally, the receiver only uses the 100-baud-section to achieve a fast 
synchronization. The 200-baud-section supplies additional information about the channel quality: if it is 
received correctly, the first CS will be CS4, otherwise CS1 is sent. After in turn having synchronized a 
CS4 or CS1, the master will continue with sending normal data packets at 200 or 100 baud, respectively. 
The first transmitted characters contain the 'system level number' (PACTOR software-version), followed 
by the master address (callsign). 

4. Changing the transmission direction 
Similar to AMTOR, the receiving station (RX) can change the transmission direction whenever it has 
received a valid packet. For this purpose a special changeover-packet is transmitted, starting at the CS 
time frame. The transmitting station (TX) will switch to RX mode immediately after it has received the 
CS3 which forms the first section of the changeover- packet. It then reads in the rest of that packet and 
transmits a CS (CS1 and CS3 = acknowledge, CS2 = reject) timed at the last three bytes of the former 
packet frame.To force a break in, the TX sets the BK-status-bit (this corresponds to AMTOR '+ ?'). 

5. Speedchange 
Speeddown only being useful in poor conditions or at low data input rates (e. g. manual typing), both 
directions are treated unsymmetrically. 
i) Speeddown 
The RX may request speeddown after any incorrectly received packet by sending CS4, which 
immediately forces the TX to build up 100-baud-packets (any unconfirmed 200 baud information is 
repeated at low speed). 
ii) Speedup 
Any valid packet may be confirmed with CS4, forcing a TX speedup. In case the following high-speed-
packet is not acknowledged after a number of tries, the TX will automatically perform a speeddown. 

6. Termination of a PACTOR contact 
Cutting an ARQ link inevitably leads to the problem that information has to be transmitted without final 
acknowledgement (Second WAA theorem). Pactor applies special QRT packets, providing an expensive 
but rather effective solution. These packets contain an active QRT status bit and the RX address in byte-
reverse order (low speed pattern). If this address is found during the standby synchronization procedure, 
the RX responds with a single transmission of the final CS (The timing relations before stby are stored). 
This method will always guarantee a well-defined QRT. 

7. Data Compression 
Character frequency analysis of typical English or German texts shows that the average amount of 
information per character does not exceed 4 bits. For that reason, ASCII text transmissions often carry a 
redundancy of 50%, which could be avoided by using a vriable length code matched to the character 
distribution.The most popular example of such a code is the Morse code; PACTOR data compression 
mode applies Huffman coding with nearly optimum efficiency, yielding up to 100% speed gain. Every 
packet contains a compressed data string; character code lengths vary from 2 to 15 bits. 

8. Memory ARQ 
In conventional ARQ systems the TX has to repeat a packet until it has been received completely error-
free. It is evident that the probability of receiving a complete packet dramatically decreases with lower 
S/N ratio. The only way to maintain the contact in that case is to shorten packet length and/or to apply 
error correcting codes which in turn will greatly reduce maximum traffic speed when conditions are good. 
The method chosen by WAA Research Group is to sum up corresponding bit samples of subsequent 
packets and to test if the mean value (reduced to a 0/1-decision) passes the CRC. To keep quantizing 
errors small, the samples are taken from the FSK-demodulator low-pass-filter output by means of an 8-bit 
AD-converter. Assuming white Gaussian noise, this accumulation method - also known as 'memory ARQ' 
- will obviously converge even at a WA4EGT, QRA WA2MFY/SYS1: low S/N ratio. Furthermore, since 
shift levels are toggled with every transmission, constant interfering signals within the receiver passband 
will not affect the resulting mean value. To prevent accumulation of old request packets, the header is 



inverted with every new information packet, thus serving as a RQ indicator (similarity test). 

9. Listen Mode (Monitor) 
This mode resembles Packet Radio monitoring: the receiver scans for valid packets which are detected by 
CRC match. This 'brute force' method was chosen in order to ensue maximum flexibility, although it 
consumes a considerable amount of the available CPU capacity. 

10. FEC Transmissions 
CQ and bulletin transmissions are supported by means of a special non- protocol mode. Packets are 
transmitted with one or more repetitions; the CS receive gap is omitted. Since the listen mode does not 
require synchronization, the transmitting station possesses great freedom of selecting packet repetition 
rate and speed. 

11. Practical Aspects 
The first PACTOR programs were running on 'breadboarded' Z80 singleboard- computers. These early 
experiments led to the development of a stand-alone 'PACTOR- Controller' with built-in modem and 
tuning-display.The conventional operating modes BAUDOT and AMTOR were added in order to 
maintain compatibility and - what might be more interesting - to allow easy comparisons. Assuming 
typical conditions, PACTOR traffic can be expected to run 4 times faster than over an AMTOR link. 

Pactor Operation
_________________________________________________________

MixW supports Pactor receive (listen mode) only via the soundcard interface. To transmit Pactor with 
MixW you must use a hardware TNC. See the TNC Configuration and Operation topic.

To receive Pactor without a TNC, set the mode for Pactor by selecting Mode | Pactor from the main 
menu, or by clicking on the Mode box in the Status Bar and selecting Pactor. Pactor sounds like chirping 
bursts of packet like transmissions. The following picture shows the waterfall-tuning window tuned to a 
Pactor QSO:

As you can see, the width is similar to RTTY and it also utilizes the same two-diamond-with-a-bar 
indicator used by RTTY, MFSK, and packet.

PSK
_________________________________________________________

PSK Introduction and Theory



PSK31 Operation

PSK63/125 Operation

PSK31 Intro & Theory
_________________________________________________________

PSK31 is based on an idea by SP9VRC and developed by Peter Martinez, G3PLX, who also developed 
AMTOR. Based on RTTY, PSK is used for live keyboard-to-keyboard QSOs at 50 WPM (31 Baud) and 
uses "Phase Shift Keying" to signal mark and space values, instead of changing the frequency. 

DSP is used to change the phase by 180 degrees when a switch from mark to space is needed. DSP 
analysis by the program instantly detects this "Phase Shift". 

PSK works in a very narrow bandwidth, which sharply reduces noise and QRM. This narrow signal also 
makes it an excellent QRP (low power) mode, with between 5 and 10 watts producing excellent inter-
continental paths in some cases. 

The front-end DSP filter and pulse shaping keep the waveform compact, approximately 40 Hz at -3dB 
and 80 Hz at -40 dB. Pulse shaping uses a raised cosine to ramp amplitude during phase transitions and 
leaves the amplitude at full value during no phase reversals. 

PSK31 uses much less bandwidth than traditional digital modes as shown here:

Picture of RTTY QSO in the MixW display.

Picture of a PSK31 QSO in the same display.

PSK31's two modes: BPSK and QPSK
In the QPSK mode, instead of just keying by phase reversals, or 180-degree phase-shifts, an additional 
pair of 90 and 270-degree phase-shifts are possible.

If you think of BPSK as reversing the polarity of the signal, then QPSK can be thought of as two BPSK 
signals on the same frequency, but 90 degrees out of phase with each other, and with only half the power 
in each.

The extra speed in QPSK is used for error correction. This works well under most conditions. Certain 
noisy conditions, and weaker signals, can benefit from the full power (single signal) of the QPSK mode.

Visit the PSK31 Official Home Page at:
http://aintel.bi.ehu.es/psk31.html 

http://aintel.bi.ehu.es/psk31.html


Note: Because this is commercial software, Peter Martinez, G3PLX's Introduction and Theory of PSK31 
cannot be included as part of these help files, but these really should be reviewed for a better 
understanding of PSK and its development. Peter Martinez's outline and theory of PSK31 can be viewed 
on the website of MixW beta tester and help file contributor, RICHARD B. GRIFFIN, NB6Z at the 
following link: http://myplace.frontier.com/~nb6z/start.htm 

MixW has full BPSK31 and QPSK31 capabilities, but Nick did not use the G3PLX source code to 
implement it. By using his own source code, Nick is in keeping with Peter's guidelines for the use of 
PSK31 in commercial software.

The MixW team is very grateful to Peter for PSK31, a great gift to the radio art. 

PSK31 Operation
_________________________________________________________

With thanks to RICHARD B. GRIFFIN, NB6Z

PSK31 Basics
Due to its limited bandwidth, PSK31 is perhaps the most critical mode for proper soundcard to radio 
configuration. Overdriving your transceiver audio input will cause over modulation, creating multiple 
side bands and interfering with adjacent QSOs. See the Basic Set Up topic in the Configuration and Set 
Up section for additional information.

Transceiver Settings
Fine Tuning: If your transceiver is equipped with a "FINE" tuning feature, always use that for PSK31 
tuning, but you will find that most of your adjustments are made in software, and not with the 
transceiver's VFO. Some older rigs are not stable enough for PSK31 operation and will drift considerably 
off frequency.

USB: USB is the convention for PSK31 operation in all bands. For BPSK31 either sideband can be used, 
but with QPSK31 the sender and receiver must be using the same sideband, or one station must be 
inverted (see Inversion in the Configuration topic of the Configuration and Set Up section.

Filtering: Optimum filtering depends on your transceiver's SSB filtering options and its IF rejection 
characteristics. Wide filtering will enable you to work the largest spectrum without retuning your 
transceiver, but can also cause problems when there are strong adjacent signals. A narrow (CW or FSK) 
filter may help significantly with some radios and situations. Many transceivers, however, do not have 
narrow filtering options while operating in SSB modes. Consult your manual and experiment for the 
optimum configuration for your setup and conditions. The following waterfall display shows MixW's 
panoramic display while using a wide filter setting on the transceiver:

Here there are 8 different PSK31 QSOs we could copy with the simple click of the mouse in roughly 3 
KHz of spectrum. You can even see the bottom of an MFSK QSO in the far right hand side of the display.

Power: Because of the narrow bandwidth, PSK31 transmit power should be kept to a minimum. PSK31 
is an excellent mode for QRP operations.

MixW Settings

Mode will be set to either BPSK31 or QPSK31. Most PSK31 operations are BPSK31 unless conditions 

http://myplace.frontier.com/~nb6z/start.htm


will benefit from the limited error correction offered in the QPSK31 mode.

AFC should be on to assist in tracking PSK31 signals. The one exception is when a strong adjacent signal 
pulls you off of a weaker station you are working.

Lock should be off so you will be transmitting on the same frequency you're receiving. The exception 
here would be if you're working a station that is drifting and want that station to always tune to your more 
stable "locked" transmit frequency, or you are working split.

Squelch and Threshold can be used and adjusted to suit your operating preferences.

Inverted is grayed out for BPKS31 operation, and is never used. It may be needed while operating 
QPSK31 however. If you are having difficulty copying a QPSK31 signal, try clicking Mode | Inverted 
and see if you start to print it.
Note: This feature works differently in MixW than most other SoundCard digital programs, so please 
read and understand the information about inversion in the Configuration and Set Up Section.

Receiving PSK31
PSK31 signals display as two closely spaced parallel lines in the Spectrum Window. Tune in a PSK31 
signal by pointing to it with the mouse and clicking the left mouse button. The text being sent by the 
station will then appear in the Receive Window.

In this screen capture of a portion of the Spectrum Window of an actual MixW screen, the bright orange 
stripe with the diamond-shaped cursor in the middle is a strong PSK31 station, the one to the left is a 
weak PSK31 station (yellowish streaks), but would likely still print readable copy, and the very faint 
signal to the right is a PSK31 station that is too weak to copy enough to sustain a QSO.

PSK31 is less than 40Hz in bandwidth, so it is virtually impossible to manually tune to the correct 
frequency with the transceiver's VFO, or even to manually touch up the tuning because the increments are 
so small. However, if your Rig is equipped with "FINE" tuning, Always use that when you're in the 
BPSK31 and QPSK31 modes.

Transmitting PSK31
To transmit to a station, first tune it as indicated above. Type outgoing text in the Transmit Window. 
Press the TX/RX button, and the text in the Transmit Window will be transmitted. You can continue to 
type, and that text will also be transmitted. As it is being transmitted, text in the transmit Window will 
also appear in the Receive Window. To stop transmitting, press the TX/RX button again. Pressing ESC 
will abort transmission and return MixW to receive mode, but the last several characters typed will not be 
transmitted. This process can also be automated with the use of MixW's Macros.

Note: PSK31 utilizes the full ascii character set, so normal useage is upper and lower case instead of all 
caps, and whatever punctuation you want. Callsigns are either upper and lower case, or ALL CAPS. Both 
ways are acceptable, but an important consideration is that the lower case letters use fewer phase changes 
and are less likely to be garbled in bad conditions.

When transmitting, the waterfall will freeze and remain frozen until returning to Receive.

See the Basic Set Up topic for adjusting your sound card volume controls. PSK31 is extremely sensitive 
to proper adjustment of both the volume and record level setting of your sound card.



This screen capture of a MixW screen shows several PSK31 stations. The station to the left of our QSO is 
idling (not typing) and the two desired sidebands of the PSK31 signal can clearly be seen as parallel lines. 
Also visible are two more, fainter parallel lines on each side of the solid parallel lines at the bottom of this 
signal, which are unwanted sidebands, produced by slightly overdriving the transceiver. It looks as if this 
station is "setting" the soundcard output level. It was too strong at first and produced the unwanted side 
bands, and it looks about right where they ended up at the top of the display. The signal marked and 
circled as "over modulated station" also has the wide unwanted sidebands. Notice how close the 
sidebands are to interfering with the QSO directly to the right of them.

As with most of the other digital modes, It is possible to open multiple RX windows and switch the active 
window (the one you will be sending to) between them.

For these and other general operation techniques see the Operation Section.

PSK63/125 Operation
_________________________________________________________

PSK63 & PSK125 Basics
BPSK63, BPSK125, QPSK63 & QPSK125 are provided as a variation of BPSK31 & QPSK31 by 
changing the BAUDRATE using either a macro command or the Settings Dialog. Two macros are 
suggested, one for switching to PSK63/125 and one for changing back to PSK31.

PSK63 will operate exactly like PSK31, except that the signal will be twice as wide, and you can transmit 
twice as fast (if you can type that fast).  By the same token, PSK125 will be 4 times as fast.

MixW will properly recognize the mode in the Log based on the baud rate. Internally however MixW 
registers the mode as only BPSK31 or QPSK31. Thus any mode specific macros for BPSK63/125 or 
QPSK63/125 will not be selected.

For earlier releases of MixW the mode xPSK31 then Baud was used but the latest releases just a macro of 
MODE:xPSKbb(b) is needed. This now causes mode macros for all 6 modes to be available.

Macros to change modes 
Early Mixw versions Macro Latest Mixw versions Macro

Macro for BPSK63 <MODE:BPSK31><BAUDRATE:62.5> <MODE:BPSK63>

Macro for BPSK125 <MODE:BPSK31><BAUDRATE:125> <MODE:BPSK125>

Macro for BPSK31 <MODE:BPSK31><BAUDRATE:31.25> <MODE:BPSK31>

See One key macro to switch PSK modes.

You can also change the baud rate by selecting the BPSK31 Settings Dialog



NOTE: PSK63 & 125 are normally found above the traditional PSK31operating frequencies rather than 
intermixed with them since PSK63 & 125 require more bandwidth. If you change from PSK31 to 
PSK63/125 during a QSO you risk expanding into another user's signal, which will not improve your 
image as a courteous and considerate operator.

MFSK
_________________________________________________________

MFSK Introduction and Theory

MFSK Operation

MFSK Image Mode

MFSK Intro & Theory
_________________________________________________________

By Murray Greenman, ZL1BPU

MFSK Overview for Beginners
MFSK is a technique for transmitting digital data using multiple tones, extending the RTTY two-tone 
technique to many tones, usually, but not always, one tone at a time.

MFSK means Multi - Frequency Shift Keying, and should not be confused with MSK (Minimum Shift 
Keying). There are a number of different techniques, using concurrent (or parallel) tones, sequential (one 
after another) tones, and combinations of tones. MT-Hell can be either concurrent or sequential, DTMF 
tones used for telephone signaling are concurrent tone pairs, while Piccolo and Coquelet, although using 
tone pairs, are decidedly sequential.

MFSK transmissions have a unique sound, almost musical, which is why Piccolo and Coquelet received 
their names (Coquelet means rooster).

MFSK uses relatively narrow tone spacing, so remarkable data rates are achieved for a given bandwidth - 
64 bps in a signal bandwidth of 316 Hz is typical. The following picture is a spectrogram of an MFSK16 
signal (16 carriers) with a spacing of 15.625 Hz and operating at 15.625 baud. The transmission operates 
at 62.5 bps (about 80 words per minute!) and occupies about 316 Hz of bandwidth. The two black 
horizontal lines in the picture are at 1000 Hz and 1300 Hz, and the horizontal scale is about 20 seconds. 



This short transmission contains about 120 letters. MFSK16 is always operated with FEC, so the text 
throughput is actually only about 42 WPM (31.25 bps).

Fig. 1. Spectrogram of an MFSK16 Signal

Advantages
MFSK has several performance advantages:

• High rejection of pulse and broadband noise due to narrow receiver bandwidth per tone 
• Low baud rate for sensitivity and multi-path rejection - data bit rate higher than symbol baud rate 
• Constant transmitter power 
• Tolerance of ionospheric effects such as doppler, fading and multi-path 

Most important of all, with an MFSK system, the error rate improves as the number of tones is increased, 
so with as many as 32 tones the performance is unrivalled. With PSK systems the opposite is true. 

Disadvantages
Let's be fair - there are disadvantages to MFSK! The main disadvantages are related to the narrow spacing 
and narrow bandwidth of the individual tone detectors - drift can be a problem and accurate tuning is 
essential. Good tuning indicators and AFC are necessary at the slower speeds. It is important that the 
radio transceiver be very stable, and also that it has very small frequency offset between transmit and 
receive (preferably less than 5 Hz). 

MFSK also uses more bandwidth for a given text speed than a 2FSK or PSK system, but by the same 
token it is therefore more robust. 

Alphabet Coding
There are many ways to encode the alphabet from the keyboard for transmission. Perhaps the most 
common now is ASCII (ITA-5), but ITA-2 (as used by teleprinters) is common. MFSK16, like PSK31, is 
based on a Varicode, which, unlike most such alphabets, assigns a different number of bits to different 
characters, so that more frequently used characters have fewer bits and are therefore sent faster. 

The number of bits per alphabet character therefore depends on the character frequency, just like Morse. 
For example: 
Character Varicode
  space 100
  a 101100
  e 1100
  E 111011100
  Z 101010110100

Thus, the alphabet coding performance depends on the chosen code, and with a Varicode, even on the text 
sent: 
Alphabet Bits/Char 
ITA-5 ASCII 10 
ITA-2 7.5 
Varicode ~ 7-8

The strength of the varicode is that the alphabet is essentially infinitely expandable. For example, all the 



European accented characters are defined, and others have been added for control purposes, that are 
outside the character set. The MFSK16 varicode is not the same as the PSK31 varicode, although the 
technique is similar. 

Another important advantage of using a varicode is that the stream of data can be much more quickly re-
synchronized in case of errors, than is possible with other systems, and so a minimum of data is lost. 

Text Throughput
The user is most interested in the actual usable text throughput, which is specified in characters per 
second (CPS) or words per minute (WPM). Both depend on the alphabet used, and the number of words 
per minute depends on the average word size. In English this is taken for convenience to be five letters 
plus a letter space. So we can say that: 

Text Throughput (CPS) = User Data Rate / Alphabet Bits per Character
Text Throughput (WPM) = CPS x 60 / letters per word
Worked Example
Say we are using an MFSK system with 16 tones (16FSK), operating at 15.625 baud with FEC Rate = 
1/2, and an ASCII alphabet using 10 bits/character. Then: 
Symbol Rate = 15.625 baud
Channel Data Rate = 15.625 x log216 = 15.625 x 4 = 62.5 bps
User Data Rate = 62.5 x 1/2 (FEC RATE) = 31.25 bps
Text Throughput (CPS) = 31.25 / 10 CPS = 3.125 CPS
Text Throughput (WPM) = 31.25 x 60 / (10 x 6) = 31.25 WPM
This will take place in a bandwidth little more than 16 x 15.625 = 250 Hz. 

Comparisons 
Amateur Radio RTTY operating at 45.45 baud achieves 60 WPM with no error correction, and requires 
about 300 Hz bandwidth. 300 baud packet is error corrected, but is unsuited by its design to HF 
conditions, and rarely delivers better than 30 WPM, and often much less. Packet requires 1 kHz 
bandwidth. PSK31 operates at 31.25 baud, and in QPSK mode gives error corrected text at 31.25 WPM 
approximately. It has the narrowest bandwidth, less than 100 Hz. 

Fig. 5. Graph showing raw data rate of various digital modes
versus approximate bandwidth.

In terms of performance, of the examples given, only MFSK16 and PSK31 are considered practical for 
DX QSOs. PSK31 often performs poorly on long path, and provides no improvement when the FEC is 
used, so is usually used without it. MFSK is virtually as sensitive as PSK31 in practice and is unaffected 
by Doppler. It is also less affected by interference, and offers effective FEC. These results are supported 
by ionospheric simulation tests. 



MFSK16
The new MFSK16 mode includes continuous phase tones and many other improvements, especially to the 
receiver. The mode is loosely based on Piccolo, but differs in a few important ways: 

• The transmitted data is bit oriented, rather than character oriented. 
• The fundamental signal is a single symbol, not a symbol pair. 
• Error reduction coding is built in. 
• Tone spacing and baud rates are divisions of 125. 
• The transmitted tones are phase synchronous CPFSK. 
• No symbol phase or other AM information is transmitted. 

1. The system can therefore potentially transmit text and binary files, any alphabet including varicodes, 
and can use error coding.

2. The tones and baud rates (15.625 Hz, 31.25 Hz etc) are chosen to allow straightforward PC sound card 
sampling at 8 kHz sample rate.

3. This means the transmitter need not be linear. Using the receiver FFT, the transmitted carrier phase can 
be extracted, and from it the symbol phase is deduced. This technique is very fast and reliable.

Of course MFSK16 is computer oriented, rather than an electromechanical system, so will be easy and 
inexpensive to install, and easy to operate, with no performance compromises.

• Accurate tuning for transceive operation using "point and click" techniques 
• Convolutional coded FEC (Forward Error Correction) with interleaver for error reduction 
• FFT (Fast Fourier Transform) symbol filtering and detection 
• Symbol sync recovery by measuring transitions or carrier phase in the symbol detector FFT 
• Two signaling speeds with differing numbers of tones (but the same bandwidth) to suit conditions 

The MFSK Varicode is slightly more efficient than others, since smaller codes are available. This in turn 
is because the combinations "000", "0000" etc do not need to be reserved for idle and can be used inside 
character bit streams. Only the combination "001" is forbidden, as this signals the end of one character 
and the start of the next. The speed on plain language text is almost 20% faster than using the G3PLX 
varicode. The average number of bits per character for plain text has been measured at 7.44, giving 
MFSK16 a text throughput of 42 WPM at 31.25 baud user data rate.

Note:  Murray has an excellent website with much more information on MFSK16 and other related 
modes. This is an great resource for anyone interested in learning more about this fascinating new mode:

MFSK, "The official MFSK website"Murray Greenman, ZL1BPU. http://www.qsl.net/zl1bpu/MFSK/

MFSK Operation
_________________________________________________________

MFSK16 uses approximately the same bandwidth as 170Hz shift RTTY and so your MFSK16 transceiver 
settings can be roughly the same as those used for standard shift RTTY.

Transceiver Settings

Fine Tuning: If your transceiver is equipped with a "FINE" tuning feature, always use that for digital 
mode tuning once you have found the general area of the signals, however, most of your adjustments can 

http://www.qsl.net/zl1bpu/MFSK/


be made in software, and not with the transceiver's VFO if you prefer. Some older rigs are really not 
stable enough for MFSK operation and will drift considerably off frequency.

USB: USB is the convention for MFSK operation in all bands. Either sideband can be used, but the 
sender and receiver must be using the same sideband, or one station must be inverted ( see: Inversion in 
the Configuration Topic).

Filtering: Optimum filtering depends on your transceiver's SSB filtering options and it's IF rejection 
characteristics. Wide filtering will enable you to work the largest spectrum without retuning your 
transceiver, but can also cause problems when there are strong adjacent signals. A narrow (RTTY or 
FSK) filter may help significantly with some radios and situations. Many transceivers do not have narrow 
filtering options while operating in SSB modes.

MixW Settings

Mode: Click on the mode box in the status bar and select MFSK. Then click on the mode box in the 
status bar again and select "Mode Settings". This brings up the following dialog box:

TX and RX frequencies are set to the location of your cursor is in the spectrum window. Keeping this 
around 1500 Hz, will keep your transceiver operating close to the center of its pass band.

AFC, which should always be set to ON for MFSK operation due to the critical nature of MFSK tuning.

Squelch and the Squelch thresholdcan be adjusted to limit garbage characters, but you can also miss 
characters by using squelch as well.

The MFSK tones can also be inverted by checking the Inverted box.
Note: This feature works differently in MixW than most other SoundCard digital programs, so please 
read and understand the information about inversion in the Configuration Topic.

Tuning MFSK
You can easily recognize the sound of MFSK once you have heard it. It sounds a lot like RTTY, only 
with multiple, rather musical tones. The following tuning display shows the distinctive waterfall pattern 
of MFSK16:

As you can see, the multiple MFSK tones are dispersed throughout the bandwidth of the signal while the 



two distinct Mark and Space tones of the RTTY signal are at the edges of the bandwidth. You can also 
see that MFSK16 uses just slightly more bandwidth than the standard 170Hz RTTY signal. To tune an 
MFSK signal, click the cursor in the middle, then adjust it to either side by using the CTRL- Arrow keys 
until you start receiving text in the RX window, and the AFC locks onto the signal. Because of 
interleaving you may find that it takes a little longer to tune MFSK than RTTY or even PSK. You will 
also notice that the RX text will come in batches instead of a steady stream.

Transmit:
To switch between transmit and receive press the Pause/Break key, click on the TX/RX box in the status 
bar, or select Options | RX, or Options | TX from the menu bar.

As with most of the other digital modes, It is possible to open multiple RX windows and switch the active 
window (the one you will be sending to) between them.

For these and other general operation techniques see the General Operation Topic.

MFSK Image Mode
_________________________________________________________

Sending Pictures in MFSK:

While operating in the MFSK mode it is possible to switch to a narrow bandwith image mode and send 
small pictures without the operators manually changing from the MFSK mode at either the sending or 
receiving station.

The pictures should be small, no larger than about 250 x 200 pixels. The operation is much easier if the 
picture is put in the MixW folder, but that is not required.

The sending station should inform the receiving station that a picture is about to be sent. Then the sending 
operator should select File | Send Picture and then choose B/W... or Color.... The following dialog box 
will open.

NOTE: B/W or Color applies only to the transmission method. Choosing B/W will result in a shorter 
transmission time than if the same picture is sent in Color.

click open to start the transmission of the picture.

An icon appears in both the RX and TX windows of the sender's MixW screen while the picture is being 



sent. Note: If an "X" appears across the icon it means that MixW could not open the picture file because 
of the file type or because the file is damaged.

At the receiving station the same icon will be shown in the RX window, and the picture will be displayed 
in the upper left corner of the screen. 



When transmission is complete the receiving operator can click on the Microsoft Icon in the upper left 
corner of the received picture, then select Save Picture..., and then select a location to save it.

On both stations MixW will switch back to the MFSK mode.

Using macros to send MFSK pictures.
There are four macro commands that can be used for sending pictures in MFSK:

<PIC?N> - same as selecting File | Send Picture... | B/W...
opens dialog box to select picture file, sends in black and white
<PIC?N%C> - same as selecting File | Send Picture... | Color
opens dialog box to select picture file, sends in color
<PIC:filename.ext 00> - sends picture file in high resolution black and white
<PIC:filename.ext %C> - sends picture file in high resolution colour

Throb
_________________________________________________________

THROB Introduction and Theory

THROB Operation 



Throb Intro & Theory
_________________________________________________________

THROB, An experimental program using 9 tones and FFT detection developed by G3PPT.

The progam code is now incorporated into MixW as mode Throb.

The Fast Fourier Transform Waterfall Display allows the display of signals that can barely be heard and 
this prompts ideas for harnessing the FFT waterfall display for communication purposes. An obvious 
example is slow CW whereby the dots and dashes are decoded visually, another is multi-tone Hell 
whereby different tones make up the dot matrix of characters and are sent simultaneously (MT Hell), or 
sequentially (SMT Hell). The author has developed a program called SLOWFELD, (available elsewhere 
on this site), which is essentially very slow speed Hellschreiber whereby the intensity of selected FFT 
bins is plotted. This is very effective but very slow at 2 chars/minute and like all the Hell methods, suffers 
from the disadvantage that the whole character has to be sent as a "picture" and there is no ciphering 
advantage of 'E' over 'Z' for instance.

The amateur fraternity has an enormous choice of methods for two-way QSO's taking place under normal 
conditions such as PSK31 and Hellschreiber and their developments. The THROB program is an attempt 
to push DSP into the area where other methods fail because of sensitivity or propagation difficulties and 
at the same time work at a reasonable speed.

At the outset, please be aware that this is at an early state of development and may change a great deal, or 
come to nothing at all.

The program uses a Pentium based PC equipped with Windows95 and a soundcard. The soundcard runs 
at 8000Hz and uses data blocks of 2048, 4096 or 8192 16 bit samples. for the three speeds of 4, 2 and 1 
baud respectively. Pairs or single tones out of a palette of 9 in a 72 or 144Hz bandwidth are sent and 
received sequentially, each tone being 2048, 4096 or 8192 samples long and shaped as a semi raised 
cosine "throb" in that the leading and trailing quarters of the block are raised cosine shaped. The 
permutations of single and pairs of tones out of a palette of 9 allow for a rudimentary character set to be 
sent in a single pulse. For reception, the 72 or 144Hz band pass (obtained via FFT and reverse FFT 
filtering) is positioned centrally over the signal, and then the presence and position of the tones is our unit 
of coding. Synchronization of the reception process to the incoming "throbs" is used, and can now be set 
automatically.

The program is a development of a previous version, which used 5 tones in a 40Hz bandwidth with the 
characters being coded into the permutations of three successive tones. This was slow at 7 words per 
minute and also sideband sensitive, however it did prove that amateurs had equipment and were able to 
use it to tune within 3 or 4 Hz and, with the aid of AFC, to hold it. The latest version of the program has 
three speeds: 1, 2 and 4 baud, allowing for a data rate of 10, 20 and 40 wpm respectively, and is not 
sideband sensitive in that both LSB and USB possibilities are decoded and displayed separately with the 
nonsense version being ignored.

Auto synchronization has now been added whereby the program looks for two consecutive minima in the 
received signal intensity, the correct time apart and then sets the commencement of sampling at the first 
one.

AFC is available wich can cope with a drift of 1Hz in 5 seconds or so.

There are still possibilities for improvement and fine-tuning of the program.

Since this work started it has become part of a general move towards trying MFSK modes on the amateur 
bands, MFSK having been neglected in the past. Murray, ZL1BPU has formulated a tentative 
specification for an amateur form of Piccolo and Nino, IZ8BLY with Murray has made enormous 



advances in this direction with a program called STREAM which is now available with several modes. 
Nino has been able to incorporate error correction into his program. I cannot do this with my current 
number of tones.

One way or another, this looks to be an interesting area of development that should ultimately yield 
benefit to the radio amateur. 

Throb Operation
_________________________________________________________

THROB is a narrow band mode, although not as narrow as PSK31. Your transceiver's set up should be 
essentially the same as used for PSK31. See PSK31 Operation to review those recommendations.

Perhaps the first thing you will notice when tuning in THROB signals is the distinctive throbbing nature 
of the sound, and the next thing is that Throb is very slow compared with most of the other digital modes.

Select the THROB mode with Mode | THROB, or by clicking on the Mode box in the Status Bar and 
selecting THROB. Then select Mode | Mode settings. This will bring up the following dialog box:

The TX and RX frequencies show the location of your cursor is in the spectrum window. A setting of 
around 1500 Hz is recommended, which keeps your transceiver operating close to the center of its pass 
band. THROB rate is selectable (if you don't see what you want in the drop down box, any number can be 
typed in)., 

AFCcan be on to assist in tuning the THROB signals.

Inverted when clicked will invert the positions of the frequencies. This can be used if you are operating 
on the opposite sideband from the station you are trying to copy. If you appear to be tuned into a strong 
signal and are only copying garbage, try clicking Mode | Inverted, or clicking the box in the Throb 
settings. You may find the station start to print 100 percent as a result. See Inversion in the Configuration 
Section.

Here is a screen shot of a Throb signal on the waterfall display:

As you can see Throb uses the two diamonds with a bar between., and that they are substantially closer 



together than any of these other modes.

Receiving Throb
Tune in a Throb signal by pointing right in the center of the tracks with the mouse and clicking the left 
mouse button. The text being sent by the station will then appear in the Receive Window. The diamonds 
will move together to track and tune Throb QSOs.

Transmitting Throb
To transmit to a station, first tune it in as indicated above. Type outgoing text in the Transmit Window. 
Press the T/R button, and the text in the Transmit Window will be transmitted. You can continue to type, 
and that text will also be transmitted. As it is being transmitted, text in the transmit Window will also 
appear in the Receive Window. To stop transmitting, press the T/R button (or one of the other toggles) 
again. Pressing ESC will abort transmission and return MixW to receive mode, but the last several 
characters typed will not be transmitted.

FSK
_________________________________________________________ 

FSK Theory and Operation

FSK31 Theory & Operation
_________________________________________________________ 

The main difference between FSK31 and PSK31 is that FSK31 represents a 90/270 degree phase shift 
(DBPSK) instead of the 0/180 pair used in the original BPSK31 by G3PLX.
 
FSK31 is not as vulnerable to over modulation as PSK31. FSK31 is Nick's solution to cleaning up the 
QRM caused by careless over modulation of PSK31 signals. Here is a comparison of PSK31 and FSK31 
using a spectrum bandwidth at the -40 db level: 

PSK31 FSK31

Clean Signal: Idle 31 31

Random 80 60

Light Distortion: Idle 220 124

Random 220 93

Heavy Distortion: Idle 500+ 160

Random 500+ 93

Random = random sequence of characters.

Operating FSK31 is essentially the same as operating PSK31



MT63
_________________________________________________________

MT63 Introduction and Theory

MT63 Operation

MT63 Intro & Theory
_________________________________________________________

By Murray Greenman, ZL1BPU

MT63 is a DSP based advanced HF mode for Amateur Radio, intended to provide high performance 
keyboard - to - keyboard conversational operation on HF bands under poor conditions. MT63 utilizes a 
number of revolutionary ideas, and is technically very complex. MT63 is no more difficult to operate than 
RTTY, and can be easy to tune. It also provides much better performance on HF than most other modes. 
The specialty of MT63 is its performance when conditions are both weak and unstable. 

Simple Description
By encoding the data to transmit (what you type on the keyboard) in a complex way, using 64 different 
modulated tones, the MT63 developer Pawel Jalocha, SP9VRC, has been able to include a large amount 
of extra data in the transmission of each character, so that the receiving equipment can work out, without 
any doubt, which character was sent, even if 25% of the character is obliterated. This technique is called 
Forward Error Correction. Other modes use FEC (for example AMTOR mode B uses a simple FEC 
technique), but MT63 has other advantages. Unlike most HF modes where a character can be lost or 
changed into something else by a single noise burst, MT63 is inherently very robust, because each 
character is spread over many tones (to avoid interference such as other radio transmissions) and over 
several seconds (to avoid bursts of noise, such as lightning). On each tone, the transmission data rate is 
also fairly slow, which suits the nature of ionospheric disturbances. Despite the low data rate, good text 
speed is maintained because the text is sent on many tones at once. The system runs at several different 
speeds, which can be chosen to suit conditions, but 100 WPM, much faster than you can type, is typical.

MT63 sounds unusual, (it sounds like a roaring noise) but the performance is spectacular. There is no 
connection process, as in AMTOR, Packet or PACTOR. Some users maintain that under poor 
propagation conditions (excessive fading) MT63 works better than either PACTOR II or Clover. Under 
good conditions the performance advantages are less obvious. The convenience advantages remain, no 
matter how good the signal - the mode is suited to nets and random QSOs, as no link need be established. 
MT63 is also far more immune to interference and deliberate jamming than any of the more conventional 
modes. Changeover from transmit to receive and vice-versa is slower than most modes.
 
There are disadvantages to MT63. First, the mode is broad (see below) and quite aggressive, i.e. it causes 
interference to other modes, but itself is little affected by other modes. Also, because of the delay through 
the error correction and interleaving processes, it is not possible have quick turnaround "slick" QSOs. In 
other words, operation is clumsy.

About Wide Modes
Modes like MT63 are quite different from the traditional Amateur digital modes, in fact even other new 
digital modes. MT63 is both wideband and relatively slow, gaining performance enhancement by 
spreading the signal in time and space, although it is not a "spread spectrum" mode. There is some 
controversy surrounding indiscriminate use of modes such as MT63, because they appear to generate 
wider signals for a given data rate than other modes. Choose your operating times and frequencies with 



care! (In other words, 20 meters when the band is open and crowded is not appropriate).

MT63 Operation
_________________________________________________________

For MT63, you must tune with your transceiver's VFO . The tuning indicators cannot be changed with the 
mouse. Their location can be changed, however, by selecting Mode | Mode Settings, while in the MT63 
Mode. This brings up the following dialog box:

The TX and RX start frequencies determine the location of your tuning indicators on the waterfall 
display. These should be the same unless your intention is to operate "split", or your transceiver's TX and 
RX frequencies are out of alignment with each other and you want to compensate for that here. 

Transceiver Settings

Fine Tuning: If your transceiver is equipped with a "FINE" tuning feature, always use that for MT63 
tuning once you have found MT63 activity. Some older rigs are really not stable enough for PSK31 
operation and will drift considerably off frequency, but because of the wider bandwidth, they are often 
fine for MT63.

Pre-Amp: This can be on or off depending on the operating conditions. It can help when working weaker 
stations in certain situations, but can also make things worse if there are strong adjacent signals.

USB: Almost all MT63 operators use USB transmissions. Note: While using the CAT features, MixW 
automatically adjusts tones depending on which sideband you are operating on. If you are not using CAT, 
MixW needs to know which sideband your operating on to set the inversion correctly. (See the discussion 
bellow under inversion).

Filtering: Optimum filtering depends on your transceiver's SSB filtering options and it's IF rejection 
characteristics, however MT63 is generally 1000Hz wide (MixW allows 500Hz and 2000Hz MT63 as 
well). This is much wider than the other digital modes, with the exception of FAX and SSTV. In general 
your SSB phone filtering will be the best choice for MT63 operations.

Power: This of course depends on conditions. MT63 uses a much wider bandwidth than the PSK31 
modes, and so it will require higher power to deliver the same overall signal to the receiving station. 
Never use more power than you need to for any given situation.



MixW Settings
As mentioned above, the TX and RX start frequencies can be set to determine the location your cursor in 
the spectrum window. A location between 500Hz - 1500 Hz, will keep your transceiver operating close to 
the center of its pass band.

Bandwidth: Bandwidth is selectable as well. Most MT63 uses a bandwidth of 1000Hz.

Squelch and Threshold can be used and adjusted to suite your operating preferences.

Interleave: Interleave must be adjusted according to bandwidth: try the following combinations:
Bandwidth Audio Range Interleave/char
500 Hz 500 - 1000 Hz Long
1000 Hz 500 - 1500 Hz Short
2000 Hz 500 - 2500 Hz Very Short

Use 8-bit encoding and Escape Char: Original MT63 supports only 7-bit encoding, which does not 
allow the use of international characters. 8 bit encoding allows an extension to MT63 protocol where each 
extended character (with code > 127) is represented as two 7-bit characters: the escape symbol and 
symbol code minus 128. To allow these charectors check the 8-bit encoding and set the Escape Charector 
to 127 (the defaulte value).

Video ID and options
This is an unusual feature used to transmit a Video ID, which is visible on the waterfall display. See 
SSTV for details on Video ID.

Inverted when clicked will invert the tones to match a station. If you appear to be tuned into a strong 
MT63 signal, which is tuned within your cursors, and are only copying garbage, try clicking Mode | 
Inverted. You will often find the station start to print 100 percent as a result.
Note: This feature works differently in MixW than most other SoundCard digital programs, so please 
read and understand the information about inversion in the Configuration Topic.

Receiving MT63
Tune your transceiver's VFO until the MT63 signal appears within the tuning indicators as shown here:

Text should decode and appear in the RX window. If the MT63 signals you're attempting to tune are too 
wide or too narrow to line up with your tuning cursors, you may need to change your bandwidth setting as 
described above.

Transmitting MT63
To transmit to a station, tune it in as indicated above and type your outgoing text in the Transmit 
Window. Press the T/R button and the text in the Transmit Window will be transmitted. You can continue 



to type, and that text will also be transmitted. As it is being transmitted, text in the transmit Window will 
also appear in the Receive Window. To stop transmitting, press the T/R button again. Pressing ESC will 
abort transmission and return MixW to receive mode, but the last several characters typed will not be 
transmitted.

SSTV
_________________________________________________________

SSTV Introduction andTheory

SSTV Operation

SSTV Intro and Theory
_________________________________________________________

By Chuck Schied, Jr., W3OHV

SSTV is facsimile, and facsimile is a method of producing a picture a line-at-a-time. Newspapers and the 
wire press (e.g., AP, Reuters, UP) use facsimile for photos and text via wire and radio. Facsimile uses a 
line scanning system. More lines, hence more time taken to send them, creates sharper better-defined 
images. Line scanning is a very old concept. It is used in infrared mapping and military reconnaissance. 
Artists have used the concept to copy graphic images freehand. Ham Radio Video is a compromise 
system that runs fast enough to produce attractive -- sometimes very beautiful -- pictures.

Slow Scan pictures used in amateur radio can be sent in a variety of time formats. Simple black-and-white 
photos of low resolution can be sent in 8 1/2 seconds. Good quality pictures in B/W or Color can be sent 
in one to three minutes. Excellent pictures in Color can be sent in about four minutes. Standard resolution 
of a picture today is a 640 width x 480 height pixels with 24-Bit color. 24-Bit color (also known as 
Truecolor) is able to reproduce up 17 million different hues. These are minute variations of eight basic 
colors like red, yellow, green, blue, white, black, magenta, and cyan. Today's Slow Scan pictures using 
formats like Scottie #1 or Martin #1 are quite stunning! There are fifty or more formats created by many 
different programmers.

Slow Scan is actually faster than facsimile but slower than standard Television! You can use the longer 
formats like Scottie DX or WRASSE 180 (4-5 minutes) and receive beautiful pictures even in poor 
receiving conditions. You may have heard SSTV on 14.230-233 MHz or 7173 MHz. You can learn a lot 
by listening. Don't invest in Slow Scan until you have learned something about it from people who know 
what they are talking about. Newcomers have many erroneous ideas about the Mode and will be poor 
tutors. Old-timers who own ROBOTS are of little help if they have not become expert users of PCs and 
use the SSTV PC Programs routinely.

Where Slow Scan Video is Today
About 1992-93, as the Personal Computer began to appear in ham shacks, Slow Scan was no longer an 
expensive, experimentalist, activity. Prior to that time an expensive converter built by ROBOT 
RESEARCH Company was the only way to receive and send Slow Scan. After several years of PC 
programs, written by radio amateurs who were also involved in programming, the mode increased in 
popularity as new and better PC performance became available, especially in CPU speed, better color, 
and sharper resolution.

For additional SSTV information vist:



http://www.qsl.net/kb4yz/ 

and

http://www.hffax.de/html/net.htm for frequencies to use. 

SSTV Operation
_________________________________________________________

MixW and SSTV
Nick does not intend that MixW will compete with MMSSTV, ChromaPIX and other dedicated SSTV 
programs. It does not have extended services like templates or diagonal texts with gradient fill, however it 
does allow you to make occasional QSOs. It has the ability to manually correct for phase and slant. It lets 
you quickly type and place text over transmitted images. Macros can be used for frequently typed words. 
This mode in MixW is intended as a tool for experimenters, and for those who want to save time by not 
having to switch to a different program for SSTV operations..

Selecting SSTV from the mode menu or the status bar brings up the following window:

The control buttons are used as follows:
RX starts the receive image function using the mode selected.
TX will start the transmission of the image loaded into the TX window using the mode selected.
Stop will stop the RX or TX functions.
COLOR and horizontal location can be adjusted using the [<<], [<], [>], [>>] and the Color buttons.
Slant is adjusted using the [\,[\and Slant buttons. 

You can also select which automatic options you want by using the Auto check boxes.

The RX, TX, History, and TX hist Tabs are used to select what is displayed in the image window.

To Load a TX image click the open folder icon and select the image from your files (the size should be 
320x256x24). 

http://www.hffax.de/html/net.htm
http://www.qsl.net/kb4yz/


To Save a RX image click the disk icon and select the location and name of the file to save. 
     If Auto Save is ticked the pictures will be saved to the directory specified by the Auto Save 
path.
     This path may be set by selecting Menu Mode-Mode settings... whilst in SSTV mode.

To Load a picture from the clipboard, click the clipboard icon.

Text can be placed on the TX screen by selecting the text color and font using the indicated icons, then 
entering the text in the text window. Click the left mouse button in the TX window and move the text to 
where you want to place it, then release the mouse. The text can be placed during transmission. 

The following screen shows a .BMP file that has been edited with text using the above procedure:

RX slant/phase correction: 
Draw a line over the border of the picture. A left mouse click on the border corrects the phase only; the 
slant will not be changed. A right click can be used to move the picture up. The slant and phase can be 
corrected during receive.

Holding the Shift+slant keys saves the current slant correction, and this value will be used while 
transmitting or receiving the next pictures. 

Modes
All the common SSTV modes are available for both TX and RX. Pull down the Mode text box for a 
complete list.

Header



desired to change the header, or select another file by holding the Ctrl key and clicking the Load icon. 
Hold shift during the load or clipboard operations to eliminate header. Just remove 
Here is a tuned SSTV signal in the Waterfall display:

This yielded the following image from my friend Ron, W4ET:

Soundcard calibration

It is most important your soundcard is fully calibrated. The MixW installation provides a very good tool 
for soundcard calibration of both receive and transmit without recourse to using an external receiver (see 
Basic Set Up) although it is slightly time consuming. Alternately use the procedure below.

SSTV Calibration using WWV

The WWV mode can be used to calibrate the soundcard while receiving WWV or RWM signals. RWM 
broadcasts from Moscow, and WWV broadcasts from Colorado and Hawaii in the USA. For more 
information check: 

http://www.irkutsk.com/radio/tis.htm

http://tf.nist.gov/stations/iform.html 

RWM time marks are transmitted on 4996, 9996, 14996 KHz. Tune your TRCVR to 4994.100, 9994.100, 
14994.100 (USB). When the RWM signals are tuned:
Uncheck ALL Auto boxes
Select the WWV mode from the dropdown mode menu
Tune your receiver so the tuning indicator is on the signal as shown below.
Click on the RX button 
You will see black and white bar patterns
Adjust the slant until the edges are straight

http://tf.nist.gov/stations/iform.html
http://www.irkutsk.com/radio/tis.htm


The image will depend on the timing intervals, but the edges should be straight in any case. It should look 
something like this:

If you cannot find the time mark signals from RWM, tune about 1 khz above the WWV signal (10001, 
15001, or 20001 khz) and click on receive. You should get a screen that looks something like this:

Adjust the slant as described above until the thin vertical line is parrallel with the edges of the window. 

This SSTV slant correction can be moved to the soundcard sample rate correction to let other modes use 
that correction as well. To do this select the SSTV settings dialog from the Mode Menu and click on the 
"Go" button:



NOTE: The procedures described above will calibrate the soundcard for RX. Some soundcards have 
separate RX and TX corrections. To check your TX correction, start with the same correction you have 
calibrated for RX. Then send to a station with a soundcard calibrated for RX. If your transmitted pictures 
do not require slant correction by the receiving station your soundcard is corrected for TX. If your 
transmitted pictures do require slant correction you will need to experiment with changes to the TX slant 
correction (in the SSTV settings dialog) until they are correct.

SSTV Settings
You can also select other SSTV options from above dialog. 
The Tuning indicator check box toggles the SSTV tuning display at the bottom of the SSTV window. 
The TX and RX frequency settings locates your tuning indicator on the waterfall display and your 
radio's pass band. These cannot be moved with a mouse click on the waterfall display, but must be set 
here. 
TX and RX slant correction are best left to the WWV calibration process, which automatically enters 
the correction here. 
The GO button sends these corrections to the soundcard sample rate correction settings. 
Selecting the history size determines how many images can fit in your History Tabs. 
Setting the Auto Save and Open Picture paths will make saving and loading images much faster and 
more convenient. 
Check the use header box if you want a header added to each TX image, and select the image you want 
to ad.

Video ID
This is an unusual feature used to transmit a Video ID, which is visible on the waterfall display as 
follows:

A simple editor is included. Since the power is divided by all points and transmitted at the same time, do 



not make long which are located in the MixW directory, or make your own. Select when to transmit your 
video (start, end, or both) and than click the Edit button, which will bring up the following dialog:

clicking on the pixels to add my callsign to it. I then saved this to a new file and selected it as my VID. 

Troubleshooting SSTV
In case of trouble with dropping receive or transmit, the following 
hints may help.
 Play with following lines in the mixw2.ini: 
- Section 
[Device 0 Setup] 
m_iBufRxNum=48 
m_iBufRxSize=256 
m_iBufTxNum=48 
m_iBufTxSize=256
declares 48 buffers, 256 bytes each to use for sound operations. 
If we use sound card at 11025 sps, total length equals to 
48*256/11025 ~ 1.1 sec. I.e. a little less that a second is 
reserved for unexpected Windows delays. We can increase the time 
by enlarging buffer sizes or increasing the number of buffers.
Increasing the buffer size in parallel with decreasing the number 
of buffers may reduce system load a little: 
m_iBufRxNum=24 
m_iBufRxSize=512 
m_iBufTxNum=24 
m_iBufTxSize=512
- Changing the task priority. Look for following section in the 
MixW2.ini: 
[Priority] 
MainThread=0 
Class=32
These values are by default, defining standard priority. 
Try 
Class=128 (HIGH PRIORITY) 
or 
Class=256 (REALTIME PRIORITY)



This will definitely help in multitasking environment, and let you 
work with other programs at the same time, but it may hang slow PC. 
Also you may play with increasing the main thread priority: 
MainThread=1 
or 
MainThread=2 
or 
MainThread=15
I could set 
Class=256 (REALTIME PRIORITY) and MainThread=15 on my C366 under 
W2000 and both SSTV TX and RX worked great while I was opening PhotoShop, 
compiled next update etc.
Also you may play with following numbers in [SSTV] section of MixW2.ini
FilterLength=4 May be increased. I use the value of 64 on my C366. 
This value defines the number of taps used for the 
FOR filter (actually the number of taps is FilterLength*2+1).
Dec=5 Decimation rate. May be decreased to 4 or 3. 
I do not recommend to set it less than 3. 

Hellschreiber
_________________________________________________________ 

Hellschreiber Introduction and Theory

Hellschreiber Operation 

Hellschreiber Intro
________________________________________________________ 

By Murray Greenman, ZL1BPU

Feld-Hell
Hellschreiber was patented in 1929, and is still in use today using the original format. Hellschreiber was 
the first successful direct printing text transmission system, and was very popular at a time when 
teleprinters were complex and expensive (the Hell receiving mechanism had only two moving parts). At 
first the Hellschreiber was mostly used for landline press services, which continued well into the 1980s. A 
military version was used by the German Condor Legion during the Spanish Civil War (1933). During 
WWII, Hellschreiber was widely used for field portable military communications, for which it proved to 
be very suitable because the equipment was simple and robust. Today we use the term "Feld-Hell", or 
"Field Hell" for this system, to help differentiate it from the slightly different landline press systems. 

Each character of a Feld-Hell transmission is portrayed as a series of dots, in a matrix, just like the 
printing of a dot-matrix printer. The dots are sent one at a time, rather like Morse code. Feld-Hell 
transmits in the following order - up each column from bottom to top, then up each successive column 
from left to right. The following picture shows a fragment of text "BCDE", depicting the order in which 
the dot elements are printed. Each of the dotted rectangles represents a potential dot location, and is 
identified by a locating letter/number. The transmit order therefore is A1, A2, A3... A7, B1, B2... etc.



In this picture, the dotted rectangles depict individual dot locations in the matrix. There are blank, 
untransmitted picture elements (pixels) at the top and bottom of each character, and between characters. 
These are depicted as empty white rectangles. The transmitted (key down) pixels are shown black. 
Looking at the above diagram, it is easy to see that the transmitter duty cycle is quite low (about 22%). 
Another way of saying this is that the peak-to-average ratio is very high, which is important for good 
readability in noise. 150 characters are transmitted every minute. Each character takes 400ms. Since there 
are 49 pixels per character, each pixel is 8.163ms long. The effective baud rate is 1/8.163ms = 122.5 
baud, and the throughput is 2.5 characters/sec, or about 25 WPM.
 
The original Feld-Hell equipment, and the best software implementations, transmit two pixels (each half 
height, or half the duration) for every pixel shown in the diagram, thus improving the vertical resolution. 
If you look carefully at the above diagram, you can see how this comes about without increasing the 
signal bandwidth. Rudolf Hell designed the font so that a single half-height pixel is never transmitted. For 
example, the right side of the "B" has enhanced resolution achieved by slipping the timing of the full-
height pixels by half the height of one pixel. Three half-height pixels are transmitted without a break, so 
the bandwidth is not increased. 

Another important reason for the restricted bandwidth design, while providing well-defined characters, 
was that this technique ensured that pulses to the radio transmitter were never less than 8ms. Shorter 
(half-pixel) pulses could be severely distorted by the slow rise-time of the transmitter, and as a result, 
cause excessive bandwidth or fail to energise the mechanical print hammer in the receiver. 

The output of the wartime Feld-Hell machine was a 900 Hz keyed audio tone, sent on a telephone line or 
to a transmitter modulator, for example an MCW transmitter. It was possible in some models to separate 
the keying contacts for direct keying of a CW transmitter. Feld-Hell is therefore amplitude keyed, just 
like Morse, as CW or MCW. Each pixel of a dot matrix character is sent in a fixed pattern as a CW dots. 
Where there is no black dot, nothing is sent. Feld-Hell is in reality a simple facsimile mode. The early 
press system, F-Hell was identical except that it ran at 245 baud (5 characters/sec). An asynchronous 
variant, GL-Hell, (used by land-line machines) utilised a fixed start block of pixels at the left of each 
character, which provided character based synchronism, but this method has no advantage to Amateurs. 
An excellent article describing the traditional mechanical method of transmitting and receiving Feld-Hell 
appeared in Ham Radio Magazine, December 1979. An article which describes the Hell font and includes 
other useful information was printed in Radcomm, April 1981. The actual machine described by the late 
G5XB in that article is now in the possession of Ian G4AKD. The Siemens A2 war-time machine is also 
described in detail on the Feld-Hell History page. 

For more information including a summary of the different Hell formats, see: Murray's Website on Hell 
modes.

PERFORMANCE
Feld Hell performs very well where the path has reasonable stability (little fading) and where the signal 
level is equal to the average noise or better. If gray-scale reception is used, performance at low signal to 
noise is much better. Feld-Hell is reasonably immune to interference, but can be badly affected by on-

http://www.qsl.net/zl1bpu/HELL/Index.htm
http://www.qsl.net/zl1bpu/HELL/Index.htm


frequency carriers or Morse. 

Hellschreiber Operation
_________________________________________________________ 

Hellschreiber is a unique mode. Some would argue that is is not a digital mode at all. Still for our 
purposes, because we are certainly using digital techniques to operate Hellschreiber, we will call it a 
digital mode. It has more of a clicking, or chirping sound than the other, more recent digital modes. 
Receiving Hellschreiber text is more like receiving a FAX image. The characters you receive and transmit 
are actually pictures of characters.

Hellschreiber is another narrow band mode, like PSK31, and will benefit from the same transceiver 
settings. To review these settings please see the PSK31 Operation topic.

First switch to the Hellschreiber mode by selecting Mode | Hellschreiber, or by clicking on the Mode box 
in the Status Bar and selecting Hellschreiber. Next bring up the mode settings by selecting Mode | Mode 
settings. This will bring up the following dialog box:

The TX and RX frequencies show the location of your cursor is in the spectrum window. The best 
frequency is around 1500 Hz, which keeps your transceiver operating close to the center of its pass band. 

Mode: The drop down box gives a choice of 3 sub-modes:

Feld HELL - The sub mode this description refers to.
FM 105bd - See FM hell description. FM245bd - For FM Hell modes a two diamond cursor is 
used in the waterfall.

These modes may also be selected via the <SET SUBMODE:> macro.

Filter: You have a selectable software DSP filter width of between 100 and 250Hz. Varying this setting 
may improve your reception during differing conditions. A setting of 200Hz seems to work well overall.

RX scale: Setting the RX scale to x2 may help you decipher hard to read characters, but you will not be 
able to see as much text on each screen. Use x1 unless your having trouble seeing the text at this 
resolution.

Font Selection; You can pre-select up to 4 different fonts by clicking the button next to each font # and 
then clicking in the font sample window. This is the font you are transmitting, not receiving. You will 
receive the font selected by the sending station.

http://www.qsl.net/zl1bpu/HELL/PSK.htm


Here is a screen shot of a Hellschreiber QSO:

As you can see Hellschreiber uses the single diamond indicator like PSK31 uses, and the bandwidth is 
very narrow. Received text appears in double or triple lines. You can see more text on your screen by 
removing the log and other tool bars from the display.

Receiving Hellschreiber
Tune in a Hellschreiber signal by pointing right in the center of the signal with the mouse and clicking the 
left mouse button. The text being sent by the station will then appear in the Receive Window.

Transmitting Hellschreiber
To transmit to a station, first tune it in as indicated above. Type outgoing text in the Transmit Window. 
Click the T/R button, and the text in the Transmit Window will be transmitted. You can continue to type, 
and that text will also be transmitted. As it is being transmitted, text in the transmit Window will also 
appear in the Receive Window. To stop transmitting, press the T/R button again. Pressing ESC will abort 
transmission and return MixW to receive mode, but the last several characters typed will not be 
transmitted.

Olivia
_________________________________________________________

Introduction to Olivia Operations

Olivia Operation
_________________________________________________________

Olivia.

Olivia was designed and first implemented by Pawel Jalocha, SP9VRC. The draft specification for the 
Olivia HF transmission system can be seen at: 

http://www.qsl.net/a/aa3eu/olivia.htm

Implementing Olivia in MixW.

Effective with version 2.16 MixW has a capability for "External mode plugin support". This allows new 

http://www.qsl.net/a/aa3eu/olivia.htm


modes to be added to MixW without modification to the main MixW program. Olivia was the first mode 
implemented using this plugin support. In order to use Olivia in MixW 2.16 to MixW2.19 the file named 
ModeOlivia.dll must be downloaded from Nick's web site at http://mixw.net into the MixW program 
directory. For MixW2.2 and later ensure you have an internet connection select menu File|Extras|Modes. 
A list of available plugins will be displayed. Select all 3 and click on download. This will download all 3 
additional mode DLLs into your data\plugins directory.

Operating Olivia in MixW.

Olivia is a version of MFSK, and in MixW the operating procedures are the same as for MFSK with the 
exception of certain options which can be set in the Olivia | Mode Settings... dialog box. After installing 
the ModeOlivia.dll file restart MixW and select Mode | Olivia, then Mode | Mode Settings. You will see 
the following dialog box:

Be sure to check the "Allow manual tuning" box which will allow you to set the center frequency of the 
Olivia signal by clicking in the waterfall or spectrum.

The "Number of tones" can be selected from 8 different settings between 2 and 256, and the "Bandwidth, 
Hz" can be selected from 5 different settings between 125 to 2000.

The tones/bandwidth combination are displayed in the status bar.

In practice, the normally used combinations are:

500 Hz, 8 Tones:.....

500 Hz, 16 Tones:....

1000 Hz, 16 Tones:...



1000 Hz, 32 Tones:...

The signals seen on the waterfall are practically identical to Contestia and RTTYM signals. As with all 
digital modes, after a little experience the user will be able to identify the various formats visually in the 
waterfall.

It is important for successful Olivia operation that the soundcard is calibrated.

Finding and Tuning Olivia Signals.

Olivia under MixW is operated exactly like any other MFSK modes, by clicking the desired center 
frequency on the waterfall or spectrum display.

Frequencies currently being used forOlivia seem to be:

For 125/250/500 bandwidth just above the BPSK63/125 frequencies
40 meters, 7072-7074
30 meters, 10134-10139
20 meters, 14100-14112

The best combination for calling CQ is probably 500 Hz, 8 Tones. However a common practice now is to 
call in whatever mode the operator wants to work in. Be carefull using the 1000 Hz width, and 
particularly changing from 500 Hz, to 1000 Hz, that you do not cause interference to other users. 

Contestia
_________________________________________________________ 

Introduction to Contestia Operations

Contestia Operation
_________________________________________________________ 

Contestia.

Contestia is a development from Olivia mode with reduced character set and robustness created by Nick 
Fedoseev (UT2UZ).

Implementing Contestia in MixW.

Effective with version 2.16 MixW has a capability for "External mode plugin support". This allows new 
modes to be added to MixW without modification to the main MixW program. Contestia has been 
implemented using this plugin support. In order to use Contestia in MixW the file named 
ModeContestia.dll must be downloaded. For MixW2.16 to MixW2.19 the ModeContestia.dll file can be 
found in the MixW Yahoo group Files section. For MixW2.2 and later ensure you have an internet 
connection select menu File|Extras|Modes. A list of available plugins will be displayed. Select all 3 and 
click on download. This will download all 3 additional mode DLLs into your data\plugins directory.



Operating Contestia in MixW.

Contestia is a version of MFSK, and in MixW the operating procedures are the same as for MFSK with 
the exception of certain options which can be set in the Contestia | Mode Settings... dialog box. After 
installing the ModeContestia.dll file and restarting MixW select Mode | Contestia, then Mode | Mode 
Settings. You will see the following dialog box:

Be sure to check the "Allow manual tuning" box which will allow you to set the center frequency of the 
Contestia signal by clicking in the waterfall or spectrum.

The "Number of tones" can be selected from 8 different settings between 2 and 256, and the "Bandwidth, 
Hz" can be selected from 5 different settings between 125 to 2000.

The tones/bandwidth combination are displayed as chars/s in the status bar.

The signals seen on the waterfall are practically identical to Olivia and RTTYM signals. As with all 
digital modes, after a little experience the user will be able to identify the various formats visually in the 
waterfall.

It is important for successful Contestia operation that the soundcard is calibrated.

Finding and Tuning Contestia Signals.

Contestia under MixW is operated exactly like any other MFSK modes, by clicking the desired center 
frequency on the waterfall or spectrum display.

Frequencies currently being used for Contestia seem to be:

For 125/250/500 bandwidth just above the BPSK63/125 frequencies
40 meters, 7072-7074
30 meters, 10134-10139
20 meters, 14100-14112

The best combination for calling CQ is probably 500 Hz, 8 Tones. However a common practice now is to 
call in whatever mode the operator wants to work in. Be carefull using the 1000 Hz width, and 
particularly changing from 500 Hz, to 1000 Hz, that you do not cause interference to other users. 

Note: QSOs with Mode Contestia will not be written to eQSL. Change the Mode in MixW's log to 
Contesti. This is the official .ADI file version 2 specification. 



RTTYM
_________________________________________________________

Introduction to RTTYM Operations

RTTYM Operation
_________________________________________________________

RTTYM.

RTTYM is a development from Contestia mode with further reduced facilities and robustness created by 
Nick Fedoseev (UT2UZ).

Implementing RTTYM in MixW.

Effective with version 2.16 MixW has a capability for "External mode plugin support". This allows new 
modes to be added to MixW without modification to the main MixW program. RTTYM has been 
implemented using this plugin support. In order to use RTTYM in MixW the file named 
ModeRTTYM.dll must be downloaded. For MixW2.16 to MixW2.19 the ModeRTTYM.dll file can be 
found in the MixW Yahoo group Files section. For MixW2.2 and later ensure you have an internet 
connection select menu File|Extras|Modes. A list of available plugins will be displayed. Select all 3 and 
click on download. This will download all 3 additional mode DLLs into your data\plugins directory.

Operating RTTYM in MixW.

RTTYM is a version of MFSK, and in MixW the operating procedures are the same as for MFSK with 
the exception of certain options which can be set in the RTTYM | Mode Settings... dialog box. After 
installing the ModeRTTYM.dll file restart MixW and select Mode | RTTYM, then Mode | Mode Settings. 
You will see the following dialog box:

Be sure to check the "Allow manual tuning" box which will allow you to set the center frequency of the 
RTTYM signal by clicking in the waterfall or spectrum.

The "Number of tones" can be selected from 8 different settings between 2 and 256, and the "Bandwidth, 
Hz" can be selected from 5 different settings between 125 to 2000.

The tones/bandwidth combination are displayed as chars/s in the status bar.



The signals seen on the waterfall are practically identical to Olivia and Contestia signals. As with all 
digital modes, after a little experience the user will be able to identify the various formats visually in the 
waterfall.

It is important for successful RTTYM operation that the soundcard is calibrated.

Finding and Tuning RTTYM Signals.

RTTYM under MixW is operated exactly like any other MFSK modes, by clicking the desired center 
frequency on the waterfall or spectrum display.

Frequencies currently being used for RTTYM seem to be:

For 125/250/500 bandwidth just above the BPSK63/125 frequencies
40 meters, 7072-7074
30 meters, 10134-10139
20 meters, 14100-14112

The best combination for calling CQ is probably 500 Hz, 8 Tones. However a common practice now is to 
call in whatever mode the operator wants to work in. Be carefull using the 1000 Hz width, and 
particularly changing from 500 Hz, to 1000 Hz, that you do not cause interference to other users. 

RTTYM is not as popular on the bands as Contestia and Olivia. 
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Cat Bar/Cat config
_________________________________________________________

The Cat Bar, Configure CAT/PTT and Bands.ini file contents are used by MixW to control the way the 
Transceiver is set up by MixW.

CAT Bar

The CAT Bar consists of three items, two drop down menus, one of which also displays as the transceiver 
frequency and tuning arrows.

Position the mouse cursor over the left arrows and left click causes MixW to decrease the transceiver 
frequency. The further left the mouse is moved the faster the tune speed. Whilst the mouse cursor is over 
the left arrows right clicking will cause MixW to increase the transceiver frequency. The inverse is true 
for the mouse positioned over the right facing arrows.

The left drop down menu displays the current transceiver frequency and if the menu is selected all the 
bands configured in the bands.ini file are displayed. Bands can be added to or deleted from the bands.ini 
file.

If a band is selected from this menu MixW will use the current MixW mode to read the prefered 
frequency and the transceiver mode from the bands.ini file and configure the transceiver accordingly. If 
the current mode does not have a separate entry for the band the ALL entry for the band will be used. If 
the transceiver mode is DEFAULT the mode selected will be as configured in menu Configuration|Trcvr 
CAT/PTT Default digi mode. If this entry is NONE no change will take place. If this entry is not valid for 
the transceiver results maybe unpredictable.

The right drop down menu displays the mode MixW believes the transceiver is in.



The transceiver type, as configured in Configure|TRCVR CAT/PTT menu, causes the selection of settings 
in this menu. The values in this menu are the ones to be used in the bands.ini file Tcvr mode position.

However the transceiver may not display the value shown in the window (the FTdx3000 shows Data USB 
but the menu item is PKTR).

Contest Operation
_________________________________________________________

MixW offers extensive support for contest operation, including special Macros, as well as special logging 
features. It can be configured for specific contests, and these settings can be stored for future use. 

The full list of configured contests is shown in the List of Contests dialog from the View | Contest Mode. 
This brings up the List of Contests menu. You may edit, delete, or add new contest settings from this 
dialog. The "Select" button sets the active contest from the list of contests. Specific DLL files for many 
contests are also available from Nick's website. When downloaded and installed in the Plugins 
subdirectory, these DLLs will keep track of your statistics for that contest, as well as enable MixW to 
automatically calculate your scores for inclusion in your electronic log submission.

The contest mode is turned on or off from the View | Contest Mode menu. While In the contest mode, the 
Log Bar can be set to display exchange numbers instead of the name and QTH fields. To do this select 
View | Log bar | Contest layout.

The contest mode also allows you to check for previous QSOs made during the current contest only.

Configuring MixW's contest mode.
For contest operation, first switch to the contest mode by selecting View | Contest Mode. This will bring 
up the following contest selection dialog:



Select the active contest by highlighting it and pressing the Select button. From here you can also add a 
new contest, edit an existing contest, or change the active contest. (Selecting none returns MixW to the 
regular "non-contest" mode) To edit a contest, highlight it and select edit. To add a contest, click on the 
add button. Either of these options will bring up the following edit contest dialog box:

Here you can configure the logging features to suite the times and rules of the specific contest you are 
operating, and these settings can be saved and recalled for the next time you operate this contest (or a 
similar one).

Name - This is the name of contest, which appears at the top of MixW window when the contest mode is 
active.

Your call - specify the call sign you want to use in this contest. All QSOs during the contest will be 
logged with this call.

NRS is the report you send. If it is a serial number, enter the number you want MixW to start with, and 



check the AutoInc box if you want MixW to automatically increment these numbers in your Macros and 
log.
Note: I found I had to check the AutoInc box, and then enter the first number manually in log bar to get 
this feature to work. If this specific contest requires a different type report, that can either be entered here, 
and simply leave AutoInc unchecked, or that can be added as text in your contest Macros.

Start is the start time of the contest.

End is the end time of the contest.
Note: Keeping track of the start and stop times enables MixW to know which QSOs count in the scoring 
and dupe checking.

If AutoInc is on, MixW automatically increments the number in the ExchSnt field of the previous QSO. 
If the previous QSOs has no number (such as at the very beginning of the contest) the number 001 is 
used.

If AutoInc is off, the ExchSnt field is just copied from the previous QSO. (The NR sent field from the 
Contest Settings dialog box is used at the beginning of the contest.)

The ExchSnt for the current QSO can be changed by typing another text in the pop up box that is 
displayed during the QSO.
.
Auto Grab - this feature allows auto-grabbing of serial numbers, time (such as for the BARTG contest) 
and states/counties/cantons/etc. from received data.

When the Auto Grab Serial number box is checked, MixW looks for strings that are likely to be a serial 
number and places them in the ExchRcv (exchange received) field of for the current QSO.

When the Auto Grab Time box is checked, MixW looks for time stamps like 2317 or 23:17 or 2317z or 
23:17z, and places them in the Notes field. (This only works if the time does is not much different from 
the local computer's GMT time.)

When the other Auto Grab boxes are checked, MixW looks for a limited set of strings, which coincide 
with that type of data. Domains can also be checked and a .dom file (located in the Plugins directory) can 
be specified to determine where to place the data received. For instance:
A RUSSIAN.DOM file contains a list of Russian oblasts to grab automatically:
------------- start of file -------------
Ab = AB
Ad = AD
Al = AL
.....
(102 lines with oblast definitions)
------------- end of file -------------
Now both the received serial number and a grabbed domain are put to ExchRcv field of the log file.
DOM files use a simple data format compatible with N6TR software:
Each line consists of the left part, equal sign, and the right part. Lines without equal signs are ignored as 
comments.
The Left part is a domain name,
The Right part is a list of words to grab.
Samples:
Ab = AB
Cd = EF, GH
Ij = JKL, MNO, PQ, R

A DOM file can be specified for each contest with domains that you expect to encounter in that contest.



Statistics
First you must download the specific contest DLLs available from the following sites:

Victor, R3BB has a Mixw contest site where a number of up-to-date DLLs and links to contest rules can 
be found. For MixW3.2 the DLLs from this site are recommended:

http://www.digitalrus.ru/

The MixW Site: http://www.mixw.net/ also has a number of contest DLLs available.

Either use the MixW File-Extras-Contest stats... menu to display the available files or scroll down the 
MixW home page and check for your required contest file. 

Once downloaded these files should be unblocked 

A blocked file can be identified by opening Windows Explorer, selecting the file and right 
clicking. Select properties from the drop down menu. If a button marked Unblock is visible in the 
Attributes section of the properties display box this file is blocked. Left click on the Unblock 
button and then click on OK to unblock the file. 

then unzipped into the Plugins directory, which is in the MixW data folder. Next they are selected in the 
Contest dialog by clicking on the Statistics browse button:

This brings up the following dialog:

This is a list of available contest DLLs found in your data Plugin directory. Simply highlight the desired 

http://www.mixw.net/
http://www.digitalrus.ru/


contest DLL you wish to use for this contest and press the Select button. Some contests also offer settings 
options, which can be accessed from this menu as well.

With these DLLs installed and selected you can click View | Statistics - Show contest statistics, which 
will allow you to see your statistics as you work the contest in the following box:

It's fun to watch your progress here as you work the contest. You can also view the Brief Log Statistics 
box for a more detailed view of your progress by selecting View | Statistics | Brief log statistics, which 
will display the following view of your progress:

Configuring the contest Macros
Macros - This is the name of a file containing the individual keyboard macros for this contest (or blank 
space if no individual macros are used).

Merge Macros - if this check box is unchecked, macros from the specified file will be directly assigned 
to the Control Bar keys. If it is checked, the macros from the file will be merged with the macros for the 
current mode and/or the default MixW macros.

Notes This can contain any useful information describing this contest.

There are several special keyboard macros, which can be used in the contest mode:



<NRS> - sent exchange number 
<NRR> - received exchange number 
<CLEARNRR> - clear the exchange received field 
<INCNRR> - Increment the NRR field if it is an integer 
<CTIME> - contest time (BARTG contest) like "2317" (hours and minutes)
<ONQSOBEFORE:macro> - if we had QSO before, run specified macro.

Here are some example contest Macros, which will prove very helpful while using the contest mode:

If a station calls you that you have worked before in this contest (a dupe), this macro tells him you have 
worked before, and then clears the QSO information from the log.
Macro: F9 
Label: QSOb4 
Text: QSO before!<CLEARQSO><RXANDCLEAR>

Now, when you press F9, the other station sees the message "QSO before", and then the new QSO data is 
erased.

<ONQSOBEFORE:macro> can also be used (for example, inside the macro that answers someone's CQ) 
to automate the process:

Without automation:
Macro: F5 
Label: Answer 
Text: <TX><CALL> de <MYCALL> 599 <NRS> <NRS> <RXANDCLEAR>
He sees " AB1CDE de UU9JDR 599 001 001 ".

With automation:
Macro: F5 
Label: Answer 
Text: <TX><CALL> de <MYCALL> <ONQSOBEFORE:F9> 599 <NRS> <NRS> 
<RXANDCLEAR>
In this case if you have not worked the station before they will see the above text. But if you have worked 
them before they will see " AB1CDE de UU9JDR QSO before! " and nothing more, because F9 macro 
with <RXANDCLEAR> at it's end and the "599 001 001" will not be sent.

You can configure Macros for a specific contest, but first you need to save the existing Macros to avoid 
loosing them and regretting it latter (ask me how I know about this!). Next, click on Save, and save the 
existing group as Basic. (You can skip this step if you have already saved the basic Macros). Now, let's 
load the generic contest Macros that come with MixW by selecting Configure | Edit Macros for this 
mode/group. This brings up the Edit Macro dialog box. Now you can load the default contest Macros that 
come with MixW by clicking on the Load button, then select the file "contest.mc". This will load the 
default Macros for contesting:



Now you can alter the Macros as you want them for this particular contest by double clicking on line 
(Macro) in this window, then edit them using the Edit Macro Window.

As an example of contest specific Macros here is a suggested set of Macros for the CCCC contest.

Set one is for calling CQ in a contest:
CQ: (To call CQ in the CCC contest)
<CLEAR><TX>CQ CQ CCC Test
CQ CQ Test de <MYCALL> <MYCALL> k<CR><LF><RX>

AutoCQ: (Assigns AutoCQ to the above Macro for this contest) 
< ASAUTOCQ><CLEAR><TX>CQ CQ CCC Test
CQ CQ Test de <MYCALL> <MYCALL> k<CR><LF><RX>

QRZ: (To ask for another call when you haven't copied the station calling)
<CLEAR><TX>QRZ? AGN Pse de <MYCALL> k<CR><LF><RX>

ANSWER: (To answer a call with your report)
<TX><CALL> de <MYCALL> Hello, ur <RSTS>-<NRS>-<NRS> k<CR><LF><RX>

REPEAT: (To repeat your report)
<TX><CALL> Agn ur <RSTS>-<NRS>-<NRS> k<CR><LF><RX>

CFM: (Confirms and calls QRZ and saves the QSO to the log)
<TX><CALL> QSL 73 de <MYCALL> QRZ? k <CR><LF><SAVEQSO><RX>

NOCFM: (To ask for your report again)
<TX><CALL> PSE AGN UR REPORT de <MYCALL> k <CR><LF><RX>

These two Macros are for answering in a contest:
CALL S/P: (To call the station currently in <CALL>)
<TX><CALL> de <MYCALL> <MYCALL> k <CR><LF><RX>

CFM S/P: (To confirm, give your report, and save the QSO)
<TX><CALL> de <MYCALL> TNX, QSL, ur <RSTS>-<NRS>-<NRS> 73 de <MYCALL> k 
<CR><LF><SAVEQSO><RX>



Note: Ensure 'Use default RST' is ticked in the View menu to ensure an <RSTS> of 599 is always sent.
 
These can be altered to work in almost any contest. When your finished editing your Macros for this 
contest, consider saving these to a new Macro file so you can use them next time by clicking on Save, and 
then calling something related to this contest.

The RUN, SEARCH AND POUNCE, and INTELLIGENT (<INT>) macros. 

There are several macros which are dependent on each other and the contents of certain fields in the 
contest log.

First, there are four macros to set the RUN or SEARCH AND POUNCE mode:

<SP1> sets search and pounce mode on.
<SP0> sets search and pounce mode off (run mode on).
<SP> sets search and pounce mode off (run mode on).
<S/P> toggles between search and pounce and run mode.

Second, there is the <INT> macro which is called by default by the OnCR macro when MixW is in the 
contest mode. The output of the <INT> macro depends on the content of the CALL and RX EXCHANGE 
fields as shown in the following tables:

Search and Pounce Mode

Call RX Exchange .....................Output..................... Macro to Edit

-empty- -empty- ? INTQRL

NEWCALL -empty- de mycall INTDE

WKDCALL -empty- nothing none

NEWCALL exchange QSL UR 599 001 (saves QSL) INTQSL

Run Mode

Call RX Exchange .....................Output..................... Macro to Edit

-empty- -empty- CQ TEST DE mycall INTCQ

NEWCALL -empty- newcall GA 599 001 INTGA

WKDCALL -empty- newcall QSO b4 QRZ INTQB4

NEWCALL exchange QSL 73 QRZ de mycall (saves QSL) INTQRZ

Cabrillo file generation

Note: The generated Cabrillo file (yourcallsign.cbr) is usually created in the default data directory. 



Before generating a new Cabrillo file make sure you have saved the previous file if you need it. 

Most contests today accept entries that are in the Cabrillo file format (see http://www.arrl.org/cabrillo-
format-tutorial for information on the file specifications).

Before starting the Cabrillo file generation it is a good idea to have the contest rules available for display.

To create a Cabrillo file after a contest select the small spectacles button (Search) below left on the MixW 
log bar

Uncheck all boxes except the Contest box in the Search in logfile selection window.

Select the contest name from the drop down list of contest names and click Display. The displayed log 
will have been selected by using the last contest settings date and time. If the start or end date and time 
are incorrect contest entries may be missed

Select the entries you wish to be entered in the contest and click on the to Cabrillo button at the bottom of 
the log display.

http://www.arrl.org/cabrillo-format-tutorial
http://www.arrl.org/cabrillo-format-tutorial


The steps following the selection of to Cabrillo depend on the contest and maybe controlled by either the 
contest statsxxx.dll (xxx is the contest name see Plugins directory) or MixW. You may have a further 
selection to make or you could have to fill in the information for the Cabrillo header file. For this you 
may need the contest rules to sort out the correct information.

Finally you will OK the information and a message box will be displayed informing you a file 
yourcall.cbr has been created. This file is in the MixW data directory (or just the MixW directory for 
MixW2.19 and earlier versions).

Check your Cabrillo file using your favourite text editor BEFORE submitting it.

Some Stats dlls create an ini file in the Plugins folder, some do not.

QTCs            With thanks to Pat ON2AD for the original information.

QTC means how many messages do you have for me or I have xx messages for you in the Q-Codes. 

In contests QTCs are a good source of points, particularly the WAE (Worked All Europe) RTTY contest. 
The rules provide information on QTCs and how to use them.

A QTC consists of up to 10 entries which contain information, taken from the log, of each contest QSO 
completed.

Each entry comprises:

Time of QSO sep Callsign sep Exchange received

where sep is a separator character, dependent on which software was used to create the QTC

e.g.
0836/CA1ZZZ/042

http://www.darc.de/referate/dx/contest/waedc/en/rules/


MixW and the WAE contest

To set up MixW for the WAE contest:

Download the statistics file StatsWAE.zip from Victor Kosobokov (R3BB)'s contest web site 
http://www.digitalrus.ru/

Extract the two files. Copy StatsWAE.dll into the MixW data folder Plugins subfolder. Copy darc-
wae-rtty.mc file into the MixW data folder. This file contains a set of macros suitable for use with 
the contest. Use the contest set up to create a WAE contest entry in the contest list

 

Click on the button to the right of the text box below the Statistics: heading. This will bring up the Select 
the statistics filter selction box.

Select the DARC-WAEDC-RTTY (C) entry then click on Settings.

Select New test if this is the start of the test. This will clear any files left over from the last time the test 
was entered. Select Use window multiplier to display all countries worked on the band currently selected. 
Use the OK buttons to save the data.

If QTCs are to be exchanged five macros are required:

http://www.digitalrus.ru/


<STATS:ReadQTC> Initiate the reception of QTCs

<STATS:SendQTC> Initiate the transmission of QTCs

<TX>I have QTCs to send<RX> Inform remote operator of QTC availability.

<TX>Have you QTCs to send?<RX> Inform remote operator you can receive their QTCs.

<TX>SRI no QTC! 73<RX> Inform remote operator no QTC operations.

These macros are included in the macro file extracted from the zip file above.

Transfer of QTCs

For MixW2.19 and earlier first save the QSO. If there is no valid current QSO a request is made for the 
callsign of the station the QTC exchange will be with.

If an exchange is requested with a station in the same continent as your station a message box is displayed 
stating the exchange is not permitted (see the contest rules). 

Sending QTCs

Execute the macro <STATS:SendQTC>

This displays the Send QTC window

The Buttons have the following actions: 
R U QRV Ask the recipient if they are ready to receive the QTCs

Send # QTC Send the QTC header information

Send All Send all the QTC data



Snd#n Send single QTC #n

SAVE QTC Save the QTCs sent to the QTCTX.log. Send a 73 message

CANCEL Cancel the QTC exchange. No data is written to the QTCTX.log

Receiving QTCs

Execute the macro <STATS:ReadQTC>

This will bring up the Receive QTC window

The Buttons have the following actions: 
RX Ready Send message informing sender you are ready to receive the QTCs

Agn #QTC Request repeat of the QTC header information 

All Agn Request repeat of all the QTC data

Agn#n Request repeat of a single QTC #n

Ins#n Create a blank entry on line #n. It will then be necessary to request QTC #n again

SAVE QTC Save the QTCs received to the QTCRX.log. Send a message confirming reception of the 
QTCs

CANCEL Cancel the QTC exchange. No data is written to the QTCRX.log

Check boxes Manual and Automatic select whether the data will be filled in by StatWAE.dll (Automatic) 
or if the data will be selected and copied across by the operator.

In manual selection when QTCs are received correctly highlight the whole message and click on Add to 
statistics on the drop down menu 



and the data will be added to the Receive QTC window.

Note:

As well as the individual QTCTX.log and QTCRX.log files a third file QTC.log is also maintained.

Before creation of the Cabrillo contest log entry file these files can be edited to correct the information if 
required.

Entry log file generation

The StatsWAE.dll is capable of generating either an STF or Cabrillo file format.

The entries to be included in the test are selected in the usual way and when the Cabrillo button is 
selected a Windows selection box is displayed for either Cabrillo or STF format. Whichever is selected 
the appropriate file is created and stored in the MixW data folder (there is no option to save it elsewhere) 



overwriting the previous file (which may have been for a different contest).

Note:

There is another file StatsWAE.dll available. This file was created by the MixW team in 2003. This file 
can also send and receive QTCs but does not have the capability to create contest entry files (Cabrillo or 
STF format)..

Use the StatsWAE.dll created by Victor (R3BB). 

DX Cluster
_______________________________________________________

MixW has a built in DX Cluster window, which can obtain data from either a Packet, Telnet or Internet 
DX Cluster. To activate this window select View | DXCluster dialog. This brings up the following 
window:

The latest releases of MixW have the yellow WWV button replaced with a yellow EN button. They both 
carry out the same function. 

Internet based "WebCluster": Clicking on the "Settings" icon allows you to set the options for the 
DXCluster window. The options shown below are the default settings, which are for the DX Summit 
WebCluster. Another WebCluster can be substituted by filling in the appropriate server, port, and page 
information. 
DO NOT put a Telnet DXCluster URL in the WebCluster Server drop down lixt box.

The Announcements entry no longer works. Two possible substitutes are:

http://dx.qsl.net/propagation/ for North America

or

http://dk0wcy.de/magnetogram/ for Europe.



Packet based DXCluster: For the Packet DXCLuster to work you must have a packet TNC connected 
and configured. This is done by selecting Configure | TNC settings. You can also write a script file to 
connect your TNC to the packet DXCLuster. Then configure the Settings as shown for the Telnet based 
DXCluster below.

Telnet based DXcluster: You can use a Telnet DX cluster by telneting to the cluster and signing on 
manually using View | Telnet Window and clicking Connect. You can then use the Telnet Cluster in the 
Telnet window, or configure the MixW DX Cluster window. Using the MixW DX Cluster window will 
give you the advantages of a formatted display, and the ability to click on a spot and automatically QSY 
the radio (using CAT) to the location and mode of the DX. To configure the MixW DX Cluster window 
for a Telnet or Packet DXCluster, click on the Settings button and DELETE the entry in the server drop 
down box as shown below.
Do NOT put the URL for a Telnet DX Cluster in the server box.

Click the OK button to close the Settings window and the MixW DX Cluster window will show "grey" 
buttons for the Get Web Cluster Page, Send Spot, and Get WWV Page buttons. The two windows below 
show the DX Cluster window and the Telnet windows displaying the same spots. You can then minimize 
either or both of the windows.



DX Cluster Selection Transceiver Setup

Note: This information was found by trial and error and may not be completely accurate.

Remember the frequency being spotted may be well outside the recommended bands.ini setting or your 
personal bands.ini setting. 

Following a click on an entry in the MixW DxCluster window an attempt is made, using CAT control, to 
set the transceiver to the correct frequency and mode. This is not always successful as a number of pieces 
of information from sources other than the DxCluster window are used. The frequency should be correct 
but the mode selected may not be.

The information that may be used is:
• Information in the DX Cluster Info entry 
• Bands.ini file  
• Default CAT Configuration Setting

If the DX Cluster Entry has a recognisible mode in the DxCluster Window Info column then this mode is 
used.
Next MixW will use the frequency to look up a mode in the bands.ini file. If entry in the bands.ini file is 
unambiguous and the DX station is using the mode assigned to the frequency in the bands.ini file the 
mode will most probably be correct. However if there are multiple entries for a particular frequency 
results will be unpredictable. MixW looks at the Preferred frequency column and will use the closest 
value in this (right hand) column to select the mode.
Finally MixW will use the Default Digital Mode as defined in the CAT/PTT configuration menu item.

These are the default entries for the MixW3.1.1h delivered bands.ini file for the 20 metre (14mhz) band.

; 20m band

20m SSB USB 14100 14350 14100 ; Defines the upper band limit
20m CW CW 14000 14350 14010 ;Defines the lower and upper band limits



20m RTTY DEFAULT 14065 14112 14080
20m BPSK31 DEFAULT 14065 14112 14070
20m QPSK31 DEFAULT 14065 14112 14070
20m FSK31 DEFAULT 14065 14112 14070
20m PACKET DEFAULT 14065 14112 14105
20m HELL DEFAULT 14065 14112 14062
20m SSTV USB 14220 14240 14230
20m ALL DEFAULT 14065 14112 14070

For the frequencies 14000 to 14065 and 14112 to 14220 there is no problem. Any entry with a frequency 
in these ranges will be set to the bands.ini setting provided no mode is set in the Info column. However an 
entry for a frequency of 14238 will be set to SSTV.

A frequency of 14072 will be mode BPSK31 as this is the first mode found with the closest preferred 
frequency to the entry frequency.

Try setting your bands.ini file from the Bands.ini file section of these help files.

FAQ
_________________________________________________________

I have changed my call or lost my registration file. 

Send an email to the person you got your original registration file from giving them your old and 
new call signs. 

My Menus do not look like the Menus in MixWHelp. 

MixW has two Menu Layouts.
Go to View | Menu and choose Layout 1. 

I cannot find Olivia, Contestia or RTTYM in my Modes Menu. 

These are "plug in modes". For MixW 2.19 and earlier there must be a dll file for each mode in 
your MixW program folder.
If it is not there go to http://www.mixw.net/ and download it.
For MixW2.2 and later the dll files must be installed in the User Data folder Plugins folder.
To download the dll files:
ensure you have an internet connection
Start MixW and ensure you have menu 1 layout
Select File->Extras->Mode... Click on Select All and then Download
All 3 mode dlls will now be downloaded to the correct location to be accessable to this MixW 
installation. 

MixW will not transmit. 

Your callsign must be entered under Configure | Personal Data.



TX/RX switching via VOX, RTS/DTR, or CAT must be properly configured.
"DSP Filters" must be set to "none" under Configure | Soundcard Settings. 

I can not get out of "Lock" mode. 

In CW: Go to Configure | TRCVR CAT/PTT and click "CW out via soundcard".
In RTTY: Go to Configure | TRCVR CAT/PTT and click "AFSK in place of FSK".
SSTV does not allow tuning on the waterfall. You must use the Tcvr tuning control to adjust the 
signal.
For Olivia, Contestia and RTTYM the lock can be over-ridden by:

Select Menu Modes->Mode settings and tick the Allow Manual Tuning box.
Manual tuning is only suitable for more powerful or multi-core CPUs. 

I have totally goofed up my screen layout. 

In your MixW installation folder, rename the MixW2.ini file to OldMixW2.ini.
Restart MixW and your screen configuration will be set back to the original format.
When you get you screen layout set the way you like it, be sure to backup the MixW2.ini file. 

Changes to my screen layout are lost when I quit MixW. 

In your MixW data folder, right click on the MixW2.ini file then left click on Properties at the 
bottom of the pop up menu. At the bottom of the MixW2.ini Properties dialog are two 
attributes,Read Only and Hidden.
Read-only must NOT have a checkmark in the attribute box. Click OK to close the dialog box. 
Now when you make screen layout changes in MixW the changes will be saved to the MixW2.ini 
file. 

If I shut down MixW during a contest and start up later to continue with the contest I lose my 
sequence numbers and DUPE function. 

When you restart MixW during a contest you must ensure the contest beginning date and time are 
set to the original contest start time. MixW automatically saves the contest settings in the file 
MixContests.ini.

I don't understand how to calibrate my sound card. 

See Sound Card Calibration in the Basic Set Up section of Configuration and Set Up. 

For very slow computers: 

Turn the tuning indicator off by selecting View | Tuning indicator (should be unchecked).
Set the spectrum speed to Slow (under Configure | Soundcard settings).
Set samplerate to 8000 (under Configure | Soundcard settings).



Set DSP filter to none (under Configure | Soundcard settings).
Reduce the height of waterfall. (Use the cursor)
Turn off the average spectrum line (if not in the waterfall mode) (View | Spectrum | Average curve 
| None.

Waterfall seems to move very slowly. 

Set the Spectrum speed (Configure | Souncard settings) to a higher value (x4 is OK).

CAT interface doesn't work. 

Refer to the interface manual and set the RTS and DTR state properly (Configure | TRCVR 
CAT/PTT, and click on the Details button).
Several interfaces require RTS=Always On and/or DTR=Always On. With these transceivers, the 
Hardware Flow Control does not work and should be unchecked.
Make sure the MixW Com port settings match the settings in the transceiver. In particular the 
Baud Rate. Some transceivers have a preset baud rate and they may not match the value assigned 
as a default by MixW.

It's very difficult to tune to MFSK16 signals. 

Right-click at waterfall window and set Zoom to x2 or x3.

Name and QTH of non-US stations are not automatically filled from Radio Amateur Callbook 
(RAC) CD-ROM. 

P.O. Box 2013, Lakewood, NJ 08701, USA - drop them a letter asking why they didn't make the 
non-USA records properly!
But for now, In MixW you can use the drag-and-drop method to copy the name and QTH from the 
Callbook window.

Is there <RESYNC> macro for MT63? 

Two possible solutions:
Position the mouse cursor over the centre of the MT63 signal. Then hold the keyboard shift key 
down and left click with the mouse.
Try to use <REPLAY> or <REPLAY:seconds>. It will resynchronize the receiver and also replay 
the sound history not to loose any information.

Is it possible to export selected QSOs? 

See Printing and Exporting your log file in the Logging and QSLing section of Operation.



I cannot find an ADIF file I have just created. 

If you have created the file using the Search Log->to ADIF function and used the default setting 
in the "Input file name for ADIF export" text box selection carry out the following steps: 

Create a macro <EXT:start cd> and execute it.
This will bring up a CMD window the last line of which shows the absolute path name to 
the directory containing your ADIF file.
Ignore the > character at the end of the line.
This is the path of your MixW data directory.

Is it possible to work PSK having another mode at second receiving channel? 

Yes, right-click a second RX channel window, click Mode... and choose a new mode for this 
window.

When I edit my macros, using the Edit Macro box, I find using copy and paste puts the data in the 
wrong place. 

When using highlight and copy (to clipboard) you must highlight from right to left. Then if you 
want to highlight and overwrite text in the macro this must also be highlighted from right to left.
This problem also occurs in the same way when editing text in the Transmit window.

The frequency display above the Waterfall has changed to AF but the CAT bar is correctly 
tracking my trcvr frequency. 

The most likely problem is the menu View|Spectrum has the Sound setting checked. Select Auto 
for MixW to decide which sideband you are using or check the appropriate setting for your mode 
of operation, either Upper or Lower sideband.

Why doesn't the log frequency date or time update? It worked yesterday. 

The most likely reason is you have gone into manual logging mode. Select View|Log and uncheck 
Manual entry mode.

Where do I find an uncorrupted version of MixW? When I try to download MixW I get a file 
corrupted message. 

You must download MixW on to your hard disc and then run it from there. Do not try to run it 
from the download instructions.

How do I get MixW3.1.1h to run on my Windows98Se machine? 

Unfortunately you can't. MixW3 requires Version 5 of Shell32.dll. Microsoft states Shell32.dll 



version 5 will only run on Windows 2000 systems and later.
By implication this means MixW3 cannot run on any system earlier than Windows 2000.

MixW cannot find file eng.cwt then exits. 

The most likely cause is MixW cannot find your data files.
See MixW Installation section in these Appendices.

For additional help and discussion on using MixW please subscribe to the MixW email reflector by 
following this link:
http://groups.yahoo.com/group/mixw/

File Descriptions
___________________________________________________________

.adi (ADIF) file description and creation

Bands.ini file description

Calls.dat File description

Cty.dat File description

MixW initialisation file

MixW log file

Master.dat file description

Pfx.dat file description

ADIF Files
_________________________________________________________

Files with a suffix .adi should be files created using the Amateur Data Interchange Format.

See The independent ADIF site for up to date information.

MixW2.19 and earlier write the ADIF spec version 1 format but from MixW2.2 the version 2 format is 
used. MixW writes a 5 line header file that indicates it is using ADIF version 1 format what ever version 

http://www.adif.org/
http://groups.yahoo.com/group/mixw/


of MixW is used to create the .adi file.

Because MixW2.19 and earlier uses ADIF V1 this limits the modes that can be written. It would appear 
the MixW team and eQSL team did attempt to allow modes not specifically in the ADIF V1 spec to be 
written to eQSL but this was lost when eQSL updated to V2 spec (and MixW did not). So MixW will not 
log any QPSK QSOs up to MixW2.19.

The only known problem of logging data to eQSL at MixW3.1.1 is mode Contestia in MixW should be 
Contesti in the .adi file. eQSL will reject the record if mode Contestia is input to it. 

.ADI file creation in MixW.

Select the QSOs to be included in the file by using the Search log facility.

Either click on Whole log to display the whole log or fill in the search criteria and click on Display

To to select all QSOs displayed position the cursor over any entry, click the right mouse button to bring 
up a further action window and select all.

If all the displayed QSOs are not required. To make a further selection from the displayed QSOs the 
standard windows selection actions can be used by use of the left mouse button and the Ctrl and Shift 
keys to select the QSOs.



When the selection is made left click on the to ADIF button. This will bring up a file selection box:

If no changes are made the default file MixW2.adi will be saved in the default data directory and will 
overwrite any previous file in this directory with the same name.

The file name and destination maybe changed.

In the example above file all_ut2uz.adi will be saved in the root directory of the C: drive.

The newly created file can be modified by using a text editor (e.g. Change the mode Contestia to 
Contesti) but make sure the ADIF file format specification is adhered to. 

Bands.ini File
_________________________________________________________

Note: this file should be checked after installation to ensure the correct limits are applied to the bands.

The bands.ini file defines the limits of the ham bands MixW will operate in and allows configuration of 
personal choice in frequency and mode selection.

Each line consists of 6 space/tab separated data columns plus an optional comment column. The lines for 
each band are grouped together for readability but do not have to be in any particular order.
A line beginning with a semi-colon is considered a comment line and is ignored. 

The entries are:

Band MixW 
Mode

Tcvr Mode Start fq
khz

End fq
khz

Prefered fq
khz

Comment

Numeric data 
in metres or 
centimetres 
with m or cm 
appended to 
the figure

A mode 
that can be 
selected 
from the 
Modes 
menu.
Can also be 
ALL which 
defines the 
action for 
all other 
modes not 
in this 
band.

A mode that 
appears in the 
Cat Bar drop 
down menu.
Varies between 
manufacturer 
and transceiver 
models.
Can also be 
DEFAULT 
which is the 
Default 
Digimode set 
in the 
Configure|

The lower 
frequency 
within the 
bandplan 
for this 
MixW 
Mode 
within the 
band.

The lowest 
frequency 
in this 
column 
defines the 

The upper 
frequency 
in the 
bandplan 
for this 
MixW 
mode.

The highest 
frequency 
in this 
column 
defines the 

The 
prefered 
frequency 
MixW will 
set when 
switching 
to this band 
using the 
frequency 
drop down 
menu in the 
Cat Bar.

Comments 
are preceded 
by a semi-
colon (;)



TRCVR 
CAT/PTT set 
up menu.

lower band 
limit

upper band 
limit

This is the default entries for the MixW3.1.1h delivered bands.ini file for the 20 metre (14mhz) band.

; 20m band

20m SSB USB 14100 14350 14100 ; Defines the upper band limit
20m CW CW 14000 14350 14010 ;Defines the lower and upper band limits
20m RTTY DEFAULT 14065 14112 14080
20m BPSK31 DEFAULT 14065 14112 14070
20m QPSK31 DEFAULT 14065 14112 14070
20m FSK31 DEFAULT 14065 14112 14070
20m PACKET DEFAULT 14065 14112 14105
20m HELL DEFAULT 14065 14112 14062
20m SSTV USB 14220 14240 14230
20m ALL DEFAULT 14065 14112 14070

There are similar entries for most of the bands.

Adding a band 

To add the 4 metre (70mhz) band to the bands.ini file enter the following lines anywhere in the bands.ini 
file:

; 4m band

4m SSB USB 70000 70500 70000
4m BPSK31 PKTR 70000 70500 70000
4m CW CW 70000 70500 70000
4m FM FM 70200 70500 70300
4m ALL USB 70000 70500 70000

The frequencies are for the UK and the modes are those used for the Yaesu FT450, FT950, FT991, 
FTdx1200, FT2000, FTdx3000, FTdx5000 and FTdx9000.

The entries do not have to be in any order and can be randomly scattered through the file. The 
requirement is they must all be started with the same characters (in this case 4m). The start characters are 
used by MixW at program load time to construct band tables and during normal operation to recognise the 
band from the frequency for use in the <OnEnterxx>, <OnLeavexx> and <BAND> macros.

Setting the Mode

As delivered the digital mode entries in the bands.ini file are set to DEFAULT and this equates to the 
DEFAULT mode in the CAT/PTT settings. Unfortunately the available values are not always suitable for 
the users transceiver (the FT450 for example) and are fixed. The CAT bar also has a drop down menu that 
displays the possible mode settings available for setting the transceiver and this menu is more 
representative of the possible settings available for the selected transceiver.

For more reliable mode selection in the CAT configuration set the Default digi mode to NONE and then 
set all the DEFAULT entries in the bands.ini file to whatever the setting is in the CAT bar menu for the 
transceiver when in each of the digital modes.



calls.dat file
_________________________________________________________ 

cty.dat and pfx.dat files to assist MixW in identifying a country or region

The file consists of single lines of data. The data comprising two colon (:) separated fields: 

UT2UZ: US5U

The left field is a complete callsign and the right field is a prefix for cross reference in the cty.dat or 
pfx.dat files. 

In the above example the call UT2UZ (normally Kiev is shown in the call information below the log) is 
now located in the US5U call area referenced from the pfx.dat file (Kyjivs'ka oblast[KO] will be shown 
instead).

Lines in the file starting with a semi-colon (;) are treated as comments. 

cty.dat File
_________________________________________________________

The cty.dat file is used for Contests to assist in the generation of country multipliers from callsigns. 
MixW also uses the entries to cross reference into the pfx.dat file to obtain possible further country 
information.

Each entry consists of multiple lines of data, the first contains 8 colon/space separated fields, the second 
and subsequent lines, are comma separated fields. The further data lines must start with a space and the 
last line is terminated by a semi-colon. 
The eight fields of the first line are:

Country name:
CQ Zone:
ITU Zone:
Two letter continent:
Latitude: a negative value is South)
Longitude: (a negative value is East. This is the opposite of the data in Personal Data)
Time difference from UTC:
Primary country prefix:

The subsequent lines are any of:
Further prefixes associated with this country
A Prefix or partial call followed by a figure in round brackets. This changes the CQ Zone for this prefix 
or partial call.
A Prefix or partial call followed by a figure in square brackets. This changes the ITU Zone for this prefix 
or partial call.
A prefix or partial call with both round and square bracketed figures. This changes both zones.
Up to MixW3.1.1g A complete callsign to be associated to this country. This call may have round or 
square brackets with it.
At MixW3.1.1h and later a complete callsign preceded by the equals sign to be associated with this 
country. This change has been made as other ham software packages had been written expecting it.



A copy of this file is delivered with the MixW software.

This file is regularly updated to reflect country changes, individual call location changes and other special 
event callsigns. For MixW there are two versions of the file, a version for use up to MixW3.1.1g and 
another version for use with MixW3.1.1h and later.
The version of cty.dat installed and in use by MixW can be identified by entering VERSION as the 
current QSO callsign. The country that is displayed changes for each version.
A release note with the cty.dat file indicates which country will be identified by the VERSION callsign.

The latest version of the file and more information can be found at:
http://www.country-files.com/

There is also a big copy of this file. It will only work with MixW3.1.1h and later. For more information 
on the big cty.dat file see:
http://www.country-files.com/bigcty/index.htm 

Initialisation File
_________________________________________________________

The initialisation file must NOT be a read only file. If it is any changes made during a MixW 
operating session will be lost.

MixW2.ini is the default name given to the file MixW uses at program load time to customise the MixW 
session.

This file is read by MixW at program launch time. It contains most of the data used to configure the 
system at start up.

MixW updates this file at exit time.

The first time MixW is started after installation this file will be created as a skeleton file. Configuration of 
MixW will set up values in the data saved by MixW at exit time pertaining to the current MixW set up.

It is quite permissible to have a number of different MixW initialisation files on your system. MixW2.ini 
is the default name and its default location is in the data files directory of the MixW installation. Prior to 
MixW2.2 the only way to change the MixW2.ini file was to copy a different file into the default MixW 
directory. There are now two ways to use a different MixW2.ini file:

From MixW2.2 on there is a file MixW2Startup.cfg. This file consists of two lines:

[Inifile]
Filename={path_toinifile}\Mixw2.ini 

To change the name and/or the location of the file either:

use a text editor or use the menu File->Save config... (to write the MixW configuration to a new 
file name or location) which brings up a standard windows file selection box or use menu File-
>Load config... (to read the MixW configuration from a different file name or location). If writing 
a file the file will not be written until MixW shutdown but the MixW2Startup.cfg file is changed 
immediately.

or at MixW3.1.1 and later

http://www.country-files.com/bigcty/index.htm
http://www.country-files.com/


a parameter (INI:) at startup can be used to select a different .ini file. 

The file consists of a number of section heading lines enclosed in square brackets followed by individual 
lines that consist of a parameter name followed by an equals character followed by the value assigned to 
the parameter.
A large number of the parameters are of no interest and their names are incomprehensible. The following 
is the Spectrum section from the MixW2.ini file with the System Info section showing the end of the 
Spectrum section:

[Spectrum]
ScaleBkg=0
Width=1
HorizSpectrums=0
Line=4227327
AverageInverted=0
Grid=0
DynRange=80
ScaleColor=16777215
TwoSpectrums=0
Type=3
AverageWidth=1
Sensitivity=2
GridColor=8421504
ShiftPx=0
AverageLine=16776960
Background=0
[System Info]
Data=406d3d0ad723951be440
MixW=3.1.1
System=Microsoft Windows 7 Home Premium ver 6.1 Service Pack 1 (build 7601)

The TwoSpectrums line can be changed by the parameters at MixW load time (see Starting MixW 
Parameters table). This line could also be edited, using a text editor (notepad.exe, wordpad.exe or your 
favourite editor) to change the parameter value to be 0 (one spectrum/waterfall display) or non-zero (two 
spectrum/waterfall displays).

Before starting to edit the MixW2.ini file ensure you have a working copy of your MixW2.ini file. If 
you haven't and make a mistake you will have to restart MixW with no MixW2.ini file which means you 
will have to reconfigure MixW.

There are a number of lines in MixW2.ini that can be changed by text editor to improve MixW useability:

m_iCatDelay=0 in [Cat]

MixW actions the CAT continuosly. As soon as 1 command is finished the next is sent. The value 
is in milliseconds and slows the CAT polling down.

isMinimized=1 in [Window]

If MixW is exited whilst it is minimized. On restart MixW is minimized but when the window is 
restored the Rx, Tx and CAT bars are in the wrong positions and wrong sizes. Either find an 
archive of MixW2.ini with isMinimized=0, use a text editor or script file to remove the line or 
restore the windows after loading.

MaxRxLines=360 in [Misc]



This is the number of lines available for scrolling back in the RX window. It can safetly be 
increased to 3000 if the user needs the extra data to be available.

QrzPage=http://qrz.com/db/ in [WEBCLUSTER]

There are two menus in the log display that have an option to call QRZ.COM to display further 
information about the selected call sign. This line defines the web address that will be called on 
selection of qrz. This address can be changed if required. 

AutoSavePath=C:\radio\mixw311h\AutoSavedPictures in [SSTV]

Defines the directory MixW will use to save SSTV pictures if the Auto Save option is checked.

A number of initialisation lines are described in other sections of these help files:

SSTV Operation section. See this section for a description of what the parameters do and why 
they may be changed.

Log Bar layout section. See this section for a description of what parameters to change to alter the 
Log Bar layout.

Master.dat File
___________________________________________________________

The Master.dat file provides a database of callsigns.

The original and still the main intention is to provide assistance to contesters enabling partial callsigns to 
be recognised or as a check for duplicate QSOs (see http://www.supercheckpartial.com/ for more 
information and to download the master.dta file) However a file has been created with, supposedly, all 
the callsigns held in the qrz.com database. This provides assistance to recognising valid callsigns and 
looking for pirates. 

The master.dat file consists of entries of just a callsign separated by a single NULL (hexadecimal 00) 
character.

MixW however can process and successfully use a file where the callsigns are separated by other 
separator characters, or character sequences. These include the space character, the carriage 
return/linefeed combination and tab character.

The master.dat file can be created locally by the user or the file master.dta downloaded from 
http://www.supercheckpartial.com/. The downloaded file, master.dta, must be renamed master.dat and 
checked to ensure it is not a blocked file. 

A blocked file can be identified by opening Windows Explorer, selecting the file and right 
clicking. Select properties from the drop down menu. If a button marked Unblock is visible in the 
Attributes section of the properties display box this file is blocked. Left click on the Unblock 
button and then click on OK to unblock the file. 

Warning: 

As the size of the Master.dat file increases the longer it takes to load. The method of electing to use 
Master.dat is to select menu View|Quick search>Use master file. Once this selection is made MixW now 
reads in the master.dat file, which must be loaded in the default data directory. During the read file 

http://www.supercheckpartial.com/
http://www.supercheckpartial.com/


process MixW will not respond to any other commands. Thus the longer it takes to read the file the longer 
MixW appears frozen, or to have crashed. To read a 10mb file takes at least 7 minutes on a modern fast 
PC. The number of processor cores is immaterial. 

Log Files
_________________________________________________________

MixW creates a log file as part of its initial set up. The default file name is MixW2.log, the default format 
is csv and the default location is in the data files directory of MixW.

Up to MixW2.19 the only format was CSV. However since MixW2.2 four formats are offered CSV, 
MDB (Microsoft Access Database file), MYSQL (MySQL file) or Web based.

MixW2 csv log contains a number of lines, each of which contains 26 semi-colon (;) separated fields.

A number has been assigned to each position for reference. It does not appear in the log data. 

Posn Field Description Custom1.d
at Field 
Ref no.

1 MYCALL As in <MYCALL> macro.  

2 CALL As in <CALL> macro. 6

3 Date/Time A combined date and time. Set when CALL field populated or 
when <SETTIME> macro executed. Time is as per the UTC 
setting (UTC or local).

4 5

4 Duration A value in seconds from when the Date/Time field was set to 
the time the QSO is saved.

*

5 QSLS Date QSL Sent.  

6 QSLR Date QSL received.  

7 RXFQ The receiver QSO frequency (includes any offset on the 
waterfall).

2

8 TXFQ The transmitter QSO frequency if different from the RXFQ. 0 
if no difference.

3

9 DxPfx The corrected country for the callsign if it has been changed in 
the Edit QSO box.

 



10 MODE As in <MODE> macro 1

11 RSTS As in <RSTS> macro. 7

12 RSTR As in <RSTR> macro. 9

13 NRS As in <NRS> macro. 8

14 NRR As in <NRR> macro. 10

15 NAME As in <NAME> macro. 11

16 QTH As in <QTH> macro. 12

17 NOTES As in <NOTES> macro. 13

18 DOMAIN The Domain field in the Edit QSO box. 14

19 MANAGER The Manager field in the Edit QSO box. 17

20 COUNTY The County field in the Edit QSO box. 15

21 IOTA The IOTA field in the Edit QSO box. 16

22 LOC As in <LOC> macro. 20

23 QSL MSG The QSL Msg field in the Edit QSO box. This field is the field 
displayed by eQSLs.

 

24 eQSLS The date an EQSL is logged as being sent.  

25 eQSLR The date an EQSL is logged as being received.   

26 CUSTOM The Custom field in the Edit QSO box.  

Field 4 Note: The duration field is used with the Date/Time field to calculate the log displayed End Date 
and End Time fields (18 & 19 in Custom1/2.dat) in the log displayed in the Mixw main window.

The MDB and MYSQL versions of the log file, default names MixW2.mdb or MixW2.sql contains an 
enhanced number of fields.



To run the MYSQL database it is necessary to be able to log into a system running MYSQL. This can be 
on the local pc or a remote system.

The default database files can be found in:
for XP:
    c:\documents and settings\all users\mixw
for Vista, Windows 7, Windows 8 and Windows 10 a linked folder:
    c:\program data\mixw
    c:\users\all users\mixw

Note: a linked folder means a change to the contents of any of the folders is reflected through to the other 
linked folders.

MDB and SQL fields: 

Posn Field Description Custom1.d
at Field 
Ref no.

1 QSO_ID QSO number in this log.  

2 MyCall As in <MYCALL> macro.  

3 Call As in <CALL> macro. 6

4 StartTime Set when CALL field populated or when <SETTIME> macro 
executed. Time is as per the UTC setting (UTC or local).

4 5

5 EndTime Set when the QSO is saved.. 18 19

6 QslSent Date QSL sent.  

7 QslRcvd Date QSL received.  

8 FqRx The receiver QSO frequency (includes any offset on the 
waterfall).

2

9 FqTx The transmitter QSO frequency. 3

10 DxPfx The corrected country for the callsign if it has been changed in 
the Edit QSO box.

 

11 Mode As in <MODE> macro 1

12 RstSent As in <RSTS> macro. 7



13 RstRcvd As in <RSTR> macro. 9

14 ExchgSent As in <NRS> macro. 8

15 ExchgRcvd As in <NRR> macro. 10

16 Name As in <NAME> macro. 11

17 QTH As in <QTH> macro. 12

18 Info As in <NOTES> macro. 13

19 Dom The Domain field in the Edit QSO box. 14

20 QslTo The Manager field in the Edit QSO box. 17

21 County The County field in the Edit QSO box. 15

22 Iota The IOTA field in the Edit QSO box. 16

23 WWLoc As in <LOC> macro. 20

24 QslInfo QSL Message field.  

25 EQslSent The date an eQSL was sent.   

26 EQslRcvd The date an eQSL was received.  

27 Custom The Custom field in the Edit QSO box.  

28 ITUZ ITU Zone.  

29 CQZ CQ Zone.  

30 Country Country name.  

31 CONT Two letter continent (as found in the cty.dat file).  



To change the log between formats, before making any changes to the log name or type export all the 
QSOs you want in the new log to an ADIF file. Then after changing the log file type in menu Configure|
Personal Details import the ADIF file you just created into the new log file.

Note
• MixW does not automatically copy QSOs between log file types.
• The ADIF file transfer does not copy the Custom, DxPfx, QslInfo or eQSL Sent/Rcvd fields. 

pfx.dat
_________________________________________________________

The pfx.dat file provides further information about the current QSO call sign prefix. This information 
supplements the information in cty.dat.

The file format is similar to the cty.dat format.

Each entry consists of multiple lines of data, the first contains 8 colon/space separated fields, the second 
and subsequent lines, are comma separated further data pertaining to the country prefix. The further data 
lines must start with a space and the last line is terminated by a semi-colon. The eight fields of the first 
line are:

Additional Name:
CQ Zone:
ITU Zone:
Two letter continent:
Latitude: (-ve is South)
Longitude: (-ve is East. This is the opposite of the data in Personal Data)
Time difference from UTC:
Primary country prefix:

The subsequent lines are callsign or partial callsigns to be associated with the first line data.
The partial callsigns will contain wildcards. ? for a single character and * to the end of the call

This file is delivered with the MixW software. It will be updated if the QSO details,Change button, 
Change Rule sequence is entered and a new call area is added. When a change is being written MixW 
displays a warning message box.



HF Digital Modes Band Plan
_________________________________________________________

General HF Digital Band Plan
There is little consensus right now on which modes are acceptable in certain portions of the digital mode 
sub-bands. The influx of new digital modes and operators is not welcome by some. Please make every 
effort to avoid interference with other modes.

To see the official band plans for all three IARU Regions see: 

http://www.iaru-r2.org/hf_e.htm

The ARRL maintains "The Considerate Operator's Frequency Guide" for the United States at: 

http://www.arrl.org/considerate-operator

In order to keep up with some of the current ideas you could join the email reflector at: 

http://groups.yahoo.com/group/DigiMode_HF_Band_Plans/

Common Operating Frequencies for Specific Digital Modes
Specific frequencies for the digital modes change often as new modes are introduced, and general purpose 
lists are frequently out of date or incorrect. Your best bet is usually to search the Yahoo discussion groups 
for "digital radio" or the specific mode you are interested in. By joining the discussion groups and 
"reading the mail" for a few weeks you will usually see questions and answers about the best places to 
find a particular mode. A good place to start is:

http://groups.yahoo.com/group/digitalradio/

Keyboard Shortcuts
_________________________________________________________

These key combinations are for MixW3.1 and later.

Standard Windows Edit Key Combinations used by MixW

Ctrl-A - Select All
Ctrl-C - Copy
Ctrl-P - Print
Ctrl-V - Paste
Ctrl-X - Cut
Ctrl-Z - Undo
Home - Go to the start of the line
End - Go to the end of the line
Shift-Home - Highlight text from cursor position to the start of the line
Shift-End - Highlight text from the cursor position to the end of the line

Ctrl Key combinations used by MixW

Ctrl-S - Swap Windows

http://groups.yahoo.com/group/digitalradio/
http://groups.yahoo.com/group/DigiMode_HF_Band_Plans/
http://www.arrl.org/considerate-operator
http://www.iaru-r2.org/hf_e.htm


Ctrl-I - Insert tab character into the TX Window at the cursor position.
     If cursor is not in the TX Window move the cursor to the TX Window.
Ctrl-> - Increase Audio Frequency by 10hz
Ctrl-< - Decrease Audio Frequency by 10hz

Ctrl-Shift-P - Add QSO to the Print Queue

Ctrl-Alt-c - In Packet mode initiate Connect Dialogue.

Ctrl-1 to Ctrl-0 are used to write the current Mode/Frequency to Memory locations 1-10
Ctrl-Shift-1 to Ctrl-Shift-0 write the current Mode/Frequency to Memory locations 11-20

Alt Key Combinations used by MixW

Alt-A - Start Auto CQ
Alt-D - Show QSO details from the currently selected Log Bar window entry
Alt-E - If Log is displayed from the Search Dialogue: Edit currently selected QSO in the Log display
     If log is not displayed: Show Edit Menu.
Alt-F - Set Frequency from CAT Bar
Alt-H - Show Help Menu
Alt-I - Show File Menu
Alt-M - Show Mode Menu
Alt-O - Clear QSO data
Alt-P - Show Options Menu
Alt-Q - Toggle display of DX Cluster Window On/Off
Alt-R - Display Search in Log dialogue box
Alt-S - Save current QSO
Alt-T - Toggle display of Telnet Window on/off
Alt-U - Show Configure Menu
Alt-V - Show View Menu
Alt-W - Toggle between Spectrum and Waterfall display
Alt-X - Go to Transmit
Alt-Z - Toggle between Transmit and Receive
Alt-> - Increase Audio Frequency by 1hz
Alt-< - Decrease Audio Frequency by 1hz

Alt-1 to Alt-0 are used to read the stored Memory locations 1-10
Alt-Shift-1 to Alt-Shift-0 read Memory locations 11-20

Other Keys used by MixW

Pause/Break - Toggle between Transmit and Receive
Esc - Puts MixW into Receive
Tab - Moves cursor between the TX Window and last used Log Bar position.

Macro Keys

The keys F1 to F12 select one of 12 Macros. The Ctrl, Shift and Ctrl-Shift keys are used in combination 
with the 12 function keys to give further 12 key selections of macros.

The maths keys Ins, Gray/, Gray*, Gray+ and Gray- give a further 5 macros.

This gives a total of 53 macros available at any one time.

If the keyboard has Multimedia keys these keys may be programmed with further macro commands. 



Macro Commands
_________________________________________________________ 

A WARNING

If an attempt is made to use a text editor to edit the raw macro files it is possible Windows will 'corrupt' 
the file when it is written back. This will occur if a 'special' character (eg the temperature degree symbol) 
is included in a macro text. Some text editors write the data back and include special characters at the 
start of the file to identify there are special characters in the text, invisible to a text editor but confusing to 
MixW and the default macro set is now appended to the back of the macro file and the user has 'lost' their 
macros.

REMEMBER BACK UP ALL YOUR MACRO FILES.

The following Macro commands are available in MixW:

Text

<CALL> - Insert the callsign of other station as in log
<NAME> - Insert the name of the other station operator as in log
<QTH> - Insert the QTH of the other station as in log
<WWLOC> - Insert the station locator
<RSTR> - Insert received RST
<RSTS> - Insert sent RST
<NOTES> - Insert the Notes field as in the log
<NRR> - Insert Exchange received
<NRS> - Insert Exchange to send
<DATE> - Insert the current date
<TIME> - Insert the current UTC time
<LOCALTIME> - Insert current local time
<STARTTIME> - Insert QSO start time
<CTIME> - Insert time in HHMM format
<MYCALL> - Insert your callsign as configured in Personal Data
<MYMAINCALL> - Insert your callsign without /P etc
<MYNAME> - Insert your name as configured in Personal Data
<MYQTH> - Insert your QTH as configured in Personal Data
<MYWWLOC> - Insert your locator configured in Personal Data
<PREVCALL> - Insert other station Callsign of last QSO saved
<PREVCTIME> - Insert <CTIME> of last contest QSO saved
<PREVNAME> - Insert other station Name of last QSO saved
<PREVNRR> - Insert Exchange received of last QSO saved
<PREVNRS> - Insert Exchange sent of last QSO saved
<PREVQTH> - Insert other station QTH of last QSO saved
<PREVRSTR> - Insert received RST of last QSO saved
<PREVRSTS> - Insert sent RST of last QSO saved
<SELCALL> - Insert other station Callsign of selected logged QSO
<SELNAME> - Insert other station Name of selected logged QSO
<SELNRR> - Insert Exchange received of selected logged QSO
<SELNRS> - Insert Exchange sent of selected logged QSO
<SELQTH> - Insert other station QTH of selected logged QSO
<SELRSTR> - Insert received RST of selected logged QSO
<SELRSTS> - Insert sent RST of selected logged QSO
<CR> - Insert Carriage Return
<CRLF> - Insert Carriage Return then Line Feed
<LF> - Insert Linefeed



<CTRL-x> - Insert Ctrl-A - Ctrl-Z (as defined by x)
<TAB> - Insert tab symbol (same as tab key)
<[> - Insert < character
<]> - Insert > character
<GA> - Insert GM GA or GE depending on time at Call station
<GAL> - As <GA> but use long phrase (Good Morning, Afternoon or Evening)
<IMD> - Insert the current IMD if IMD is fixed on the statusbar
<KHZ> - Insert current frequency in Khz
<KHZ:n> - Insert current frequency in Khz to n decimal places
<MHZ> - Insert current frequency in Mhz
<MHZ:n> - Insert current frequency in Mhz to n decimal places
<BAND> - Insert current Band
<MODE> - Insert current mode
<QSOBEFOREDATE> - Insert previous QSO for this band and mode date
<QSOBEFORETIME> - Insert previous QSO for this band and mode time
<ANYQSOBEFOREDATE> - Insert date of last QSO with this call
<ANYQSOBEFORETIME> - Insert time of last QSO with this call
<ANYQSOBEFOREBAND> - Insert band of last QSO with this call
<ANYQSOBEFOREMODE> - Insert mode of last QSO with this call
<QSONR:BAND> - Insert this band QSO number
<QSONR:MODE> - Insert this mode QSO number
<QSONR> - Insert this QSO number
<TXTIME> - Insert the elapsed time of transmission of the previous message
<WX> - Insert weather data as input with <WX?>
<MILES> - Insert distance in miles
<DIST> - Insert Distance in km
<AZ> - Insert azimuth
<CWID> - Insert CWID
<CWID:DEFAULT> - Set CWID as defined in Personal Data
<CWID:text> - Set CWID to text
<FILE> - Insert contents of file (opens file selection dialogue)
<FILE:filename> - Insert contents of filename
<TEXTFILE> - Insert text from file (opens file selection dialogue)
<TEXTFILE:filename> - Insert text from file filename
<RANDOM:filename> - Insert random string from a file. Designed to simulate live typing
<INIFILE:file,section,name> - Insert data from inifile
     file FILE, section [SECTION], name Name=
<VER> - Insert Version Number

Program

<TX> - Switch to TX mode immediately
<TXE> - Switch to TX mode when the RX carrier drops
<TXTOGGLE> - Toggle between TX and RX
<RX> - Switch to RX when encountered in the TX data stream
<RXANDCLEAR> - Switch to RX when encountered in the TX data stream and clear TX window
<RXC> - Same as <RXANDCLEAR>
<RXE> - Switch to RX mode when all TX data is transmitted
<ACALL> - Allows call changing on the fly

The Call in the log maybe changed at any time up to the start of transmission of the call.

<CLEARQSO> - Erase the data in the current QSO line
<CLEARRXWINDOW> - Clear RX window



<CLEARTXWINDOW> - Clear TX window
<CLEARWINDOW> - Clear current window
<CURSOR:n> - Position cursor at field n of the log file
<CURSOR:TX> - Position the cursor in the TX window
<DTMF:abcd> - Send DTMF sequence
<ESCAPE> - Same as escape key
<EXEC:program> - Execute a program and continue
<EXT:command> - Run an external program or command and wait until the action terminates
<FILTER:name> - Turn filter on
     Filters available are NONE, PASS, NOTCH, NOISE
<FIXSTARTTIME> - Set current time as QSO start time in log
<GRABCALL> - Grabs calls from stack
<LASTCALL> - Grabs the last call received
<SHOW:name> - Show Toolbar
<HIDE:name> - Hide Toolbar
<TOGGLE:name> - Toggle Toolbar
     The following toolbars can be controlled
     by the SHOW, HIDE and TOGGLE Macros:
     CONTROLBAR, LOGBAR, CATBAR, TUNINGBAR,
     TNC, WORLDMAP, QSOMETER, QSO statistic
     STATUSBAR, DXCLUSTER, CALLBOOK,
     BEACONS, TELNET, CONTESTSTATS, QUICKSEARCH
<INPUTVOLUME> - Set the soundcard input volume using the Windows Volume Control
<OUTPUTVOLUME> - Set the soundcard output volume using the Windows Volume Control
     There maybe problems with <INPUTVOLUME>
     and <OUTPUTVOLUME> in the latest windows versions
<MARKERS:xx,yy,...> - Add marker lines to the waterfall/spectrum at xx,yy etc (up to 5) fq
<MARKERS:OFF> - Remove all marker lines
<MODE:mode> - Set mode to MixW mode
<MODEADD:mode> - Set mode to additional mode
<MODETNC:mode> - Set mode to TNC mode
<NEWRXWINDOW:audiofq:mode> - Create RX mode window at audiofq
<NEWRXWINDOW:audiofq> - Create RX current mode window at audiofq
<NEWRXWINDOW> - Create new RX window in current mode and fq
<NEWRXWINDOW2:audiofq:mode> - Create RX mode window at audiofq
<NEWRXWINDOW2:audiofq> - Create RX current mode window at audiofq
<NEWRXWINDOW2> - Create new RX window in current mode and fq
     The NEWRXWINDOW2 Macros are for use with the
     dual channel Waterfall/Spectrum only.
<CLOSERXWINDOWS> - Closes all secondary RX Windows
<PTTOFF> - Switch PTT off
<PTTON> - Switch PTT on
<PTTSWITCH> - Toggle the PTT
<BEEP:OFF> - Turn the PC Beep off
<BEEP:ON> - Sound the PC Beep
<SAVEQSO> - Save QSO data. Make sure this macro comes before any 'Clear' macros.
<SCRIPT:filename> - Run script from filename
<ASSCRIPT> - Run following text as a script file
<TELNETSCRIPT:filename> - Run filename as telnet script
<TNCSCRIPT:filename> - Run script for 2nd TNC from filename
<SEEKLEFT> - Initiate a seek left
<SEEKRIGHT> - Initiate a seek right
<SENDEQSL> - Sendcurrent QSO to eQSL. Prompts for password.
     This macro must come before a SAVEQSO or any 'Clear' macros.
<SENDEQSLNP> - Sendcurrent QSO to eQSL with no prompt.
     Same restrictions as <SENDEQSL>



<QSLPRINT> - Addcurrent QSO to the QSL print queue.
     Same restrictions as<SENDEQSL>
     Use QSLprint to print card or label
<REPLAY> - Replay the sound history
<REPLAY:n> - Replay n seconds of the sound history
<STARTRECORD> - Start a wav recording
<STARTRECORD:filename> - Start wav recording to filename
<STARTRECORD:filename.mp3> - Start mp3 recording to filename (requires lame_enc.dll)
<STARTRECORD2> - Start wav recording from 2nd Spectrum/Waterfall
<STOPRECORD> - Stop recording
<SAVESH> - Save the last 40 seconds of sound history.
     Brings up file selection dialogue box. 
<SAVESHAUTO> - Save the last 40 seconds of sound history. 
     To a file with a name of the format shYYMMDDHHMISS.wav
<WAVE:filename> - Play filename as a .wav file
<RXLOGSTART> - Start RXLog (opens RXLog file select dialogue)
<RXLOGSTART:filename> - Start RXLog using filename
<RXLOGSTOP> - Stop RXLog
<SNAPNOW> - Do snap now
<STARTSCAN> - Starts the scan feature
<STOPSCAN> - Stops the scan feature
<TOGGLECATPORT> - Toggle the CAT port Enable/Disable
<TOGGLEPTTPORT> - Toggle the PTT port Enable/Disable
<TOGGLESOUNDDEV> - Toggle the sound device Enable/Disable
<TUNE> - Send a tuning signal (ESC key aborts)
<TUNE:nn> - Send a tune signal for nn seconds
<WKDIGNOREBEFORE:date time> - QSO is ignored before specified time
<WKDPERIOD:nn> - QSO is ignored until nnn minutes has elapsed
<CAPITALSONLY:x> - Switch capitals only (x = 1 on, x = 0 off)
<WORDMODE:x> - Switch word mode (x = 1 on, x = 0 off)
<SHOW:RIGEXPERTS> - Display Rigexpert devices connected to PC
<YAPPRECV> - YAPP receive
<YAPPSEND:filename> - YAPP send filename
<YAPPSEND> - YAPP send
<ALERT:text> - Display message box with text. Need to action OK to continue
<SENDSPOT> - Send spot to DX cluster if DX cluster is open
<GOOGLEEARTH:<SELCALL>> - Display map position of selected logged QSO call
<GOOGLEEARTH:<CALL>> - Display map position of current QSO call
<LANG_> - Change name of a macro depending on current callsign

Frequency

<FQ:fq_in_kHz> - Set the transceiver frequency (use +/- for relative change)
<FQB:fq_in_kHz> - Set the transceiver VFO B frequency
<ZFQ:fq_in_kHz> - Set the transceiver zero-beat frequency (use +/- for relative change)
<JUMPTOTXFQ> - RX frequency jumps to TX frequency
<ALIGN:fq_in_Hz> - Aligns on the specified audio frequency
<AUDIOFQ:fq_in_Hz> - Sets the audio frequency (use +/- for relative change)
<BOOKMARK> - Toggles the Bookmark on/off
<BMERASE> - Clears all marks on this frequency
<CATCMD:text_command> - Sends the text command to the transceiver
<CATCMDDDE:text_command> - Sends text via DDE
<CATCMDHEX:hex_command> - Sends the hex command to the transceiver
<CATENABLEVFOSYNC> - Enable VFO sync
<CATDISABLEVFOSYNC> - Disable VFO sync



<CATVFOSYNCSHIFT:shift> - Set VFO B to VFO A +/- shift value.
     Use <CATDISABLEVFOSYNC>to stop this command.
<CATVFOSYNCONCE:fq> - Set VFOB to fq khz (use +/- for relative change)
<CATTRANSVERTER:(+/-)shift_in_hz> - Allows working with different Transverters
<CATWAIT:ms> - CAT delay in ms
<SPSHIFT:fq_in_Hz> - Sets the spectrum or waterfall shift
<SPZOOM:n> - Set the spectrum or waterfall zoom (0.5, 1, 2, 3, 4 are available)
<SCROLLLOCK:ON> - SETSCROLLLOCK On.
<SCROLLLOCK:OFF> - SETSCROLLOK Off
<SCROLLLOCK:TOGGLE> - Toggle SCROLLLOCK
     SCROLLLOCK when On causes the waterfall frequency marker to stay fixed
     to a transceiver frequency.
     When Off the marker stays with the MixW audio frequency.
<MEMW:n> - Save certain settings to memory number n (1-20)
<MEMR:n> - Restore settings from memory number n
<SPLIT:1> - Put the transceiver into split mode working
<SPLIT:0> - Restore the transceiver to single frequency working

Macros

<MACROS:filename> - Load macros from filename
     filename will be used as default macros (instead of MixMacros.ini)
<MODEMACROS:filename> - Load macros from filename for this mode
     This macro sets filename to store macros for this mode
<EDITMACRO:name> - Edit macro with specified name
     This command brings Edit User Macro dialogue
     This command can be used to edit Event macros
<HIDETEXT> - Don't show Macro text in window
<SHOWTEXT> - Show Macro text in window
<ONQSOBEFORE:name> - Run Macro name if QSO before
<QSOCMDDDE:command> - DDE command to external program
<WX?> - Enter weather data that will be recalled by the <WX> macro

Mode

<AFCON> - Switches AFC On
<AFCOFF> - Switches AFC Off. See <LOCKRX> below
<AFC> - Toggle AFC
<INVON> - Turns invert on
<INVOFF> - Turns invert off
<INV> - Toggle invert
<SNAPON> - SwitchesSnap on
<SNAPOFF> - Switches Snap Off
<SNAP> - Toggle Snap
<SQUELCHON> - Switches squelch on
<SQUELCHOFF> - Switches squelch off
<SQUELCH> - Toggle squelch
<LOCKRX> - Lock RX Frequency. Turns waterfall flag blue
     Does not inhibit AFC. RX fq may still wander
<LOCKRXTOGGLE> - Toggle Lock RX
<UNLOCKRX> - Unlock RX Frequency
<LOCKTX> - Lock TX Frequency. Turns waterfall flag red
<LOCKTXTOGGLE> - Toggle Lock TX



<UNLOCKTX> - Unlock the TX Frequency
<MODESETTINGS> - Displays mode settings dialogue box
<THRESHOLD> - Displays the Squelch dialog box

Auto CQ

<ACQ> - Pause and restores AutoCQ mode
<ACQDELAY> - Set the AUTOCQ delay
<ALARM:string> - Beeps when string is received but see <OnAlarm> event macro
<ASAUTOCQ> - Initiate the following string as AUTOCQ
<AUTOCQ> - Initiates the auto CQ routine as set under Options | AutoCQ
<AUTOCQRESUME> - Resume an interrupted AUTOCQ

Contest

<SP:0> - Run mode on (also <SP0>)
<SP:1> - Search and pounce mode on (also <SP1>)
<SP> - Switch to Run mode (same as SP:0)
<S/P> - Toggle between Search and Pounce and Run
<OnSP0> - Execute when switch to Run mode
<OnSP1> - Execute when switch to Search and Pounce mode
<STATS:GENERATEQTC> - Send 10 QTCs
<STATS:REPEATQTC> - Repeat the same 10 QTCs
<CLEARNRR> - Clear the NRR received field
<INCNRR> - Increment the NRR field if it is an integer
<INT> - Action depends on S&P or Run mode and content of CALL and NRR fields
<INTELIGENT> - Same as <INT>
<INTQRL> - Called in S&P mode when Call is empty
<INTDE> - Called in S&P mode with a new call but NRR empty
<INTQSL> - Called in S&P mode with a new call and NRR complete
<INTCQ> - Called in Run mode when Call is empty
<INTGA> - Called in Run mode with a new call but NRR empty
<INTQB4> - Called in Run mode with a previous QSO call
<INTQRZ> - Called in Run mode with new call and NRR complete
<INTAGNCALL> - Request call sign again
<INTAGNNR> - Request exchange again

Rotor

<ROTOR:LP> - Turn rotor to the Long Path for the station in the <CALL> field
<ROTOR:SP> - Turn rotor to the Short Path for the station in the <CALL> field
<ROTOR:n> - Turn rotor to the specified azimuth using n
<ROTORCMD:command> - Send command to the rotor port
<ROTORCMDHEX:command> - Send hexadecimal command to the rotor port

CW

<LANGUAGE:xxx> - Select language
     A language must have a corresponding xxx.cwt file
<FORCELANGUAGE:xxx> - Force receiving as xxx



<WPM:-n> - Decrease the CW speed by n
<WPM:+n> - Increase the CW speed by n
<WPM:n> - Set the CW speed to n
<WPM:RX> - Match the TX speed to the RX speed
<WKHEX:hex command> - Send hex command to WinKey
<WKTEXT:text> - Send text to WinKey
<WKPOT> - Enable WinKey pot
<WKNOPOT> - Disable WinKey pot

Hell

<SET FILTER:width_in_hz> - Set filter width
<SET FONT:n> - Set the font to n
<SET RXFQ:fq_in_hz> - Set the RX frequency
<SET SCALE:n> - Set the scale
<SET SUBMODE:submode> - Set the Hell submode (FELD, FM105, FM245)
<SET TXFQ:fq_in_hz> - Set the TX frequency

MFSK

<PIC:filename 00> - Sends filename in high resolution black and white
<PIC:filename %C> - Sends filename in high resolution colour
<PIC?N> - Same as selecting File->Send Picture->B/W..
     opens dialog box to select picture file, sends in black and white
<PIC?N%C> - Same as selecting File->Send Picture-> Colour...
     opens dialog box to select picture file, sends in colour

Olivia

<GET OFFSET> - Get frequency offset
<GET RATE> - Get sample rate difference
<GET SN> - Get s/n ratio
<SET BW:n> - Set bandwidth in hz
<SET TONES:n> - Set number of tones

Contestia

<SET BW:n> - Set bandwidth in hz
<SET TONES:n> - Set number of tones

RTTYM

<GET SN> - Get s/n ratio
<SET BW:n> - Set bandwidth in hz
<SET TONES:n> - Set number of tones

RTTY



<LETTERS> - Forces letters
<NUMBERS> - Forces numbers
<SHIFT:shift_in_Hz> - Sets the RTTY shift in Hz
<BAUDRATE:baudrate> - Sets the baudrate

SSTV

<FONTBOLD:n> - Set font bold (n=1 on, n=0 off)
<FONTCOLOR:n> - Set font color
<FONTFACE:name> - Set the font face name
<FONTITALIC:n> - Set font italic (n=1 on, n=0 off)
<FONTSIZE:n> - Set the font size
<FROMCLIP> - Load picture from clipboard
<LIMITSCANLINES:n> - Send only n lines
<LOADPICTURE:filename> - Load picture with header
<LOADPICTUREONLY:filename> - Load picture only
<LOCKMODE> - Lock the SSTV mode
<PLACETEXT:x:y:text> - Place text at position x,y
<PLACETEXT:x:y> - Place cursor at position x,y
<PUTHEADER:filename> - Put filename header file
<PUTRXPICT:x0:y0:x1:y1> - Put received picture into the specified rectangle
<TEXTSTYLE:n> - Set current text style
<UNLOCKMODE> - Unlock current SSTV mode

Event

<OnAlarm> - Execute after an <ALARM> event. Beep is cancelled
<OnOpenTelnetWindow> - Execute after open of Telnet window
<OnCloseTelnetWindow> - Execute after close of Telnet window
<OnOpenTNCWindow> - Execute after open of TNC window
<OnCloseTNCWindow> - Execute after close of TNC window
<OnCRm> - Execute when Enter is pressed with focus in log field m
<OnCR> - Execute when focus in log (also see <INT>)
<OnSpace> - Execute when focus in call field and space bar is pressed
<OnSpaceTXW> - Execute when focus is RX/TX/Waterfall area and space bar is pressed
<OnStartMixW> - Execute when MixW starts
<OnEndMixW> - Execute during close of MixW
<OnStartMode> - Execute when mode is entered
<OnEndMode> - Execute on leaving current mode
<OnEnter#> - Execute when band# is entered (set in bands.ini file)
<OnLeave#> - Execute when band# is exited (set in bands.ini file)
<OnGrabCall> - Executed when call has been received (<GRABCALL> retrieves it)
<OnGrabCallTx> - Execute when call is grabbed from keyer
<OnGrabNumber> - Execute when (serial) number is grabbed
<OnSaveQSO> - Execute when QSO is saved
<OnRemoveQSO> - Execute when QSO is removed
<OnRX> - Execute when RX is initiated
<OnTX> - Execute when TX is initiated
<OnEscape> - Execute when Escape key pressed
<OM> - Execute if <NAME> is called and Name field in the log is empty
<OnAPPCommandxx> - Execute when multimedia key xx is pressed
<OnClickAny> - Execute when any of the selectable fields is transfered to the log
<OnClickCall>; - Execute when the CALL is transfered to the log
<OnClickLoc> - Execute when the Locator is transfered to the log



<OnClickName> - Execute when the Name is transfered to the log
<OnClickNr> - Execute when the Number is transfered to the log
<OnClickQth> - Execute when the QTH is transfered to the log
<OnClickRst>; - Execute when the received RST is transfered to the log

Single/Double clicking the fields in the RX Window transfers them to the log. When this method is used 
to populate the log field the appropriate OnClick macro is executed

Further explanation on the use of some of MixW's special Macro commands:

OnEnter# If, for example, you had a set of MARS macros defined in a file named MARS.mc, and you 
were working MARS in the 150 meter band, you would first define the 150m band in the bands.ini file, 
and then you could define the macro OnEnter150m as <MACROS:MARS.mc>.

OnCRm This macro tells MixW what to do if CR is pressed while focus is in the log in field m. If m is 
omitted it applies to any field. This macro is specified in the default macros dialog. Use with 
<CURSOR:n> macro to move the cursor to field n in the log.
Example: After entering Call (field 5) and hitting Enter you want the cursor to jump to the field Rx 
Exchange (field 9) then declare the macro OnCR5 as <CURSOR:9>.

CWID: To add a CW ID to the default signoff macro you must first define it under Personal Data. Select 
Configure | Personal Data. This brings up the personal data window. Check the "use CWID" box and then 
enter your sign off CW ID text, then uncheck this box to avoid sending the CWID when you don't want 
too. Next add <CWID> to the end of the macro, such as, 73 <CALL> DE <MYCALL> SK<CWID>. Of 
course, <CWID> can also be assigned to a separate function key, as can <TIME> and <DATE>, but 
MixW's log also logs the time and date automatically. If you use CW ID, keep in mind that while it is 
executing, the other station is printing only garbage. For that reason, you might want to use CW ID only 
at the end of your signoff macro.

AUTOCQ:
Auto CQ is a very handy Macro that enables you to transmit a predetermined CQ sequence at regular 
intervals. It will stop automatically when a call sign is received (indicating that your CQ has been 
answered). AutoCQ must first be configured by selecting Options | Auto CQ | Text. It can then be 
configured just like any other Macro by using the following dialog box:

When you're done configuring this click OK to save it. Then select options | Auto CQ | Delay, which 
brings up the following box:



Enter the delay in seconds you want between your AutoCQ transmissions. Next simply assign 
<AUTOCQ> to one of your Macro Keys as any other Macro.

You can initiate AutoCQ in three ways: Click on the button you have assigned it to, depress the key you 
have assigned it to, or select Options | Auto CQ | Start. You will see the AutoCQ indication box appear 
above your cursor in the spectrum or waterfall display. AutoCQ will cycle until a call sign is received in 
the RX window, when it will automatically stop (MixW knows that your CQ has been answered!). You 
can manually stop AutoCQ by depressing the Escape Key, or by Selecting Options | Auto CQ | Stop.

By selecting Options | Auto CQ | and Watch squelch, AutoCQ will then only operate when your RX is 
squelched, thereby avoiding accidentally transmitting over the top of an existing QSO.

<ASAUTOCQ>
Using this Macro command at the beginning of any Macro string will define it as the new AutoCQ text 
and commence to AutoCQ with it when selected. This enables MixW to have multiple AutoCQ strings. 
For instance you could define one for a contest or special event station, and still leave your default 
AutoCQ text for your normal operations.

<WAVE:filename>
Plays the indicated *.WAV file. This is very handy to use as a voice Keyer for contesting or otherwise 
calling CQ or other automated voice responses. Simply record wave files using the Windows Sound 
Recorder (included with Windows) or another digital recording program and save them as .WAV files. 
Then you can configure your Macros to replay your voice as recorded all automatically. For instance the 
following Macro would be used for calling CQ in a contest:

Where CQCONTEST is the name of the pre-recorded .WAV file of my voice saying, "CQ Contest CQ 
Contest CQ Contest CQ Contest, this is K4SET calling CQ Contest". For this Macro to work, you should 
be in SSB, AM, or FM phone modes. Then by initiating this Macro (by clicking on the button or 
depressing the F6 key in this case) MixW will automatically key your transceiver, then play your 
recorded voice calling CQ through the soundcard to your transceiver's input audio, then it will switch 
back to receive while you just sit by and listen for answers. You can likewise pre-record any number of 
other transmissions including reports or QRZ type end of contact calls. This can really save you voice 
during a long contest or special event operation.

Note: <WAVE:filename> can also be used in conjunction with your <AUTOCQ> or <ASAUTOCQ> 
Macros to use the voice keyer to automatically call CQ.



<TEXTFILE:filename> - Inserts the indicated text file
When creating or editing a text file (.txt) for use with a Macro, be sure that the file is terminated by hitting 
the "Enter" key on the computer keyboard. This will place a cr/lf at the end of the file. Without the 
"Enter" at the end the file will not be sent to the TX window, but will just produce an empty line.

<INIFILE:file,section,name> - insert a line from an ini-file.
Suppose I have a program that measures the temperature using a sensor outside of the house and 
periodically writes the value into d:\emp\ensor.ini file:
--- start of d:\emp\ensor.ini ---
[Sensor]
Temperature=xx
Humidity=yy
Illumination=zz
--- end of d:\emp\ensor.ini ---

Then I can make a macro:

The current temperature in Kiev is
<INIFILE:d:\emp\ensor.ini,Sensor,Temperature> degrees centigrade.

<INIFILE:friend.ini,[HI],<CALL>> - is a special application of the INIFILE macro for use with the 
friend.ini file.
The format of the friend.ini file is:
[HI]
UA4FCO=Yuri
DS4AEM=Cha
F5NBX=Meuzac
. . . etc. . .
One way to use this macro would be to combine it with the <OM> macro. To edit the OM macro go to 
Configure | Default Macros and change the Text to <INIFILE:friend.ini,[HI],<CALL>>. Now when you 
use the OM macro, if there is no name in the current log Name field, the Call will be looked up in the 
friend.ini file and the name found there will be transmitted. If the call is not found, nothing will be sent.

Use of <EXT> and <EXEC> macros

Although both these macros can be used to execute windows commands and programs their behaviour 
can be different.

<EXT:dir> will execute the CMD.exe command dir on the current default data directory and put the 
output in the MixW TX window.
<EXEC:dir> will cause MixW to create an Error! message box informing 'Cannot execute dir!
<EXT:notepad> will execute notepad and MixW then halts and displays 'Not Responding' in the main 
MixW window title bar until the notepad window is closed.
<EXEC:notepad> executes notepad and then MixW continues.

The <EXEC:> cannot be used to execute an internal CMD.exe command directly. However a separate 
command window can be opened using <EXEC:cmd>. 

MFSK Picture macro commands:

A picture file of about 250 x 200 pixels can be sent using the following macro commands:
<PIC?N> - same as selecting File | Send Picture... | B/W...
opens dialog box to select picture file, sends in black and white
<PIC?N%C> - same as selecting File | Send Picture... | Color
opens dialog box to select picture file, sends in color
<PIC:filename.ext 00> - sends picture file in high resolution black and white



<PIC:filename.ext %C> - sends picture file in high resolution colour

See the MFSK Topic in the Digital Modes Section of this Help File for more information.

Creating or Changing Macros

The macroname is the key combination (eg Shift-F8) or the event name not the label name.

New macros can be added or the contents changed by a number of different methods:

Use the MixW menu Configure->Default Macros (or Macros for this mode)

and select Add new or Edit from the macro selection box.

Right Click on the Macro button to bring up the Edit user macro box.

This method cannot be used to edit the 5 'Maths' key macros (Gray+, Gray-, Gray*, Gray/ and 
INS), the Media keyboard macros, the Search and Pounce/Run integral macros nor the Event 
Macros.



Use the <EDITMACRO:macroname> macro 

Use <macroname?>

This will bring up a small text input box. Input or change the text as required.
Using this method of creating or changing a macro has limitations. If you press the Enter key 
whilst the focus is in the text area the edit will terminate and the macro will be executed 'as is'. It is 
not possible to create extra lines for the macro being changed and if it is being created only one 
line is possible. However by use of <CRLF> multiple transmitted lines can be created.

Use <macroname> to execute the macro if it is being created/changed as an event macro
An example in the macro list is <WX?> 

Alphabetical list of Macro Commands

<[> - Text 
<]> - Text 
<ACALL> - Program 
<ACQ> - Auto CQ 
<ACQDELAY> - Auto CQ 
<AFC> - Mode 
<AFCOFF> - Mode 
<AFCON> - Mode 
<ALARM:string> - Auto CQ 
<ALERT:text> - Program 
<ALIGN:fq_in_Hz> - Frequency 
<ANYQSOBEFOREBAND> - Text 
<ANYQSOBEFOREDATE> - Text 
<ANYQSOBEFOREMODE> - Text 
<ANYQSOBEFORETIME> - Text 
<ASAUTOCQ> - Auto CQ 
<ASSCRIPT> - Program 
<AUDIOFQ:fq_in_Hz> - Frequency 
<AUTOCQ> - Auto CQ 
<AUTOCQRESUME> - Auto CQ 
<AZ> - Text 
<BAND> - Text 
<BAUDRATE:baudrate> - RTTY 
<BEEP:OFF> - Program 
<BEEP:ON> - Program 
<BMERASE> - Frequency 
<BOOKMARK> - Frequency 
<CALL> - Text 
<CAPITALSONLY:x> - Program 
<CATCMD:text_command> - Frequency 
<CATCMDDDE:text_command> - Frequency 
<CATCMDHEX:hex_command> - Frequency 
<CATDISABLEVFOSYNC> - Frequency 
<CATENABLEVFOSYNC> - Frequency 
<CATTRANSVERTER:(+/-)shift_in_hz> - Frequency 
<CATVFOSYNCONCE:2xxxxx> - Frequency 
<CATVFOSYNCSHIFT:shift> - Frequency 
<CATWAIT:ms> - Frequency 
<CLEARNRR> - Contest 
<CLEARQSO> - Program 



<CLEARRXWINDOW> - Program 
<CLEARTXWINDOW> - Program 
<CLEARWINDOW> - Program 
<CLOSERXWINDOWS> - Program 
<CR> - Text 
<CRLF> - Text 
<CTIME> - Text 
<CTRL-x> - Text 
<CURSOR:n> - Program 
<CURSOR:TX> - Program 
<CWID:DEFAULT> - Text 
<CWID:text> - Text 
<CWID> - Text 
<DATE> - Text 
<DIST> - Text 
<DTMF:abcd> - Program 
<EDITMACRO:name> - Macros 
<ESCAPE> - Program 
<EXEC:program> - Program 
<EXT:command> - Program 
<FILE:filename> - Text 
<FILE> - Text 
<FILTER:name> - Program 
<FIXSTARTTIME> - Program 
<FONTBOLD:n> - SSTV 
<FONTCOLOR:n> - SSTV 
<FONTFACE:name> - SSTV 
<FONTITALIC:n> - SSTV 
<FONTSIZE:n> - SSTV 
<FORCELANGUAGE:xxx> - CW 
<FQ:fq_in_kHz> - Frequency 
<FQB:fq_in_kHz> - Frequency 
<FROMCLIP> - SSTV 
<GA> - Text 
<GAL> - Text 
<GET OFFSET> - Olivia 
<GET RATE> - Olivia 
<GET SN> - Olivia/RTTYM 
<GOOGLEEARTH:<CALL>> - Program 
<GOOGLEEARTH:<SELCALL>> - Program 
<GRABCALL> - Program 
<HIDE:name> - Program 
<HIDETEXT> - Macros 
<IMD> - Text 
<INCNRR> - Contest 
<INIFILE:file,section,name> - Text 
<INPUTVOLUME> - Program 
<INT> - Contest 
<INTAGNCALL> - Contest 
<INTAGNNR> - Contest 
<INTCQ> - Contest 
<INTDE> - Contest 
<INTELIGENT> - Contest 
<INTGA> - Contest 
<INTQB4> - Contest 
<INTQRL> - Contest 



<INTQRZ> - Contest 
<INTQSL> - Contest 
<INV> - Mode 
<INVOFF> - Mode 
<INVON> - Mode 
<JUMPTOTXFQ> - Frequency 
<KHZ:n> - Text 
<KHZ> - Text 
<LANG_> - Program 
<LANGUAGE:xxx> - CW 
<LASTCALL> - Program 
<LETTERS> - RTTY 
<LF> - Text 
<LIMITSCANLINES:n> - SSTV 
<LOADPICTURE:filename> - SSTV 
<LOADPICTUREONLY:filename> - SSTV 
<LOCALTIME> - Text 
<LOCKMODE> - SSTV 
<LOCKRX> - Mode 
<LOCKRXTOGGLE> - Mode 
<LOCKTX> - Mode 
<LOCKTXTOGGLE> - Mode 
<MACROS:filename> - Macros 
<MARKERS:OFF> - Program 
<MARKERS:xx,yy,...> - Program 
<MEMR:n> - Frequency 
<MEMW:n> - Frequency 
<MHZ:n> - Text 
<MHZ> - Text 
<MILES> - Text 
<MODE:mode> - Program 
<MODE> - Text 
<MODEADD:mode> - Program 
<MODEMACROS:filename> - Macros 
<MODESETTINGS> - Mode 
<MODETNC:mode> - Program 
<MYCALL> - Text 
<MYMAINCALL> - Text 
<MYNAME> - Text 
<MYQTH> - Text 
<MYWWLOC> - Text 
<NAME> - Text 
<NEWRXWINDOW:audiofq:mode> - Program 
<NEWRXWINDOW:audiofq> - Program 
<NEWRXWINDOW> - Program 
<NOTES> - Text 
<NRR> - Text 
<NRS> - Text 
<NUMBERS> - RTTY 
<OM> - Event 
<OnAlarm> - Event 
<OnAPPCommandxx> - Event 
<OnClickAny> - Event 
<OnClickCall> - Event 
<OnClickLoc> - Event 
<OnClickName> - Event 



<OnClickNr> - Event 
<OnClickQth> - Event 
<OnCloseTelnetWindow> - Event 
<OnCloseTNCWindow> - Event 
<OnCR> - Event 
<OnCRm> - Event 
<OnEndMixW> - Event 
<OnEndMode> - Event 
<OnEnter#> - Event 
<OnEscape> - Event 
<OnGrabCall> - Event 
<OnGrabCallTx> - Event 
<OnGrabNumber> - Event 
<OnLeave#> - Event 
<OnOpenTelnetWindow> - Event 
<OnOpenTNCWindow> - Event 
<ONQSOBEFORE:name> - Macros 
<OnRemoveQSO> - Event 
<OnRX> - Event 
<OnSaveQSO> - Event 
<OnSP0> - Contest 
<OnSP1> - Contest 
<OnSpace> - Event 
<OnSpaceTXW> - Event 
<OnStartMixW> - Event 
<OnStartMode> - Event 
<OnTX> - Event 
<OUTPUTVOLUME> - Program 
<PIC:filename 00> - MFSK 
<PIC:filename %C> - MFSK 
<PIC?N%C> - MFSK 
<PIC?N> - MFSK 
<PLACETEXT:x:y:text> - SSTV 
<PLACETEXT:x:y> - SSTV 
<PREVCALL> - Text 
<PREVCTIME> - Text 
<PREVNAME> - Text 
<PREVNRR> - Text 
<PREVNRS> - Text 
<PREVQTH> - Text 
<PREVRSTR> - Text 
<PREVRSTS> - Text 
<PTTOFF> - Program 
<PTTON> - Program 
<PTTSWITCH> - Program 
<PUTHEADER:filename> - SSTV 
<PUTRXPICT:x0:y0:x1:y1> - SSTV 
<QSLPRINT> - Program 
<QSOBEFOREDATE> - Text 
<QSOBEFORETIME> - Text 
<QSOCMDDDE:command> - Macros 
<QSONR:BAND> - Text 
<QSONR:MODE> - Text 
<QSONR> - Text 
<QTH> - Text 
<RANDOM:filename> - Text 



<REPLAY:n> - Program 
<REPLAY> - Program 
<ROTOR:LP> - Rotor 
<ROTOR:n> - Rotor 
<ROTOR:SP> - Rotor 
<ROTORCMD:command> - Rotor 
<ROTORCMDHEX:command> - Rotor 
<RSTR> - Text 
<RSTS> - Text 
<RX> - Program 
<RXANDCLEAR> - Program 
<RXC> - Program 
<RXE> - Program 
<RXLOGSTART:filename> - Program 
<RXLOGSTART> - Program 
<RXLOGSTOP> - Program 
<S/P> - Contest 
<SAVEQSO> - Program 
<SAVESH> - Program 
<SAVESHAUTO> - Program 
<SCRIPT:filename> - Program 
<SCROLLLOCK:OFF> - Frequency 
<SCROLLLOCK:ON> - Frequency 
<SCROLLLOCK:TOGGLE> - Frequency 
<SEEKLEFT> - Program 
<SEEKRIGHT> - Program 
<SELCALL> -Text 
<SELNAME> - Text 
<SELNRR> - Text 
<SELNRS> - Text 
<SELQTH> - Text 
<SELRSTR> - Text 
<SELRSTS> - Text 
<SENDEQSL> - Program 
<SENDEQSLNP> - Program 
<SENDSPOT> - Program 
<SET BW:n> - Contestia 
<SET BW:n> - Olivia 
<SET BW:n> - RTTYM 
<SET FILTER:width_in_hz> - Hell 
<SET FONT:n> - Hell 
<SET RXFQ:fq_in_hz> - Hell 
<SET SCALE:n> - Hell 
<SET SUBMODE:submode> - Hell 
<SET TONES:n> - Contestia 
<SET TONES:n> - Olivia 
<SET TONES:n> - RTTYM 
<SET TXFQ:fq_in_hz> - Hell 
<SHIFT:shift_in_Hz> - RTTY 
<SHOW:name> - Program 
<SHOW:RIGEXPERTS> - Program 
<SHOWTEXT> - Macros 
<SNAP> - Mode 
<SNAPNOW> - Program 
<SNAPOFF> - Mode 
<SNAPON> - Mode 



<SP:0> - Contest 
<SP:1> - Contest 
<SP> - Contest 
<SPLIT:0> - Frequency 
<SPLIT:1> - Frequency 
<SPSHIFT:fq_in_Hz> - Frequency 
<SPZOOM:n> - Frequency 
<SQUELCH> - Mode 
<SQUELCHOFF> - Mode 
<SQUELCHON> - Mode 
<STARTRECORD:filename.mp3> - Program 
<STARTRECORD:filename> - Program 
<STARTRECORD> - Program 
<STARTRECORD2> - Program 
<STARTSCAN> - Program 
<STARTTIME> - Text 
<STATS:GENERATEQTC> - Contest 
<STATS:REPEATQTC> - Contest 
<STOPRECORD> - Program 
<STOPSCAN> - Program 
<TAB> - Text 
<TELNETSCRIPT:filename> - Program 
<TEXTFILE:filename> - Text 
<TEXTFILE> - Text 
<TEXTSTYLE:n> - SSTV 
<THRESHOLD> - Mode 
<TIME> - Text 
<TNCSCRIPT:filename> - Program 
<TOGGLECATPORT> - Program 
<TOGGLEPTTPORT> - Program 
<TOGGLESOUNDDEV> - Program 
<TUNE:nn> - Program 
<TUNE> - Program 
<TX> - Program 
<TXE> - Program 
<TXTIME> - Text 
<TXTOGGLE> - Program 
<UNLOCKMODE> - SSTV 
<UNLOCKRX> - Mode 
<UNLOCKTX> - Mode 
<VER> - Text 
<WAVE:filename> - Program 
<WKDIGNOREBEFORE:date time> - Program 
<WKDPERIOD:nn> - Program 
<WKHEX:hex command> - CW 
<WKNOPOT> - CW 
<WKPOT> - CW 
<WKTEXT:text> - CW 
<WORDMODE:x> - Program 
<WPM:-n> - CW 
<WPM:+n> - CW 
<WPM:n> - CW 
<WPM:RX> - CW 
<WWLOC> - Text 
<WX?> - Macros 
<WX> - Text 



<YAPPRECV> - Program 
<YAPPSEND:filename> - Program 
<YAPPSEND> - Program 
<ZFQ:fq_in_kHz> - Frequency

External Resources
_________________________________________________________

Using External Resources

MixW has a number of purpose written programs to enable it to be linked to external software packages 
both for sending and receiving data.
There are also a number of inbuilt features available to allow any amateur programmers to develope their 
own custom solutions. See Using MixW with other Programs for a description of some of the available 
information.

ProLog

A standalone logging program written and supported by DataMatrix. Has inbuilt support for 
MixW. See http://www.prologsystem.com/ for more information. 

MixWLogger32.exe

This utility allows the MixW log to be used by the Logger32.exe logging software.

Download from Victor Kosobokov ( R3BB)'s site http://www.digitalrus.ru/ 

Mixw2-dx-labs-gateway

Provides an interface between MixW and the DXLabs suite of ham radio software. See the 
download site http://www.n2amg.com/software/mixw2-dxlabs-gateway/ for a full description of 
all that is available. 

MixWeblookup.exe

This utility allows the look up of callsigns from 4 different callsign holder websites plus an extra 
one for USA and Canadian callsigns.

The access policy of some sites now make it necessary to log in before the callholders data is 
available.

Download from http://www.mixwusa.com/downloads.htm or
the MixW Yahoo group files section (membership necessary).

CBDLL

An online Callbook DLL permitting MixW to lookup callsigns on QRZ.COM.

See the download site http://www.k1pgv.com/cbdll.html for more information on all the facilities 
available. 

MixWButtons.exe

http://www.k1pgv.com/cbdll.html
http://groups.yahoo.com/group/mixw/
http://www.mixwusa.com/downloads.htm
http://www.n2amg.com/software/mixw2-dxlabs-gateway/
http://www.digitalrus.ru/
http://www.prologsystem.com/


MixWButtons provides up to 100 extra Macro buttons which can be used in the same way as the 
48 available MixW macro buttons.

See the download site http://www.k1pgv.com/mixwbuttons.html for more information on all the 
facilities available. 

MixWBuddy.exe

MixWBuddy is the precursor to MixWButtons.

See the download site http://www.k1pgv.com/mixwbuddy.html for more information on the 
features in this utility 

JT-Alert

This utility provides some access to the MixW log from JT65-HF.

See http://hamapps.hamspots.net/ for more information on the features in this utility

MixW Facilities to Access External data

Using the <EXEC:> macro to access internet sites.

If you wish to activate an internet site try using the macro:
<EXEC:"c:\program files\internet explorer\iexplore.exe" site to access>

The following macro will display the current qso call eQSL page (if one exists):
<EXEC:"c:\program files\internet explorer\iexplore.exe" www.eqsl.cc/member.cfm?<CALL>>

Other free callsign holding sites include:
www.hamqth.com
www.callook.info (USA only)
www.rac.ca (Canada only)
www.qrz.com (login required before callsign information is available)
hamcall.net

You will need to find the path/program name for other browsers

The <EXEC:> macro can be used to activate almost any program on the computer. See Use of 
<EXT> and <EXEC> macros.

Use of External Modes to Activate programs.

MixW has the ability to run modes externally, disabling the CAT, PTT and Soundcard if required. Using 
these facilities it is possible to run any program. To enable another mode or other piece of software select 
Menu Modes|Additional Mode Settings... 

http://hamapps.hamspots.net/
http://www.k1pgv.com/mixwbuddy.html
http://www.k1pgv.com/mixwbuttons.html


To activate either of these Additional Modes from MixW either use the menu Modes|Additional Modes or 
use the the macro <MODEADD:additional mode name>. One limitation on using this method of 
launching a program is there can be no parameter arguments on the pathname.

MixW: Installing and Uninstalling
_________________________________________________________

MixW Installing

A MixW release is delivered as a single self install program (e.g. MixW3_01b.exe for release 
MixW3.01b).

Once the program has been checked to make sure it is not blocked decide where the extracted files are to 
be installed (either a default or custom installation). 

For MixW2.19 and earlier a default installation is not recommended. Microsoft does not encourage 
writing to the program file folder, which is where MixW installs the data files in these earlier releases. 
For MixW2.2 and later releases, as the installation progresses the split between program and data files can 
be seen.

Start the downloaded and unblocked program. An installation window will be displayed, click next which 
will cause the user licence screen to be displayed, Click I Agree to continue and the component 
installation screen will be displayed.



Initially all components are marked for installation. Left click on the checked boxes of any components 
you don't want to install (if you are unsure hover your mouse pointer over the component to find out what 
it does) then click Next.

This causes the file installation folder (MixW2.19 or earlier) or the program files installation folder 
(MixW2.2 or later) selection screen to be be displayed.

Either leave the screen unchanged for a default installation or for a custom installation use the Browse 
button or directly type into the text box to select the required folder.

MixW2.19 and earlier file folder selection screen. 

If the installation is for MixW2.19 or earlier click on Install.



MixW2.2 and later program file folder selection screen. 

For MixW2.2 and later clicking on Next will display the data folder selection.

MixW2.2 and later data file folder selection screen.

As for the program files selection leave the screen unchanged for a default installation. Otherwise use the 
Browse button or directly enter the required folder in the text box. Click on Install.

Remember the location name entered in the screen above. MixW uses this location to 
write the latest information files to. 

Once installation is complete it will now be necessary to configure MixW.



MixW Uninstalling

The recommended way to uninstall MixW is to use Control Panel - Programs and Features (or run 
appwiz.cpl) select MixW and uninstall. This will execute a program uninst.exe which is installed in the 
program files of every version of MixW.

This method is fine so long as the version is MixW2.19 or earlier but for MixW2.20 and later only the 
latest version of MixW should be uninstalled using uninst.exe.

If there are two or more versions of MixW later than V2.20 then uninstalling using the uninst.exe 
program may lead to the latest data files being deleted instead of the required ones. This will prevent 
MixW from loading with the error message Unable to find eng.cwt.

To prevent this happening the only safe way is to manually delete the program and data folders for 
versions that are earlier than the latest version installed. 

MixW folder structure on disc

MixW2.19 and earlier

MixW will create the folder specified in the Choose Install Location screen above (if it does not exist) 
and then copy all the installation files and sub-folders into this folder. 

MixW2.2 and later

The latest MixW installation is more complex. The program files and data files are installed as two 
separate parts although the installer can, if they so wish, install most of the files into the program 
directory. MixW now offers 4 different log formats, CSV, MDB, MYSQL or Web and the program load 
sequence is changed.

The last two changes to MixW result in a new folder and files being installed although the installer has no 
control over where the folder is installed. This new folder is a linked folder. A linked folder means it can 
be addressed from more than one location and any change made to the folder or its contents are reflected 
to all the locations it is visible in. The new folder is:

c:\programdata\mixw

which is linked to:

c:\documents and settings\All Users\application data\mixw in Windows XP
c:\Users\All Users\mixw in Windows Vista, 7, 8 and 10

and the new files are:

mixw2launch.cfg 
  

contains a pointer to the MixW data 
folder

MixW2.mdb Skeleton MDB log file database

MixW2.sql Skeleton MYSQL log file database

The sub-folders created by the installation process are:

Folder Name Usage



AutoSavedPicture
s Default for saving MFSK/SSTV pictures

Icons MixW Icon files saved in this folder.

Plugins Storage for various files used as tools by MixW.
Language Files
Contest Statistics dlls
From MixW2.2 onwards extra mode DLLs

PrintQueue Record of QSOs to be printed using 
QSLPrint.exe.

MixW3.2.102 and later creates an extra folder:

MixMacros            Suggested contents of macro 
groups.

MixW Load Actions

NOTE:

During the loading of the latest MixW release the Windows Registry maybe accessed. Considering the 
danger to the Windows system if an accident should take place no information will be given of what 
activity takes place. If MixW fails to load the registry is very unlikely to be the problem.

PLEASE BE CAREFUL. WINDOWS MAYBE UNUSABLE AFTER A MISTAKE

The actions below are listed in chronological load order as observed on one Windows 7 system. There 
maybe minor differences in activity but it is unlikely these minor differences will inhibit a MixW load.

The first actions taken by MixW after the user has activated a MixW start up vary between MixW2.19 
and earlier and MixW2.2 and later.

During the initial sequence both versions are trying to find the MixW initialisation file. Once this has 
been found the actions are common between the different releases

There are certain internal Windows security actions that take place before MixW takes control but these 
are not shown below.

The changes between releases:

MixW2.19 and earlier 

User activates MixW2.exe MixW identifies the load folder and attempts to read MixW2.ini.

The common path is now entered. 

MixW2.2 and later 

User activates MixW2.exe (V2.2), MixW3.exe (V3.0/V3.1) or MixW3_2.exe (V3.2). The first action is to 
find the data folder.

MixW looks for and reads mixw2launch.cfg. If mixw2launch.cfg is not found MixW uses the registry to 
try to find the data folder and finally uses the runtime parameters (if any). MixW attempts to read the 



MixW2.ini file. 

Common Path 

If MixW2.ini is not found a new MixW2.ini file is created.

Once MixW has first actioned the MixW2.ini file it reads:

.cwt files - If the eng.cwt file is not found it aborts the start up
icons.cfg file
icon files
lang.ini
cty.dat - Error flagged if file not found but MixW starts
pfx.dat - Error flagged if file not found but MixW starts
calls.dat
default macro file is read or created.
MixWContests.ini
bands.ini - Error flagged if file not found. MixW starts but log is not read.
events.dat
log file is now read or created
log bar display initialised
audio system is initialised
Plugins folder searched for any required files (Olivia, Contestia, RTTYM dlls, contest stats dlls)
current mode macros
KnownFqs.dat
Not Saved QSO - If last MixW session had an unsaved QSO

Once the MixW installation is complete it is strongly recommended the latest help files are copied from 
the MixW reflector. 

Release History
_________________________________________________________

This is the Release History of MixW.

MixW 3.2.105 (July 25 2017)
- Improved format for Extras Download window.
- New Macros <SCROLLLOCK:ON>, <SCROLLLOCK:OFF> and <SCROLLLOCK:TOGGLE>
- New Macro <TOGGLE:Toolbar> enhamces SHOW/HIDE functionality
- Additional pane to QSO meter window.
- Added Intelligent whitespace functionality to the Edit menu.
- ADIF file creation to V3.0.5 of the specification.
- Support for Yaesu FT-891.

MixW 3.2.104 (with 14-11-16)
- Automatic checking for updates
- New view Callbook settings
- New macro <NEWRXWINDOW2: audiofq: mode> opens a window into the second channel
- Server Log backup bug with password was fixed
- A bug in SO2R mode was fixed

MixW 3.2.103 (with 14-11-16)



This release was withdrawn due to a bug and re-issued as MixW3.2.104.

MixW 3.2.102 (with 10-10-16)
- Added the ability to check the contest log for errors (using new Stats.dll)
- Added a directory with a set of examples of macros and "macros for this mode" (Macros from ON2AD)
- Added settings button contest mode
- Fixed errors that were present in previous versions (Statistics log, DX-Cluster window, QSO statistics 
window) 

MixW 3.2.1 (with 11-07-16)
- Enabling / Disabling the playback history waterfall
- View QSO statistics. Able to filter the QSO by bands, modulation type, call sign, country
- Toggle QSO meter indicator
- Fixed errors that were present in older versions

MixW 3.2
- A new type of panel function keys (with the ability to display 12 or 48 macros)
- Added settings button Log bar.
- Log bar slider control.
- QSO per hour meter display.
- QSO statistics display.
- Support for new transceivers for the CAT system: Yaesu FT-991, FT (DX) -1200, FT (DX) -3000. Icom 
IC-7100, IC-7300, IC-7410, IC-7851.
- Directory callsigns via QRZ.com. In the settings for Callbook: Callbook Type - choose - Site 
www.qrz.com. In the Password - enter your password QRZ.com site.
- Fixed errors that were present in older versions.

MixW 3.1.1
- RX windows coloring
- Log improvements: sort and optimization

MixW 3.01
- New World Map with resizing and greyline
- New Telnet dialog with talk and links to QRZ.com and google map
- Backup logs on mixw.net server (password protected)
Edit Backup.pwd with notepad to set the password

MixW 2.20
- New LOG database engine with MDB and SQL support
See personal data, log [...] button
SQL lets use remote SQL database via internet connection
more details to follow
- New fast CheckSR (Check samplerate utility)
- Updated QslPrint utility
- Vista/W7 compatibility

MixW 2.19
- Rx window highlights URLs like http://site.net or mailto:me@server.com
and posts according system request on doubleclick
- files Custom1.dat and Custom2.dat contain a list of log fields for
the corresponding log layout. Each of these files looks like this:

8<--- Custom1.dat -------------------------------
1 MODE
2 FQRX
3 FQTX



4 DATE
5 TIME
6 CALL
7 RSTSNT
;8 EXCHSNT
9 RSTRCV
;10 EXCHRCV
14 DOM
11 NAME
12 QTH
;15 COUNTY
16 IOTA
17 MGR
13 NOTES
;18 ENDDATE
;19 ENDTIME
20 LOC
8<------ end of file ----------------------------

Lines which begin with ";" are ignored, so fields EXCHSNT,
EXCHRCV, COUNTY, ENDDATE, and ENDTIME are absent in this 
example. You may change the order of lines (and according 
columns) but do not change the numbering, i.e. CALL should 
always have 6 at the beginning.
- The following CAT systems are added:
- Yaesu FT-2000, FT-950, FT-9000D, FT-450, FT-1011
- Kenwood TS-2000, TS-480
- Ten-Tec RX-350, OMNI-VII, ORION-II
- Rotor control added for FT-2000, RC2800, WINROTOR
- Added support for upcoming FSK441m and JT6x modes
- ADIF SRX_STRING tag is added
- Up to 25 lines in the log bar
- Interface Setup Wizard (See the Configure menu) will help
setting up MixW to operate with RigExpert interfaces
(Plus, Standard or Tiny models) 
- "MixW2 /setup" command line option will also start the Wizard
- New macros:
<CATTRANSVERTER:shift_in_Hz> - allows working with different transverters
<STARTRECORD2> - writes WAVe file from the second input channel
<SHOW:RIGEXPERTS> - lists connected RigExpert interfaces
- Hungarian language file is added

MixW 2.18 (18-Feb-2006)
- Spanish translation by Jose Luis (EB2CYQ) added.

MixW 2.18 (09-Jan-2006)
- Kenwood and layout size bugs fixed

MixW 2.18 (30-Dec-2006)
- German language file is added
- Several minor bugs are fixed

MixW 2.18
- Yaesu FT-2000 and FT-9000 supported
- Mouse wheel over macro bar lets you see all 48 macros 



- SSTV TX: brightness/contrast fast editing
- Variable number of visible lines for the log bar

MixW 2.17 (01-Nov-2006)
- FT-2000 and FT-9000D support is added
- RigExpert Standard is auto-detected
- Minor bugs fixed

MixW 2.17 (04-Jun-2006)
- QslPrint program is updated (printer settings are now saved/loaded)
- MixW: CAT under WinXP bug is fixed
- Other minor fixes

MixW 2.17
- International language support via language plugins.
- Singe- and dual-channel MixW versions joined into the single exe file.
- Command-line parameters:
/1 - run MixW in single-channel mode
/2 - run MixW in dual-channel mode

MixW 2.16
- Language extensions, see lang.ini as an example:
[MASK] and [DXCC] sections define rules of changing the name of
a macro depending on a current callsign. For instance,
<LANG_HELLO> will run <RUS_HELLO> for R* and U* callsigns,
<DEU_HELLO> for German callsigns, and so on. If there is no rule,
just <HELLO> is executed.
- External mode plugin support (with Olivia as an example: ModeOlivia.dll
is available as a separate downloadable file).
- RigExpert Plus interface is automatically set up (if detected). See
http://mixw.net/RigExpertPlus/ for details about RigExpert Plus.
- FSK port and WinKey port settings are now accessible through the
Configure menu.
- Extended WinKey setup, see the WinKey.ini file.
- Command-line parameters:
NODDE - disable DDE function.
DDE:xxx - set DDE server name to "xxx".
NOOLE - disable OLE function.
NONIC - disable TCP/IP over AX.25
NOREP - disable RigExpert Plus automatic detection.
MENU1 - use alternative menu.
- Multimedia keyboard support.
For instance, create the following macro:
Name: OnAppCommand11
Label: does not matter
Text: <FQ:+0.1>
Then, pressing the Next Track button will increase the transceiver
frequency by 0.1 kHz.
Macro names which correspond to multimedia keys pressed appear in the
status bar when MixW is running.
- A separate program to check sound card sample rate is added.
See "Check sound card sample rate" in Start - Programs - MixW menu.
- New install/uninstall system.
- Several minor bugs fixed.

MixW 2.15



- DTMF generation macro for SSB/FM/AM modes:
<DTMF:xxxxx> where xxxxx is what to send
- <SENDSPOT> macro. It works only when Dxcuster Dialog is opened.
- New MixW215s.exe update (a separate download) has two spectrum windows
and allows receiving in both of them. Best viewed with FT1000mp :-)
- User defined scrambling is supported for VFH PACKET
- FT980 support is added
- Telnet window script command set is extended by a few commands:
- echo on/off
- autolf on/off
- logging on/onlydx/everything

MixW 2.14
- Extended contest support
- CAT support for JRC, FT857, IC7800, IC756PRO3
- MP3 format support (you must have lame_enc.dll in the MixW folder)
Use <STARTRECORD:filename.mp3> to start record in the MP3 format
(extension must be "mp3")
- ProSisTel rotor support
- WinKey basic support
- Added e-mail field to the Cabrillo output.

MixW 2.13 beta 25
- OmniRig support added

MixW 2.13 beta 21
- Log bar font and vertical size can be changed

MixW 2.13 beta 20
- Telnet window improvements. Try one of scripts to connect the DX cluster.
DX Spot Send feature uses telnet window automatically.
- Macro <[> and <]> allow transmitting "<" and ">"
- Receiving sensitivity is improved for some modes
- Controller CBOX 2003 for Pro.Sis.Tel rotators is supported
- "Macros for this contest" item is added in the menu Configure.
It is active ONLY in contest mode.
- Frequencies listed in KnownFqs.dat will be shown at the spectrum bar
with grey marks, see KnownFqs.dat for the format and add your own if needed.
- "Search and pounce" (SP) and "Run" modes of operation are added.
Run mode assumes CQ operation.
"Run" is displayed at the caption in Run mode. Three macros are added
to switch between Run and SO.
We can switch between RUN and SEARCH-AND-POUNCE (SP) modes by
<SP1> (SP on)
<SP0> (SP off = RUN)
<SP> (switch between SP and RUN)
- New Macros
- <MILES> is similar to <DIST> but prints miles instead of km
- <TAB> does the same as pressing TAB key
- <TUNE:nn> macro allows limit the transmission to nn seconds
- <ACALL> macro is similar to <CALL>, but allows call changing on the fly.
- <TXE> is similar to <TX> but waits for carrier loss (end or transmission)
- <OnGrabCall> will be called (if defined) when two same calls will be received
- <OnGrabNumber> will be called if serial when number is grabbed into the log
- <STARTRECORD:filename.mp3> will start record a MPEG3 file instead of
usual PCM WAVE. The presence of lame_enc.dll is required in the MixW



folder (separate download).
- <CURSOR:N> moves the cursor to the field number N (not column),

N=5 : Call
N=9 : Nr Recv
Known bug: It does not work if the macro button is pressed with mouse,
use keyboard instead.

<CURSOR:TX> moves the cursor to the TX window
- <OnCR> macro tells MixW what to do if CR will be pressed while focus
is in the log. It calls <INT> macro by default in contest mode (see below).
- <INT> macro or <INTELIGENT> does a specific job. It's output depends
of the content of CALL and RX EXCHANGE fields.

S/P mode.
Call Rx exchange Output according macro to edit if needed
-empty -empty ? INTQRL
NEWCALL -empty de UT2UZ INTDE
WKDCALL -empty (nothing)
NEWCALL exchange QSL UR 599 001 INTQSL
(and saves the QSO)

RUN mode.
Call Rx exchange Output according macro to edit if needed
-empty -empty CQ TEST DE UT2UZ INTCQ
NEWCALL -empty CALL GA 599 001 INTGA
WKDCALL -empty CALL QSO b4 QRZ INTQB4
NEWCALL exchange QSL 73 QRZ de UT2UZ INTQRZ
(and saves the QSO)

See default macro definitions and change them if needed.
Of course, <INT> macro can be used not only inside OnCR.

MixW 2.12
- PSK31, QPSK31, FSK31:
MMVari codetable is supported (G3PLX table
is extended to Japanese alphabet by Makoto Mori, JE3HHT)
- Spectrum View:
Dynamic range switch is added (80, 60, 40
or 20 db for the visible range of spectrum/waterfall)
- Spectrum View:
FFT window selection is added in the Soundcard settings
(Square, triangle, cosine, Hamming, Nuttall). Square window has the best
frequency resolution, Nuttall has the best sidelobe suppression and
is the best for the IMD measurements. Cosine window is the default and
seems to be a reasonable compromise for usual daily operations.
- RX window:
Tooltip shows the distance and the azimuth to the pointed WW GRID locator
- PSK31:
bandpass filter is improved, seems to work better for close signals.
- RigExpert support:
Input/Output level dialog is added
- CAT:
IC-703 is added to the supported TRCVR table
KENWOOD TS50 lockup at start bug fixed
- New Macros:



<MYWWLOC>, <WWLOC> - local and remote WW GRID locator
- Macro <NAME> returns "my friend" instead of "OM" when the name field is empty.
You may change the value by editing the macro <OM>. Just erase
"my friend" in the text box of Edit Macro dialog if you want
nothing to be transmitted in that case.
- TEOAN:
Remote operation via LAN is supported for RigExpert device.
Soundcard settings dialog is rearranged in order to support
remote operations settings.
For MixW RigExpert users: MixW 2.12 offers an unique feature of
connecting a PC with TEOAN program and MixW RigExpert connected to a
transceiver into a local area network. Then, running MixW 2.12 on
another computer on a network (or via high-speed internet connection)
makes possible operating digital modes using that transceiver. In the
TEOAN program, set the virtual COM port number for MixW RigExpert and
a TCP port number (the default value is OK in most cases). In MixW2,
choose "The Eye of a Needle" as an audio device. Enter an IP address
or a name of the computer with TEOAN running, and the same TCP port
value.
Note: the sound stream is not compressed, so no loss of quality is
expected but on the other hand the data rate is high, up to 0.4 MBit/sec
(RX or TX) or 0.8 MBit/sec for TX in fullduplex mode. Usual 10MBit LAN is
good enough for this application, but slow modem connections will not
be able to handle such big stream of data.
- CW:
"@" (AC) symbol is added to the CW table
- Esc behaviour has been changed
. It stops the macro and cleans the TX buffer but does not turn off
the TX. Press Esc twice to abort the transmiision. If you do not like
new behavior then find "OldEsc=0" in the MixW2.ini file and replace "0"
with "1".
- Fast INI file reading.
Slow built-in system INI file reading and writing procedures are replaced
with optimized ones.
- HTML help support is added. If you prefer old MixW2.HLP file then just remove
the file MHH.dll from MixW2 folder (or rename it).
- Band edges are marked with "stop" icon on the frequency scale.

MixW 2.11
- 64 kb INI file limit removed (actual for long friends.ini)
- MFSK transmission begins with single tone for easier tuning
- Scanner dialog:
Start button continues scanning instead of restarting.
Right click on the list move the TRCVR to the pointed frequency.
- RX window: local menu (by mouse right click) allows selecting calls
with spaces inside, like E A 5 B C 
- IC756(pro/pro2): split command bug fixed (IC756 has one command
different from other models)
- LOG bar: uppercase characters are entered in the CALL field
- CW settings dialog is changed to support QSK mode
- RigExpert support is improved
- ZelPro rotor support is added

MixW 2.10:
- New MixW2.exe command-line parameters:
NODDE - disables DDE feature



DDE:xxx - sets DDE service name to xxx
NOOLE - disables OLE feature
NONIC - disables the use of virtual network adapter
- AFSK in place of FSK option added to PTT/CAT dialog to explicitly
set whether we want to use AFSK in RTTY mode (checked by default)
- User-configurable multi-language support added to CW module.
See the *.cwt files in MixW directory (unicode files,
should be open with notepad.exe).
- New CW macros:
<LANGUAGE:xxx> - select a language
where xxx=

ENG - English
RUS - Russian
FRA - French
SWE - Swedish
SPA - Spanish
GER - German
ESP - Esperanto
JAP - Japanese

<FORCELANGUAGE:xxx> - for languages where CW codes are
shared with English alphabet
(for instance, Russian and Japanese).
This macro forces characters to be received as xxx.
- Added support for Ten-Tec Argo, Orion, RX-350, YAESU FT-897 and FT-1000mp with
different firmware
- Added support for RigExpert
- New macros:
<AZ> - Azimuth
<DIST> - Distance in km
<WKDPERIOD:nnn> : nnn = period in minutes. QSO before is ignored
if more than nnn minutes elapsed.
<WKDIGNOREBEFORE:date time>: QSO before is ignored
before specified time.
<PTTON>, <PTTOFF>, <PTTSWITCH> : switch the TRCVR PTT
<PRINTQSL> : put the selected QSO line into the QSL Print Queue
<FROMCLIP> : get the picture from the clipboard (SSTV mode)
- We can explicitly set a DXCC country for the callsign in any QSO to
fix the problem with several possible DXCC entries for the same callsign.
See the Edit QSO dialog.

MixW 2.09:
- PSK63 is supported for the Export operation
- CAT for FT1000MP is imporved
- a couple of minor bugs fixed (in CW RX module and CAT system)
-   collection of icons by K6MKF is added

MixW 2.08:
- Notch filter is added, accessible via Spectrum window local menu
(right click on the waterfall). Be sure, this feature requires faster CPU
- one more AX25 modem (4800 baud) is added.
- Alternate LPT interface has been added
- Icons will be drawn in the RX window after some known words. See Icons.cfg.
- PSK63 mode support via <BAUDRATE:62.5> macro.
- <CURSOR:n> macro places the input focus to the specified column number of



the log bar, useful for contests. Example:
<TX><CALL> de <MYCALL> <GA> ur <RSTS><NRS><RX><CURSOR:9>

MixW 2.07:
- SSTV Drag'nDrop
- Q15AX25 support. Note: Q15X25dll.dll is not included to the distribution
due to licensing limitation. Download and install the dll separately.
- Resizing history bitmaps.
- MT63 manual tuning & secondary channel.
- MACRO <MARKERS:xx,yy,zz,tt,ww>.
- Auto-created macros like <WX?>.
- One level recursion like <CATCMD:PO<POWER>>.
- Friends file support <INIFILE,HI,?C>.
- Telnet echo on/off toggle.
- MT63 secondary RX, manual tuning.
- Set markers macro <MARKERS:1000,1020> (up to five frequencies).
- Transmitting pictures in MFSK16 mode.
- International characters transmission support, including Japanese.
hieroglyphs. See menu Mode - Character encoding, UTF8, JIS etc.
- QslPrint executable allows printing a huge amount of QSLs and labels.
- Cabrillo support for BARTG Sprint and BARTG Spring (AKA BARTG-RTTY).
- Macro <IMD>, works if IMD is fixed on the statusbar

MixW 2.06:

- Control bar (Macro bar):
- resizing horizontally and vertically
- background color can be changed for each button,
see button "A" after "Label" in Edit macro dialog.
- DxCluster dialog rearranged, button "Back" is added, it
jumps to previous frequency (if any).
- Ten-Tec Jupiter support (requires new "Enhanced PC Control" firmware)
- Added ability to use macros in packet beacon text.
Example:
Beacon de UU9JDR, local time=<LOCALTIME:%H:%M:%S>

MixW 2.05:

- YAPP file transfer support for PACKET mode.
Crash recovery is supported.
See File - Yapp menu:
- "Auto receive" turns on the feature when MixW automatically opens
YAPP Receive window when remote station starts sending a file.
- "Crash recovery" turns on YAPP protocol extension to be able to
resume partially received files.

- LPT port support for paddle input and PTT/CW output (TRLog-compatible).
See Configure - LPT port settings. Go to CW settings dialog
to turn on the LPT paddle.

- Telnet window is implemented to access DxClusters via telnet
See View - Telnet window menu. See "EA7URC_DXC.scr" as an example
how to automatically login to a node. To automatically run this
script when Telnet window opens, define OnOpenTelnetWindow macro
as follows:



Macro: OnOpenTelnetWindow
Label: - doesn't matter -
Text: <TELNETSCRIPT:EA7URC_DXC.scr>

- optional "Check QSL" flag is added to the DxCluster dialog.
(see system menu in that dialog)

- PACTOR-1 LP mode is added, RX only :-(

- DxCluster dialog:
- WWV page can be called.
- Modified Settings dialog.
- Font selection is added.
- Column widths are remembered.

- Memory dialog is added to watch Ctrl+1..10, Sh+Ctrl+1..10 channels.
See menu Options.

- SSTV FSKID is added, compatible with MMSSTV, turned on by default,
recommended, can be turned off in SSTV mode settings.

- Search result dialog:
- column widths are remembered.
- Font selection is added (see menu under butterfly).
- Esc returns to the previous dialog.
- Set QSL Rcvd, Set QSL Sent added to the local menu. That allows
input multiple QSLs at a time.

- Log bar:
- resize: doubleclick on the edge of logbar, resize, doubleclick again.
- QSO column shows QSO number

- New macros:
- OnOpenTncWindow, OnCloseTncWindow,
OnOpenTelnetWindow, OnCloseTelnetWindow,
use these macros to run specified commands when TNC or Telnet
window opens or closes.
- <CLOSERXWINDOWS> closes all opened secondary RX windows
- <YAPPRECV>, <YAPPSEND>, <YAPPSEND:filename> - YAPP support
- <MYMAINCALL> returns callsign stripped from "/P"."/QRP" etc
- SSTV specific macros:
- <LOCKMODE>, <UNLOCKMODE> - lock/unlock current SSTV mode
- <PUTRXPICT:x0:y0:x1:y1> - put received picture into the specified rect
- <PLACETEXT:x:y>, <PLACETEXT:x:y:text> - place text to specified x,y
- <TEXTSTYLE:n> - set current text style
- <TNCSCRIPT:filename>, <TELNETSCRIPT:filename> - run script file in
2nd TNC or Telnet window.

MixW 2.04:

- IC746pro is added to the list of directly supported TRCVRs.

- RTTY: ASCII7 and ASCII8 modes are added, high speed limit is now
1800 baud for two filters demodulator and more than 2400 for single filter.

- SSTV: MP115 mode is added



- SSTV: New text styles are added: outline with and without fill,
gradient fill, diagonal cross fill. Use Shift+Font Color
and Ctrl+Font Color (Red "A") to change outline and second
gradient color accordingly.

- Advanced Waterfall option is added (see menu View > Spectrum)
It moves waterfall along with frequency. CAT must be installed
to use this feature.

- Spectrum/Waterfall speed may be increased up to x16.
This will not work on slow computers. Reducing the RX buffer size
to 128 is recommended (m_iBufRxSize=128 in MixW2.ini).

- Packet:
- KISS TNC emulation. This allowes usage MixW2 packet module
with other packet software. Tested with UI-View.
- UI frames are sent in "NOT CONNECTED" state. Beacon address is used.

- New macros: <NEWRXWINDOW:audiofq> create New Rx Window on specified
audio frequency
<NEWRXWINDOW:audiofq:mode> same as above with specified mode
<CWID:text> set "text" as CW ID. Useful in <OnStartMode>.
<CWID:DEFAULT> set default CWID (as described in personal data dialog).

- Added some icons to the DxcDialog dialog
;

MixW 2.03:

- Hellscreiber: FM mode is added (see mode settings).
- Mouse wheel support to tune the TRCVR. See PTT/CAT settings dialog.

- Scanner dialog (menu View > Scanner). Very useful for checking condx
on dead bands like 10m, 6m, VHF, and UHF.

- New Macro:

- <ALERT:text> - Brings up a Messagebox with "text".
- <BEEP:xx>, xx = On or Off. Switches beeper.
- <OnEnterNNN>, <OnLeaveNNN>, NNN = 160m, 80m etc. Macro to
execute nn band change. Define such macros of you need to do 
extra work on band change (like run external program to switch relays or
send specipic CAT command to the TRCVR)

- Friendly "No Soundcard" message

- Manual entry mode now sorts log entries. See
menu View->Log bar->Manual Entry Mode

- Log scanning procedure improved (takes less time).

- "Merge from" button is added to the Edit Macro dialog.
This feature is useful to add transceiver-specific macros.
For example, CatKenwoodTS450.mc may contain several macros:



Name: AIPON
Label: AIP on
Text: <CATCMD:MX1;>

Name: AIPOFF
Label: AIP off
Text: <CATCMD:MX0;>

and so on.

Then I can use <AIPON> and <AIPOFF> to control the transceiver
like if they were built-in macros.

- VHF 2400/4800 packet is reanimated.

- Some Brazilian prefixes are added

- IC910H, IC718, FT1000m are added to the list of directly supported TRCVRs.

- SSTV: CWID is supported now

MixW 2.02:

- IARU beacons dialog added (menu View > NCDXF/IARU Beacons)
Be sure your computer time is set correctly, high accuracy
(+-1 second) is desired. Use wellknown freeware utilities
like NetDate to be in sync with the whole world automatically.
GPS or any other precise clock source may be used as well.
Click onto desired frequency to move the TRCVR there.
Previous Fq and mode will be restored after closing the dialog.

- TCP/IP connection via PACKET, as an alternative to SV2AGW PACKET
ENGINE and FLEXNET. Requires additional network driver
(download from http://tav.kiev.ua/~nick/TcpIp.html)

- PACKET settings dialog:
- General tab:
- Separate callsign box for TCP/IP operation
- Parameters tab:
- 9600 baud (G3RUH-compatible) bit shapes (select one of 16)
- Beacon/monitor tab:
- Show content of IP/ARP packets
- Baudrate measurement (show baudrate of "I" packets)

- The TRCVR/CAT dialog has an option "Show zero beat frequency"
this affects CAT bar only, LOG shows real FQ as was before.

- Export: DxccPfx is added

- Statistics: SSTV is no longer DIGITAL

- 2nd RX window size is saved

- Word mode added (menu View). To turn on or off this mode use new macros
<WORDMODE:ON> or <WORDMODE:OFF>



- Capitals Only mode added. Use according macros <CAPITALSONLY:ON> or
<CAPITALSONLY:OFF> to switch the mode.

- <MEMW:n> and <MEMR:n> macros are equivalent to Ctrl+n and Alt+n
and can be used to save and restore current frequency and mode.

- some fixes for YAESU CAT control

- Elecraft K2 Support added

- Callbook datapath adviser (for those who do not want to read FAQ or
HELP)

- CWID amplitude bug fixed (now it follows current mode setting)

- SSTV:
- B/W 8s and 12s (160x120), 24s, 36 and 43s (320x256) B/W modes added
- WWV mode can be used to calibrate the soundcard while receiving WWV
signals. Time marks are transmitted on 4996, 9996, 14996 KHz.
Tune TRCVR to 4994.100, 9994.100, 14994.100 (USB) accordingly since
audio center is usually at 1900 Hz.
Be patient if you do not hear anything. Time marks aren't transmitted
all the time, up to 5 min. pauses are expected.
- SSTV slant correction can be moved to soundcard samplerate
correction, to let other modes use that correction as well.
See button "Go" in SSTV mode settings dialog.
- Tuning indicator improved
- Zoom window now is non-modal, so it can be placed anywhere to see
what's being received while preparing the TX picture.
- Up to 16 history bitmaps can be shown now (smaller size, of course)

MixW 2.01:

- New macros:
<INIFILE:file,section,name> - insert a line from an ini-file.

Suppose I have a program that measures the temperature using a sensor
outside of the house and periodically writes the value into d:\temp\sensor.ini file:

--- start of d:\temp\sensor.ini ---
[Sensor]
Temperature=xx
Humidity=yy
Illumination=zz
--- end of d:\temp\sensor.ini ---

Then I can make a macro:

The current temperature in Kiev is
<INIFILE:d:\temp\sensor.ini,Sensor,Temperature> degrees centigrade.

- Export to CSV format: See the Search Results dialog.
- Export to text format: Text format has been changed.
- PTT / CAT dialog: "DIG" drop-down box sets DIG mode



(for YAESUs only) to use LSB, USB, or FM.

- Search dialog: Added "QSL sent" and "QSL received" search options.
Print support is added.

- CW: Proper receiving of own CW while keying with Joystick or Mouse.

- Install: Icons are created on the desktop and Start Menu.
Known bug: Icon creation may not work on old W95 with old version
of Internet Explorer (or without it at all). Just ignore the error
and create Icons manually if needed.
- Bugs: SSTV dialog remembers the last position

QSLPrint.exe
_________________________________________________________

QSLPRINT.EXE

This program is installed as part of the MixW installation. The program is installed in the program files 
folder. The latest version is 1.08, delivered with MixW2.2 and later, QSLPRINT.exe V1.07 was delivered 
with MixW2.19.

This program is designed to print QSL cards designed by the user, or to print labels. The data is obtained 
from a Print Queue set up by the user using MixW or for QSLPRINT.exe V1.08 only directly from a 
selected QSO in the MixW Log Bar.

Once loaded there is an example QSL card that can be loaded to demonstrate the program capabilities.

Print Queue

The print queue is set up as a folder PRINTQUEUE within the MixW Data Folder.

Each file within the print queue contains the QSO data line extracted from the MixW log. The file name 
has the format PR-Callsign.qpq where PR is the country prefix for the country the callsign comes from. 
So for example the call CG3ZZZ is from Canada so the file name would be VE-CG3ZZZ.qpq. 

The print queue may be set up in one of three ways. Either:
Select the QSO to be added to the print queue in the log bar and press Ctrl-Shift-P key combination
Select the QSO to be added to the print queue in the log bar and select File->Add QSO to print queue
Display the log using the hourglass icon bottom left of the log bar, select the QSO(s) to be printed, right 
click and select Print QSL.

The program QSLPRINT.exe does not need to be running to set up the print queue.

Once the QSO data has been copied to the print queue a message box will be displayed indicating the fact 
(different message box depending on which method you used to put the data in the print queue).

Once the QSO data is in the print queue folder the QSL sent field in the log will be set.

Note: If the callsign for a selected QSO already has an entry in the print queue the data will be merged 
with the existing entry. Although any number of QSO records may be merged into a single entry the 
program will only select and print the first two entries on a label or first 3 entries for a QSL card.



Formatting and Printing the Media

Start QSLPRINT.exe. There are no command line parameters. 

First make your personal selections in the File, Edit and View menus. This information will be saved in a 
file QSLPRINT.ini, found in the MixW data directory. 

Now select your media and if you are using QSL or Labels set up the dimensions for your selected media. 
At this point save the set up in a new file name. By default QSLPRINT.exe will save the data in the 
MixW data folder using a suffix of .qsl. 

Now use the New menu to insert new objects on to the media. Each item you create is a separate object. 
These objects maybe dragged into position using standard windows methods. 

If you are creating text double click on the row of 5 Xs to bring up the edit text box, change the Xs to 
your desired text and use the Font button to change the font to the desired size and characteristics 
(including colour). 

The text can include field names to incorporate unique data from entries in the print queue or from the 
selected MixW log bar QSO. The usable field names are listed below. Beware a couple of spelling 
anomalies. 

If the media is being created with a capability to print multiple QSO acknowledgements on the same 
media then the field names should have the figure 1 appended to the name (e.g. <MODE> and 
<MODE1>) to select the second set of data and 2 to select the third set of data. 

When each object is created it has an attribute Enable Print Object assigned to it. The attribute must be set 
to enable the object to be printed. To remove an object from the printed output but retain it on the media 
select the object and select the Edit menu->Enable Print Object. Once this is unchecked the object will 
not be printed until the menu item is re-enabled. 

Now go to the Edit->QSL Data and select Load from Queue or (if available) Use DDE.

The media will now be populated.

Note: Although a print queue entry can contain an infinite number of entries only the first three sets of 
data will be printed on a QSL card and two sets of data will be printed on a label, although multiple labels 
will be created until all the entries in a print queue record have been produced. 

Fields available

<BAND> - Print Band
<CALL> - Print Call
<COUNTRY> - Print County ***Spelling?***
<DATE> - Print Start QSO Date
<DATETIME> - Print Start QSO Date & Time
<DOMAIN> - Print Domain
<EDATE> - Print End QSO Date
<EDATETIME> - Print End QSO Date and Time
<EDAY> - Print End QSO Day
<EMONTH> - Print End QSO Month
<ETIME> - Print End QSO Time
<EXCHRCV> - Print Exchange Received
<EXCHSHT> - Print Exchange Sent ***Spelling?***
<EXCHSNT> - Print Exchange Sent



<EYEAR> - Print End QSO Year
<IOTA> - Print IOTA
<KHZ:n> - Print QSO Frequency in KHZ to n decimal places
<MANAGER> - Print Manager
<MHZ:n> - Print QSO Frequency in MHZ to n decimal places
<MODE> - Print Mode
<MONTH> - Print Start QSO Month
<MYCALL> - Print My Call
<NAME> - Print Name
<NOTES> - Print Notes
<QSLINFO> - Print QSL Message
<RSTR> - Print RST Received
<RSTS> - Print RST Sent
<TIME> - Print Start QSO Time
<VIAMANAGER> - Print via Manager
<YEAR> - Print Start QSO Year

To properly use this program and its facilities you need to experiment.

Script Commands
_________________________________________________________

Script commands are written one per line. A line beginning with a semicolon is considered a comment. 
Invalid commands are skipped. The following information is taken from Nick's website.

The following Script commands are available in MixW:

send "string to send"
- String may include control characters, for example, "^C"

timeout n
- The following waitfor commands will timeout in n seconds

waitfor "string to wait for"
- Wait for this string before continuing (^C, etc. allowed)

sleep n
- Sleep n seconds

Pause
- Pause and wait for operator to press "Continue" button

Close
- End the script and close the script window

runmacro "macroname"
- Run this macro (example: runmacro "FQ:14071")

sendmacro "macroname"
- Insert macro as text (example: sendmacro "MYCALL")

_________________________________________________________ 



Macros used with scripts

<SCRIPT:filename>
- Run script from a file

<ASSCRIPT>
- Treat the rest of this macro as script

<TNCSCRIPT:filename>
- Run script on the second TNC

<TELNETSCRIPT>
- Run script file in Telnet window

TEOAN
_________________________________________________________

by Denis Nechitailov, UR8US (ex UU9JDR) 

A soundcard/CAT interface device called RigExpert1 or RigExpert S/D was introduced specifically for 
use with MixW. This interface is now discontinued and has been replaced by a number of general purpose 
sound/cat interfaces.

TEOAN will only work with RigExpert S/D and RigExpert1 devices.

MixW 2.12 and later versions offer an unique feature of connecting a PC with TEOAN program and 
MixW RigExpert plugged to a transceiver into a local area network. 

Then, running MixW 2.12 on another computer on a network (or via high-speed internet connection) 
makes possible operating digital modes using that remote transceiver. 

Left side: computer (network name: dn-acer) running MixW software
Right side: computer (network name: dn-compaq) with MixW RigExpert connected. 

In the TEOAN program, set the virtual COM port number for MixW RigExpert and a TCP port number 
(the default value is OK in most cases). 



 

TEOAN settings at dn-compaq computer.

In MixW2, choose "The Eye of a Needle" as an audio device. Enter an IP address or a name of the 
computer with TEOAN running, and the same TCP port value.

Please make sure that the CAT port speed is set properly. See the TRCVR CAT/PTT dialog from  
Configure menu.

MixW sound device settings at dn-acer computer.

Note: the sound stream is not compressed, so no loss of quality is expected but on the other hand the data 
rate is high, up to 0.4 Mbit/sec (RX or TX) or 0.8 Mbit/sec for TX in full duplex mode. Usual 10 Mbit 
LAN is good enough for this application, but slow modem connections will not be able to handle such a 
big stream of data.

The TEOAN program is located in the MixW directory. Copy TEOAN.EXE from the computer with 
MixW installed to the other computer (create a  separate directory).



TNC Config & Operation
_________________________________________________________

With thanks to RICHARD B. GRIFFIN, NB6Z

TNC operation is accomplished in MixW by providing a communications link (using a serial port) 
between the PC running MixW and the TNC. The PC will act as a "terminal" to send commands to the 
TNC and display characters sent from the TNC. In this configuration the TNC will be operated in the 
"command" mode and not in the "host" mode, as would be done if a "host" program like XPWin or 
KaGold were being used. In command mode appropriate commands are used to correspond with the 
model of TNC being used. The command structure for your TNC should be available in the Operator's 
Manual provided from the TNC manufacturer.

To configure MixW for TNC operation, first select Configuration | TNC Settings, which brings up the 
following dialog:

Set these parameters to the same values that you were previously using with your TNC or refer to the 
TNC Operator's Manual for the com-port setup information. You have the option to "echo" all commands 
back to the MixW screen. Normally you will leave ECHO unchecked.

Next, select Mode | TNC mode settings, which will bring up the following dialog:



On the first UNDEFINED line in the list replace the word UNDEFINED with the name of the TNC mode 
as you want it to be shown in the log. In the Decsciption column enter information to further identify the 
mode. Then in the "Macros for TNC modes" column enter the file name (ending in .mc) that you will use 
to save the macros for this mode. The button with the (...) may also be used to browse for a file on your 
disk if you have imported a file or made a previous file. Then click OK.

Now you can start a TNC session by selecting Mode | TNC modes | <the mode from your TNC modes>

If you have Configure | Merge macros checked, your default macros will still show up on the macro 
buttons, but you can now define or redifine your macro buttons specificially for the TNC mode you are 
in.

As a very simple example, you can create a macro button to start the TNC "command" mode (<CTRL-
C>X for the KAM) and then type commands directly into the TX window and execute them by hitting the 
ENTER key. To do this, first right click on the button you want to use. If you right click on F4, for 
example, you will see this dialog:



You can convert this macro to be used to initialize the TNC by changing the label to "TNC Start", 
changing "Default for all modes" to "For this mode", and replacing the contents of the Text window with: 
<CTRL-C>X. Click on the OK button when finished. Now you can click on your "TNC Start" macro 
button to put the Kam into command mode and then begin to type TNC commands directly into the TX 
window.

When you want to leave the TNC mode select Mode | <any other mode> and the F4 button will revert to 
its previous state.

Obviously you would not want to operate your TNC this way for very long, so now you can continue to 
redefine other macro buttons for the various TNC functions and actions you want to use.

Two very important macro commands for configuring your TNC are OnStartMode and OnEndMode 
which will allow you to automatically initialize the TNC when the TNC mode is selected and leave the 
TNC in the appropriate state when you leave the TNC mode. Event macros such as OnStartMode can not 
be edited with the right click method outlined above, since they do not show on a button. To add event 
macros to a macro file select Configure | Macros for this mode, brouse for the file your want to modify, 
and then click on the Edit button.

A sample macro file for the KAM TNC called pactor-kam.mc is provided with the MixW program. You 
may use this file to operate Pactor mode on a KAM TNC and duplicate/modify it for other KAM TNC 
modes like G-tor and Amtor. If you have another manufacturer's TNC, you should use this file as a 
template to create macro files with the commands specified by your TNC manufacturer.

Voice Keying
_________________________________________________________ 

By Jim Jaffe, WA2VOS 

One of the best things in MixW is its’ ability to use WAV files in the SSB Mode for Voice Keying. I’ve 
made up a few Macros which I use constantly to call CQ thus saving my voice when the band appears to 
be Dead! I have a macro for each band starting with 10 and ending with 75 meters.

In order to use the WAV file you need to be in SSB mode! Go to the Modes Menu and Select SSB. You 
can make as many Macros as you wish following this format: 



You can transmit in any mode you like ie; AM LSB USB FM using your Rig’s mode control or if you’re 
running CAT mode click the Mode from USB to any other you prefer..most common would be USB/LSB 
as most of us use Single Sideband modes.

A very quick and easy way to create a WAV file: The following are 3 macros each one is separate and 
apart from the other. 

<STARTRECORD:echo.wav> - Start recording into the specified file
<STOPRECORD> - Stop the above record
<WAVE:echo.wav> - Play it now 

All voice keying files are titled SSB#.wav

Second Method for Creating WAV files: To create the file click Start, go to ALL Programs 
/Accessories/Entertainment select Sound Recorder. You get 60 seconds of recording. Save file as 
SSB#.wav. Try the default settings of the Sound Recorder and test with your rig using a Dummy load. 

DXAtlas
_________________________________________________________

By Finn Helmuth Pedersen, OZ6LI

You will need to make a few preparations in order for MixW and DxAtlas to work together :

Go to the MixW site to get the latest MixW version, and then DxAtlas.

Now follow this sequence:
1) After downloading the files, install in the usual/suggested MixW and DXAtlas directories.

2) Download the Visual Basic source code and Exe file:
www.mixw.net/files/Mix2DxAtlas1.zip
After download unpack the file into your MixW directory.

3) Third step is to create a Macro within MixW:
Load MixW and create a new Macro, e.g. with the name of "ATLAS".

This macro will need the following content:
<EXEC:C:\Programmer\DX Atlas\DXAtlas.exe>
<EXEC:C:\Programmer\MixW\Mix2DxAtlas.exe>
Of course the path names will depend of your actual paths.

The first line is to initially activate the DxAtlas program from within MixW. The second line awakes the 

http://www.mixw.net/files/Mix2DxAtlas1.zip


DDE data transfer program Mix2DxAtlas.
Now you are ready to utilize the benefits of the great Digital program (MixW2) in "tandem" with the 
great DX Atlas program.

1) Load MixW as usual.
2) Click on your newly created macro button "ATLAS".
3) The DxAtlas is now loading, as well as the DDE routine Mix2DxAtlas.exe
4) After some seconds a smaller DxAtlas window pops up in the upper left corner.
5) Enlarge the atlas to the whole screen.
6) To get the Mix screen back, click the Mix Butterfly at the very bottom. Click a couple of times to 
watch MixW and DxAtlas screens toggling.

Daily work with DxAtlas and MixW:
Use MixW as usual. Select a station in the waterfall and click on the callsign in the RX window. As soon 
as you click the call, data will automatically be transferred to the DxAtlas. To actually see the result of 
this transaction, toggle the screens by clicking the Mix Butterfly at the bottom of the screen. Now you 
will see the "DX" station placed correctly on the world map.

Of course the station is placed in the middle of a Prefix area. But if you, for instance, copy your Callbook 
CD to your hard disk, latitude and longitude data for the station in question (if present in callbook) will be 
transferred to DxAtlas as well. The station will then be placed right on spot in the map.

Other Programs
_________________________________________________________

By Denis Nechitailov, UR8US (ex UU9JDR) updated by Colin Bell 

MixW provides a DDE interface to pass data to other programs. This is the list of available data items to 
transfer:

Entity Server Topic Item

Your call MixW Info MyCall

Your name MixW Info MyName

Your QTH MixW Info MyQth

Your Latitude MixW Info MyLat

Your Longitude MixW Info MyLong

Your Location MixW Info MyLoc

Program name MixW Info Program

MixW version MixW Info Version

QSO date MixW QSO Date

QSO end date MixW QSO EndDate



QSO time MixW QSO Time

QSO end time MixW QSO EndTime

Frequency, MHz MixW QSO Mhz

Mode MixW QSO Mode

Call MixW QSO Call

Name MixW QSO Name

QTH MixW QSO Qth

Domain (state) MixW QSO Domain

County MixW QSO County

IOTA number MixW QSO IOTA

DXCC prefix MixW QSO DxccPrefix

WAZ zone MixW QSO WAZ

ITU zone MixW QSO ITU

Country MixW QSO Country

Continent MixW QSO Continent

Continent (full name) MixW QSO LongCont

RST sent MixW QSO RstSnt

Exch sent MixW QSO ExchSnt

RST received MixW QSO RstRcv

Exch received MixW QSO ExchRcv

QSL manager MixW QSO Manager

QSL message MixW QSO QSLmsg

Notes MixW QSO Notes

QSO is unsaved MixW QSO Changed



Band MixW QSO Band

QSO freq. MixW QSO Khz

Azimuth MixW QSO Az

Distance MixW QSO Dist

Latitude, deg. MixW QSO Lat

Longitude, deg. MixW QSO Long

Locator MixW QSO Loc

<QSOCMDDDE:txt> MixW QSO Command

Zero beat freq, kHz MixW CAT Khz

PTT state MixW CAT PTT

<CATCMDDDE:txt> MixW CAT Command

If the Callbook dialogue is open the following list of items is available for use:

Server Topic Item

MixW Callbook Call

MixW Callbook FirstName

MixW Callbook LastName

MixW Callbook MiddleName

MixW Callbook Suffix

MixW Callbook City

MixW Callbook Zip

MixW Callbook State

MixW Callbook LicClass

MixW Callbook LicDate

MixW Callbook LicExp

MixW Callbook Longitude



MixW Callbook Latitude

MixW Callbook AreaCode

MixW Callbook County

MixW Callbook TimeZone

MixW Callbook DayOfBith

MixW Callbook DxccCountry

MixW Callbook PostalCountry

MixW Callbook PrevCall

MixW Callbook PrevClass

MixW Callbook VanityCall

MixW Callbook Comment

MixW Callbook FaxNr

MixW Callbook Email

MixW Callbook Code

MixW Callbook Street

MixW Callbook ProcessDate

MixW Callbook GridSquare

MixW Callbook TransactionType

MixW Callbook QslManager

MixW Callbook MailingAddressCountry

MixW Callbook Homepage

MixW Callbook VanityFlag

Using DDE for printing QSL cards.
See MixW QSL card test.doc file from MixW directory. This file shows a sample QSL card. Names, 
QTHs and other data is automatically updated in the Microsoft Word document when you change them in 
MixW. Normally, current QSO is shown. To print a previous QSO, select it from the list in Search 
Results dialog. 



Three files are required for printing QSL cards. They are:
MixW DDE test.doc
MixW QSL card test.doc
StarOffice MixW DDE test.sdw for Star Office and OpenOffice Writer up to V3.1.

For the latest OpenOffice Writer see Using the MixW program to create a QSL card to print or to email

If any of these files are not in your MixW data folder download them as follows:

Download the Microsoft Word DDE test file:
mixw.net/files/MixW DDE test.doc

and the MixW DDE test.doc and sample QSL card:
mixw.net/files/MixW QSL card test.doc

Download Sun Star Office notes:
mixw.net/files/StarOffice MixW DDE test.sdw

Using DDE to pass QSO data to external loggers.
Here is a sample application to pass data to DXBase 2002 software.
http://www.dxbase.com
Download Visual Basic source code and EXE file:
http://mixw.net/files/Mix2DxBase4.zip.

(All Visual Basic EXE files require Visual Basic 6 DLLs to be present in your system.)

Click Send! button to send data to DXBase.

Or, create keyboard macro (for example, for F2 key):
Macro: F2
Label: Save
Text: <QSOCMDDDE:WRITE><QSOCMDDDE:>
Then use F2 to get the same result.
MixW also automatically generates <QSOCMDDDE:Send> when you press Save QSO button, and 

http://mixw.net/files/Mix2DxBase4.zip
http://www.dxbase.com/


<QSOCMDDDE:Remove> when you press Remove QSO button.

Using DDE to pass data to external maps.
Here is a sample application to pass data to DX Atlas software (www.dxatlas.com).
http://www.dxatlas.com/.

Download Visual Basic source code and EXE file:
http://mixw.net/files/Mix2DxAtlas1.zip.

This sample program plots your own and other operator's position on the map. If you are using a callbook 
and it contains the other operator's coordinates, they will be used instead of approximate ones calculated 
from his callsign.

Using DDE to switch/rotate antennas.
Download Visual Basic source code and EXE file:
http://mixw.net/files/MixAntSw1.zip.

Suppose you have two perpendicular dipoles for 80m (North/South and East/West), a multiband beam for 
20,15, and 10m and a long wire antenna for other bands.

This program demonstrates the possibility of automatic switching between all your three antennas and 
rotating the beam.

Click Switch! button to switch the antennas depending on the current frequency (80m dipoles also depend 
on the azimuth).

Click Rotate! to rotate the beam to the other station direction.

http://mixw.net/files/MixAntSw1.zip
http://mixw.net/files/Mix2DxAtlas1.zip
http://www.dxatlas.com/


To initiate switching and rotating from MixW window, create two keyboard macros (e.g. F3 and F4):
Macro: F3
Label: Switch
Text: <CATCMDDDE:SWITCH><CATCMDDDE:>
Macro: F4
Label: Rotate
Text: <CATCMDDDE:ROTATE><CATCMDDDE:>
Now F3 will switch antennas, and F4 will rotate the beam.
Check "Auto switch" and "Auto rotate" to start switching and rotating immediately when the frequency or 
direction changes.

Custom Callbooks
Using external DLL driver, it is now possible to use callbooks not directly supported by MixW.

Writing callbook drivers in C language.
Download C++ source code and DLL file:
http://mixw.net/files/MixCallBook1.zip.

Place MixCallBook.dll file to MixW directory. Then open Callbook Settings dialog and select "MixW 
custom DLL" as callbook type. Enter the database path and other data passed to the DLL (not needed in 
this sample).

This sample DLL does not contain an actual database and returns data only for UU9JDR (yes, 
megalomania). But it could be easily extended to support a real database file. See included C++ files for 
details.

Writing callbook drivers in Visual Basic.
Using a "bridge" DLL written in C language, it's possible to use Visual Basic ActiveX DLL as a callbook 
driver.

Download C++ and Visual Basic source code and DLLs:
http://mixw.net/files/MixActiveXCb1.zip.

Copy both DLLS (MixActiveXCallBook.dll and MixCallBook.dll) from the ZIP file to the MixW 
directory, then register ActiveX DLL by typing

regsvr32 MixActiveXCallBook.dll

Now choose the "MixW custom DLL" as Callbook type in Callbook Settings dialog to activate the 
"bridge" DLL.

This sample Visual Basic ActiveX DLL opens MsgBox windows in response to initializing DLL, it's 
deinitializing, and callsign lookups.

http://mixw.net/files/MixActiveXCb1.zip
http://mixw.net/files/MixCallBook1.zip


It also returns data in response to searching for UU9JDR.

You do not need to modify the MixActiveXCallBook.dll written in C language. Add your code to three 
Visual Basic functions to support your callbook database, it's easy:
Private Sub Class_Initialize()
' Add your initializing code here
...
End Sub
Private Sub Class_Terminate()
' Add your terminating code here
...
End Sub

Public Function LookupCall(Path As String, Callsign As String, ByRef Info As String) As Long
' Add your lookup code here
...
End Sub
See sample Visual Basic project from VB directory of the ZIP file for details.

ActiveX Use and Calls 

Return Call Parameter(s)

long PTT

double FqA

double FqB

double AudioFq

double Azimuth

double Elevation

BSTR Mode

BSTR GetQsoData( long index)

long GetQsoCnt()



void SetContestScore( BSTR Score)

void SetStatInfo( BSTR Info)

long AXSend( IUnknown* pData

long iCnt

long iType)

long AXReceive( IUnknown* pData

long iBufLen

long iType)

BSTR AXReceiveString()

long AXSendString( BSTR text)

void ExecuteMacros( BSTR macros)

BSTR ExtReceive()

void SetQsoData( long index

BSTR szData)

long GetSquelch()

Index values for SetQsoData and GetQsoData 

SetQsoData GetQsoData

Index Value Log item to send Index Value Log item returned

0 Call 0 Mode

1 Name 1 Fq RX

2 RST Rx 2 FQ TX

3 QTH 3 Date

4 Notes 4 Time

5 RST Snt 5 Call

6 Exch Rx 6 RST Snt



7 Domain 7 Exch Snt

8 County 8 RST Rx

9 Manager 9 Exch Rx

10 Locator 10 Name

11 Exch Snt 11 QTH

12 IOTA 12 Notes

13 13 Domain

14 14 County

15 15 IOTA

16 16 Manager

17 17 End Date

18 18 End Time

19 19 Locator

20 20

Note: The latest Microsoft development environments do not permit generation of DDE code.

Using the Spectrum
_________________________________________________________

By Jim Jaffe, WA2VOS 

MixW offers two separate displays for tuning purposes which would be the ubiquitous Waterfall and the 
Deluxe display which is the Spectrum display. The essential difference is the WATERFALL is NOT a 
REAL TIME display but an average of the signals and any attempt to tune a signal in with that display 
using the VFO knob results in a blurred trace in the direction that the VFO knob is turned.

With the Spectrum display there are actually two signals displayed: the Peak is the real time display, and 
the Average Curve is the Peak in Average time. Keep that Average curve in mind as that will come in 
handy later on. You can toggle between the Waterfall and the Spectrum Display using the keyboard 
shortcut "ALT-W".

To set up the Spectrum go to the View menu and select the following items:



 Scroll down to the Spectrum highlight and then Select Average Curve then Select Show 10DB grid. The 
colors are up to you. The colors in my illustrations are Orange for the Peak Curve, and Yellow for the 
Average Curve. The illustration below shows the Peak Curve as an inverted "V" in Orange, and the 
Average Curve as a Yellow "V".

Using the Spectrum it is very easy to see the signal and be able to tune it. If you need to use the Notch 
Filters just put your cursor on each of the individual peaks one at a time, right click and choose Set Notch 
filter and you will have completely eliminated the offending signals. In the Spectrum display you can see 
exactly where they are in relation to the signal you're trying to receive.



In the illustration you can see the filter skirts and how well you are using the filters to isolate the signal 
you want to copy. Working with the Spectrum display really makes it easy. Take a look at this illustration 
with a 500 Hz IF filter and center frequency about 1360 Hz

Tuning an MFSK signal is very difficult with the Waterfall as only the initial tone trace is visible. If you 
lose the sync you will have to wait until you can see a better trace. With the Spectrum you have to keep 
the multiple peaks in between the two Cursors. Once that is achieved you are printing the MFSK signal 
quite easily. The same applies to a RTTY Signal which this illustration depicts.

 As you can see the Spectrum Display is so effective that I never use the Waterfall. I only use the 
Waterfall display to report Sidebands on the sending station's signal upon his/her request..

Using the Waterfall
_________________________________________________________

This topic is about using MixW without a CAT (computer control) interface, and understanding what is 
going on with the waterfall and the frequency markers. This Topic may be particularly usefull for hams 
who are converting to MixW from other digital mode programs.

How Hard Could This Be?

MixW makes using the digital modes so intuitive that it may not occur to you exactly what is happening 
on the screen in front of you until something unusual occurs. So let's look carefully at the process of 
tuning in a BPSK signal in MixW, assuming that your radio and computer are all hooked up and ready to 
go.

Step 1. 



Start MixW and set your transceiver to 14,070,000 Hz. (14.070 MHz.), Upper Side Band (USB). If your 
waterfall is blank, go back to the Configuration and Set Up Section. If you have something in the 
waterfall, go to Configure | TRCVR CAT/PTT (in the MixW Menu) and click the "Display zero beat 
frequency" box to put a check mark there, and then click the OK button. Then select View | Spectrum | 
Auto. If Auto is not checked, click on it with the mouse to select it. Now right-click the mouse in the 
waterfall and select Zoom x2 from the pop up menu. The center of your waterfall and Status Bar should 
look something like the following illustration.

In this example there are two fairly strong BPSK31 signals in the waterfall, one just above 1200 Hz, and 
one at about 1580 Hz. You can also see the red and blue triangles with the green flag at 1100 Hz. In the 
status bar you can see that the mode is BPSK31, the RX, AFC, and Snap options are selected (pushed 
down), and the Squelch (Sq) and Lock options are not selected (are not pushed down).

If you move your mouse pointer into the waterfall and left click with the tip of the mouse pointer (arrow) 
in the center of the strongest signal, the green flag with the red and blue triangle will move to the center 
of the signal (about 1205 Hz in the example above), and the text of the QSO should start to print in the 
RX pane.

If the signal you are "printing" is a ham calling CQ, you can answer the call by left clicking with the 
mouse on the RX button in the staus bar (which will then change to TX) and typing your outgoing text 
into the TX pane (between the RX pane and the Waterfall).

Now, if you only want to work casual 20 Meter PSK31 contacts, you've got it mastered. But probably 
you've got a few questions. For example, if you like to log the exact frequency of your QSOs, what 
frequency would you log for that contact at 1205 Hz on the Waterfall?

Frequency
For both CW and SSB we are accustomed to simply using the dial setting as the frequency when we make 
a schedule, or log a QSO. This works because everything else is pretty much set by convention. With the 
digital modes the conventions are still developing, so you have to know what questions to ask.

The proper way to specify a digital frequency is as the center of the RF signal. If you look at a digital 
signal on your waterfall you can see where the center of the signal is because there is a little flag there! So 
the real question is: what is the RF frequency where the little flag is? Like so many things in ham radio, 
the answer is: "It depends". And what it depends on is the sideband.

Sideband
The digital modes do NOT change sidebands when they change bands. In other words you ALWAYS use 
Upper Side Band (USB) for soundcard digital modes on all bands (at least until you get to the tricky 
stuff). So knowing that you will be using USB how do you find an RF frequency in the MixW waterfall?

You do a little arithmetic. You know that in SSB your radio dial shows the frequency of the suppressed 
carrier, and that for USB the audio signals will be at a frequency higher than the suppressed carrier. So, to 
calculate the RF frequency of the QSO in the example above, just add the frequency of the suppressed 
carrier (transceiver frequency) to the audio frequency shown by the position of the flag on the MixW 
waterfall and you have the RF frequency of the signal (14.070,000 Hz plus 1,205 Hz gives 14,071,205 
Hz. or 14.071.205 KHz in the example) to be logged for the QSO.



Step 2.
But wait a minute. We are using a computer here, so why can't it do the arithmetic? MixW will do the 
arithmetic for you if you give it the information it needs. First select View | Spectrum | RF, USB to tell 
MixW you are using USB. Then select View | CAT bar. I know you don't have CAT, but this is how you 
tell MixW what frequency your transceiver dial is set to. Then click in the Fq: box, in the CAT Bar, type 
in the DIAL frequency from your transceiver (14070), and hit the enter key.

Now your waterfall should show the RF frequencies across the top, and you can see exactly what the 
center frequency of any signal is. Also, MixW will enter the frequency of the QSO properly into the Log 
as the center of the RF frequency. In the following illustration you can see that MixW entered 14070.882 
KHz into the log.

Sometimes it is necessary to reselect the mode (BPSK31 in this example) to get the proper frequency in 
the log.

NOTE: Every time you change your transceiver dial you must tell MixW what the new frequency is by 
typing it into the CAT Bar. I recommend, therefore, that you keep the CAT bar on the screen even though 
you are not using CAT.

Step 3.
There is one more aspect of frequency and sideband choice that you need to know about. Up there in Step 
1 you were told that you should always use USB for the soundcard digital modes, regardless of the band 
you are using. That probably bothered you a little, because you know that when operating SSB you use 
LSB for 160 - 40 meters, and USB for the others. You may also remember, if you have been a ham for a 
while, that in the past RTTY normally used LSB.

You are remembering correctly, but things have changed with modern transceivers and the use of 
computer programs and soundcards for the digital modes, including RTTY. Again, MixW will take care 
of most cases for you if you give it the information it needs, which you have already done in Step 2. Here 
is what a RTTY signal looks like in MixW. Note that the center of the transmitted signal (the green flag), 
14085.275 KHz is shown in the log entry. The transceiver is set to 14084 KHz, and USB.



Inversion
 When using a traditional hardware TNC, RTTY is almost always operated in the LSB mode, utilizing a 
170 Hz shift between the MARK and SPACE tones, with the MARK tone being the higher in frequency. 
If MixW is set on "RF, LSB" it will set the Mark tone as the higher tone. However, if MixW is set on 
"RF, USB" then the Mark tone will be set to the lower tone. (You can think of this as an automatic 
inversion if you like). In other words, if MixW is configured correctly (it needs to know if you are using 
LSB or USB) then it will automatically adjust your Mark and Space tones for you.

Note: This feature works differently in MixW than most other SoundCard digital programs so it may be 
confusing at first. Other modes that utilize the inversion feature are QPSK31, MFSK16, AMTOR, 
Hellschreiber, THROB, and FAX. In MixW, "Inverted" means to invert the Mark and Space tones 
from the normal operating standards of the active mode. If you are tuned to a strong signal, but 
copying only garbage, try opening the Mode Settings Dialog and clicking the Inverted box to see if the 
signal can be copied in the inverted mode.

Step 4.
Now for the big step. Once you have experimented with MixW by working a few QSOs you should go to 
the Operation Section and read the General Operation Topic all the way through. You may not understand 
some of it the first time through, but it will ring a bell later on when you are trying out all the great 
features in MixW.

Waterfall Colors

The waterfall colors maybe selected for personal preferences.



Select the Waterfall Palette set up from View|Spectrum|Colors menu
This window is confusingly entitled Spectrum colors but does not affect the spectrum display.

The nine buttons in the centre row are used to select the colour to be used for the different strength of 
signal in the waterfall display. The left button is the weakest and the right the strongest. Once the choices 
are made and the Apply button has been clicked on, the selection can be saved to a file that will have a 
.pal suffix.

MixW will remember these palette settings but archive your palette files.

Backup of the default settings is unnecessary. Click Default then Apply and the default settings will be 
restored.
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